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Preface
The purpose of the MIPAV software program is to allow medical researchers 
to extract quantitative information from image datasets of various medical 
image modalities.

Scope of this guide

The primary purpose of the MIPAV User's Guide is to provide medical 
researchers the information they need to use the MIPAV software program. 

A secondary goal is to give researchers the information needed to extend, if 
desired, the software’s capabilities through the development of new 
functions in plug-in applications via use of the software’s application 
program interface (API).

Who should use this guide

Medical researchers, medical technicians, and other people who are 
involved in analyzing medical images or maintaining and supporting the 
equipment used to produce images form the audience for the User’s Guide.
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Chapter 2, Using MIPAV Algorithms: Skills you need to perform tasks in MIPAV
Skills you need to perform tasks in MIPAV

Depending on the platform—Windows, MacIntosh, or Unix—that is running 
your workstation, it is recommended that you are familiar with installing 
and using software programs for that platform. If you plan to create plug-in 
applications for MIPAV to add new functionality, you must have software 
programming skills and be familiar with Java.

How this guide is organized

The MIPAV User’s Guide is divided into two volumes: 

• Volume 1, Basics, explains how to use the basic features and functions 
of MIPAV and how to incorporate plug-in applications.

• Volume 2, Algorithms, presents detailed information about the 
purpose, background, and function of the algorithms packaged with 
MIPAV and gives instructions for using them.

Volume 1, Basics
The MIPAV User’s Guide, Volume 1, Basics, includes the following:

• Chapter 1, “Introducing MIPAV,” presents an overview of the MIPAV 
software program.

• Chapter 2, “Installing MIPAV,” explains how to install, remove, and 
upgrade the MIPAV software program. It also explains how to 
subscribe to the MIPAV mail list and how to search the MIPAV archive.

• Chapter 3, “Getting Started Quickly with MIPAV,” explains how to use 
MIPAV to perform common functions, such as opening an image file, 
saving the file, and printing a log file. 

• Chapter 4, “Understanding Image Basics,” provides background 
information on image file formats. It also provides information on how 
to view and adjust image file attributes.

• Chapter 5, “Working with DICOM Images,” explains how to access 
DICOM databases, perform queries, and retrieve image files. In 
addition, it explains how to send files to a database.
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• Chapter 6 “Get Connected to SRB BIRN”  explains how to connect to 
SRB BIRN.

• Chapter 7 “NDAR Imaging Import,” provides the help for the NDAR 
Imaging Import tool, which is designed to assist uses in moving data 
from the MIPAV XML output to the NDAR shared data repository for 
the benefit of the greater autism community.

• Chapter 8, “Visualizing Images,” provides instruction on how to 
customize the way image files are displayed, how to magnify and 
minify images, how to view images together, how to view a portion of 
the image, and how to change image brightness and contrast by 
generating histograms and adjusting color look-up tables (LUTs). 

• Chapter 9, “Segmenting Images Using Contours and Masks,” explains 
how to create, group, rearrange, and modify volumes of interest 
(VOIs); how to create masks; and how to use paint to further identify 
VOIs.

• Chapter 10, “Analyzing Images,” discusses how to calculate statistics 
for VOIs and masks and how to generate intensity profiles, or graphs, 
for images.

• Chapter 11, “Changing Image Datasets Using MIPAV Utilities . . .,” 
explains how to use the utilities included in the software.

• Chapter 12, “Using Scripts (Macros) in MIPAV,” describes how to 
develop scripts, which you can use to customize the program.

• Chapter 13, “Developing Plug-in Programs,”  and Appendix D explain 
how to incorporate plug-in programs into MIPAV.

• Chapter 14, “Technical support” on page 557 provides information 
about MIPAV technical support and also explains how to use the debug 
mode.

• Appendix A, “References,” provides a list of references that can be used 
to learn more about MIPAV functions.

• Appendix B, “DICOM Conformance Statement,” provides a copy of the 
formal DICOM Conformance Statement, which specifies MIPAV’s 
service classes, information objects, communications protocols, and 
media storage application profiles.

• Appendix C, “Supported formats” on page 562 lists graphical and file 
formats supported by MIPAV. It also provides examples of MIPAV 
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system files (such as the preference file) and explains how the user can 
interpret them; provides limited instruction on how to modify specific 
files. 

• Appendix D, “PluginAlgorithmMedian” gives an example of MIPAV 
plug in.

The guide also includes a glossary of terms and acronyms.

Volume 2, Algorithms
Volume 2, Algorithms, includes two chapters:

• Chapter 1, “Understanding MIPAV capabilities,” which discusses the 
tools and application programming interface provided with MIPAV

• Chapter 2,  “Using MIPAV Algorithms,”  provides detailed information 
about the algorithms packaged in MIPAV

In addition, the book includes the glossary of terms and acronyms.

Where to find more information

Both volumes 1 and 2 of the MIPAV User’s Guide are available as Acrobat 
PDF files, which you can view, download, and print. You can either print 
each volume, or you can print individual chapters separately. For PDFs of 
this guide, go to the MIPAV web site: http://mipav.cit.nih.gov
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Chapter 2, Using MIPAV Algorithms: Conventions used in this guide
Conventions used in this guide

This guide uses the following conventions:

Both volumes of the MIPAV User’s Guide include special information that 
briefly highlights particular features or functions or that provide 
clarification. Based on the type of information they convey, these notes are 
labeled “note,” “tip,” “example,” “recommendation,” “remember,” 
“reference,” “caution,” and “disclaimer.” The following examples indicate 
how these notes appear and the type of information they include.

Note: Notes provide additional information that is related to the subject at hand. 
They tend to be “by the way” types of information or asides.

Tip: Tip paragraphs point out application shortcuts or briefly describe special 
features of the software.

This convention . . . Stands for . . .

Italics Names of books, guides, or manuals as 
references

New terms or emphasis

Names of executable files

Bold User input

Names of programming commands

All caps File types, such as TIFF, GIF, or JPG 

Upper- and lowercase Names of keys

name@address.com E-mail address format

Hyperlink An internet link (position the cursor on this 
word and click the left mouse button)* 

Monospace Code sample, including keywords and variables 
within text and as separate paragraphs, and 
user-defined program elements within text

*All figure and table citations, such as Figure 1 or Table 1, are hyperlinks although they 
are not underscored. Clicking the citation displays the appropriate figure or table.
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Example: An example paragraph provides an example of a task or incident in 
which something of note could occur.

Recommendation: Paragraphs that are labeled “Recommendation” suggest 

methods of good practice or advice.

Definition: The definitions of specific words or phrases of note appear in 
“definition” paragraphs. 

Remember: Notes labeled “Remember” present information that was 
previously discussed and that is pertinent in the current topic.

Reference: A reference note highlights one or more references that contain 
information on the current topic.

Caution: A paragraph labeled “Caution,” alerts you to be very careful 
about avoiding some action that could harm your equipment or data.

Disclaimer: A disclaimer indicates the possible limitations or 
ramifications of a topic.
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Understanding MIPAV capabilities
MIPAV Algorithms Overview

“Introducing MIPAV” 
“Understanding MIPAV capabilities” 
“Developing new tools using the API” 

Introducing MIPAV

Imaging is an essential component in many fields of medical research and 
clinical  practice. Biologists study cells and generate three-dimensional (3D) 
confocal microscopy datasets, virologists generate 3D reconstructions of 
viruses from micrographs, radiologists identify and quantify tumors from 
Magnetic Resonance Imaging (MRI) and Computerized Tomography (CT) 
scans, and neuroscientists detect regional metabolic brain activity from 
Positron Emission Tomography (PET) and functional MRI scans. Analysis 
of these diverse types of images requires sophisticated computerized 
quantification and visualization tools. Until recently, 3D visualization of 
images and quantitative analyses could only be performed using expensive 
UNIX workstations and customized software. Because of technological 
advancements, much of the today’s visualization and analysis can be 
performed on an inexpensive desktop computer equipped with the 
appropriate graphics hardware and software. The Medical Image 
MIPAV User’s Guide, Volume 2, Algorithms 47
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Chapter 2, Using MIPAV Algorithms: Understanding MIPAV capabilities
Processing, Analysis, and Visualization (MIPAV) software application takes 
advantage of the recent technological advancements, while offering 
functionality specifically designed for the medical community.

MIPAV is an extensible image processing, analysis, and visualization 
software. Because MIPAV is Java-based, it can run on virtually any 
platform. It can also accommodate n-dimensional images in over 20 
different file formats, including DICOM, Analyze, TIFF, JPG, and RAW. 

MIPAV is designed to be both a software application and an application 
programming interface (API). As a software application, MIPAV provides 
an easy-to-use graphical user interface (GUI) that allows researchers to 
extract quantitative information from various medical imaging modalities.

Understanding MIPAV capabilities

MIPAV provides ready-made, general-purpose tools that meet the majority 
of requirements of many researchers. Researchers can use these tools to 
perform a variety of tasks:

• View image files, juxtapose images, and adjust opacity level so that 
overlapping areas can be studied

• Create image files and view and modify the attributes of an image, 
including DICOM and volume of interest (VOI) information

• Adjust the display of an image file and adjust magnification settings

• View DICOM overlays and sanitize DICOM information and send and 
receive image files to and from databases residing on DICOM-
compliant servers (on computer or imaging device)

• Manually, semiautomatically, and automatically delineate or segment 
volumes of interest (VOI) and generate graphs and run statistics on 
VOIs

• Generate and adjust histograms and lookup tables (LUT) using 
customized or preset options

• Run sophisticated, predefined algorithms and generate a log of each 
algorithm run for each image

• Create new plug-ins to further customize the analysis of data
MIPAV User’s Guide, Volume 2, Algorithms 48
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Chapter 2, Using MIPAV Algorithms: Developing new tools using the API
• Save transformation, look-up table (LUT), and VOI data and apply 
them to other images

• Print image files, graphs, statistical data, algorithmic logs, and 
debugging log data

Developing new tools using the API 

Researchers who have programming resources can use MIPAV as an 
application programming interface (API) to develop and incorporate new 
and innovative image processing, registration, and visualizations. MIPAV 
provides researchers the ability to quickly build a specific program, which 
can be installed in MIPAV as a plug-in, to quantify and visualize their data. 

The API provides much flexibility while the software application provides a 
variety of commonly used features, thus allowing researchers to use MIPAV 
to meet a variety of research needs. 

For more information of how to develop MIPAV plug-ins, refer to MIPAV 
Users Guide Volume 1, Chapter “Developing Plug-in Programs”.
MIPAV User’s Guide, Volume 2, Algorithms 49

12/5/08 



7

Using MIPAV Algorithms
In this chapter . .

“Recording algorithms usage with the history feature” on page 50
“Introducing MIPAV algorithms” on page 51

MIPAV supports a wide range of image-processing algorithms to facilitate 
the quantification of data from medical images. Although MIPAV provides 
storage for all types of 3D volumes, most of the algorithms are designed for 
application to 3D datasets where all three dimensions are spatial. However, 
MIPAV’s storage techniques do not preclude developing algorithms or 
visualization for datasets of any dimensionality.

Recording algorithms usage with the history 
feature

MIPAV provides a way for you to record the actions, whether with 
algorithms or utilities, that you perform on images. To turn on this feature,  
use the MIPAV Options dialog box. See also “Debugging MIPAV” on 
page 76.
MIPAV User’s Guide, Volume 2, Algorithms 50
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Chapter 2, Using MIPAV Algorithms: Introducing MIPAV algorithms
 Introducing MIPAV algorithms

Table 1 lists both the current and planned MIPAV algorithms (planned 
algorithms marked as TBD). This table also explains what effect the 
algorithms have on images.

Table 1. MIPAV algorithms and their effects on images

Algorithm Effect Image types

“Interpolation methods 
used in MIPAV” 

Bilinear, Trilinear, B-spline 3-rd 
order, B-spline 4-th order, Cubic 
Lagrangian, Quintic Lagrangian, 
Heptic Lagrangian, and 
Windowed sinc

“Cost functions used in 
MIPAV algorithms” 

“Autocorrelation 
Coefficients” 

The algorithm calculates 
autocorrelation coefficients for 
images

Color and black and white 3D 
and 4D images

“Autocovariance 
Coefficients” 

The algorithm produces auto 
covariance coefficients which help 
to provide a description of the 
texture or a nature of the noise 
structure.

Color and black and white 3D 
and 4D images.

“Barrel Distortion 
Correction” 

The algorithm is a cost-effective 
alternative to an expensive lens 
system 

RGB and grayscale 2D images 

DTI

“DTI Color Display” This plug-in introduces a novel 
technique to visualize nerve fiber 
tracts in diffusion-weighted 
magnetic resonance imaging data 

The algorithm works with any 
image types supported by 
MIPAV 
MIPAV User’s Guide, Volume 2, Algorithms 51
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“DTI Create List File” This utility takes as an input a 
DICOM study directory or a PAR/
REC file extracts the information 
and creates the following files:

– A list file with metadata 
information 

– A sorted relative path file that 
contains the relative paths to the 
slice files

– B-matrix file

DICOM study directory or a 
PAR/REC file

Edge Detection

“Edge Detection: Zero X 
Laplacian” 

The algorithm finds edges that 
form a closed contour, which 
completely bound an object

2D and 3D grayscale images 

“Edge Detection: Zero X 
Non-Maximum 
Suppression” 

The method produces an edge 
map of the zero-crossings of the 
non-maximum suppression for 
2D and 3D images 

2D and 3D grayscale images 

Extract Surface: Adaptive 
Climbing

TBD TBD 

Extract Surface: 
Tetrahedron

TBD TBD 

Brain tools

‘‘Extract Surface (Marching 
Cubes)’’

Extracts surface information from 
a 3D array of values 

2D and 3D MRI images 

“Extract Brain: Extract 
Brain Surface (BET)” 

Extracts the surface of the brain 
from a T1-weighted MRI 

3D MRI images 

“Extract Brain: Extract 
Brain Surface (BSE)” 

This algorithm strips areas out-
side the brain from a T1-
weighted magnetic resonance 
image (MRI)   

3D MRI images 

“Face Anonymizer (BET)” The algorithm extracts an 
approximated face from a T1-
weighted MRI, eliminating facial 
areas outside of a certain buffer 
from the brain 

You can apply this algorithm 
only to 3D T1-weighted MRI 
images 

Fourier Transform

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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“Fast Fourier 
Transformation (FFT)” 

Processes images by filtering in 
the frequency domain 

• Gray-scale 2D and 3D 
images

• Conjugate, symmetric, and 
complex data (frequency 
filter or inverse FFT only)

Filters

“Filters (Frequency)” Frequency filters process an 
image in the frequency domain

2D and 3D grayscale images 

“Filters (Spatial): Adaptive 
Noise Reduction” 

Reduces noise without blurring 
the edges 

• Color images
• Black-and-white images

“Filters (Spatial): Adaptive 
Path Smooth” 

The algorithm reduces noise 
without blurring edges. It 
replaces a pixel value with a 
weighted sum of the local pixels 
on the low-cost path 

Color and grayscale 2D and 3D 
images 

“Filters (Spatial): 
Anisotropic Diffusion” 

Blurs image except across the 
boundaries 

Grayscale images.

“Filters (Spatial): 
Coherence-Enhancing 
Diffusion” 

Useful for filtering relatively thin, 
linear structures such as blood 
vessels, elongated cells, and 
muscle fibers 

• All data types except 
complex

• 2D, 2.5D, and 3D images

“Filters (Spatial): Gaussian 
Blur” 

Blurs an image. This algorithm 
produces a similar result as 
applying a low-pass or smoothing 
filter 

• All image data types except 
Complex

• 2D, 2.5D, 3D, and 4D images

“Filters (Spatial): Gradient 
Magnitude” 

Generates a strong response at 
the edges of an objects 

• All image data types except 
Complex

• 2D, 2.5D, 3D, and 4D images

“Filters (Spatial): Haralick 
Texture” 

The Haralick texture features are 
used for image classification. 
These features capture 
information about the patterns 
that emerge in the image texture

Any noncomplex 2D image

“Filters (Spatial): 
Laplacian” 

Detects edges in an image by 
identifying meaningful disconti-
nuities in a gray level or color 

• All image data types except 
Complex

• 2D, 2.5D, and 3D images

Filters (Spatial): Local 
Normalization

TBD TBD 

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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“Filters (Spatial): Mean” Provides a simple way of reduc-
ing noise, either in an entire 
image, or in a delineated VOI in 
the image 

• All image data types except 
COMPLEX

• 2D and 3D images

“Filters (Spatial): Median” Removes shot noise by replacing 
a target pixel’s value with the 
median value of neighboring pix-
els 

• Gray-scale 2D, 2.5D, and 3D 
images

• Color 2D, 2.5D, and 3D 
images

“Filters (Spatial): Mode” Uses mode filtering (a nonlinear 
spatial filtering technique) to 
replace a target pixel with the 
mode of the neighboring pixels 

2D, 2.5D, and 3D images of the 
following data types:

• BYTE and UBBYTE
• SHORT and USHORT
• INTEGER and UINTEGER

“Filters (Spatial): 
Nonlinear Noise Reduction” 

Reduces noise in an image while 
preserving both the underlying 
structure and the edges and cor-
ners 

Black-and-white 2D, 2.5D, and 
3D images 

“Filters (Spatial): 
Nonmaximum 
Suppression”  

Defines the edges of an image • Black-and-white 2D, 2.5D, 
and 3D images

• Edge processing only 
applicable to black-and-white 
2D images

“Filters (Spatial): 
Regularized Isotropic 
(Nonlinear) Diffusion” 

Regularized isotropic nonlinear 
diffusion. Diffusion filtering, 
which models the diffusion pro-
cess, is an iterative approach of 
spatial filtering 

• All data types except 
complex

• 2D, 2.5D, and 3D images

“Filters (Spatial): Slice 
Averaging” 

Reduces image noise • All image data types 
• All 2D, 2.5D, and 3D images

“Filters (Spatial): Unsharp 
Mask” 

Produces a sharpened version of 
the image or a VOI of the image 

• All image data types, except 
complex and RGB images 

• 2D, 2.5D, 3D, and 4D images

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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Chapter 2, Using MIPAV Algorithms: Introducing MIPAV algorithms
“Filters (Wavelet): De-
noising BLS GSM” 

“Filters (Wavelet): 
Thresholding” 

The modulated window is shifted 
along the signal, and for every 
position, the spectrum is 
calculated. This process is 
repeated many times with a 
slightly shorter (or longer) 
window for every new cycle. The 
result appears as a collection of 
time-frequency representations 
of the signal, all with different 
resolutions. This solves the 
signal-cutting problem which 
arises in the Fourier transform

• 2D and 3D datasets
• RGB datasets

Fuzzy C-Means

“Fuzzy C-Means: 
Multispectral and Single 
Channel Algorithms” 

Performs both hard and soft 
segmentation on multiple images 

• 2D and 3D datasets
• RGB datasets

Histogram tools

“2D Histogram” The algorithm takes as an input 
two grayscale images or one 
color image, and then creates a 
2D histogram image based on the 
data from two input images 

Color and black-and-white 
images 2D and 3D images 

“Cumulative Histogram” Calculates the cumulative 
histogram for a chosen image.

2D, 2.5D and 3D grayscale and 
color (RGB) images. For RGB 
images the algorithm will 
display a separate cumulative 
histogram for each channel (R, 
G, and B).

“Histogram Equalization: 
Neighborhood Adaptive” 

Enhances the contrast in an 
image by reevaluating the gray-
scale or intensity value of each 
pixel based on a region of nearby 
pixels 

• Color image
• Black-and-white images

“Histogram Equalization: 
Regional Adaptive” 

Enhances the contrast in an 
image 

• Color images
• Black-and-white images
• Whole images, not VOIs

“Histogram Matching” The algorithm generates an 
output image based upon a 
specified histogram 

Color and black-and-white 2D 
and 3D images 

“Histogram summary” Displays frequency distribution 
information for a chosen image 

All image types 

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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Image calculator

“Image Calculator” 

See also MIPAV Volume1 
User Guide

Adds, subtracts, multiplies, and 
divides, etc. the pixel values of 
one image by the pixel values of 
another image. Two images can 
also be ANDed, ORed or XORed 
together. More advanced math 
operators available via the dialog 
text field 

2D and 3D color and grayscale 
images 

“Image Math” 

See also MIPAV Volume1 
User Guide

The algorithm adds, subtracts, 
multiplies, or divides an image by 
a user specified value. The 
square root, absolute value, or 
log of an image also can be 
calculated 

2D and 3D grayscale images 

InsightToolkit (ITK) 

“ITK” This technical guide explains how 
to integrate Kitware’s 
InsightToolkit (ITK) with MIPAV

Levelset tools

Levelset TBD TBD 

Mask tools

“Mask” Generates a mask, with a speci-
fied intensity, of the region inside 
or outside the contoured VOIs 
that are delineated on an image 

2D, 2.5D, 3D, and 4D images, 
not RGB images 

“Quantify Mask” 

See also MIPAV Volume1 
User Guide

There are two similar algorithms 
Quantify Mask(s) and Quantify 
Using Mask that calculate Center 
of Mass, area (in resolutions), 
and number of pixels for a 
selected mask(s) 

Algorithms work with Boolean, 
byte, unsigned byte, and short 
masks 

Microscopy

“Microscopy: Blind 
Deconvolution” 

Recovers a target object from a 
set of blurred images in the pres-
ence or a poorly determined or 
unknown Point Spread Function 
(PSF) 

2D and 3D images, color and 
grayscale 

“Microscopy: Colocalization 
Orthogonal Regression” 

Provides an automatic method of 
quantifying the amount of colo-
calization in images 

Color and black-and-white 2D 
or 3D images 

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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“Microscopy: FRAP 
(Fluorescence Recovery 
After Photobleaching)” 

Determines an association rate, 
dissociation rate, and diffusion 
transfer coefficient in images 

Color and black-and-white 3D 
images 

“Microscopy: Colocalization 
Orthogonal Regression 
(FRET)—
Acceptor Photobleaching” 

This algorithm uses acceptor 
photo bleaching to compare the 
proximity of fluorescent-labeled 
molecules in two 2D images over 
distance 

You can apply this algorithm to 
two 2D images or to a single 2-
slice 3D image 

“Microscopy: Fluorescent 
Resonance Energy Transfer 
(FRET) Bleed Through and 
Efficiency” 

This section provides information 
on and discusses how to use the 
following two FRET algorithms:

• FRET Bleed Through algorithm

• FRET Efficiency algorithm

Three 2D images

“Microscopy (Restoration): 
Computational Optical 
Sectional Microscopy 
(COSM)” 

This algorithm removes out-of-
focus light in 3D volumes 
collected plane by plane using 
either widefield or confocal 
fluorescence microscopes

All types of 3D microscopy 
images that can be opened in 
MIPAV

Morphology: 

Morphology: “Background 
Distance map” 

This operation converts a binary 
image into an image where every 
foreground pixel has a value cor-
responding to the minimum dis-
tance from the background 

All Morphology operations 
can be applied to the images of 
the following types:

• Boolean–1 bit per pixel/voxel 
(1 on, 0 off)

• Unsigned byte–1 byte per 
pixel/voxel (0, 255)

• Unsigned short–2 bytes per 
pixel/voxel (0, 65535)

Morphology: “Close” Performs Morphology closing for 
a selected image 

Morphology: “Delete 
Objects” 

Deletes objects larger and or 
smaller than the indicated maxi-
mum/minimum size 

Morphology:“Dilate” Dilates the image using the user 
specified structural element 

Morphology: “Distance 
Map” 

The algorithm uses the Euclidean 
distance metric to calculate a dis-
tance map for a selected image 
or image region 

Morphology: “Erode” Erodes the image using the user 
specified structural element 

Morphology: “Evaluate 
Segmentation” 

Compares segmentation results 
of a test image to segmentation 
results of an ideal gold standard 
true image 

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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Morphology: “Fill holes” Fills holes in a selected image 

Morphology: “Find Edges” Finds the edges of the objects in 
an image using combinations of 
the following Morphology opera-
tions: dilation, erosion and XOR 

Morphology: “ID objects” The algorithm labels each object 
in a selected image with a differ-
ent integer value and also deletes 
objects which are outside of the 
user defined threshold 

Morphology: 
“Morphological filter” 

It corrects a selected image for 
non-uniform illumination and 
non-uniform camera sensitivity 

Morphology: “Open” Perform Morphology opening of 
the selected image using the user 
specified structural element 

Morphology: Particle 
Analysis

Generates the information on the 
particle composition for the 
binary images 

Morphology: “Skeletonize” Skeletonizes the image by means 
of a lookup table, which is used 
to repeatedly remove pixels from 
the edges of objects in a binary 
image, reducing them to single 
pixel wide skeletons 

Morphology: “Skeletonize 
3D pot field” 

The algorithm uses an iterative 
approach to simultaneously pro-
duce a hierarchical shape decom-
position of a selected image and 
create a corresponding set of 
multi-resolution skeletons.

Morphology: “Ultimate 
erode” 

Generates the ultimate eroded 
points (UEPs) of an Euclidian dis-
tance map for an image 

End of Morphology

Muscle segmentation

“Muscle Segmentation” 

“Abdomen Segmentation” 

This is a semi automatic tool for 
segmenting different muscles 
and muscles and fat in Computed 
Tomography (CT) images of the 
thigh and abdomen

Any CT image of the thighs and 
abdomen that can currently be 
opened by MIPAV

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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Noise TBD TBD 

Plot Surface TBD TBD 

Principal Component TBD TBD 

“Randomizing image 
(slice) order” see Volume 
1, Utilities

Randomizes the order of slices in 
the image dataset 

3D images 

Registration

Registration: AFNI-Shear TBD TBD 

Registration: AIR Linear TBD TBD 

Registration: AIR Nonlinear TBD TBD 

Registration: “B-Spline 
Automatic Registration” 

B-spline based registration of 
images in two and three 
dimensions 

2D and 3D color (RGB) and 
grayscale images

“Registration: Patient 
Position (DICOM)” TBD

The method uses the image 
origin coordinates and image 
orientations to align DICOM 
images based on a patient 
position

DICOM images

“Registration: Display Pixel 
Similarity Cost Functions” 

The algorithm calculates costs for 
various voxel similarity cost 
functions that are used in 
registration and output them to 
the Output window 

Color, grayscale, and black and 
white 2D and 3D images 

“Registration: Landmark—
Least Squares” 

Registers an image to the refer-
ence image by using correspond-
ing points placed in both images 

2D and 3D gray-scale and color 
images 

“Registration: Landmark—
TPSpline” 

Registers two images in a nonlin-
ear manner using the corre-
sponding landmark points that 
you delineate in both of the 
images 

All 2D and 3D images

“Registration: Manual 2D 
Series” 

Registers manually or semimanu-
ally two images by placing corre-
sponding points on both imagoes 
and then, applying either the 
Landmark—Thin Plate Spline or 
Landmark—Least Squares algo-
rithm 

All 2D gray-scale and color 
images 

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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Registration: “Midsagittal 
Line Alignment” 

Used for the automatic detection 
of the midsagittal line in 2D and 
midsagittal plane in 3D brain 
images 

Color and black-and-white 3D 
images 

Registration: “Mosaic 
Registration” 

This is a user interface for a 
semi-manual image registration. 
It allows the user, first, manually 
aligns two images using a mouse, 
and then it calls the Optimized 
Automatic Registration 2D 
algorithm for further precise 
registration 

Color, grayscale, and black and 
white 2D images 

Registration: “NEI Build MP 
maps plug in” 

The method includes the 
measurements of MP that are 
performed by analysis of 
autofluorescence (AF) images 
and building the MP maps

 2D retinal images

Registration:“Optimized 
Automatic Registration 3D” 
and 2.5 D

Determines a transformation that 
minimizes a cost function, which 
represents the quality of 
alignment between two images 

Color, grayscale, and black and 
white 3D images 

“Registration: Time Series 
Optimized Automatic 
Registration” 

Registers individual 3D volumes 
within a 4D time series to a refer-
ence volume 

Both 4D color and gray-scale 
images 

Registration: “Reslice—
Isotropic Voxels” 

Applies image resampling All image data types except 
RGB and complex 

Shading correction

“Shading Correction: 
Inhomogeneity N3 
Correction” 

Corrects for shading artifacts 
often seen in MRI 

2D and 3D MRI images 

Talairach Space

“Labeling and Measuring 
Brain Components in 
Talairach Space” 

How to use the 
TalairachTransformation wizard 
and the FANTASM (Fuzzy and 
Noise Tolerant Adaptive 
Segmentation Method) plug-in 
programs, which were developed 
by the Johns Hopkins University, 
with MIPAV

Threshold

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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Chapter 2, Using MIPAV Algorithms: Introducing MIPAV algorithms
“Standard Deviation 
Threshold” 

Standard Deviation Threshold 
works by, first, examining an 
active VOI for which the standard 
deviation (st.dev) of pixel intensi-
ties and other statistics are calcu-
lated. The algorithm, then, 
thresholds an image using the 
user defined parameters, such as 
a number of standard deviations 
and/or values outside of the 
range 

2D, 3D, and 4D color (RGB) and 
grayscale images 

“Threshold” The algorithm replaces the image 
pixel values with the fill values 
specified by a user. The pixel 
values change or remain 
unchanged depending on 
whether the original color value is 
within the threshold range  

All 2D, 3D, and 4D color (RGB) 
and grayscale images 

Stereo Depth TBD TBD 

“Subsampling images” Reduces an image in size by a 
chosen factor of 2, 4, or 8 times 

All image types 

Subtract

Subtract VOI Background TBD TBD 

Transformation

“Transform to power of 2” The algorithm resamples the 
original image to dimensions that 
are powers of 2 

Color and black-and-white 2D 
and 3D images 

“Transform” Offers multiple options that help 
a user to define the 
transformation matrix, and then 
execute the transformation and 
(or) resampling 

Color and black-and-white 2D, 
2.5D, 3D, and 4D images 

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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Chapter 2, Using MIPAV Algorithms: Introducing MIPAV algorithms
“Transform: Conformal 
Mapping Algorithms” :

• “Circular Sector to 
Rectangle” 

• “Transformation: Circle 
to Rectangle” 

• “Transformation: Ellipse 
to Circle” 

• “Transformation: Nearly 
Circular Region to Circle” 

The methods described in this 
document use conformal 
mapping to transform points in a 
circular sector, circle, ellipse, or 
nearly circular region to points in 
a circle or rectangle

All ultrasound images that can 
be opened in MIPAV and also 2D 
color and black and white 
images

Transform Nonlinear The algorithm takes a source 
image and uses information read 
in from a nonlinear 
transformation (.nlt) file to 
perform a nonlinear B-Spline 
transformation on the image

Color (RGB) and grayscale 2D 
and 3D images

Watershed

Watershed This is an interactive algorithm 
that allows automatically 
segment the image regions of 
interest using the topographical 
approach

2D and 3D grayscale images

Table 1. MIPAV algorithms and their effects on images (continued)

Algorithm Effect Image types
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Chapter 2, Using MIPAV Algorithms: Cost functions used in MIPAV algorithms
Cost functions used in MIPAV algorithms

A similarity or cost function measures the similarity between two images. 
During the registration the adjusted image V is transformed using the vari-

ous transformation functions. And the similarity S(U;Vt) between the refer-

ence image U and transformed image Vt is then calculated. 

We assume that the transformation that gives the smallest value of the cho-
sen inverse cost function  is the transformation that also gives the best 
alignment.

In this MIPAV User Guide we use the term cost function to refer to the negative 
cost function. 

Background
For the registration algorithms, suchs OAR, the main approach for deter-
mining an optimal transformation is  to

• Calculate a cost function, 

• Determine how it changes as individual transformation parameters are 
varied, 

• And find the parameters that minimize the value of the cost function. 

For instance, Figure 1 shows a plot of a sample cost function for a selection 
of transformation parameters; in each plot, a single parameter is varied 
while all other are kept constant.
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Chapter 2, Using MIPAV Algorithms: Cost functions used in MIPAV algorithms
The cost functions implemented in MIPAV: 

• Correlation ratio, refer to page 64 

• Least Squares, refer to page 66 

• Normalized Cross Correlation, on page 67

• Normalized Mutual Information, see page 70

POWELL ALGORITHM

In MIPAV, the most of the methods  and algorithms use the Powell algo-
rithm to find the global minimum of the chosen cost function. For more 
information about the Powell algorithm, refer to http://math.fullerton.edu/
mathews/n2003/PowellMethodMod.html

CORRELATION RATIO

Given two images I and R, the basic principle of the Correlation Ratio 
method is to search for a spatial transformation T and an intensity mapping 

Figure 1.  The plots of the Correlation Ratio cost function versus some of 
the individual parameter values. In each plot (A, B, C, and D), a single 
parameter is varied while the other are kept constant
MIPAV User’s Guide, Volume 2, Algorithms 64

12/5/08 

http://math.fullerton.edu/mathews/n2003/PowellMethodMod.html
http://math.fullerton.edu/mathews/n2003/PowellMethodMod.html


M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Cost functions used in MIPAV algorithms
f such that, by displacing R and remapping its intensities, the resulting 
image f(R* T) be as similar as possible to I. This could be achieved by mini-
mizing the following correlation ratio function:

EQUATION 1

which integrates over the voxel positions xk in the image I.

Image types

Correlation Ratio can be used in multimodal image registration, e.g. that 
involves Magnetic Resonance (MR), Computed Tomography (CT), and 
Positron Emission Tomography (PET) images.

LAPLACIAN ZERO-CROSSING

The laplacian zero-crossing is a binary edge feature used for edge detection, 
see also “Edge Detection: Zero X Laplacian” . Convolution of an image with 
a laplacian kernel approximates the 2-nd partial derivative of the image. 
The laplacian image zero-crossing corresponds to points of maximal (or 
minimal) gradient magnitude. Thus, laplacian zero-crossings represent 
“good” edge properties and should, therefore, have a low local cost meaning 
edge detection. If IL(q) is the laplacian of an image I at pixel q, then

EQUATION 2

Though, application of a discrete laplacian kernel to a digital image 
produces very few zero-valued pixels. Rather, a zero-crossing is represented 
by two neighboring pixels that change from positive to negative values. Of 
these two neighboring pixels, the one closest to zero is used to represent the 
zero-crossing. The resulting feature cost contains single-pixel wide cost 
“canyons” used for boundary localization.
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Chapter 2, Using MIPAV Algorithms: Cost functions used in MIPAV algorithms
GRADIENT MAGNITUDE

Gradient Magnitude provides a direct correlation between the edge strength 
and local cost. If Ix and Iy represent the partials of an image I in Xx and Y 

directions respectively, then the gradient magnitude G is approximated 
with

EQUATION 3

The gradient is then scaled and inverted,  so high gradients produce low 
costs and vice-versa. Thus, the gradient component function is

EQUATION 4

Finally, gradient magnitude costs can be scaled by Euclidean distance. To 
keep the resulting maximum gradient at unity, fG(q) can be scaled by 1 if q is 

a diagonal neighbor to p and by 1/sqrt(2) if q is a horizontal or vertical 
neighbor.

LEAST SQUARES

Least squares measures the average of the squared difference in image 
intensities.

EQUATION 5

Where,
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R(pi) = reference image(pi) - minimum reference image value

I(pi) = input image(pi) - minimum input image value

N = the number of values over which the sum is performed

It can be divided by count to normalize the cost function or make it invari-
ant to the number of voxels in the region of overlap. If two images show 
large differences in image intensity, then we recommend using Scaled Least 
Squares with a global scaling term added, refer to Equation 6:

EQUATION 6

Where s is a global scaling factor.

Image types

It can be shown that Least Squares is the optimum cost function when two 
images only differ by Gaussian noise. Images in two different modalities, 
such as PET and MRI, will never differ by only Gaussian noise. Even two 
images in the same modality, such as two PET images, will seldom only 
differ by Gaussian noise as medical scan noise is frequently not Gaussian 
and because the object often changes between the image acquisitions. The 
effectiveness of this cost function will be greatly diminished by small 
numbers of voxels having large intensity differences.

NORMALIZED CROSS CORRELATION

The Cross-Correlation function can be described as 

EQUATION 7

Where,

R–reference image intensity
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I–input image intensity

And the summation is taken over the region (s,t) where R and I overlap. For 
any value of (s,t) inside R(x,y) the cross-correlation function yields one 
value of CrossCorr. The maximum value of CrossCorr(s,t) indicates the 
position where I(x,y) best matches R(x,y).

The correlation ratio ranges from 0 for very good registrations to 1 for very 
bad registrations.

Normalized cross correlation

Normalized Cross Correlation – (NCC)= var(RI)/sqrt(varR* varI). Where,

var is the variance
varRI = sum(RI)/(count-1)  - (sumR*sumI)/((count-1)*count)

varR = sum(R2)/(count-1) - (sumR*sumR)/((count-1)*count)

varI = sum(I2)/(count-1) - (sumI*sumI)/((count-1)*count)
R = (the reference image value - reference image minimum value);
I = (the input image value - input image minimum value);
count is a total number of values.

For correlation ratio:

First, go over all pixels forming numY, sumY, and sumY2:

indexValue = (int)( (reference image[index] - minimum 
reference image value) * constant);                           

numY[indexValue]  = numY[indexValue] + 1

sumY[indexValue]  = sumY[indexValue] + input image 
value - minimum input image value

sumY2[indexValue] = sumY2[indexValue] + (input 
image value - minimum input image value)2

Now calculate the individual variances 

For each iso-set weighting them by the number of pixels from the input 
image that contribute.

 for (int b=0; b < nBins; b++) 

{

     numTotY  = numTotY + numY[b]
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Chapter 2, Using MIPAV Algorithms: Cost functions used in MIPAV algorithms
     totSumY  = totSumY + sumY[b]

     totSumY2 = totSumY2 + sumY2[b]

The following should be the variance of the b-th iso-subset 

     variance = (sumY2[b] - sumY[b]*sumY[b]/
numY[b] ) / ( numY[b]-1)

     corrRatio = corrRatio +  variance * numY[b]

 }

Normalize the weighting of numY[]

 corrRatio = corrRatio/numTotY

Calculate the total variance of input image and then normalize by this

variance = ( totSumY2 - totSumY * totSumY / 
numTotY ) / (numTotY - 1)

corrRatio = corrRatio/variance

More simply the above steps can be expressed as 

EQUATION 8

Image types

The Cross-Correlation function can be used for aligning the images that 
have a linear relationship between the intensity values in the images. E.g. 
images acquired using the same modality. However, the Normalized Cross-
Correlation may not work very well in two images that are identical except 
for a global scaling factor.  

The Normalized Cross Correlation is 1 for identical images and approach 0 for 
images that are very different.
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NORMALIZED MUTUAL INFORMATION

Mutual information (MI) measures how well one image explains the other.  
In medical image processing, it is often used as 1) a similarity measure for 
image registration for images that were acquired at different times or by 
different modalities and 2) also for combining multiple images to build 3D 
models. The mutual information (MI) of random variables A and B is 
defined as:

EQUATION 9

Where, p(a,b) is the joint probability distribution function of A and B, and 
p(a) and p(b) are the marginal probability distribution functions of A and B 
respectively. 

Equation 9 can be also rewritten as  MI(A,B,C) = H(A) + H(B)-H(A,B), 

where H(A) and H(B) are the Shannon entropies of image A and B 
respectively computed on the probability distributions of their grey values. 
And H(A,B) denotes the conditional entropy, which is based on the 
conditional probabilities p(a |b) – the chance of grey value a in image A 
given that the corresponding voxel in B has grey value b. MI measures the 
distance between the joint distributions of the images' gray values p(a,b) 
and the distribution when assume that images are independent  from each 
other.

Normalized mutual information can be calculated as NMI(A,B) = 
(H(A) + H(B))/H(A,B).

Image types

The normalized mutual information has been shown to work very well for 
registering multi-modality images and also time series images.  The 
normalized mutual information approaches 0 for identical images and 
approaches 1 for images that are very different. 
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DEGREES OF FREEDOM

The number of independent pieces of information that go into the estimate 
of a parameter is called the degrees of freedom (DOF). In general, the 
degrees of freedom of an estimate is equal to the number of independent 
scores that go into the estimate minus the number of parameters estimated 
as intermediate steps in the estimation of the parameter itself. In image reg-
istration, a transformation matrix establishes geometrical correspondence 
between coordinate systems of  different images. It is used to transform one 
image into the space of the other. The following transformations are gener-
ally used in biomedical imaging:

• 1Rigid-body transformations include translations and rotations. They 
preserve all lengths and angles. These are 6 DOF transformation, and 
the transformation matrix is as follows:

EQUATION 10

Where Rx, Ry, and Rz represent rotations and Tx, Ty, Tz – translations.

• Global rescale transformations include translations, rotations, and a 
single scale parameter S=Sx=Sy=Sz. They preserve all angles and 

relative lengths. These are 7DOF transformations and the 
transformation matrix is as follows:

EQUATION 11

• Affine transformations include translations, rotations, scales, and/or 
skewing parameters. They preserve straight lines but necessarily not 

1. Here, DOF are given for 3D images.
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angles or lengths. Transformation matrixes for affine transformations 
are as follows:

9 DOF transformation matrix which includes scale parameters Sx, Sy and Sz:

EQUATION 12

12 DOF transformation matrix which includes both scale and skew parame-
ters. In the matrix,  skewing parameters are  presented as Skx, Sky, and Skz:

EQUATION 13
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Interpolation methods used in MIPAV

The registration and transformation algorithms implemented in MIPAV 
resampes images (if needed) using an interpolation scheme, where aniso-
tropic voxels (or pixels for 2D images) are resampled into isotropic 1 mm 
cubic voxels. New voxel values are computed using a weighted combina-
tion of existing voxel values within a defined neighborhood of the new 
voxel location. The following interpolation methods are available in this 
implementation of the registration technique, including Bilinear, Trilin-
ear, B-spline 3-rd order, B-spline 4-th order, Cubic Lagrangian, Quintic 
Lagrangian, Heptic Lagrangian, and Windowed sinc. 

Bilinear Interpolation
Bilinear interpolation considers the closest 2x2 neighborhood of known 
pixel values surrounding the unknown pixel. It then takes a weighted 
average of these 4 pixels to arrive at its final interpolated value. This results 
in smoother looking images.

Figure 1 is for a case when the known pixel distances are not equal, 
therefore the interpolated value is calculated using the Equation 1.–
Equation 4.

First, we will do a linear interpolation in X direction and calculate values for 
blue pixels R1 and R2:

Figure 1.  The red dots show the known pixels and the green dot is the 
pixel we wish to interpolate
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EQUATION 1

EQUATION 2

Then, we will do interpolation in Y direction:

EQUATION 3

This gives us the desired interpolated value for P=f(x,y)\

EQUATION 4

Trilinear Interpolation
Trilinear interpolation computes values located between existing voxel val-
ues by linearly weighting the eight closest neighboring values. Specifically, 
Figure 2 depicts the situation where it is desired to determine an intensity 
value at the point labeled (x, y, z), given the values at the corner of the cube. 
The unknown value is computed by combining the known corner values 
weight by their distance from the location of the point (x, y, z) according to 
the following formula:

EQUATION 5
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Vxyz = V000 (1 - x) (1 - y) (1 - z) +V100 x (1 - y) (1 - z) + V010 (1 - x) y (1 - z) + V001 (1 - x) (1 - y) 

z +V101 x (1 - y) z + V011 (1 - x) y z + V110 x y (1 - z) + V111 x y z 

Trilinear interpolation operates in a parameter space with dimension D = 3 

of order n = 1, thus requiring (1 + n)3 = 8 adjacent pre-defined values 
surrounding the interpolation point.

Trilinear interpolation is the default resampling interpolation method used in this 
registration technique.

B-spline basis interpolations
B-spline interpolation utilizes weighted voxel values in a larger neighbor-
hood compared to trilinear interpolation. The larger number of values are 
weighted based on a 3-rd and 4-th order of polynomial, instead of a second 
order polynomial as in the case of trilinear interpolation. B-spline interpola-
tion refers to the locations of the neighboring points as control points and 
combines the intensity values at these locations using a set of polynomial 
basis according to Equation 6.

The equation for k-order B-spline with n+1 control points (P0, P1, ... , Pn) is 

EQUATION 6

Figure 2.  Trilinear interpolation
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In Equation 6, Ni,k are the polynomial functions of degree k-1, and n is the 

number of control points. Note, that the degree of the weighting polynomial 
is independent of the number of control points, n.

The weighting polynomial is recursively defined as 

EQUATION 7

Here, t(i) represents an index that refer to the control points and t(i) are 
generally referred as knot points, see Figure 3. The sequence of knot points 
is also called a knot vector. This indexing scheme allows one to weight dif-
ferent control points more than other control points by using it more than 
once during the computation. Typically, the first and last control points are 
weighed more heavily than the internal points to provide a smooth interpo-
lating curve. The Optimized Automatic Registration method uses the open 
uniform knot vectors for calculating B-splines. Open uniform knot vectors 
are vectors that have k equal knot values at each end, such as described in 
Equation 8.

EQUATION 8

For example: [o,o,o,o,1,2,3,4,4,4,4,] for k=4; [1, 1, 1, 2, 3, 4, 5, 6, 6, 6] for 
k=3; [0.1, 0.1, 0.1, 0.1, 0.1, 0.3, 0.5, 0.7, 0.7, 0.7, 0.7, 0.7] for k=5.
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Lagrange interpolations
To obtain higher-order interpolations, the Optimized Automatic Registra-
tion algorithm uses Lagrange interpolations. The Lagrange kernel of degree 
N-1 for N x N region can be defined by Equation 9.

Note: Options provided by this method include the following Lagrange 
interpolations: Cubic (N = 3), quintic (N = 5), and heptic (N = 7).

EQUATION 9

The Lagrange kernel for N=1 is nearest neighbor interpolation. In the case 
N=2 it is linear interpolation. The Lagrange kernel for N=4 supporting 
points results in cubic polynomials. See Equation 10:

Figure 3.  B-spline interpolation
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EQUATION 10

The Lagrange kernel for N=5 supporting points results in quadratic 
polynomials as shown in Equation 11 below:

EQUATION 11

All Lagrange kernels are direct current (DC) constant. In other words, the 
mean brightness of the image is not affected if the image is interpolated or 
re-sampled. However, the even Lagrange interpolators do not fit C1-contin-
uously at the connecting points causing significant sidelobes within their 
Fourier transforms. Figure 4 below shows the Lagrange kernels for N=4 and 
N=5, respectively. 

• Lagra h4(x) shows a sharp edge at the center of the mask in the spatial 

domain. The amplitude of the sidelobe in the Fourier domain is about 
4%. 

• The odd Lagrange kernels, such as  Lagra h5(x), is not C0-continuous.
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Therefore, the amplitude of the sidelobe is raised up to 10% as shown in 
Figure 4-F. However, the plateau in the passband is wider causing the major 
lobe to approximate more closely the ideal rectangular shape. In other 
words, the passband characteristic is improved by raising the order of the 
Lagrange kernel. Therefore, odd Lagrange kernels, such as cubic (N = 3), 
quintic (N = 5), and heptic (N = 7), should be used for images with high 
contrasts.

Gaussian
The Gaussian function is as follows:

EQUATION 12

Figure 4.  Lagrange third-order interpolation, N = 4: (A) - Kernel, (B) - 
Magnitude of Fourier transform, (C) - Logarithmic plot of magnitude. 
Lagrange fourth-order interpolation, N = 5, (D) -Kernel, (E) - Magnitude 
of Fourier transform, (F) - Logarithmic plot of magnitude
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Where sigma is the standard deviation of the distribution. We assume that 
the distribution has a mean of zero (i.e. it is centered on the line x=0). The 
distribution is illustrated in Figure below.

In 2-D, an isotropic (i.e. circularly symmetric) Gaussian has the form:

EQUATION 13

The idea of Gaussian interpolation is to use the 2-D distribution as a point-
spread function, and this is achieved by convolution. Since the image is 
stored as a collection of discrete pixels the algorithm, first,  produces a 
discrete approximation to the Gaussian function before it performs the 
convolution. 

In theory, the Gaussian distribution is non-zero everywhere, which would 
require an infinitely large convolution kernel, but in practice it is effectively 
zero more than about three standard deviations from the mean, and so the 
algorithm truncates the kernel at this point. Figure 6 shows a suitable 
integer-valued convolution kernel that approximates a Gaussian with a 
sigma of 1.0.

Figure 5.  1-D Gaussian distribution with mean 0 and sigma=1
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Once a suitable kernel has been calculated, then the Gaussian interpolation 
can be performed using standard convolution methods. The convolution 
can be performed fairly quickly since Equation 13 for the 2-D isotropic 
Gaussian shown above is separable into X and Y components. Therefore, 
the 2-D convolution can be performed by, first, convolving with a 1-D 
Gaussian in the Y direction, and then, convolving with another 1-D 
Gaussian in the Y direction. (The Gaussian is the only completely circularly 
symmetric operator which can be decomposed in such a way.) A further way 
to compute a Gaussian interpolation with a large standard deviation is to 
convolve an image several times with a smaller Gaussian. 

The Gaussian function is a recurrent with respect to operations such as 
derivation and Fourier transform.

Windowed sinc
The Windowed sinc function is a product of the sinc function with a window 
function of a limited spatial support. The sinc function can be defined as 
shown in Equation 14: 

EQUATION 14

Consider an image data set consisting of a 3D matrix of voxels with intensi-
ties I(X; Y; Z) identified by integer position coordinates (X; Y; Z). If one 

Figure 6.  Discrete approximation to Gaussian function with sigma=1.0
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wants to calculate the intensity value at an interior point defined by non-
integer coordinates (x; y; z), this can be achieved by forming the following 
triple sum, see Equation 15:

EQUATION 15

There are two limiting conditions that the function I(x, y, z) must satisfy:

• I(x, y, z) must be bandlimited. In other words, the function must have a 
Fourier transform F{I(x, y, z)}=I(f)=0 for |f|>B for some maximum 
frequency B>0.

• The sampling rate –fs, must exceed twice the bandwidth, e.g. fs >2B. 

The interpolation formula reconstructs the original signal, I(interior), as long 
as these two conditions are met.

Equation 15 implies a sum over all voxels for each new intensity value calcu-
lated. Since this is computationally very demanding and since distant voxels 
(for which sinc weighting is small) make a little contribution, it is conve-
nient in practical situations to truncate the interpolation series. This can be 

done by limiting the calculation to a cubic sub-volume containing (2R+2)3 
voxels centered on the target point (x; y; z) for which an intensity is calcu-
lated. Here, R determines the size of the cubic box, and when R is zero only 
the eight nearest neighbors will be used in the calculation.

Because of the oscillating nature of the sinc function, some truncation 
errors and negative values may result from this procedure. To reduce the 
truncation error, each sinc function is multiplied by an apodizating the 
Hann window function, refer to Equation 16:

EQUATION 16

Where,  can be replaced by (x-X), (y-Y) or (z-Z) as appropriate.
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REFERENCES

Bourke Paul “Interpolation methods” http://local.wasp.uwa.edu.au/ ~pbourke/other/
interpolation/index.html

B-splines: http://www.cl.cam.ac.uk/teaching/1999/AGraphHCI/SMAG/ node4.html

Chapter 3: “Registration Methodology: Concepts and Algorithms” by Derek L.G.Hill and 
Philipe Batchelor in Medical Image Registration edited by Joseph V. Hajnal, Derek L.G.Hill, 
and David J. Hawkes, CRC Press, 2001, pp. 40-70.

Chapter 33 “Within-Modality Registration Using Intensity-Based Cost Functions” by Roger 
P. Woods in Handbook of Medical Image Processing and Analysis, Editor, Isaac N. 
Bankman, Academic Press, 2000, pp. 529-553. 

Thomas M. Lehmann,* Member, IEEE, Claudia Gonner, and Klaus Spitzer. Survey: 
Interpolation Methods in Medical Image Processing. IEEE TRANSACTIONS ON MEDICAL 
IMAGING, VOL. 18, NO. 11, NOVEMBER 1999 1049.

Figure 7.  T y=sinc(a), where a=px, xÎ [-30,30]; a sample Hann function and its frequency 
response. Here, N represents the width, in samples, of a discrete-time window function. 
Typically, it is an integer power-of-2, such as 210 = 1024. 
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Autocorrelation Coefficients

The algorithm calculates autocorrelation coefficients for images.

Background
In any time series containing non-random patterns of behavior, it is likely 
that any particular item in the series is related in some way to other items in 
the same series. This can be described by the autocorrelation function and/
or autocorrelation coefficient. 

The correlation of two continuous functions f(x) and g(x) can be defined as 

EQUATION 1

where, “·”represents the complex conjugate. If f(x) and g(x) are the same 
functions, f(x) ·g(x) is called autocorrelation function.

For a 2D image, its autocorrelation function (ACF) can be calculated as

EQUATION 2

where f(x,y) is the two-dimensional brightness function that defines the 
image, and a and b are the variables of integration. Like the original image, 
the ACF is a 2D function. Although the dimensions of the ACF and the 
original image are exactly the same, they have different meaning. In the 
original image, a given coordinate point (x,y) denotes a pixel position, while 
in the ACF, a given coordinate point (a,b) denotes the endpoint of a 
neighborhood vector.

The ACF describes how well an image correlates with itself under conditions 
where the image is displaced with respect to itself in all possible directions.

f x( ) g x( )• f a( ) g x a+( )⋅( ) xd∫=

f x y,( ) g x y,( )• f a b,( ) g x a y b+,+( )⋅( ) xd∫=
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For a given series of points {xi}, the autocorrelation coefficient can be 
described as follows: 

EQUATION 3

<a measure of covariance among the {xi}>/<signal variance>

Or, for a given autocorrelation function f(x, y) autocorrelation coefficient A 
can be described as 

EQUATION 4

IMAGE TYPES

Color and black and white 3D and 4D images.

Figure 1.  Visualization of ACF
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REFERENCES

Digital Image Processing, Second Edition by Rafael C. Gonzalez and Richard C. Woods, 
Prentice-Hall, Inc., 2002, pp. 205 - 208 and pp. 414-417.

Applying the AutoCorrelation Coefficients algorithm
To use this algorithm, do the following:

1 Open an image of interest.

2 Select Algorithms > AutoCorrelation Coefficients in the MIPAV window. 
The AutoCorrelation Coefficients dialog box (Figure 3) appears.

3 Click OK. The algorithm begins to run, and a status bar appears with the 
status. When the algorithm finishes running, the progress bar 
disappears, and the result image replaces the original one.

Figure 2.   Calculating autocorrelation for 2D grayscale image

OK Applies the algorithm according to the 
specifications in this dialog box.

Cancel Disregards any changes that you made in 
the dialog box and closes this dialog box.

Help Displays online help for this dialog box.

Figure 3.  AutoCorrelation Coefficients dialog box
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Autocovariance Coefficients

Autocovariance is a measure of the degree to which the outcome of the 
function f (T + t) at coordinates (T+ t) depends upon the outcome of f(T) at 
coordinates t. It provides a description of the texture or a nature of the noise 
structure.

Background
In statistics, given a real stochastic process f(t), the auto-covariance is 
simply the covariance of the signal against a time-shifted version of itself. If 
each state of the series has a mean:

EQUATION 1

then the auto-covariance is given by

EQUATION 2

If f(t) is wide sense stationary function, then 

EQUATION 3

for all T and S, therefore

EQUATION 4

Where t=S-T is the amount of time by which the signal has been shifted.

When normalized by the variance sigma2 the auto-covariance function 
becomes the auto-covariance coefficient

EQUATION 5

E f T( )[ ] μT=

Gxx T S,( ) E fT μT–( ) fS μS–( )⋅[ ] E fT fS⋅[ ] μT μS⋅( )–( )==

μT μS= μ=

Gxx T S,( ) Gxx S T–( ) Gxx t( )= =

ρ Gxx t( ) σ2⁄=
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Calculation of the auto-covariance function   G(t) of a randomly varying 
function i(T) may be done in the time domain using the following equation:

EQUATION 6

Correspondingly, the auto-covariance function may be calculated in the 
spatial domain, as 

EQUATION 7

Where, the <> brackets indicate integration over time. And

EQUATION 8

which gives us the normalized auto-covariance function or auto-covariance 
coefficient

EQUATION 9

When the data consist of a set of N discrete points, the averaging is 
performed as sums, then in spatial domain the 1D auto-covariance function 
is calculated by

EQUATION 10

If the random intensity variable, i, is a function of two independent 
variables, x and y, then, it is possible to define a corresponding two-
dimensional auto-covariance function:

G t( ) i T( ) i T t+( )⋅〈 〉=

g ξ( ) ∂i x( ) ∂i x ξ+( )⋅=

∂i T( ) i T( ) i T( )〈 〉–( ) i T( )〈 〉⁄=

g t( ) σi T( ) σi T t+( )⋅〈 〉 i T( ) i T t+( )⋅ i T( )〈 〉2–[ ] i T( )〈 〉2⁄ G t( ) i t( )〈 〉2⁄[ ] 1–= = =
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EQUATION 11

For a discrete set of data this becomes 

EQUATION 12

Note that while some medical literature refers to this as an autocorrelation, it is 
actually an auto-covariance since means are subtracted. 

NOTES

An auto-covariance function, which falls rapidly as a function of t, indicates 
that the resultant noise is in actual fact independent except at short 
separated distances, providing an appearance of 'sharp' noise. 

An auto-covariance function, which falls off slowly and smoothly as a 
function of t, indicates that the noise is highly correlated. At a given point, a 
positive value of the auto-covariance means that the noise tends to be of the 
same sign, while a negative value indicates that the noise tends to be of the 
opposite sign. 

In short, the amplitude of the auto-covariance at zero displacement 
provides a measure of the noise magnitude, while the shape the auto-
covariance can be used to describe the nature of noise.
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IMAGE TYPES

Color and black and white 3D and 4D images.

REFERENCES

Digital Image Processing, Second Edition by Rafael C. Gonzalez and Richard C. Woods, 
Prentice-Hall, Inc., 2002, pp. 205 - 208 and pp. 414-417.

"Two-photon image correlation spectroscopy and image cross-correlation spectroscopy" by 
P. W. Wiseman, J.A. Squier, M.H. Ellisman, and  K.R. Wilson, Journal of Microscopy, Vol. 
200. Pt. 1, October 2000, pp. 14-25. 

"Quantitation of Membrane Receptor Distributions by Image Correlation Spectroscopy: 
Concept and Application" by Nils O. Petersen, Pia L. Hoddelius, Paul W. Wiseman, Olle 
Seger, and Karl-Eric Magnusson, Biophysical Journal, Volume 65, September, 1993, pp. 
1135-1146. 

"Image cross-correlation spectroscopy: A new experimental bipohysical approach to 
measurement of slow diffusion of fluorescent molecules" by Mamta Srivastava & Nils O. 
Petersen, Methods in Cell Science, Vol. 18, March, 1996, pp. 47-54.

"Analysis of recorded image noise in nuclear medicine" by Benjamin M. W. Tsui, Robert N. 
Beck, Kunio Doi and Charles E. Metz, Phys. Med. Biol., 1981, Vol. 26. No. 5, 883-902. 
Printed in Great Britain.

Figure 1.  Calculating auto-covariance for a 2D grayscale image
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Applying the AutoCovariance Coefficients algorithm
To use this algorithm, do the following:

1 Select Algorithms > AutoCovariance Coefficients in the MIPAV window. 
The AutoCovariance Coefficients dialog box (Figure 2) appears.

2 Click OK. The algorithm begins to run, and a status bar appears with the 
status. When the algorithm finishes running, the progress bar 
disappears, and the results replace the original image.

OK Applies the algorithm according to the 
specifications in this dialog box.

Cancel Disregards any changes that you made in 
the dialog box and closes this dialog box.

Help Displays online help for this dialog box.

Figure 2.  AutoCovariance Coefficients dialog box
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Barrel Distortion Correction

Barrel distortion occurs when the magnification at the center of the lens is 
greater than at the edges. Fisheye lenses, which take hemispherical views, 
produce this type of distortion as a result of a hemispherical scene being 
projected onto a flat surface. A higher quality lens can be used to correct for 
distortion; however, this will greatly rise the cost of the image capture sys-
tem. A cost effective alternative to an expensive lens system is to algorithmi-
cally correct for barrel distortion using the presented method.

Barrel distortion is primarily radial in nature, therefore it can be corrected 
using a relatively simple model compensating for the most of the distortion. 

Background
The correcting function M(a,b,c,d,rcorr) is a third order polynomial. It 

relates the distance of a pixel from the center of the source image (rsrc) to 

the corresponding distance in the corrected image (rcorr):

EQUATION 1

M = a *r3corr + b * r2corr + c * rcorr + d 
and

rsrc = (a * r3corr + b * r2corr + c * rcorr + d) * rcorr 

Where rsrc and rcorr are specified in units of the 

min((xDim-1)/2, (yDim-1)/2).

Parameters in Eq. 1 are as follows:

Figure 1.  Illustration of barrel distortion
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Chapter 2, Using MIPAV Algorithms: Barrel Distortion Correction
• a, b and c describe distortion of the image

• d describes the linear scaling of the image

Correcting using a affects only the outermost pixels of the image, while b 
correction is more uniform. Using negative values for a, b, and c shifts 
distant points away from the center. This counteracts barrel distortion, and 
forms the basis for the above corrections. 

Using positive values for a, b, and c shifts distant points towards the center. 
This counteracts pincushion distortion which is opposite to barrel 
distortion. See Figure 2.

Using d=1, and a=b=c=0 leaves the image as it is. Choosing other d values 
scales the image by that amount. See Figure 2.

Correcting pincushion and/or barrel distortion

Finally, you may correct pincushion and barrel distortions simultaneously 
in the same image: if the outer regions exhibit barrel distortion, and the 
inner parts pincushion, you should use negative a and positive b values. If 
you do not want to scale the image, you should set d so that a +b + c + d = 1.

Examples

In most cases, you will get quite satisfactory results by using just one 
parameter, such as the parameter b from the examples shown in Figure 2. 

original a=c=0, b=-0.01

Figure 2.  Barrel distortion correction
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Examples from Figure 2 may also serve as a guide of how large parameter 
values should be, i.e. select the parameters around 0.1 (in absolute value) if 
barrel distortion is quite visible, or close to 0.01 if it is very small. Simply 
optimize the initial parameters until you like your image. 

REFERENCES

Helmut Dersch, “Correcting Barrel Distortion” available at  http://www.all-in-one.ee/
~dersch/barrel/barrel.html

PanoTools wiki: Lens correction model available at http://wiki.panotools.org/
Lens_correction_model

a=c=0, b=-0.1 a=c=0, b=-0.2

a=b=c=0, d=2 a=c=0.05, b=0.2

Barrel distortion correction – the parameters for each image are shown 
below the image. As b becomes more negative (e.g. changes from -0.1 to   
-0.2), the amount of barrel distortion correction increases, while positive 
coefficients make barrel distortion worse. If d parameter is not shown, that 
means that d is set so that a +b + c + d = 1. 

Figure 2.  Barrel distortion correction (continued)
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IMAGE TYPES

The algorithm can be applied to RGB and gray 2D images.

Applying barrel distortion correction algorithm

1 Open an image of interest.

2 Select Algorithms > Transformation tools > Barrel Distortion 
Correction. The Barrel/pincushion distortion correction dialog 
box opens.

3 Complete the dialog box and click OK.

The corrected image appears in a new image frame. See Figure 2.

a

b

c

d

Correcting using a 
affects only the 
outermost pixels of the 
image.

b and c parameters 
should be used for 
more uniform 
correction.

Using negative values for a, b, and c shifts distant points away from the 
center of the image. This negates barrel distortions.

Using positive values for a, b, and c shifts distant points towards the 
center. This negates pincushion distortions.

Using d=1, and a=b=c=0 leaves the image as it is. Choosing other d 
values scales the image by that amount.

Set d=1-a-b-c Activate this option if you do not want to scale the image, e.g. you set d so 
that a +b + c + d = 1.

OK Applies the parameters that you specified to the image.

Cancel Disregards any changes you made in this dialog box and closes the dialog 
box.

Help Displays online help for this dialog box.

Figure 3.  Barrel/pincushion distortion correction dialog box
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B-Spline Automatic Registration

This section describes the B-spline based registration of images in three 
dimensions (3D). The description specializes to two dimensions  (2D) is in 
the obvious manner.

Background

Let the target image have dimensions  with image indices 

satisfying , , and . Let the source image have 

dimensions  with image indices satisfying , , 

and . The B-spline volume function maps indices  via 

Equation 1.

EQUATION 1

where the  functions are the B-spline basis functions, and the B 

values are the control points. The numbers , , and  are user 

selectable, the degrees , , and  for the basis functions are user 

selectable, and the B-spline basis functions are open and uniform.

The control points have the following characteristics:

• Each control point has coordinates from the unit cube.In two 
dimensions, each control point has coordinates from the unit square.

• The initial placement of the control points depends on the B-spline 
basis and must yield the identity function; that is, 

. The initial placement of the control 

points is described in Section “Improving performance ” on page 105. 
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• A control point is said to be in the outer layer if one of its indexes is 
either the minimum index (zero) or the maximum index (one less than 
the number of control points in a given dimension). The position of the 
control points in the outer layer are fixed as follows:

EQUATION 2

This constraint implies that the  for all .

• A control point not in the outer layer is said to be an interior control 
point. The position of the interior control points is constrained such 
that its movement must not cause any folding in the B-spline 
transformation. Folding is defined to occur when there is a negative 
value anywhere in the computed deformation for the current B-spline 
transformation. The computation of the deformation is described in 
Section “Deformation” on page 109. The method by which folding is 
detected is described in Section “Detect folding” on page 110. 

Each  contains normalized 3D coordinates (i.e., in the unit cube) 

that identify a location in the source image corresponding to the sample at 

( ) in the target image. The  coordinates are related to sample 

coordinates in the source image by  where 

the output indices ( ) are considered to be continuous values; that 

is, they are not necessarily integer valued. If the source image’s samples are 

, where  for all , we need to evaluate the image at the 

nonintegral values ( ). We can use trilinear interpolation to do 

this (use bilinear interpolation in the case of two-dimensional (2D) 
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registration). Let , the largest integer smaller than . Define 

. The interpolated image value is:

EQUATION 3

If the target image samples are , where  for all , then 

the source image  is trilinearly interpolated at ( ), which are the 

coordinates of . This means that the currently registered source 

image, denoted , has the same dimensions as the target image and can be 

defined in terms of the target image samples as . 

A measure of error between the two images Sj0,j1,j2 and Tj0,j1 ,j2 can be 

computed. A number of possible error measure functions are defined in 
Section 1.2. The goal is to select the control point positions to make the 
error measure as small as possible. This is done by moving a single control 
point at a time using gradient descent. 

The gradient of the error function is estimated for the control point Bi0,i1,i2 

by means of finite differences, where changes in the error function are 
measured for small steps of the control point from its current position in 

each of the coordinate axis directions. Let , and  be small step 

kw k′w= k′w

wΔ k′w kw–=

U0 1 Δ0–( ) Sk0 k1 k2, ,⋅ Δ0 Sk0 1+ k1 k2, ,⋅+=
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U2 1 Δ0–( ) Sk0 k1 k2 1+, ,⋅ Δ0 Sk0 1+ k1 k2 1+, ,⋅+=

U3 1 Δ0–( ) Sk0 k1 1+ k2 1+, ,⋅ Δ0 Sk0 1+ k1 1+ k2 1+, ,⋅+=
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sizes equivalent to one sample increment in the target image, 

EQUATION 4

The gradient of the error function is estimated at each control point Bi0,i1,i2. 

The gradient at each control point is denoted by 

EQUATION 5

The gradient descent step is as follows. The current control point under 
consideration is Bi0,i1,i2. The ray originating at this point and having 

direction of greatest decrease in E is 

 EQUATION 6

where the direction is the unit length vector 

and where  is computed using Equation 5. The idea is to choose t > 0 to 
minimize 
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A calculus approach which sets the first derivative to zero and solves for t 
yields an expression for e(t) that is really complicated. Instead, you should 

choose a set of t-values, t1 through tm, evaluate e(ti) and find the minimum 

value. Suppose this occurs at tk. Replace this in Equation 6 to obtain the 

new location for the control point. 

Only those t-values which do not result in the occurrence of folding in the B-
spline transformation are considered. The method described in Section 
“Detect folding” on page 110 is used to determine if folding occurs for a 
given set of control point positions. Note that sample t0  (i.e., t=0) is 
equivalent to the location of the control point before any movement 
attempt, and by definition, sample t0 does not cause folding. A test is made 
to determine whether folding occurs for tm, the extreme sample in the set of 
chosen t-values. If folding does not occur at tm, then folding does not occur 
at any of the other t-values between t0 and tm. If folding does occur at tm, 
then a bisection method is employed to find the tf old value between t0 and 
tm where folding begins to occur. The search for a minimum value of e(t) by 
sampling must be limited to the t < tf old.

Error measures
All of the error measures between two images defined in this section assume 
that the two images have the same dimensions. This is the case for the tar-
get image Tj0 ,j1,j2  and registered source image S‘(j0,j1,j2) = S(k‘0,k‘1,k‘2). 

The particular error measures defined here are only concerned with corre-
sponding samples from the two images or histograms of the values of the 
samples from the two images, and are not concerned with whether the 
images have two or three dimensions. For simplicity, each image measure 
will be defined with a single index to access its samples. 
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LEAST SQUARES MEASURE

The least squares measure is defined by 

EQUATION 7

where the summation is over all the indices for the target image voxels. 

Here, S‘(j) is a registered source image and T(j) is a target image. The 
minimum value of this measure is zero; the maximum value depends on the 
range of values in the target and registered source images. 

CORRELATION RATIO MEASURE 

The correlation ratio measure is defined by 

EQUATION 8

where 

• Var(S’) is the variance of the registered source image S’. 

• k is the number of intensity histogram bins equally distributed over the 
range of intensity values of the target image T. 

• Sk’ is the k-th isoset defined as the set of intensities in registered source 

image S’  at positions where the intensity in target image T is in the k-
th intensity bin. 

• nk is the number of elements in the set Sk’, such that N =Σk nk.

• N is the number of samples in the target image T which is the same 
number of samples in the registered source image S’. 

• Var(S’k) is the variance of the values in the set S’k. 

The range of values for this measure is [0,1]. 

ELS S′ j( ) T j( )– 2

j
∑=

ECR

nk
N
-----Var S'k( )

k
∑

Var S( )
----------------------------------=
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NORMALIZED MUTUAL INFORMATION 
MEASURE 

The normalized mutual information measure is defined by 

EQUATION 9

where 

is the standard entropy definition for probability pij estimated using the (i,j) 
joint histogram bins, and similarly for the marginals H(S’) and H(T).

The standard entropy calculation 

for an image X of N samples and user-selectable k histogram intensity bins 
equally distributed over the range of samples in image X can be rewritten as 

where nk is the histogram value for the k-th intensity bin and N =Σ k nk. The 

computational effort can be reduced by factoring to get 

ENMI
H S' T,( )

H S'( ) H T( )+
--------------------------------=

H S' T,( ) pi j, pi j,log
i j,
∑–=

H S' T,( ) pk pklog
k
∑–=

H X( )
nk
N
-----

nk
N
-----⎝ ⎠
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where log nk can be a precomputed lookup table of logarithms of integer 

values.

The range of values for this measure is [0,1].

Improving performance 
The gradient descent applied to a control point at a time can be quite slow. 
Performance can be improved by taking advantage of the local control 
aspect of using B-splines. Since only one control point is being moved at a 
time, the local control aspect of using B-splines means that only some of the 
registered source image values will be different. Note that for an image of a 
given size, the number of image values, under local control, affected by 
moving a control point decreases as the number of control points increases. 

One performance improvement can be achieved by precomputing the B-
spline basis function values once for each possible sample for each dimen-
sion. Since the registration occurs by transforming the source image into 
the space of the target image, all samples for B-spline basis function evalua-
tion always occur at the discrete sample coordinates for the target image. 
Since the number of target images samples for a dimension is xed, the B-
spline basis function will be evaluated on the [0, 1] interval at equally 
spaced intervals (we are using open, uniform B-splines). For each dimen-
sion, a 2D array is created which stores B-splines basis function evaluations 
for each sample with the weight associated with each control point. Because 
of local control, many of these weights will be zero indicating that a sample 
is not affected by a particular control point. In the process of creating this 
2D array of precomputed basis function evaluations, the index range of 
samples affected by each control point can be determined. The algorithm to 
determine this range does not examine the weights as they are computed; 
instead, the range of control points affecting a single sample are determined 
from the computed knot index and the known B-spline degree. 

Another performance improvement involves maintaining intermediate 
error measure calculations. For example, in the case of the least squares 
error measure, an image is maintained of the current error calculations, 
that is, the target image subtracted from the current registered source 

H X( ) 1
N
----–⎝ ⎠

⎛ ⎞ nk nklog Nlog–( )⋅
k
∑=
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image. A cumulative total error value is also maintained, which is the sum of 
the squared error values for all current values in the error image. When a 
control point is moved, the old values that are being replaced are first sub-
tracted from the total error, and then the new values to be stored are added 
to the total error. Similar approaches are performed for the correlation ratio 
and normalized mutual information error measures such as storing cumula-
tive histogram values and images which contain predetermined histogram 
bin indexes. 

Initial placement of control points for identity map 
Referring to Equation 1 for the definition of the B-spline mapping function, 
the identity map is the one which yields

 .

This section describes how to initially place the control points to yield this 
identity map. Since a separate set of B-spline basis functions is defined for 
each dimension, it happens that the placement of the control points to pro-
vide this identity map is computed independently for each dimension. This 
means that the x-coordinate for each control point initially is determined by 
the B-spline basis defined for the X-axis, and similarly for other dimen-
sions. 

Let k be the coordinate for which the control point identity map is being 
computed for the associated B-spline basis. Let nk be the number of control 

points defined for that B-spline basis. Let ik be the index of the control point 

coordinate such that 0<= ik <= nk. The goal is to compute the coordinate 

values Bik for all ik where each coordinate value is in the [0,1] range. 

For a B-spline basis of degree 1, the initial placement of the control points 
for the identity map is such that the control point coordinates are uniformly 
spaced as follows: 

EQUATION 10

Mj0j1j2

j0
p0 1–
---------------

j1
p1 1–
---------------

j2
p2 1+
---------------, ,

⎝ ⎠
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=
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for coordinate k. If the problem is to register images of three dimensions, 
and the B-spline bases for all three dimensions are selected to have degree 1, 
then 

EQUATION 11

For a B-spline basis of degree 2 or larger, the initial placement of the control 
point coordinates is computed by the method of least squares. Again 
referring to Equation 1 for the definition of the B-spline mapping function, 
the identity map for coordinate k is 

for any target image coordinate jk satisfying 0<= jk <pk. 

A system of pk equations above for nk + 1 unknowns (i.e., the Bik coordinate 

values) is set up in a matrix form AX = C, where 

The solution is computed as 

The repositioning of the control points to yield this identity map is 
guaranteed not have create folding in the resulting transformation. 

Bi0 i1 i2, ,
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n2
------, ,

⎝ ⎠
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--------------
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COMPOSITION FOR TWO-PASS REGISTRATION

Let S be a source image and T be the target image. If the image S is 
registered to image T, then image S becomes the registered source image 
where R(T) is the registration mapping. This is graphically shown as: 

For B-spline registration, the R(T) mapping is based on the selected B-
spline basis and control points for each axis. 

In the case of two-pass registration, the registered source image S’ is then 
registered to the same target image T, but this time using different mapping 
parameters, i.e., a different set of B-spline basis and control points for the 
axes. The output of this second registration is a new registered source image 
S”. Let R1(T) be the mapping for the first pass registration and R2(T) be the 

mapping for the second pass registration. This is graphically shown as: 

The usefulness of a two-pass registration is that the first pass would apply a 
coarse-level computation to quickly arrive at an approximate registration, 
and then the second pass would apply a finer-level computation to continue 
from the point where the first pass registration finished. The first pass regis-
tration may use B-spline bases with fewer control points and a smaller 
degree. 

Although the two-pass registration can be performed in the manner just 
described, it is desirable to have a final registration between the original 
source image S and the target image T. 
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This means defining a mapping R(T) having the same B-spline bases as the 
second pass registration mapping R2(T), but which maps the original source 

image S into the final registered source image S. This is graphically shown 
as: 

The R(T) mapping for the second pass in a two-pass registration is different 
in that the initial placement of the control points does not yield the identity 
map to the original source image S. 

Instead, the initial placement of the control points for R(T) yields the output 
of the R1(T) mapping. This is achieved by initializing the R2(T) registration 

mapping in the normal manner which provides an initial placement of its 
control points to yield the identity map from the registered source image S. 
The initial placement of the control points for the R(T) mapping then are 
the initial placement of the control points for R2(T) mapped through R1(T). 

Deformation
The deformation from the nonlinearly registered source image S to the tar-
get image T can be measured at each sample in the target image by comput-
ing the determinant of the Jacobian matrix for the nonlinear 
transformation. For three dimensions, the nonlinear registration transfor-
mation is defined by Equation 1. Since each Mj0j1j2 contains normalized 3D 

coordinates of the position in the source image mapped for each (j0, j1, j2) 
in the target image, a map image of 3D coordinates can be created that con-
tains these Mj0j1j2 source images coordinates (this map image has the same 

dimensions as the target image). An estimate of the gradient at each sample 
in this map image is computed using central finite differences at interior 
samples and forward/backward finite differences at “outer layer” samples. 
Since each sample in the map image contains 3D coordinates, the estimated 
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gradient at each sample then is a 3x3 matrix of values representing the 
Jacobian matrix. A single-valued deformation image with the same dimen-
sions as the target image is created which contains the computed determi-
nants of the Jacobian matrices for each sample. 

If no deformation has occurred at a sample, the Jacobian matrix is the iden-
tity and its determinant is 1. If the source image is compressed near a sam-
ple, the determinant will be less than one. If the source image is expanded 
near a sample, the determinant will be greater than one. The computation of 
deformation is unaffected by differences in the dimensions for the source 
and target images. Because of the constraints on the placement of the con-
trol points, a negative determinant should not be possible, which would 
indicate some type of folding in the mapping. 

Detect folding
The situation of folding in a 2D or 3D B-spline transformation occurs when 
there is a negative value in the computed deformation. The computation of 
the deformation is described in Section “Deformation” on page 109. This 
section describes a method for detecting if such folding occurs given the 
current positions for the lattice of the B-spline control points. Given the 
lattice structure of the B-spline control points, folding can be detected by 
geometric means. In two dimensions, consider any interior control point 
and its 8 neighboring control points forming a polygon. Construct 8 
triangles involving the chosen interior control point each time with the 8 
pairings of adjacent control points on the polygon perimeter. The 
intersection of any one triangle with the other 7 triangles should each be 
empty in order for there to be no folding. Alternatively, the area of the 
polygon should be identical to the union of the areas of the 8 triangles. 

The issues are similar in three dimensions by considering the 26 neighbor-
ing control points forming a polyhedron. In this case, 48 tetrahedrons are 
constructed involving the chosen interior control point each time along with 
the triples of control points from the 48 triangles forming the polyhedron 
mesh. The intersection of any one tetrahedron with the other 47 tetrahe-
drons should each be empty in order for there to be no folding. Alterna-
tively, the volume of the polyhedron should be identical to the union of the 
volumes of the 48 tetrahedrons. 

A sufficient but not necessary condition to conclude that folding occurs in 
the case of two dimensions is the premise that any interior control point is 
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outside the polygon formed by its 8 neighboring control points. In the case 
of three dimensions, the premise is that any interior control point is outside 
the polyhedron formed by its 26 neighboring control points. 

A condition that is both necessary and sufficient to conclude that folding 
occurs does exist for both 2D and 3D. In the case of two dimensions, again 
consider the 8 triangles formed by the chosen interior control point each 
time with the 8 pairings of adjacent control points on the polygon perime-
ter. It is important that these triangles formed by control points from the 
lattice be consistently counterclockwise ordered. For each triangle, let A 
=(a0,a1) be the 2D coordinates of the chosen interior control point, and let 
B =(b0,b1) and C =(c0,c1) be the 2D coordinates of the other two triangle 
control points taken in counterclockwise order. The normal to the plane 
which contains this triangle can be computed from the (right handed) cross 
product of the two vectors AB and AC. One way to express the calculation of 
the cross product involves the construction of the following matrix which 
contains the three triangle point coordinates: 

EQUATION 12

The determinant of this matrix is twice the signed area of the triangle. Start-
ing with consistently counter clockwise ordered triangles from the initially 
placed lattice of control points, the determinant of this matrix should 
remain positive as control point positions are moved. The determinant will 
become negative when the triangle folds. 

The premise for the necessary and sufficient condition to detect when fold-
ing occurs extends to three dimensions. Consider the 48 tetrahedrons 
formed by the chosen interior control point each time with the triples of 
adjacent control points from the 48 triangles forming the polyhedron mesh. 
It is important that the tetrahedrons formed by the control points from the 
lattice be consistently counterclockwise ordered, in the 3D sense. For each 
tetrahedron, let A = (a0,a1,a2) be the 3D coordinates of the chosen interior 
control point, and let B = (b0,b1,b2), C = (c0,c1,c2), and D = (d0,d1,d2) be 
the 3D coordinates of the other three tetrahedron control points taken in 
counterclockwise order. Extending the matrix determinant formulation 

a0 a1 1

b0 b1 1

c0 c1 1
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used for two dimensions to three dimensions, the following matrix is con-
structed which contains the four tetrahedron point coordinates: 

The determinant of this matrix is 6 times the signed volume of the tetrahe-
dron. Starting with consistently counterclockwise ordered tetrahedrons 
from the initially placed lattice of control points, the determinant of this 
matrix should remain positive as control point positions are moved. The 
determinant will become negative when the tetrahedron folds.

Support for color images 

The registration of 2D and 3D color images involves first converting the 
three color channels of values at each sample in the source and target color 
images to create single channel source and target intensity images. Once the 
conversion has been done, the single channel intensity source and target 
images are registered as described in  “Background” on page 98. The result-
ing transformation map is extracted from the registration which is then 
used to interpolate the original source color image in order to generate the 
output registered source color image. 

Normally, the three color channels represent red, green, and blue 
intensities, and so the conversion to a single channel value usually 
represents overall intensity. In this manner, the conversion is simply a 
weighted average of the three color channels where separate weights can be 
provided for each channel. The current implementation uses equal weights 
for each channel. 

Support for 2.5D images 

A 2.5D image is actually a 3D image containing a series 2D slice images. The 
registration of a 2.5D intensity or color image involves a 2D registration of 
each slice in the 2.5D image to a reference slice also in the same 2.5D image. 
The reference slice can either be a xed slice or the previous slice. The 
resulting output registered 2.5D image contains the same number of slices 
as the original 2.5D image where the sample values in a slice of the 
registered output are from the same slice of the original only “warped” by 
the B-spline registration transformation.  

a0 a1 a2 1

b0 b1 b2 1

c0 c1 c2 1

d0 d1 d2 1
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If the reference slice is fixed, then the reference slice will appear in the 
registered output as being unchanged. If the reference slice is the previous 
slice, then the first slice will be registered to the last slice. 

EXAMPLES OF B-SPLINE REGISTRATION

Figure 1 below shows an example of B-spline 3D image registration. 
Figure 2 shows the registration deformation image and its lookup table. The 
registration was done using the default parameter values, which are 
explained in Section “Image types” on page 114. 

Note: that the input and the target image are both images of the same brain, 
that’s why the registration demonstrates a very good overall fitting. 

Figure 1.  The input source image (A), the input target image (B) and the output registered image 
(C). Note that images (A) and (B) are both the images of the same brain. That’s why it shows a 
very good overall fitting. Results may vary, if you take different brain images. 
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IMAGE TYPES

The algorithm can be applied to 2D and 3D color (RGB) and grayscale 
images.

User Dialogs in MIPAV 
Whenever B-spline registration is selected by the user, a dialog is displayed 
for the user to select the registration reference and the options related to 
how the registration is to be performed. A different dialog is displayed 
depending on whether the user selects 2D/3D registration between two 
images, or 2.5D registration of slices within a single image. The displayed 
dialogs differ only in how the registration reference is specified which 
depends on whether 2D/3D registration or 2.5D registration was selected; 
otherwise, options related to how the registration is to be performed are the 
same. 

The choice of 2D/3D or 2.5D B-spline registration is made by selecting the 
appropriate menu item from the Algorithms: Registration submenu of 
MIPAV. Refer to Figure 3 for details.

Figure 2.  The deformation image and its lookup table. The dark areas on the deformation 
image are related to the areas on images (A) and (B) which did not perform a deformation 
during the registration or the deformation was relatively small. The light areas are related 
to the areas on images (A) and (B) which perform a bigger deformation.
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Figure 3.  The choice of 2D/3D or 2.5D B-spline registration is made by 
selecting the appropriate menu item from the Algorithms: Registration 
submenu 

The 2D/3D B-spline registration is available through the B-spline 
automatic registration 2D/3D menu item. This menu item is enabled 
when a 2D or 3D image (intensity or color) is the currently active image. 
The dialog is displayed only if there is at least one other loaded image in 
MIPAV which is compatible for registering to the currently active image. A 
compatible image is one that has the same number of channels of data and 
the same number of dimensions, but not necessarily the same sizes for each 
dimension. Refer to Figures 4 and 5.

The 2.5D B-spline registration is available through the B-spline 
automatic registration 2.5D menu item. This menu item is enabled 
only when a 3D image (intensity or color) is the currently active image.  
Refer to Figure 6.

Since the options related to how the registration is to be performed are 
identical for 2D/2.5D/3D and intensity/color images, and the only 
difference is how the registration reference is selected for 2D/3D vs. 2.5D, 
the dialog for presenting these options to the user is implemented in the 
same class. This class is JDialogRegistrationBSpline and is in the 
mipav/model/view/dialogs package. The class dynamically creates a 
dialog to present to the user with options that are appropriate for the type of 
registration. 
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Figure 4 below shows an example of the dialog which is displayed for 2D/
3D intensity/color image registration. Note that this dialog is shown with 
the default options for single-pass registration.

 

General

Register Displays a list of currently 
active 2D/3D images to 
registration. The drop down list 
of options show the names of 
available images currently 
loaded to which this image can 
be registered. This list will only 
contain the names of images 
currently loaded in MIPAV 
which are compatible. 

Cost 
function

This drop down list contains the 
following choices for cost 
measure to use during 
registration: Least Squares, 
Correlation Ratio, and 
Normalized Mutual Information.

Perform 
two-pass 
registra-
tion

This dialog is shown with the default options for single-pass registration. If the 
Perform two-pass registration option is enabled, then the dialog will change to 
make options for two-pass registration available.

Transformation Options

The following is a discussion of the dialog options which control each registration pass, one 
set of options per pass. For more information refer to “Transformation options” on page 124.

Sub-
sample 
image for 
speed

If this option is enabled, the image will be subsample in power of 2 for each dimension. 
Subsampling increases performance of the algorithm, but it exhibits lower accuracy of 
registration.

B-Spline 
Degree 
(same for 
all axes)

This is the degree of the B-Spline to use for all axes of the image. The drop list of 
options show the values of 1 (linear), 2 (quadratic), 3 (cubic), and 4 which are 
available. Although, the underlying BSpineBasisf class supports any degree, this dialog 
restricts the degrees to these values. Choosing a smaller degree executes faster than a 
larger degree, but a higher degree offers a higher order of continuity. 

Figure 4.  B-Spline Single - Pass Automatic Registration 2D/3D dialog box 
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If the Perform two-pass registration check box is selected, then the 
dialog will change to the following: 

B-Spline 
Control 
Points(sa
me for all 
axes)

This is the number of B-spline control points to use for all axes of the image.The 
minimum number of control points is the larger of the number 2 and the degree of the 
B-Spline. This dialog limits the maximum number of control points to one-half of the 
number of samples in the smallest dimension. 

Gradient 
Descent 
Minimize 
Step Size 
(sample 
units)

This is the size of steps each control point is moved along the gradient-based direction 
when searching for a minimum of the error. The registration does not take into account 
the size of an image sample in each dimension, so this step size is specified in 
units of a sample. E.g., a value of 0.5 will move the control point in increments of 
half of a sample while searching for the minimum error. The minimum step size is 0.1 
sample and the maximum is 5 samples. 

Gradient 
Descent 
Minimize 
Max 
Search 
Steps

This is the maximum number of steps the control point is moved along the gradient-
based direction when searching for a minimum of the error. If the distance from the 
control point current position to the bounding polygon/polyhedron of its neighboring 
control points along the gradient-based direction is less than this specified value, then 
the computed distance value will be used for this control point instead. The minimum 
number of steps is 1 and the maximum is 100.

Iteration options (one iteration=move each control point once)

Convergence limit (min change rate for one 
iteration)

This is a rate of change threshold such that if the 
rate the error changes between starting and 
ending of each iteration is smaller than this value, 
then the registration terminates.

Maximum Number of Iterations If the convergence limit is not satisfied after this 
many iterations have been executed, then the 
registration terminates. The range of possible 
values is 1 to 100. 

Results

Create 
deforma-
tion field 
image

If this checkbox is enabled, then the deformation image is computed after the last pass 
of registration is performed. The image that is created has the same dimensions as the 
target and the registered source images, and has the name of the source image 
appended with deformation suffix. The deformation image will be automatically 
displayed along with the registered source image upon completion of registration. 
Refer to Figure 2 for details.

OK Applies the algorithm to the input image that you chose in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes the dialog box.

Help Displays online help for this dialog box.

Figure 4.  B-Spline Single - Pass Automatic Registration 2D/3D dialog box  (continued)
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General

Register Displays a list of currently 
active 2D/3D images to 
registration. The drop down list 
of options show the names of 
available images currently 
loaded to which this image can 
be registered. This list will only 
contain the names of images 
currently loaded in MIPAV 
which are compatible. 

Cost 
function

This drop down list contains the 
following choices for cost 
measure to use during 
registration: Least Squares, 
Correlation Ratio, and 
Normalized Mutual Information.

Perform 
two-pass 
registra-
tion

This dialog is shown with the default options for two-pass registration. If the 
Perform two-pass registration option is disabled, then the dialog will change to 
make options for single-pass registration available as shown in Figure 4.

Transformation Options

The following is a discussion of the dialog options which control each registration pass, one 
set of options per pass. For more information refer to “Transformation options” on page 124.

Sub-
sample 
image for 
speed

If this option is enabled, the image will be subsample in power of 2 for each dimension. 
Subsampling increases performance of the algorithm, but it results lower accuracy of 
registration.

B-Spline 
Degree 
(same for 
all axes)

This is the degree of the B-Spline to use for all axes of the image. The drop list of 
options show the values of 1 (linear), 2 (quadratic), 3 (cubic), and 4 which are 
available. Although, the underlying BSpineBasisf class supports any degree, this dialog 
restricts the degrees to these values. Choosing a smaller degree executes faster than a 
larger degree, but a higher degree offers a higher order of continuity. 

B-Spline 
Control 
Points(sa
me for all 
axes)

This is the number of B-spline control points to use for all axes of the image.The 
minimum number of control points is the larger of the number 2 and the degree of the 
B-Spline. This dialog limits the maximum number of control points to one-half of the 
number of samples in the smallest dimension. 

Figure 5.  B-Spline Two-Pass Automatic Registration 2D/3D dialog box 
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This dialog is shown with the default options for a two-pass registration. As 
previously mentioned and as indicated in the dialog, a single iteration 
involves the movement of each interior control point in a gradient descent 
minimization manner. 

Gradient 
Descent 
Minimize 
Step Size 
(sample 
units)

This is the size of steps each control point is moved along the gradient-based direction 
when searching for a minimum of the error. The registration does not take into account 
the size of an image sample in each dimension, so this step size is specified in 
units of a sample. E.g., a value of 0.5 will move the control point in increments of 
half of a sample while searching for the minimum error. The minimum step size is 0.1 
sample and the maximum is 5 samples. 

Gradient 
Descent 
Minimize 
Max 
Search 
Steps

This is the maximum number of steps the control point is moved along the gradient-
based direction when searching for a minimum of the error. If the distance from the 
control point current position to the bounding polygon/polyhedron of its neighboring 
control points along the gradient-based direction is less than this specified value, then 
the computed distance value will be used for this control point instead. The minimum 
number of steps is 1 and the maximum is 100.

Iteration options (one iteration=move each control point once)

Convergence limit (min change rate for one 
iteration)

This is a rate of change threshold such that if the 
rate the error changes between starting and 
ending of each iteration is smaller than this value, 
then the registration terminates.

Maximum Number of Iterations If the convergence limit is not satisfied after this 
many iterations have been executed, then the 
registration terminates. The range of possible 
values is 1 to 100. 

Results

Create 
deforma-
tion field 
image

If this checkbox is enabled, then the deformation image is computed after the last pass 
of registration is performed. The image that is created has the same dimensions as the 
target and the registered source images, and has the name of the source image 
appended with deformation suffix. The deformation image will be automatically 
displayed along with the registered source image upon completion of registration. 
Refer to Figure 2 for details.

OK Applies the algorithm to the input image that you chose in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes the dialog box.

Help Displays online help for this dialog box.

Figure 5.  B-Spline Two-Pass Automatic Registration 2D/3D dialog box  (continued)
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The following is an example of the dialog which is displayed for 2.5D inten-
sity/color image registration: This dialog is show with the default options 
for a single-pass registration. If the Perform two-pass registration 
check box is selected, then the dialog will change in a manner similar to that 
for the 2D/3D image registration shown in Figure 5. 

General

Register The Register source field is 
already filled with the name of 
the currently selected 2.5D 
image. The reference slice is 
selected from among the slices 
in the selected image. 

Radio buttons are used to 
select whether the reference 
slice is the the adjacent  
(previous) slice or a particular 
slice number in the image. If 
the Reference Slice radio 
button is selected, then a drop 
down list of slices numbers is 
enabled where the middle slice 
is selected by default. 

Cost 
function

This drop down list contains the 
following choices for cost 
measure to use during 
registration: Least Squares, 
Correlation Ratio, and 
Normalized Mutual Information.

Perform 
two-pass 
registra-
tion

This dialog is shown with the default options for single-pass registration. If the 
Perform two-pass registration option is enabled, then the dialog will change to 
make options for two-pass registration available. Refer to Figure 7.

Transformation Options

The following is a discussion of the dialog options which control each registration pass, one 
set of options per pass. For more information refer to “Transformation options” on page 124.

Sub-
sample 
image for 
speed

If this option is enabled, the image will be subsample in power of 2 for each dimension. 
Subsampling increases performance of the algorithm, but it results lower accuracy of 
registration.

Figure 6.  B-Spline Single-Pass Automatic Registration 2.5D dialog box 
MIPAV User’s Guide, Volume 2, Algorithms 120

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: B-Spline Automatic Registration
B-Spline 
Degree 
(same for 
all axes)

This is the degree of the B-Spline to use for all axes of the image. The drop list of 
options show the values of 1 (linear), 2 (quadratic), 3 (cubic), and 4 which are 
available. Although, the underlying BSpineBasisf class supports any degree, this dialog 
restricts the degrees to these values. Choosing a smaller degree executes faster than a 
larger degree, but a higher degree offers a higher order of continuity. 

B-Spline 
Control 
Points(sa
me for all 
axes)

This is the number of B-spline control points to use for all axes of the image.The 
minimum number of control points is the larger of the number 2 and the degree of the 
B-Spline. This dialog limits the maximum number of control points to one-half of the 
number of samples in the smallest dimension. 

Gradient 
Descent 
Minimize 
Step Size 
(sample 
units)

This is the size of steps each control point is moved along the gradient-based direction 
when searching for a minimum of the error. The registration does not take into account 
the size of an image sample in each dimension, so this step size is specified in 
units of a sample. E.g., a value of 0.5 will move the control point in increments of 
half of a sample while searching for the minimum error. The minimum step size is 0.1 
sample and the maximum is 5 samples. 

Gradient 
Descent 
Minimize 
Max 
Search 
Steps

This is the maximum number of steps the control point is moved along the gradient-
based direction when searching for a minimum of the error. If the distance from the 
control point current position to the bounding polygon/polyhedron of its neighboring 
control points along the gradient-based direction is less than this specified value, then 
the computed distance value will be used for this control point instead. The minimum 
number of steps is 1 and the maximum is 100.

Iteration options (one iteration=move each control point once)

Convergence limit (min change rate for one 
iteration)

This is a rate of change threshold such that if the 
rate the error changes between starting and 
ending of each iteration is smaller than this value, 
then the registration terminates.

Maximum Number of Iterations If the convergence limit is not satisfied after this 
many iterations have been executed, then the 
registration terminates. The range of possible 
values is 1 to 100. 

Results

Create 
deforma-
tion field 
image

If this checkbox is enabled, then the deformation image is computed after the last pass 
of registration is performed. The image that is created has the same dimensions as the 
target and the registered source images, and has the name of the source image 
appended with deformation suffix. The deformation image will be automatically 
displayed along with the registered source image upon completion of registration. 
Refer to Figure 2 for details.

OK Applies the algorithm to the input image that you chose in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes the dialog box.

Help Displays online help for this dialog box.

Figure 6.  B-Spline Single-Pass Automatic Registration 2.5D dialog box  (continued)
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General

Register The Register source field is 
already filled with the name of 
the currently selected 2.5D 
image. The reference slice is 
selected from among the slices 
in the selected image. 

Radio buttons are used to 
select whether the reference 
slice is the the adjacent  
(previous) slice or a particular 
slice number in the image. If 
the Reference Slice radio 
button is selected, then a drop 
down list of slices numbers is 
enabled where the middle slice 
is selected by default. 

Cost 
function

This drop down list contains the 
following choices for cost 
measure to use during 
registration: Least Squares, 
Correlation Ratio, and 
Normalized Mutual Information.

Perform two-pass registration This dialog is shown with the default options for 
two-pass registration.

Transformation Options

The following is a discussion of the dialog options which control each registration pass, one 
set of options per pass. For more information refer to “Transformation options” on page 124.

Sub-
sample 
image for 
speed

If this option is enabled, the image will be subsample in power of 2 for each dimension. 
Subsampling increases performance of the algorithm, but it results lower accuracy of 
registration.

B-Spline 
Degree 
(same for 
all axes)

This is the degree of the B-Spline to use for all axes of the image. The drop list of 
options show the values of 1 (linear), 2 (quadratic), 3 (cubic), and 4 which are 
available. Although, the underlying BSpineBasisf class supports any degree, this dialog 
restricts the degrees to these values. Choosing a smaller degree executes faster than a 
larger degree, but a higher degree offers a higher order of continuity. 

Figure 7.  B-Spline Automatic Two-Pass Registration 2.5D dialog box 
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B-Spline 
Control 
Points(sa
me for all 
axes)

This is the number of B-spline control points to use for all axes of the image.The 
minimum number of control points is the larger of the number 2 and the degree of the 
B-Spline. This dialog limits the maximum number of control points to one-half of the 
number of samples in the smallest dimension. 

Gradient 
Descent 
Minimize 
Step Size 
(sample 
units)

This is the size of steps each control point is moved along the gradient-based direction 
when searching for a minimum of the error. The registration does not take into account 
the size of an image sample in each dimension, so this step size is specified in 
units of a sample. E.g., a value of 0.5 will move the control point in increments of 
half of a sample while searching for the minimum error. The minimum step size is 0.1 
sample and the maximum is 5 samples. 

Gradient 
Descent 
Minimize 
Max 
Search 
Steps

This is the maximum number of steps the control point is moved along the gradient-
based direction when searching for a minimum of the error. If the distance from the 
control point current position to the bounding polygon/polyhedron of its neighboring 
control points along the gradient-based direction is less than this specified value, then 
the computed distance value will be used for this control point instead. The minimum 
number of steps is 1 and the maximum is 100.

Iteration options (one iteration=move each control point once)

Convergence limit (min change rate for one 
iteration)

This is a rate of change threshold such that if the 
rate the error changes between starting and 
ending of each iteration is smaller than this value, 
then the registration terminates.

Maximum Number of Iterations If the convergence limit is not satisfied after this 
many iterations have been executed, then the 
registration terminates. The range of possible 
values is 1 to 100. 

Results

Create 
deforma-
tion field 
image

If this checkbox is enabled, then the deformation image is computed after the last pass 
of registration is performed. The image that is created has the same dimensions as the 
target and the registered source images, and has the name of the source image 
appended with deformation suffix. The deformation image will be automatically 
displayed along with the registered source image upon completion of registration. 
Refer to Figure 2 for details.

OK Applies the algorithm to the input image that you chose in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes the dialog box.

Help Displays online help for this dialog box.

Figure 7.  B-Spline Automatic Two-Pass Registration 2.5D dialog box  (continued)
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Transformation options

The following is a discussion of the dialog options which control each regis-
tration pass, one set of options per pass: 

B-spline Degree (same for all axes): This is the degree of the B-spline 
to use for all axes of the image. Even though the BSplineRegistration2Df 
and BSplineRegistration3Df classes allow for specification of separate 
degrees for each axis, this dialog restricts the degrees to be the same. The 
drop list of options show the values of 1 (linear), 2 (quadratic), 3 (cubic), 
and 4 which are available. Although, the underlying BSpineBasisf class 
supports any degree, this dialog restricts the degrees to these values.Choos-
ing a smaller degree executes faster than a larger degree, but a higher 
degree offers a higher order of continuity. 

B-spline Control Points (same for all axes): This is the number of B-
spline control points to use for all axes of the image. Even though the 
BSplineRegistration2Df and BSplineRegistration3Df classes allow 
for specification of separate number of control points for each axis, this dia-
log restricts the numbers of control points to be the same. Initially, the con-
trol points are evenly spaced in each dimension, and the registration 
algorithm moves the interior control points to minimize the error difference 
between the target image and the registered source image. The minimum 
number of control points is the larger of the number 2 and the degree of the 
B-spline. This dialog option limits the maximum number of control points 
to one-half of the number of samples in the smallest dimension. Choosing 
more control points generally results in better overall fitting, but a limita-
tion may be that the control points will be closer to each other and that will 
limit how much a control point can move to minimize the error (in order to 
satisfy the constraint that an interior control point must be within the 
bounding polygon/polyhedron formed by its neighboring control points). 
Also, since choosing more control points means that control points will be 
closer to each other, it may be helpful to reduce the maximum number of 
steps for searching for the gradient descent minimum. 

Choosing more control points rather than fewer should result in a longer 
execution time. Even though more control points means fewer samples (for 
the same size input image) are affected by a single control point, the fact 
that there are more control points to move and each one requires a gradient 
descent sample search for a minimum error most likely results in the longer 
execution time. 
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Choosing more control points may require a different convergence limit. 
Since the convergence limit is tested once per iteration and an iteration 
involves moving each interior control point once, it may be that more con-
trol points could result in more (or less) overall changes in the error 
between starting and ending one iteration. 

Gradient Descent Minimize Step Size (sample size units): This is 
the size of steps each control point is moved along the gradient-based direc-
tion when searching for a minimum of the error. The registration does not 
take into account the size of an image sample in each dimension, so this step 
size is specified in units of a sample. For instance, a value of 0.5 will move 
the control point in increments of half a sample while searching for the min-
imum error. The minimum step size is 0.1 sample and the maximum is 5 
samples. 

Gradient Descent Minimize Max Search Steps: This is the maximum 
number of steps the control point is moved along the gradient-based direc-
tion when searching for a minimum of the error. If the distance from the 
control points current position to the bounding polygon/polyhedron of its 
neighboring control points along the gradient-based direction is less than 
this specified value, then the computed distance value will be used for this 
control point instead. The minimum number of steps is 1 and the maximum 
is 100. 

Convergence limit (min change rate for one iteration): This is a 
rate of change threshold such that if the rate the error changes between 
starting and ending of each iteration is smaller than this value, then the reg-
istration terminates. As mentioned previously, the rate of change is com-
puted as 

(previousError-currentError) / previousError 

where previousError is the error measured before starting an iteration 
and currentError is the error measured after completing an iteration. The 
error being measured here depends on the particular cost function selected. 

Maximum Number of Iterations: If the convergence limit is not satis-
fied after this many iterations have been executed, then the registration ter-
minates. The range of possible values is 1 to 100. 
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OUTPUT FILES

After the B-spline registration algorithm finishes running, the following 
files can be found in the image directory:

• the source and target image,

• the *.xmp files with the recorded history for both source and target 
images,

• the NonLinear Transformation (*.nlt) file that contains the 
information about the performed B-spline transformation, such as the 
dimensionality of the transformed image, the degree of the B-spline, 
the number of control points, and the values of the control points. This 
file is used for the Transform Nonlinear algorithm, refer to “Transform 
Nonlinear” ,

• the result file.

Class implementation for MIPAV 
The following classes are part of the mipav/model/structures package: 

• B-splineBasis

• B-splineBasisDiscretef 

• BSplineLattice2Df 

• BSplineLattice3Df 

• BSplineRegistrationBasef 

• fBSplineRegistration2Df 

The following classes are also part of the mipav/model/algorithms/
registration package: 

• AlgorithmRegBSpline 

• AlgorithmRegBSpline2D 

• AlgorithmRegBSpline3D 

• AlgorithmRegBSpline25D 
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DTI Create List File

This utility takes as an input a DICOM study directory or a PAR/REC file 
extracts the information and creates the following files:

• A list file with metadata information, such as shown in Figure 2; 

• A sorted relative path file that contains the relative paths to the slice 
files; 

• And a b-matrix file;

• If the Register option is activated, it, first, registers the image volume 
to the reference volume, and then creates a list file, a path file, and a b-
matrix file for the result image. For more information, refer to Section 
“If the Registration option is activated” on page 134.

These three files are used for the diffusion tensor (D) computation in the 
MIPAV Diffusion Tensor Imaging module.

Figure 1.  The outline of the method
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Outline of the method

LIST FILE

The list file contains metadata which describe the study and experiment. It 
includes the information about the acquired image, such as image format, 
number of slices, slice thickness, image plane, and also it keeps the name of 
the path file.

DICOM

For DICOM images, this information is extracted directly from the file 
header. A sample list file is shown in Figure 2.

PAR/REC

The method extracts metadata from the PAR file and uses them to form the 
list file. A sample list file for PAR/REC dataset is shown in Figure 3.

PATH FILE

The method forms the path file that has the relative paths to all image 
volumes and slices arranged in the following order (the example below is 
given for a 7 Volume image):

Example 1: a path file structure

A path to slice 1 Volume1
A path to slice 1 Volume2
………………………………….
A path to slice 1 Volume7
A path to slice 2 Volume1
A path to slice 2 Volume2
………………………………….
A path to slice 2 Volume7
………………………………….
………………………………….
A path to slice n Volume1
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A path to slice n Volume2
………………………………….
A path to slice n Volume7

DICOM

In order to get this path information for DICOM images, the method parses 
the study directory and sorts files into lists using a series number that is 
available in the DICOM image header. Then, based on the filename, it gets a 
volume number, for example, 
mipav_dicom_dti_series11_volume10005.dcm, and sorts within lists 
using the volume number and instance number that comes from the 
corresponding DICOM tag.

PAR/REC

The reconstructed image (a *.REC file) is a data file that has all DWIs stored 
in a single volume pixel by pixel in Integer data format (16-bit or 8 bit per 
pixel) defined by the header parameter. 

For Phillips PAR/REC format, the method does the following: 

1 In the study_name_proc directory it creates a subdirectory with the 
name that corresponds to the name of your s PAR/REC file;

2 It decomposes the *.REC file into and slices in Float format   one *.RAW 
+XMP file per slice and copies these files into the 
your_study_name_slices directory. The slice name includes the 
volume number. See Figure 4;

3 Finally, the method forms the path file that contains the relative paths 
to all slices arranged by volumes as shown in Example 1 (this example is 
given for a 7 Volume image). See also Figure 4.
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<!-- DTI initialization file -->

<!-- do not remove the above comment line -->

<!-- NUMBER OF COLUMNS -->

<original_columns>64</original_columns>

<!-- NUMBER OF ROWS -->

<original_rows>64</original_rows>

<!-- NUMBER OF SLICES -->

<slice>38</slice>

<!-- NUMBER OF BMATRICES -->

<nim>42</nim>

<!-- ORIENTATION OF PHASE ENCODING (vertical, horizontal) -->

<phase_encode_direction>vertical</phase_encode_direction>

<!-- HORIZONTAL FIELD OF VIEW (in mm) -->

<x_field_of_view>200.000000</x_field_of_view>

<!-- VERTICAL FIELD OF VIEW (in mm) -->

<y_field_of_view>200.000000</y_field_of_view>

<!-- FORMAT OF RAW IMAGES (integer, float, dicom, dummy) -->

<rawimageformat>dicom</rawimageformat>

<!-- NAME OF BMATRIX FILE -->

<bmatrixfile>433672_BOS_20040628_minc_dicom.BMTXT</bmatrixfile>

<!-- GAP BETWEEN SLICES (in mm. Write 0 for contiguous slices) -->

<slice_gap>0.0</slice_gap>

<!-- SLICE THICKNESS (in mm) -->

<slice_thickness>4.0</slice_thickness>

<!-- IMAGE PLANE (axial,coronal,sagittal) -->

<image_plane>axial</image_plane>

<!-- NAME OF FILE CONTAINING PATH OF RAW IMAGES -->

<raw_image_path_filename>433672_BOS_20040628_minc_dicom.path<
/raw_image_path_filename>

Figure 2.  A sample list file for a DICOM image
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<!-- DTI initialization file -->

<!-- do not remove the above comment line -->

<!-- NUMBER OF COLUMNS -->

<original_columns>128</original_columns>

<!-- NUMBER OF ROWS -->

<original_rows>128</original_rows>

<!-- NUMBER OF SLICES -->

<slice>50</slice>

<!-- NUMBER OF BMATRICES -->

<nim>33</nim>

<!-- ORIENTATION OF PHASE ENCODING (vertical, horizontal) -->

<phase_encode_direction>vertical</phase_encode_direction>

<!-- HORIZONTAL FIELD OF VIEW (in mm) -->

<x_field_of_view>240.000</x_field_of_view>

<!-- VERTICAL FIELD OF VIEW (in mm) -->

<y_field_of_view>240.000</y_field_of_view>

<!-- FORMAT OF RAW IMAGES (integer, float, dicom, dummy) -->

<rawimageformat>float</rawimageformat>

<!-- NAME OF BMATRIX FILE -->

<bmatrixfile>1 9_5_8_1.BMTXT</bmatrixfile>

<!-- GAP BETWEEN SLICES (in mm. Write 0 for contiguous slices) -->

<slice_gap>0.000</slice_gap>

<!-- SLICE THICKNESS (in mm) -->

<slice_thickness>2.500</slice_thickness>

<!-- IMAGE PLANE (axial,coronal,sagittal) -->

<image_plane>axial</image_plane>

<!-- NAME OF FILE CONTAINING PATH OF RAW IMAGES -->

<raw_image_path_filename>1 9_5_8_1.path</
raw_image_path_filename>

Figure 3.  A sample list file for a PAR/REC image
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B-MATRIX FILE FOR DICOM IMAGE 
DATASETS

If a user provides a b-matrix file, the method simply copies that file to the 
study_name_proc directory and renames it using the correct naming 
syntax, which is as follows: your_study_name.BMTXT.

If the user did not provide the b-matrix file, the method gets b-values for 
each volume set directly from the provided image dataset.

For DTI image datasets: 

• If the image was acquired using the Siemens magnet, then the method 
extracts b-value from a public tag 0018,0024. The b-value is the 
number following after the keystroke ep_b and before #.

• If the image was acquired using the General Electric (GE) magnet and 
the version of the software used is 8 or less, then the method extracts 

Figure 4.  A sample path file for a Phillips PAR/REC image
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the b-value from a private tag 0019,10B9 and the b-value is the 
number following after the ep_b keystroke.

• If the image was acquired using the GE magnet and the software's 
version is bigger than 8, then the method extracts the b-value from a 
private tag 0043,1039 and the b-value is the first number in the string.

For eDTI image datasets:

• If the image was acquired using the Siemens magnet, then the method 
extracts the b-value from a public tag 0018,0024 and the b-value is the 
number following after the ep_b keystroke and before #.

• If the image was acquired using the GE magnet, then the method 
extracts the b-value from a private tag 0043,1039 and the b-value is 
the first number in the string.

Note: if for some reason the algorithm fails to extract b values and create the b-
matrix file, the user has the option to provide his own b-matrix file, and then 
rerun the algorithm.

B-matrix file for PAR/REC image datasets

For the software version 4.1 and greater, the method extracts b values and 
gradient information from a PAR file. It creates the b-matrix file that has 
the name your_study_name.BMTXT and copies it to the same directory 
where the list and path files are stored.

For the software version 4.0 and lesser the method extracts only the b 
values, but the gradient file must be provided by the user.

If the user provides the b-matrix file, the method simply copies that file to 
the your_study_name_proc directory and renames it using the correct 
naming syntax, which is as follows your_study_name.BMTXT.

IF THE REGISTRATION OPTION IS ACTIVATED

1 The algorithm registers the image dataset to the reference volume using 
either the default, or the user defined settings of the Optimized 
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Automatic Registration algorithm. For more information, refer to 
“Optimized Automatic Registration 3D” on page 596.

Note: For DICOM files you should provide the path to the first slice of the B0 
volume. See Figure 5. For PAR/REC files the algorithm uses the B0 volume as a 
reference volume and it finds it automatically.

2 Under the your_study_name_proc directory, it creates the subdirectory 
with the following name your_study_name_registered_slices.

3 In that subdirectory the algorithm saves the result image volume after 
registration.

4 When the registration is done, the algorithm creates the b-matrix, list 
and path files and stores them in the your_study_name_proc directory. 
In this case the file names are as follows:

• your_study_name_registered.BMTXT – for the b-matrix file,

• your_study_name_registered.list – for the list file,

• your_study_name_registered.path – for the path file.

5 These files are stored in the your_study_name_proc directory. 

Figure 5.  The DTI Create List File dialog box with the Registration 
option activated for DICOM images
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Running the DTI Create List File utility

FOR DICOM DATASETS

1 Run MIPAV.

2 Navigate to File > Diffusion Tensor Imaging >Create List File.

3 Run the DTI Create List File utility.

4 In the DTI Create List File dialog box that appears:

• Navigate to the study path directory;

• Open the gradient file or the b-matrix file (depending on what you 
have). Note that for interleaved datasets, you must provide the b-
matrix file.

Figure 6.  The b-matrix, list and path files and the default directory for 
the PAR/REC dataset if the Register First option is activated in the 
dialog box
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5 If you need to register your dataset before running the Create List File 
utility, check the Register first box. Provide the path to the first slice 
of the B0 volume, see Figure 7. And then click the Registration Setting 
button. This will call the Optimized Automatic Registration dialog box. 
In the dialog box, adjust the registration parameters and then press OK. 
For more information, refer to “If the Registration option is activated” 
on page 134 and “Optimized Automatic Registration dialog box options” 
on page 609.

6 Press OK. The plug-in begins to run and the list file, path file, and b-
matrix file appear in the sub directory of the study path directory that 
has the following name your_study_name_proc. See Figure 2 and 
Figure 7.

For PAR/REC datasets

7 Run MIPAV.

Figure 7.  The DTI Create List File dialog box opened for a DICOM image
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8 Navigate to File > Diffusion Tensor Imaging >Create List File.

9 Run the DTI Create List File utility.

10 In the DTI Create List File dialog box that appears:

• Open the REC file;

• Open the gradient file if the software version is less than 4.0. Note that 
for interleaved datasets, you must also provide the b-matrix file.

11 If you need to register your dataset before running the Create List File 
utility, check the Register first box. This activates the Registration 
Settings button. Click the button to open the Optimized Automatic 
Registration dialog box. In the dialog box, adjust the registration 
parameters and then press OK. For more information, refer to “If the 
Registration option is activated” on page 134 and “Optimized Automatic 
Registration dialog box options” on page 609.

Figure 8.  Running the DTI Create List File plug-in for PAR/REC datasets
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12 Press OK. The plug-in begins to run and the list file, path file, and b-
matrix file appear in the sub directory of the study path directory that 
has the following name your_study_name_proc. See Figure 6 and 
Figure 8.
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DTI Color Display

A common problem in biomedical sciences is the in vivo identification and 
analysis of anatomical structures. The DTI Color Display plug-in intro-
duces a novel technique to visualize nerve fiber tracts in diffusion-
weighted magnetic resonance imaging data. The method uses the 
improved diffusion tensor-based Directionally Encoded Color (DEC) 
schemes which can be used, for example, to identify and display white 
matter fiber tracts in the human brain.

Background
The method takes as an input indices of diffusion anisotropy and the princi-
pal directions of diffusion (eigenvectors of diffusion tensor D), which char-
acterize specific features of the diffusion process. And then, it uses a color 
(RGB and/or HSV) representation of the components of the eigenvector 
associated with the largest eigenvalue of the diffusion tensor (Vmax) 

weighted by some measure of diffusion anisotropy. This technique provides 
an effective way to display the directions of anisotropic structures in a single 
brain image, because:

• The principal directions of diffusion provide information on the spatial 
orientation of anisotropic structures that may be useful to further 
characterize tissue structural anatomy. 

• Anisotropy measures yield information about the structure of normal 
and pathological white matter. 

There are three issues or three sources of misinterpretation in 
the DEC schemes that DTI Color Display method improves:

• Antipodal symmetry of the eigenvectors of D, refer to Section 
“Antipodal Symmetry of the Eigenvectors of D” on page 141

• Nonlinear effects of the display device, refer to Section “Color 
processing” on page 146

• Properties of human color vision, also refer to Section “Color 
processing” on page 146
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ANTIPODAL SYMMETRY OF THE 
EIGENVECTORS OF D

The method is based on assumptions that the orientation of fibers is 
described by the diffusion tensor eigenvector associated with the largest 
eigenvalue, Vmax and the parallel and anti-parallel vectors convey the same 

information. Thus, to have a unique vector representation, the vectors have 
to be mapped to only one hemisphere in a spherical coordinate system. The 
plane that divides this spherical coordinate system into two hemispheres, 
e.g., the plane of discontinuity can be positioned in an arbitrary direction; 
however, within this plane, fiber orientation will still be represented by two 

antipodally symmetric vectors Vmax and -Vmax.1 

To reduce these discontinuity artifacts, the method uses a spherical coordi-
nate system fixed to defined anatomical landmarks and independent from 
the laboratory reference frame in which the tensor dataset is acquired. 
Within that anatomical coordinate system the eigenvector Vmax is a unit 

vector completely determined by its polar theta and azimuthal phi angles 
that are defined as shown in Figure 1. A particular color representation is 
shown on a unit sphere, which is called the color representation sphere.

Only the vectors expressed in the upper hemisphere, e.g. z more or equal to 
0 or theta   in a range of [0, Pi/2] and the XY plane is the plane of disconti-
nuity, are used for unique color representation. The lower hemisphere is 
just an antipodally symmetric copy of the upper hemisphere. Refer to 
Figure 1 in which the color representation sphere is split along the plane of 
discontinuity. The brightness of a DEC map is weighted by a measure of dif-

fusion anisotropy.2 

The following considerations were also used to design the color 
representation sphere:

• Color differences are proportional to actual differences in direction, 
characterized either by the Euclidian distance between vectors or by 
the angle between them. 

1. In statistics, directional data with such antipodal symmetry are referred to as axial data.
2. Pi = 3.14159265
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• Only the directional information contained in the D is displayed, and 
the representation is not affected by parameters related to the 
magnitude of diffusivity, such as Trace D or diffusion coefficients. 

• Commonly identifiable color groups (e.g., red, green, blue, yellow, 
cyan, magenta, etc.) are associated with a characteristic direction (e.g., 
direction along x, y, z, and directions bisecting the XY, YZ, XZ planes).

The method allows different directions in the color maps to be represented 
with the same color if some form of symmetry exists between these direc-
tions. However, it causes an orientational ambiguity, because the color rep-
resentation of orientation is not unique, in some situations using such 
symmetries is justified by existing symmetries in the human anatomy. With 
regard to which type of symmetry is used, the method offers the following 
options: No Symmetry, Rotational Symmetry, Mirror Symmetry, and Abso-
lute Value. See Figure 6.

Figure 1.  Definition of the anatomical reference frame for brain images. 
The YZ plane corresponds to the sagittal plane aligned with the inter-
hemispheric fissure; the y axis corresponds to the anterior posterior 
intercommissural line. When no anisotropy filter is used, a particular 
color representation can be shown on a unit color representation 
sphere. The color representation sphere shown in this picture is for the 
no symmetry scheme (described in Section “No Symmetry” on 
page 143). The sphere is anchored to the anatomic frame of reference; 
thus, for a given scheme, an anisotropic structure has the same color 
independent of the view (axial, coronal, or sagittal). The figure also 
shows how Vmax for a generic direction is mapped on the color sphere.
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Proper rotations should be done to convert image data from the laboratory frame 
of reference to the specified anatomical frame of reference before applying the 
method. See also Section “Importance of midsagittal alignment” on page 150.

No Symmetry

This representation is implemented by relating the azimuthal angle of the 
vector phi to color hue and the polar angle theta less or equal Pi/2 to color 
saturation. For HSV scheme (H=Hue, S=Saturation, V=Value) the following 
equations are used:

EQUATION 1

Where, phiR is the phi angle of the vector Vmax lying in the XY plane that will 

be represented in a pure red color, and pS is an heuristic parameter that 

takes values in the interval [0,1]. When pS < 0, S is approximately a linear 

function of theta. No Symmetry representation is unique because a particu-
lar color describes a single direction, but it suffers from discontinuity arti-
facts.

Rotational Symmetry

In this scheme, any vector and its pair rotated by 180° around the z axis 
have the same color representation, e.g. Vmax(theta, phi) = Vmax(\theta, 

phi+Pi) or Vmax(vx,vy,vz) = Vmax(-vx,-vy,-vz). This representation is 

implemented in a fashion similar to the No Symmetry approach, but with 
the constraint H(phi) = H(phi+Pi). 

EQUATION 2
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Where, phiR is the phi angle of the vector lying in the XY plane that will be 

represented in a pure red color. pS in the interval [0,1] is the same heuristic 

parameter as used for No Symmetry and equations for S and V are also the 
same that were used for No Symmetry. See also Equation 1.

Rotational Symmetry scheme removes the discontinuity artifacts but does 
not provide a unique representation of directions and is, also, perceptually 
highly nonuniform.

Mirror Symmetry

The mirror symmetry representation scheme implies that any two vectors 
that are mirror images of each other relative to the YZ plane of the 
anatomical frame of reference will have the same color representation, e.g. 
Vmax(-vx,vy,vz) = Vmax(vx,vy,vz).

EQUATION 3

Where, phi is an azimuthal angle of Vmax(|vx|,vy,vz). Mirror symmetry exists 

between many structures in the left and the right brain hemispheres. 
Equations for S and V are also the same that were used for No Symmetry, 
refer to Equation 1.

Absolute Value

The Absolute Value scheme implies that the sign of any vector is unimpor-
tant; only the absolute value is important. This yields a simple representa-
tion in RGB color space in which RGB components are associated with the 
absolute value of the components of the vector, e.g. 

EQUATION 4
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Where RI, GI, and BI are the RGB components of the color representation of 

Vmax,which are defined in the interval (0,1). See also Figure 2.

COLOR CIRCLES

The method uses color circles to relate a chosen color representation sphere 
with its corresponding fiber orientation. The color circles are constructed by 
projecting a chosen color representation sphere onto viewing plane using 
the equal area Lambert's projection. According to the standard convention 
for viewing MR images, for axial images the representation color sphere is 
viewed from below (negative z axis of our anatomical coordinate system 
pointing at the viewer, see Figure 2-a) and for coronal images from the front 

(positive y axis pointing at the viewer, see Figure 2-b). See also Figure 6.1

In Figure 2, the orientation of a structure represented with a given color, 
can be approximately obtained from the color circle by placing one end of a 
pencil, whose length is approximately equal to the radius of the circle, at the 
center of the circle and the other end right above the corresponding color.

Figure 2.  a: Anatomic reference frame. b: Color representation sphere 
for the absolute value scheme. c: A unit sphere for your reference. In (b) 
the projection of the color representation sphere onto a color circle for 
axial and coronal views is shown, assuming that axial and coronal slices 
are exactly perpendicular to the z and y axes of the anatomical 
reference frame, respectively. Note that the grid for coronal view is not 
the projection of the constant theta and phi lines but rather the grid of 
constant thetav and phiv as defined in the text.

1. Lambert's Cylindrical Equal Area Map projection implies the following: meridians are equally 
spaced; parallels get closer near poles; parallels are sines; true scale at equator.
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Building color circles

Figure 2 shows a grid of parallels and meridians added to the circle at 15 
degree intervals to indicate the angles thetav (angle at which the structure is 

positioned relative to the viewing direction) and phiv (angle within the 

viewing plane). Here, phiv and thetav are related to the 2D cylindrical 

coordinates rho and of the equal area color circle as rho=2sin(thetav/2) and 

phi=phiv as shown in Figure 2.

COLOR PROCESSING

The color processing sequence provided by the method aims at faithfully 
representing 3D antipodally symmetric vector data, taking into account 
artifacts associated with particular color display and human color percep-
tion. The final goal is that the differences in orientation of such data be pro-
portional to the perceived color differences, as much as that is possible. 
Since color perception properties, as well as those of antipodally symmetric 
data, do not allow this to be achieved precisely, the method resorts to 
approximate schemes using symmetries in data, then it provides tools for 
correcting the direct color representation using red, green and blue shifts, 
which aim to equalize different perceptual qualities of those primary colors. 
Then intensity scaling corrects for our non-uniform perception of luminos-
ity, and finally the gamma correction should be applied to correct for the 
common non-linearity effect introduced by different color display.

Color processing heuristic parameters

Anisotropy Max and Min are used to set the Anisotropy filter. After the 
filter is set, only structures where the Anisotropy index was larger than 
anisotropy min and smaller than anisotropy max are represented, the 
others are truncated and set to black. \s{DTIAdjustEXp.png}.

Gamma Correction is used to encode RGB values into luminosity 
produced by the device, e.g. your computer monitor.

pB Sat.Blue is used to decrease the saturation of blue hue to achieve better 
uniformity of perceived brightness for different hue values (e.g. red, green, 
and blue), and more faithful representation of diffusion anisotropy. It is 
also used as a basis for calculation brightness of red color.
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pG Dim Green is used to adjust brightness for green color.

pC Color Range. pC Color Range = 0 yields the maximal range of colors 
without regard to uniform brightness. pC Color Range = 1 reduces the range 
of colors, but allows a more faithful representation of anisotropy and a more 
uniform color representation.

pS Sat vs. Theta is used to modify the dependence between the saturation 
and the angle theta.

Adjust Exp is used to modify the nonlinear relationship between the 
perceived brightness and the anisotropy measure. The algorithm uses two 
types of anisotropy filters in color representations. See also Figure 3.

• In the first one, each of the color components is, first, normalized 
based on the anisotropy min and max values, e.g. 
newIntensityValue =(value - anisotropyMin)/(anisotropyMax - 
anisotropyMin), and then the normalized value is multiplied to a 
weighting factor equals AdjustExp/StevensBeta. This corresponds 
to the Multiply option activated in the DTI Color Display dialog 
box, refer to Figure 3- (b).

• In the second one, only structures where the lattice index was larger 
than anysotropy min are represented, the others are truncated and 
set to black. This corresponds to the Truncate option activated in the 
DTI Color Display dialog box, refer to Figure 3- (a).

Stevens law exponent or StephensBeta which employs the simple 
nonlinear relationship between the true luminosity of monochromatic light 
and its perceived brightness, is also treated as heuristic parameter, i.e. it can 
be adjusted.
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Figure 3.  Applying the Adjust Exp. slider. The DTI Color Display dialog 
box shows two representations of the same image. (a): the Truncate 
option activated, thus the image intensity values, which are lower than 
the Anisotropy min threshold, are set to zero. (b): the Multiply option is 
activated, that makes the brightness of a given color to be modulated by 
the degree of anisotropy.
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Blue, red and green shifts

Uniform brightness is important to view the directional information and the 
degree of anisotropy simultaneously. In other situations, when the degree of 
anisotropy is less important one may use a larger range of colors. This is 
governed by the parameter pC Color Range. 

To preserve uniform brightness, the method, first, shifts blue toward the 
white point according to the following equations:

EQUATION 5

Where RS, GS, and BS are shifted intensities for red, green and blue 

components, pB represents the pB Sat.Blue parameter and pC represents pC 

Color Range. See also “Color processing heuristic parameters” on page 146.

Then, the algorithm performs the red shift in the same manner, but using 
the smaller pB Sat.Blue, e.g. pB for red shift = pB/4.

And finally, it performs the green shift:

It calculates new shifted intensities for red, green and blue components 
taking into account the following heuristic parameters: pG Dim Green, pC 
Color Range, and StephensBeta. See also “Color processing heuristic 
parameters” on page 146.
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Gamma correction

The default values for the gamma correction exponent and StephensBeta 
are as follows: gamma = 2.2 and StephensBeta = 0.4. However, the method 
treats them as heuristic parameters, i.e., they can be empirically adjusted. 
See also Figure 3.

IMPORTANCE OF MIDSAGITTAL ALIGNMENT

In real life, the anatomic coordinate system and the reference system for 
image display do not necessarily coincide, i.e., axial, coronal, and sagittal 
images are not lying in the XY, XZ, and YZ planes of the anatomical coordi-
nate system, respectively. In such case, the color coordinate system appears 
shifted relative to the color circle grid and the above proposed symmetries 
in color representation (e.g. rotational symmetry and mirror symmetry) 
would not be easily seen on the color circle. If the misalignment between the 
anatomical coordinate system and the reference system for image display is 
severe, images should be rotated and interpolated before applying the 
method.

IMAGE TYPES

The algorithm works with any image types supported by MIPAV. However, 
in order to run the algorithm you should provide two files: an eigenvector 
file and an anisotropy file. The eigenvector file should be 4D image file with 
nine time slices, where the first three slices contain the principal eigenvec-
tor information. The anisotropy file should be 3D file with anisotropy value 
range (0,1). The files must have the same 3D dimensionality.

Figure 4.  An eigenvector (left) and anisotropy (right) files opened in 
MIPAV.
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REFERENCES

Sinisa Pajevic and Carlo Pierpaoli [1999]. “Color Schemes to Represent the Orientation of 
Anisotropic Tissues From Diffusion Tensor Data: Application to White Matter Fiber Tract 
Mapping in the Human Brain”, Magnetic Resonance in Medicine, vol. 42, pp 526---540.

Applying DTI Color Display

1 Install the plug-in.

2 Then select Plugins > General > DTI Color Display. The DTI Color 
Display dialog box opens displaying the Absolute Value color wheel.

3  In the dialog box, select the eigenvector and anisotropy files.

4 Click OK. The image appears in the Image window.

5 Use the Image slice slider to select the slice of interest.

6 Select the color wheel which you would like to apply to the image. Note 
that:

• Absolute Value yields a simple representation in RGB color space in 
which RGB components are associated with the absolute value of the 
components of the diffusion vector.

•  In No Symmetry scheme, a particular color describes a single 
direction, but this representation suffers from discontinuity 
artifacts.

•  Rotational Symmetry scheme removes the discontinuity artifacts 
but does not provide a unique color representation of directions and 
is, also, perceptually highly nonuniform.

• Mirror Symmetry implies that any two vectors that are mirror 
images of each other relative to the YZ plane of the anatomical 
coordinate system will have the same color representation. See also 
Figure 6.

Then, use the Heuristic Parameters sliders to adjust the parameters to 
achieve the most satisfactory image representation. See also Section “Color 
processing heuristic parameters” on page 146.
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Figure 5.  DTI Color Display dialog box. 
• In the Color Wheel window, use the list box to select the color scheme. 
• Use the Heuristic Parameters options to adjust colors and also alleviate artifacts associated with the 

properties of your color display and perception. For more information, refer to Section “Color processing 
heuristic parameters” on page 146.
• Use the Save parameters option to save current parameters in a file. 
• Use the Load parameters option to load saved parameters. 
• Use the Restore Default parameters option to restore default values. 
• In the Image window, use the Image Slice slider to select the slice that you would like to examine. 
• Use the Zoom In and Zoom Out to magnify or minify the image. 
• Use 1:1 option restore the image to its original size. 
• And you can also capture the image into a new frame using the Camera icon. Note that this option 

becomes available only if the image is restored to its original size.
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Figure 6.  Four types of color wheels which are used in the algorithm.
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Edge Detection: Zero X Laplacian

Edge detection is possibly the most common method for segmenting 
objects in medical images. Typically, these algorithms find edges that form 
a closed contour, which completely bound an object. Currently, MIPAV 
offers two edge detection algorithms: Zero X Laplacian. and “Edge Detec-
tion: Zero X Non-Maximum Suppression” . 

Background
The Laplacian is a 2-D isotropic measure of the 2-nd spatial derivative of an 
image and can be defined as:

EQUATION 1

in 2D images and

EQUATION 2

in 3D images.

The Laplacian of an image highlights regions of rapid intensity change and 
therefore can be used for edge detection. Zero X Laplacian algorithm finds 
edges using the zero-crossing property of the Laplacian. The zero crossing 
detector looks for places in the Laplacian of an image where the value of the 
Laplacian passes through zero – i.e. points where the Laplacian changes its 
sign. Such points often occur at the edges in images – i.e. points where the 
intensity of the image changes rapidly. 

Figure 1 on page 155 shows that in the approach of a change in intensity, the 
Laplacian response is positive on the darker side, and negative on the 
lighter side. This means that at a reasonably sharp edge between two 
regions of uniform but different intensities, the Laplacian response is:
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• zero at a long distance from the edge,

• positive just to one side of the edge,

• negative just to the other side of the edge,

• zero at some point in between, on the edge itself. 

However, as a second order derivative, the Laplacian is very sensitive to 
noise, and thus, to achieve the best result, it should be applied to an image 
that has been smoothed first. This pre-processing step reduces the high 
frequency noise components prior to the differentiation step.

The concept of the Zero X Laplacian algorithm is based on convolving the 
image with 2D Gaussian blur function, first, and then applying the 
Laplacian. The 2D Gaussian blur function can be defined as

Figure 1.  Edge detection by derivative operations – for given two 
images (light stripe on a dark background and dark stripe on a light 
background) the first and second derivatives were taken. Note that the 
second derivative has a zero crossing an the location of each edge
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EQUATION 3

where  –sigma is a standard deviation. This function blurs the image with 
the degree of blurring proportional to sigma.

In that case the 2-D Laplacian of the Gaussian (that is the second derivative 
of h with respect to r) is centered on zero and with Gaussian standard 
deviation sigma has the form of

EQUATION 4

where r2=x2+y2. See also Figure 2.

Since the convolution operation is associative, the method convolves the 
Gaussian smoothing filter with the Laplacian filter, first, and then convolves 
this hybrid function (defined by Equation 4) with the image to achieve the 
required result.

 

Once the image has been Laplacian of a Gaussian filtered, the algorithm 
detects the zero crossings. Note that, zero crossings might occur at any place 

Figure 2.  The picture shows a cross section of the circularly symmetric 
function defined by Equation 4. The function crosses the zero point at r 
equals + or -sigma

σ
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where the image intensity gradient starts increasing or starts decreasing, 
and this may happen at places that are not obviously edges. To cure that 
problem, the method applies the Marching Squares algorithm to detect 
those zero crossings that corresponds to edges. To learn more about March-
ing Squares, refer to Volume 2, Algorithms, “Extract Surface (Marching 
Cubes)” . 

The resulting image is an unsigned byte image with values of 255 at the 
edges and 0 elsewhere.

IMAGE TYPES

You can apply this algorithm to 2D and 3D grayscale images.

REFERENCES

See the following references for more information about this algorithm: 

http://homepages.inf.ed.ac.uk/rbf/HIPR2/log.htm.

http://homepages.inf.ed.ac.uk/rbf/HIPR2/zeros.htm

Rafael C. Gonzalea, Richard E. Woods, “Digital Image Processing” Second Edition, Prentice 
Hall, 1992, pp. 581–585.

Applying the Zero X Laplacian algorithm
To run this algorithm, complete the following steps:

1 Open an image of interest;

2 Select Algorithms > Edge Detection > Zero X Laplacian. The EdgeLap 
dialog box opens. For the dialog box options, refer to Figure 4.

3 Complete the fields in the dialog box. Click OK. 

The algorithm begins to run, and a status window appears. When the 
algorithm finishes, the resulting image appears as an unsigned byte 
mask in a new image window as shown in Figure 3. 
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Figure 3.  The original image and its unsigned byte mask with detected 
edges

Scale of the 
Gaussian

Specifies the standard deviation of the 
Gaussian filter in X, Y, and Z directions 
which were used to determine edges in 
the image.

Use image 
resolutions to 
normalize Z 
scale

If checked, Z scale*(X resolution/Y reso-
lution) will be used to generate the edge 
map.

If unchecked, Z scale will be used in gen-
eration of the edge map.

Options

Use separable 
convolution 
kernels

If checked, the algorithm convolves the 
image with X kernel and Y kernel 
independently, and then combines the 
result images.

Process each slice independently (2.5D) Applies the algorithm to each 
slice individually. 

Destination New image – this is the default option; Replace image – this option cannot be 
selected.

Process Whole Image – if checked the edge detection will be calculated for the whole 
image; VOI region – if checked the edge detection will be calculated for the 
selected VOI.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Closes the dialog box.

Help Displays online help for this dialog box.

Figure 4.  The EdgeLap dialog box options
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Edge Detection: Zero X Non-Maximum 
Suppression

This method produces an edge map of the zero-crossings of the non-
maximum suppression for 2D and 2.5D images. Edges are defined as the 
union of points for which the gradient magnitude assumes a maximum in 
the gradient direction. 

Background
For a 2D image, let's introduce a local coordinate system (u, v) such that at 
any point in the image P0(x0,y0) v-axis is parallel to the gradient direction at 

(x0,y0) and the u-axis is perpendicular to it, i.e.,

EQUATION 1

Where L is a convolution of an image (represented as a function f(x,y) with 
the Gaussian kernel defined as:

EQUATION 2

so that 

EQUATION 3

where the circle represents convolution of g(x,y;t) and f(x,y) and semicolon 
in the argument of g implies that the convolution is performed only over the 
variables x and y, while the scale parameter t after the semicolon just 
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indicates which scale-space level is being defined. Directional derivatives in 
this local (u,v) system are related to partial derivatives in the Cartesian 
coordinate system by the following system of equations, 

EQUATION 4

where, at a given point P0

EQUATION 5

And this (u,v) coordinate system is characterized by the fact that one of the 
two first-order derivatives –Lu, is zero, e.g.

EQUATION 6

EQUATION 7

EQUATION 8
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Below, are equations used in the method for calculating the second and 
third derivative – Lvv and Lvvv.

EQUATION 9

EQUATION 10

EQUATION 11

EQUATION 12

EQUATION 13

According to the notion of non-maximum suppression, an edge point is 
defined as a point at which the gradient magnitude assumes a maximum in 
the gradient direction. In terms of directional derivatives, such definition 
can be also expressed as a combination of two conditions:

• The second-order directional derivative in the v-direction Lvv being 

zero; 
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• And the third-order directional derivative in the same direction Lvvv 

being negative, e.g.:

EQUATION 14

Since only the sign information is important, these conditions can be 
restated as: 

EQUATION 15

Here, L is the scale-space representation of an image f(x,y;t) at a certain 
scale t, and the last equation defines the edges of f at that scale.

This condition can also be formulated in terms of zero-crossings of the 
partial derivative of L with respect to the scale parameter (i.e., as a 
directional derivative in the vertical scale direction). For more information 
about the zero-crossings method for detecting edges used in MIPAV, refer 
to MIPAV User Manual, Volume 2, Algorithms, “Edge Detection: Zero X 
Laplacian” on page 154.

The method evaluates detected zero-crossings using the Marching Squares 
algorithm to determine only those zero-crossings that corresponds to edges. 
To learn more about the Marching Squares algorithm, refer to MIPAV User 
Manual, Volume 2, Algorithms, “Extract Surface (Marching Cubes)” on 
page 395.

The resulting image is an unsigned byte image with values of 255 at the 
edges and 0 elsewhere.
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IMAGE TYPES

You can apply this algorithm to 2D and 3D grayscale images.

REFERENCES

Bart M. ter Haar Romeny(Ed.), “Geometry-Driven Diffusion in Computer Vision”, Chapter2: 
Linear Scale-Space II: Early Visual Operations by Tony Lindeberg and Bart M. ter Haar 
Romeny, Kluwer Academic Publishers, 1994, pp. 39–46.

MIPAV User Manual, Volume 2, Algorithms, “Edge Detection: Zero X Laplacian” on 
page 154.

Tony Lindeberg [1996]. “Edge detection and ridge detection with automatic scale selection” 
Technical report ISRN KTH/NA/P-96/06-SE, May 1996, Revised August 1998. Int. J. of 
Computer Vision, vol 30, number 2, 1998. (In press). Shortened version in Proc. CVPR'96, 
San Francisco, June 1996. http://www.nada.kth.se/~tony

Figure 1.  The original image and its unsigned byte mask with detected 
edges.
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Applying the Zero X Non-Maximum Suppression 
algorithm

To run this algorithm, complete the following steps:

1 Open an image of interest;

2 Select Algorithms > Edge detection > Zero x non-maximum 
suppression. The EdgeNMSuppression dialog box opens. For the dialog 
box options, refer to Figure 2.

3 Complete the fields in the dialog box. Click OK. 

The algorithm begins to run, and a status window appears. When the 
algorithm finishes, the resulting image appears as an unsigned byte 
mask in a new image window as shown in Figure 3. 

Scale of the 
Gaussian

Specifies the standard deviation (from 1.0 
to 10.0) of the Gaussian filter in X, Y, and 
Z directions which were used to 
determine edges in the image. 

Note that larger standard deviation 
produces an image with smaller number 
of edges. Smoothing the image before 
applying the algorithm also reduce the 
number of detected edges. Refer to 
Figure 3 for more information.

Use image 
resolutions to 
normalize Z 
scale

If checked, the following equation – Z 
scale*(X resolution/Z resolution) will be 
used to generate the edge map.

If unchecked, only Z scale will be used in 
generation of the edge map.

Process each 
slice indepen-
dently (2.5D)

Applies the algorithm to each image slice individually. 

Destination New image – this is the default option; Replace image – this option cannot 
be selected.

Process Whole Image – if checked the edge detection will be calculated for the whole 
image; VOI region – if checked the edge detection will be calculated for the 
selected VOI.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Closes the dialog box.

Figure 2.  The EdgeNMSuppression dialog box options
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Help Displays online help for this dialog box.

Figure 2.  The EdgeNMSuppression dialog box options

a b

c d

Figure 3.  The original image (a) and its unsigned byte mask with 
detected edges depending on the standard deviation: (b) – standard 
deviation is set to 1; (c) – standard deviation is set to 4; (d) – standard 
deviation is set to 6; (e) – standard deviation is set to 8; (f) – standard 
deviation is set to 6, but the original image has been smoothed before 
applying the algorithm.
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e f

Figure 3.  The original image (a) and its unsigned byte mask with 
detected edges depending on the standard deviation: (b) – standard 
deviation is set to 1; (c) – standard deviation is set to 4; (d) – standard 
deviation is set to 6; (e) – standard deviation is set to 8; (f) – standard 
deviation is set to 6, but the original image has been smoothed before 
applying the algorithm.
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Extract Brain: Extract Brain Surface (BET)

This algorithm extracts the surface of the brain from a T1-weighted MRI, 
eliminating the areas outside of the brain. This algorithm is similar to the 
brain extraction tool developed at the Oxford Center for Functional 
Magnetic Resonance Imaging of the Brain. 

Background
The procedure used by this algorithm to extract the brain surface consists of 
four major steps:

• Step 1, Estimating image parameters

• Step 2, Selecting an initial closed mesh within the brain

• Step 3, Evolving a mesh in a surface tangent direction, in a surface 
normal direction, and in a vertex normal direction

• Step 4, Identifying the voxels inside and on the brain surface

STEP 1, ESTIMATING IMAGE PARAMETERS

A number of important parameters must be calculated from histograms 
composed of 1024 bins. These parameters are used to estimate the initial 
axes of the ellipsoid. As well as affect the evolution of an initial ellipsoid to 
the surface of the brain. Using an ellipsoid to initial surface as opposed to a 
sphere significantly improves the segmentation especially around the eyes 
and sinus cavities.

There are three such intensity values: 

• Minimum threshold: tmin = 0.5 background threshold

• Background threshold: tback = histogram index with the greatest count

• Median threshold: tmed = median pixel value with the initial ellipsoid 
that are greater than tback
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STEP 2, SELECTING AN INITIAL CLOSED MESH

MIPAV uses a different approach to constructing an initial mesh (i.e., 
ellipsoid), which is used as the initial surface for approximating the brain 
surface. The final approximation to the brain surface lies near the CSF and 
scalp. The shape of the mesh at the top of the head is nearly the shape of the 
scalp.

As a way of identifying the scalp voxels that lie at the top of the head, this 
algorithm locates all the bright voxels using the threshold tbright. Voxels in 
the lower half of the head also show up due to fatty tissue, much of it at the 
base of the neck. Empirically, the number of bright voxels near the scalp at 
the top of the head appear to be noticeably smaller than those voxels in the 
bottom half of the head. This algorithm stores only those voxels that are 
near the scalp at the top of the head. The voxel locations are fit with an 
ellipsoid by means of a least squares algorithm for estimating the 
coefficients of the quadratic equation that represent the ellipsoid.

The ellipsoid obtained is reduced in scale by approximately half. The initial 
ellipsoids in all the test images evolved to reasonable brain surface 
approximations in a reasonable amount of time. Figure 1 shows the 
ellipsoid of intersection of the ellipsoid with the middle slice of the images.

Note: If it is unable to calculate the parameters to form an ellipsoid, MIPAV 
estimates a sphere instead to initialize the surface extraction process.
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The ellipsoid is topologically equivalent to a sphere centered at the origin 
and with unit radius. Therefore, the initial mesh that approximates an 
ellipsoid is constructed by tessellating this sphere and then by applying an 
affine transformation to map the sphere-mesh vertices to ellipsoid-mesh 
vertices. The tessellation is performed by starting with an octahedron 
inscribed in the sphere. The octahedron vertices are (±1, 0, 0), (0,±1, 0), 
and (0, 0,±1). There are initially 6 vertices, 12 edges, and 8 triangles. Each 
level of subdivision requires computing the midpoints of the edges and 
replacing each triangle by four subtriangles as shown in Figure 2.

Figure 1.  The initial ellipsoids intersected with the middle slices.
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To avoid a lot of dynamic allocation of memory, it is possible to compute the 
total number of vertices, edges, and triangles that are required for the mesh 
given the number of subdivisions. Let V0, E0, and T0 be the current 
quantities of vertices, edges, and triangles. Each subdivide edge leads to a 
new vertex, so the new number of vertices is V1 = V0 + E0. Each triangle is 
replaced by four triangles, so the new number of triangles is T1 = 4T0. Each 
edge is split into two edges and each subdivided triangle creates three 
additional edges, so the new number of edges is 
E1 = 2E0 +3T0. These recurrence formulas are iterated over the desired 
number of subdivisions to compute the total objects required.

All edges are subdivided first. When each edge is subdivided, the index of 
the newly generated vertex must be stored for later use by triangle sharing 
the edge that is being subdivided. A hash map is used to store an edge as a 
pair of vertex indices as the key of the map. The value of the map is the 
index of the vertex that is generated as the midpoint. The triangles are then 
subdivided. The edges of the triangle are looked up in the hash map to find 
the indices of the three new vertices to be used by the subtriangles.

The subtriangles are stored as triples of vertex indices. After the triangles 
are subdivided, the original edges must all be discarded and replaced by the 
subdivided edges in the new mesh. These steps are repeated for all 
subdivision steps. Once the subdivided mesh is generated, we also need to 
know the vertices adjacent to a given vertex. This information is required to 
compute the average of the neighboring vertices. The mean length of all the 

Figure 2.  Subdivision of a triangle.
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edges of the mesh can be computed using the edge hash map as storage for 
the edges, so after triangle division the edge hash map must exist 
throughout the mesh updates. Figure 3 shows a rendering of an initial 
ellipsoid, both solid and wireframe.

The median intensity threshold, tmed, is obtained by iterating over all the 
voxels with the image with intensity larger than tback and which are located 
inside the initial ellipsoid. The corresponding set of intensities is sorted and 
the middle value selected for the median intensity threshold.

STEP 3, EVOLUTION OF THE MESH

The first step is to compute the average edge length L of the edges in the 
mesh. This is easily done by iterating over the hash map of edges, looking up 
the vertices from the indices stored in each edge, calculating the edge 
length, accumulating the lengths, then dividing by the total number of 
edges.

Second, the vertex normals are needed for evolving the mesh in a direction 
normal to the surface. This is also easily done by iterating over the triangles. 
A running sum of non-unit triangle normals is maintained for each vertex. 
Once the sums are calculated, the vertex normals are normalized by an 
iteration over the array storing them.

Third, the surface tangents, normals, and curvatures must be computed. If 

Figure 3.  An initial ellipsoid: (A) solid and (B) wireframe.
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 is a vertex, then  is the average of all the neighbors of . The 

neighbors are rapidly accessed by using the adjacency structure that keeps 
track of the array of indices of neighbors for each vertex, so the mean vertex 
is easily computed. The difference between vertex and mean is 

. This vector is decomposed into a surface normal and surface 

tangential component. The normal component is in the direction of the 

vertex normal ,

The tangential component is

The estimate of surface curvature is chosen to be:

where L is the mean edge length of the mesh. The minimum and maximum 
curvatures are maintained as the various surface quantities are computed 

for all the vertices. These values are denoted min and max and are used to 

compute two parameters that are used in the update of the mesh in the 
surface normal direction,

Once all these values are computed, each vertex of the mesh is updated by

It is important to note that the BET: Brain Extraction Tool paper (refer to 

“Reference” on page 176) uses the notation  to denote the surface normal, 

usually a non-unit vector, and  to denote the normalized vector for . 

However, Equation (13) in the BET paper incorrectly lists the last term in 
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the update equation to use  when in fact it should be . Both vectors 

are parallel, but not necessarily pointing in the same direction. The 
discussion about Equation (8) in the BET paper makes it appear that the 
vector should be the vertex normal, not the surface normal. In any case, 

MIPAV uses .

The  allows the mesh to move a little bit in the tangential direction to 

“align” the vertices with the desired goal of being located at the mean 
vertices. This allows the mesh to shift about somewhat.

The  is a smoothing term. The coefficient  represents a stiffness of 

the mesh against motion in the surface normal direction. The formula for 

 in the BET paper is 

where  is the estimate of surface curvature at the vertex. This formula 

made the surface too stiff and unable to expand to a good approximation of 
the brain surface. So the formula was modified to add a stiffness parameter, 

, with a default value of 0.1 and use.

Moreover,  is allowed to increase over time, then decrease later, to 

properly evolve the surface. 

The  term controls the surface evolution based on the MRI data. The 

algorithm is almost exactly the formula described in the BET paper. A ray 
pointing inside the surface is sampled to a certain maximum depth and the 
sampled intensities are used to construct a minimum Imin and a maximum 
Imax. The coefficient for the update is then 

ŝn VN

VN

0.5ST

c1SN c1

c1

c1
1
2
--- 1 F(( ) κ E–( ) )tanh+( )=

κ

σ

c1
σ
2
--- 1 F κ E–( )( )tanh+( )=

σ

c2VN

c2 0.1L b– t
Imin tmin–

Imax tmin–
------------------------------+

⎝ ⎠
⎜ ⎟
⎛ ⎞

=

MIPAV User’s Guide, Volume 2, Algorithms 173

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Extract Brain: Extract Brain Surface (BET)
where

L is the mean edge length

bt is what the BET paper calls the brain selection term (value chosen to 
be 1/2)

tmin is the minimum intensity threshold calculated during histogram 
analysis

Figure 4 shows a rendering of a brain surface extracted using the methods 
discussed in this section.

STEP 4, SELECTING BRAIN VOXELS

This algorithm selects in two phases those voxels that are inside or on the 
triangle mesh that represents the surface of the brain. The first phase makes 
a pass over the triangles in the mesh. Each triangle is rasterized in the 3D 
voxel grid. The rasterization is done three times in the coordinate 
directions. The idea for a given direction is to cast rays in that direction and 
find voxels that are approximately on or near the triangle. The final result of 
all the rasterization is a surface that is a few voxels thick. More important is 
that it is a closed surface.

Figure 4.  Two views of a brain surface mesh.
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The end result is a ternary 3D image whose voxels are 0 for background, 1 
for surface, and 2 for interior. The distinction between the surface and 
interior voxels allows an application to color the surface voxels in image 
slices to see how accurate the segmentation is. Figure 5 shows a few slices of 
the original MRI with the brain voxels colored.

IMAGE TYPES

You can apply this algorithm only to 3D MRI images.

Figure 5.  MRI slices with colored brain voxels.
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SPECIAL NOTES

You can save the triangle mesh in the sur format that the level surface 
viewer supports. This allows you to render the extracted surface. The code 
also gives you access to the ternary mask image to do with as you please.

REFERENCE

Refer to the following reference for more information about this algorithm:

Smith, Stephen. BET: Brain Extraction Tool. FMRIB Technical Report TR00SMS2, Oxford 
Center for Functional Magnetic Resonance Imaging of the Brain, Department of Clinical 
Neurology, Oxford University, Oxford, England.

Applying the Extract Brain Surface algorithm
To use this algorithm, do the following:

1 Select Algorithms > Extract Brain. The Extract Brain dialog box opens 
(Figure 6).

2 Complete the information in the dialog box.

3 Click OK. The algorithm begins to run, and a progress bar appears with 
the status. When the algorithm finishes running, the progress bar 
disappears, and the results replace the original image.
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Axial image 
orientation

Specifies that the image is in the axial orientation.

Unless you first change the default values of the Initial mesh position 
boxes, marking or clearing this check box changes their values.

Estimate initial 
boundary using a 
sphere

Uses a sphere shape instead of an ellipse for estimating the initial 
boundary.

Unless you first change the default values of the Initial mesh position 
boxes, marking or clearing this check box changes their values.

Display initial 
ellipsoid result

Displays the ellipsoid sphere to be used in extracting the brain. This option 
allows you to verify that the initial ellipsoid sphere correctly covers the area 
in the image where the brain is located.

Second stage edge 
erosion

Performs erosion process at the edge of the brain to remove nonbrain 
voxels. When you select this check box, the Erode at percent above median 
text box is enabled.

Iterations Specifies the number of times to run the algorithm when evolving the 
ellipsoid into the brain surface. The default is 1000.

Depth Specifies the maximum depth inside the surface of the brain to use in 
sampling intensities. The default value is 5.

Image influence Controls the surface evolution by sampling to the specified depth to 
calculate the maximum and minimum intensities. The default value is 0.10.

Figure 6.  Extract Brain dialog box
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Stiffness Controls the stiffness of the mesh against motion in the surface normal 
direction. The default value is 0.15.

Erode at percent 
above median

Removes voxels (nonbrain material) that are at the edge of the 
segmentation and that have an intensity above the percent of the median 
voxel intensity of the brain. Type the appropriate percentage in this text 
box.

This text box is enabled when you select Second stage edge erosion.

Use the volume 
center of mass

Contructs the mesh using the volume center of mass. When you select this 
check box, you cannot specify the Initial X, Y, or Z mesh positions.

Initial mesh X 
position

Constructs the mesh using the X position that you specify. To specify a 
value for this text box, clear Use the volume center of mass.

Unless you first change the default value of this box, marking or clearing 
either the Axial image orientation or Estimate initial boundary using a 
sphere check boxes changes the default value. 

Initial mesh Y 
position

Constructs the mesh using the Y position that you specify. To specify a 
value for this text box, clear Use the volume center of mass.

Unless you first change the default value of this box, marking or clearing 
either the Axial image orientation or Estimate initial boundary using a 
sphere check boxes changes the default value.

Initial mesh Z 
position

Constructs the mesh using the Z position that you specify. To specify a 
value for this text box, clear Use the volume center of mass.

Unless you first change the default value of this box, marking or clearing 
either the Axial image orientation or Estimate initial boundary using a 
sphere check boxes changes the default value.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.

Figure 6.  Extract Brain dialog box (continued)
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Extract Brain: Extract Brain Surface (BSE)

This algorithm strips areas outside the brain from a T1-weighted magnetic 
resonance image (MRI). It is based on the Brain Surface Extraction (BSE) 
algorithms developed at the Signal and Image Processing Institute at the 
University of Southern California by David W. Shattuck. This is MIPAV’s 
interpretation of the BSE process and may produce slightly different results 
compared to other BSE implementations.

Background
This algorithm works to isolate the brain from the rest of a T1-weighted 
MRI using a series of image manipulations. Essentially, it relies on the fact 
that the brain is the largest area surrounded by a strong edge within an MRI 
of a patient’s head. There are essentially four phases to the BSE algorithm:

• Step 1, Filtering the image to remove irregularities, refer to page 179;

• Step 2, Detecting edges in the image, refer to page 179;

• Step 3, Performing morphological erosions and brain isolation, see 
page 180;

• Step 4, Performing surface cleanup and image masking, refer to 
page 180.

STEP 1, FILTERING THE IMAGE TO REMOVE 
IRREGULARITIES

The first step that MIPAV performs is to filter the original image to remove 
irregularities, thus making the next step—edge detection—easier. The filter 
chosen for this was the Filters (Spatial): Regularized Isotropic (Nonlinear) 
Diffusion. Figure 1-A shows the original image, and Figure 1-B shows the 
image after it is filtered.

STEP 2, DETECTING EDGES IN THE IMAGE

Next, MIPAV performs a thresholded zero-crossing detection of the filtered 
image's laplacian. This process marks positive areas of the laplacian image 
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as objects by setting them to 1 and identifies nonobject areas by setting their 
values to 0 (Figure 1-C).

STEP 3, PERFORMING MORPHOLOGICAL 
EROSIONS AND BRAIN ISOLATION

During this step, the software performs a number of 3D (or, optionally, 
2.5D) morphological erosions on the edge image mask to remove small 
areas identified as objects that are not a part of the brain. It then performs a 
search for the largest 3D region within the image, which should be the brain 
(Figure 1-D). It erases everything outside this region and then performs 
another morphological operation, dilating the brain image back to 
approximately its original size and shape before the erosion (Figure 1E).

STEP 4, PERFORMING SURFACE CLEANUP AND 
IMAGE MASKING

Once MIPAV isolates the brain, it needs to clean up the segmentation a bit 
by performing more morphological operations. It first performs a 2.5D 
closing with a circular kernel in an attempt to fill in interior gaps and holes 
that may be present. Since it is better to have too much of the original 
volume in the extracted brain than to miss some of the brain, MIPAV 
performs an extra dilation during the closing operation, making the mask 
image slightly larger. If a smaller mask is desired, the closing kernel size can 
be reduced (keep in mind that this size is in millimeters and is the diameter 
of the kernel, not its radius).

As an option, MIPAV can then fill in any holes that still exist within the 
brain mask. Finally, it uses the mask to extract the brain image data from 
the original volume (Figure 1F). 

SELECTING PARAMETERS

Careful parameter selection must be done for the BSE algorithm to produce 
good results. For example, excessive erosion or dilation, closing kernel size, 
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or edge detection kernel size can remove detail from the brain surface or 
remove it completely.

Edge detection kernel size parameter 

The edge detection kernel size parameter is especially sensitive. Small 
changes to it (e.g., from the default of 0.6 up to 0.7 or down to 0.5 in the 
following example) can result in large changes to the extracted brain 
volume. Refer to Figure 1.

Recommendation: To find an optimal set of parameters values, run this 

algorithm repeatedly on a representative volume of the MRI images that you 

want to process with different parameter values and with Show intermediate 

images selected.

Figure 1 shows images that were produced from running this algorithm with 
the default parameters against a 256 x 256 x 47 MRI. In each image, the 
middle slice is shown. 

IMAGE TYPES

You can apply this algorithm only to 3D MRI images. The resulting image is 
of the same data type as the original image.

REFERENCES

Refer to the following references for more information about the Brain 
Surface Extraction algorithm and general background information on brain 
extraction algorithms.

A. I. Scher, E. S. C. Korf, S. W. Hartley, L. J. Launer. “An Epidemiologic Approach to 
Automatic Post-Processing of Brain MRI.”

David W. Shattuck, Stephanie R. Sandor-Leahy, Kirt A. Schaper, David A. Rottenburg, 
Richard M. Leahy. “Magnetic Resonance Image Tissue Classification Using a Partial Volume 
Model.” NeuroImage 2001; 13(5):856-876.
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Applying the Extract Brain Surface (BSE) algorithm
To use this algorithm, do the following:

1 Select Algorithms > Extract Brain Surface (BSE). The Extract Brain 
Surface (BSE) dialog box opens (Figure 2 on page 183).

2 Complete the information in the dialog box.

Figure 1.   Examples of Extract Brain Surface (BSE) image processing
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3 Click OK. The algorithm begins to run, and a progress bar appears with 
the status. When the algorithm finishes running, the progress bar 
disappears, and the results replace the original image.

Filtering

Iterations (1-5) Specifies the number of 
regularized isotropic 
(nonlinear) diffusion filter 
passes to apply to the image. 
This parameter is used to find 
anatomical boundaries 
seperating the brain from the 
skull and tissues. For images 
with a lot of noise, increasing 
this parameter will smoth 
noisy regions while 
maintaining image 
boundaries.

Gaussian standard 
deviation (0.1-5.0)

Specifies the standard 
deviation of the Gaussian filter 
used to regularize the image. 
A higher standard deviation 
gives preferebce to high-
contrast edges for each voxel 
in the region.

Edge Detection

Kernel size (0.1-
5.0)

Specifies the size of the symmetric Gaussian kernel to use in the Laplacian 
Edge Detection algorithm. An increase in kernel size will yield an image 
which contains only the strongest edges. Equivalent to using a narrow filter 
on the image, a small kernal size will result in more edges.

Perform fast 
convolutions 
(requires more 
memory)

Specifies whether to perform Marr-Hildreth edge detection with separable 
image convolutions. 

The separable image convolution completes about twice as fast, but it 
requires approximately three times more memory. If memory is not a 
constraint, select this check box.

Figure 2.  Extract Brain Surface (BSE) algorithm dialog box
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Erosion/Dilation

Iterations (1-10) Specifies the number of:

• Erosions that should be applied to the edge image before the brain is 
isolated from the rest of the volume;

• Dilations to perform afterward.

A higher number of iterations will help distinguish brain tissue from blood 
vessels and the inner cortical surface. Noise resulting from blood vessels or 
low image contrast may be present when few iterations are used.

Process slices 
independently

Applies the algorithm to each slice of the dataset independently. Separable 
image operations will again produce results more quickly while using 
increased memory. Since this part of the brain surface extraction is meant to 
fill large pits and close holes in the surface, indepent processing may not 
yield optimal results.

Closing

Kernel diameter 
(in mm) (0.1-
50.0)

Specifies the size of the kernel to use (in millimeters). The value defaults to a 
number of millimeters that ensures that the kernel is 6 pixels in diameter and 
takes into account the volume resolutions. Closing operations act to fill 
smaller pits and close holes in the segmented brain tissue.

Fill all interior 
holes

Fills in any holes that still exist within the brain mask. When optimal 
parameters for a given image have been used, this option will generally 
produce a volume of interest that lies between the inner cortical surface and 
the outer cortical boundary.

Options

Show intermediate 
images

Shows, when selected, in addition to the final brain image, the images that 
are generated at various points while the BSE algorithm is running. Selecting 
this check box may help you in finding the optimal parameters for running 
the BSE algorithm on a volume. 

For an image named ImageName, the debugging images displayed would 
include:

• The filtered image (named ImageName_filter)

• The edge image (named ImageName_edge)

• The eroded edge image (named ImageName_erode_brain)

• The isolated brain mask after erosion and dilation (named 
ImageName_erode_brain_dilate)

• The brain mask after closing (named ImageName_close)

• The closing image is shown before any interior mask holes are filled

Extract brain to 
paint

Paints the extracted brain onto the current image. See also Figure 3.

Figure 2.  Extract Brain Surface (BSE) algorithm dialog box (continued)
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OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.

Figure 2.  Extract Brain Surface (BSE) algorithm dialog box (continued)

Figure 3.  The Extract Brain to Paint option: on your left is the original 
image and on your right is the result image with the brain extracted to 
paint.
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Face Anonymizer (BET)

This Face Anonymizer (BET) algorithm extracts an approximated face from 
a T1-weighted MRI, eliminating facial areas outside of a certain buffer from 
the brain. The algorithm employs several other algorithms developed by the 
MIPAV project, refer to page 188 for applicable references. 

Background
The procedure used by this algorithm to return an image with an extracted 
face consists of five major steps:

1 Extract the brain, refer to page 186;

2 Buffer the brain, refer to page 187;

3  Define the face, refer to page 187;

4 Extract the face, refer to page 187;

5 Smooth the face, refer to page 187.

STEP 1, EXTRACT THE BRAIN

The brain extraction portion of the algorithm employs the Extract Brain 
Surface (BET) tool. This tool extracts the surface of the brain from a T1-
weighted MRI by expanding an initial ellipsoid. The brain extraction tool is 
derived from a similar tool developed at the Oxford Center for Functional 
Magnetic Resonance Imaging of the Brain.

Parameters that directly relate to the mechanics of the brain extraction tool 
can be changed using the dialog box for the face anonymizer. For more 
information, refer to the dialog help section on page 188.

For more information concerning the mechanics of this portion of the 
algorithm, see references on page 188.
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STEP 2: BUFFER THE BRAIN

The brain extracted from the brain extraction tool is buffered by a certain 
number of millimeters that can be set using this algorithm's dialog menu. 
This portion of the algorithm employs the morphological dilate algorithm to 
extend the brain mask derived from brain extraction tool in three 
dimensions. Refer to “Extract Brain: Extract Brain Surface (BSE)” for more 
information.

STEP 3: DEFINE THE FACE

The face is searched for in an area defined by the MRI given orientation. 
This orientation is derived from the file information of the MRI and can be 
changed using this algorithm's dialog options. Within this region an initial 
shape is chosen that will expand in an effort to extract the face.

STEP 4: EXTRACT THE FACE

Face extraction is achieved by appending spheres of random radius onto the 
initial shape. This size of the spheres decays exponentially as the area of the 
two octants is filled. Eventually the process converges to a shape that is 
defined as an approximate face and does not lie within the buffered brain 
area. For more information on the method of sphere approximation, see 
references on page 188.

STEP 5: SMOOTH THE FACE

The extracted face is smoothed to approximate a quarter-cylinder within the 
two given octants. The final extracted face is guaranteed to not lie within the 
extracted brain.
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IMAGE TYPES

You can apply this algorithm only to 3D T1-weighted MRI images. The 
image file must represent the whole brain (from the left to the right side and 
from the top to the bottom of the brain). The algorithm would not work if 
the image file contains only a few slices.

NOTES

The resulting image is of the same data type as the original image.

REFERENCE: 

Within the MIPAV project:

    The brain extraction tool, which extracts the surface of the brain from a T1-weighted MRI 
and the dilate algorithm, which buffers the extracted brain by a set number of millimeters, 
are described here: ‘‘Extract Brain: Extract Brain Surface (BSE)’’.

 Outside of MIPAV:

    Smith, Stephen. BET: Brain Extraction Tool. FMRIB Technical Report TR00SMS2, Oxford 
Center for Functional Magnetic Resonance Imaging of the Brain, Department of Clinical 
Neurology, Oxford University, Oxford, England. Smith's paper is also available here: http://
portal.acm.org/citation.cfm?id=246

McIlroy, M. D. Best approximate circles on integer grids. ACM Transactions on Graphics 
(TOG), Volume 2 Issue 4. An approximation for spheres also available at http://
portal.acm.org/citation.cfm?id=246. 

Applying the Face Anonymizer Algorithm
To use this algorithm, do the following:

1  Select Algorithms > Brain Tools > Face de-Identification. The Face 
Anonymizer dialog box appears.

2  Complete the information in the dialog box. Check that the MRI 
orientation information is correct.

3  Click OK. 
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4 The algorithm begins to run, and a progress bar appears with the status. 
When the algorithm finishes running, the progress bar disappears, and 
the original image without the extracted face appears.

Recommendation: To find an optimal set of parameter values, run this 

algorithm repeatedly on a representative volume of the 3D T1-weighted MRI 

images using different parameter values. Keep the records of parameter 

values you use.

Figure 1.  An example of the Face Anonymizer (BET) image processing. 
The image has been processed using default parameters.
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Figure 2.  Face Anonymizer dialog box options

Which way is the 
patient’s face 
pointing?

Specifies the orientation of 
the image. MIPAV extrapo-
lates this value from the 
image file information. Con-
firm that the orientation 
given is correct:

Right – sagittal image with 
x-axis oriented posterior to 
anterior;

Left – sagittal image with X-
axis oriented anterior to 
posterior;

Down – axial image with Y-
axis oriented posterior to 
anterior;

Up – axial image with y-axis 
oriented anterior to 
posterior;

Into the screen – coronal image with Z-axis oriented posterior to anterior;

Out of the screen – coronal image with Z-axis oriented anterior to posterior.

Face Removal Options

Brain buffer Guarantees that the extracted brain will be avoided by the specified number of 
millimeters. Refer to ‘‘Step 2: Buffer the brain’’ for more information.

Brain Extraction Options

Initial shape Uses a sphere shape instead of an ellipse for estimating the initial boundary.

Specifies whether a sphere should be used for initial brain extraction. For more 
information, see the sphere approximation option for the brain extraction tool.

Image influence 
ratio

Specifies the depth to calculate in approximating brain maximum and minimum 
intensities. For more information, refer to “Extract Brain: Extract Brain Surface (BSE
to learn more about the image influence option for the brain extraction tool. Defaul
value is 0.1. Allowed values range from 0.01 to 0.5.

Mesh stiffness Controls the stiffness of the brain approximation mesh. For more information about
the stiffness option, refer to Chapter “Extract Brain: Extract Brain Surface (BSE)” o
the MIPAV manual.

Default value is 0.15. Allowed values range from 0.01 to 0.5.

OK Confirms the dialog settings and runs the algorithm.

Cancel Disregards any changes that you made in this dialog box and closes this dialog box

Help Displays online help for this dialog box.
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Fast Fourier Transformation (FFT)

There are two main approaches to filtering an image. The first is the 
convolution of an image and kernel in the spatial domain. The second is the 
multiplication of an image's fourier transform with a filter in the frequency 
domain. The fast fourier transformation (FFT) algorithm, which is an 
example of the second approach, is used to obtain a frequency-filtered 
version of an image. Processing images by filtering in the frequency domain 
is a three-step process:

1 Perform a forward fast fourier transform to convert a spatial image to its 
complex fourier transform image. The complex image shows the 
magnitude frequency components. It does not display phase 
information.

2 Enhance selected frequency components of the image and attenuate 
other frequency components of the image by multiplying by a low-pass, 
high-pass, band-pass, or band-stop filter. 

In MIPAV, you can construct frequency filters using one of three 
methods: finite impulse response filters constructed with Hamming 
windows, Gaussian filters, and Butterworth filters. However, for the 
Gaussian filters, only low-pass and high-pass filters are available.

3 Perform an inverse fast fourier transform to reconvert the image from 
the frequency domain to the spatial domain.

You can also use Algorithms > Filters (frequency) to obtain a frequency-
filtered version of an image in a single step. A contrast of the FFT and Filter 
(frequency) commands on the Algorithms menu is helpful in determining 
which one to select.

Use . . . To . . .

Algorithms > Filters 
(frequency)

Obtain a frequency-filtered version of an image 
in a single step. All three steps in the process 
are performed internally and only the resultant 
filtered image is displayed.

Algorithms > FFT Produce pictures of the fourier transform of the 
image and the filtered fourier transform of the 
image.
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Background
Since all dimensions of an n-dimensional dataset must be powers of 2, 
datasets with arbitrary dimensions are zero padded to powers of 2 before 
applying the Fast Fourier Transform and stripped down to the original 
dimensions after applying the Inverse Fast Fourier Transform.

If real source data is used, then the output obtained after the final Inverse 
Fast Fourier Transform step is purely real, no matter what filter 
construction method is used. Any non-zero imaginary part present after the 
Inverse Fast Fourier Transform is due to Randolph error. Hence, the 
imaginary part is discarded and only the real part is imported into the final 
image. Figure 1 shows the application of the FFT algorithm to a 2D image.

In MIPAV, frequency filters may be constructed using one of three methods: 
finite impulse response filters constructed with Hamming windows, 
Gaussian filters, and Butterworth filters. You select the method when you 
enter the parameters for the algorithm.

Figure 1.  FFT algorithm processing 
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FINITE IMPULSE RESPONSE (FIR) FILTERS 
WITH HAMMING WINDOWS

If you use FIR filters with Hamming windows, an ideal filter kernel is 
constructed in the spatial domain. A Hamming window kernel is also 
constructed in the spatial domain. Then, the ideal filter kernel and the 
Hamming window kernel are multiplied together in the spatial domain. The 
resultant kernel is a circle or odd diameter sphere with its center at (kernel 
diameter - 1)/2 in every dimension. The kernel is zero padded up to the 
same dimensions as the original image data. 

The two fourier transforms (image and filter) are multiplied, and the 
inverse fourier transform is obtained. The result is a filtered version of the 
original image shifted by (kernel diameter - 1)/2 toward the end of each 
dimension. The data is shifted back by (kernel diameter - 1)/2 to the start of 
each dimension before the image is stripped to the original dimensions.

In every dimension the length of the resulting fourier image must be greater 
than or equal to the length of non-zero image data + kernel diameter - 1 so 
that aliasing does not occur. In aliasing, higher frequency components 
incorrectly shift to lower frequencies. Thus, if the image is not cropped, each 
frequency space dimension must be greater than or equal to the minimum 
power of two that equals or exceeds the original dimension size + kernel 
diameter 1. If cropping is selected, the fourier image is only increased to the 
minimum power of 2 that equals or exceeds the original dimension size 
rather than the minimum power 2 that equals or exceeds the original 
dimension size + kernel diameter - 1. With cropping, a band of pixels at the 
boundaries of the image is set equal to 0. A power of 2 increase in 
dimension length is avoided at the cost of losing edge pixels.

The following formula defines the discrete-space fourier transform pair:

X ω1 ω2( , ) x n1 n2( , )e
jω1– n1e

j– ω2n2

n2 ∞–=

∞

∑
n1 ∞–=

∞

∑=

x n1 n2( , ) 1

2π( )
2

-------------- X
ω2 π–=
π

∫ ω1 ω2( , )e
j– ω1n2e

j– ω2n2
ω1d ω2d

ω1 π–=
π

∫=
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While centering is invoked in FFT to provide a clearer display, centering is 
not used in frequency filter where no fourier images are produced.

GAUSSIAN AND BUTTERWORTH FILTERS

In the frequency filtering step, both the real and imaginary parts of the 
fourier transform are scaled by the same formula, which depends only on 
the distance from the center of image. 

The FIR filter must create two fourier transforms: one for the original image 
and one for the kernel. The Butterworth and Gaussian filters only need to 
create one fourier transform for the image since frequency scaling is done 
with a formula. Therefore, the FIR filter uses about twice as much memory 
as the Gaussian or Butterworth filters.

Centering is needed for the Gaussian and Butterworth filters since the 
scaling formulas are based on frequency magnitude increasing from the 
center of the image.

Butterworth 2D and 3D filters

The following are the formulas for the Butterworth 2D and 3D filters, 
respectively.

The real data is the product of the real data and the coefficient. The 
imaginary data is the product of the imaginary data and the coefficient.

Butterworth low-pass, high-pass, band-pass, 
and band-stop filters

The following are the equations for the Butterworth low-pass, high-pass, 
band-pass, and band-stop filters.

distsq x xcenter–( )
2 xcenter( )

2 y ycenter–( )
2 ycenter( )

2
⁄+⁄=

distsq x xcenter–( )
2 xcenter2

( ) y ycenter–( )
2 ycenter( )

2

z zcenter–( )
2 zcenter( )

2
⁄

+⁄+⁄=
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Butterworth low-pass filter

High-pass filter

Band-pass filter

Band-stop filter

Gaussian low- and high-pass filters

The following equations are for the Gaussian low- and high-pass filters.

coefficient 1.0

1.0 distsq
f1( )

---------------⎝ ⎠
⎛ ⎞

2 butterworthorder⋅
+

------------------------------------------------------------------------------------------=

coefficient 1.0

1.0 f1( )
distsq
---------------⎝ ⎠

⎛ ⎞+
2 butterworthorder⋅

------------------------------------------------------------------------------------------=

width f2 f1 centersq f1 f2⋅=,–=

num distsq centersq–( )
2.0butterworthorder=

coeff num

num distsq centersq–( )+ 2 butterworthorder⋅
( )
------------------------------------------------------------------------------------------------------------------------------=

width f2 f1 centersq f1 f2⋅=,–=

num distsq width⋅( )
2 butterworthorder⋅

=

coeff num

num distsq width⋅( )
2 butterworthorder⋅

+⎝ ⎠
⎛ ⎞
-------------------------------------------------------------------------------------------------------------------------=
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Gaussian low-pass (2D) filter

Gaussian low-pass (3D) filter

Note: The routine bessj1 for determining a bessel function of the first kind and 
first order is taken from “Numerical Recipes in C.”

IMAGE TYPES 

You cannot apply a forward FFT to complex data. However, you can apply 
the frequency filter or perform an inverse FFT on conjugate, symmetric, and 
complex data. You cannot apply this algorithm to Alpha Red Green Blue 
(ARGB) datasets, but you can apply it to other gray-scale 2D and 3D images.

SPECIAL NOTES

By default, the resultant image is a float-type image. Intermediate fourier 
transform images and filtered fourier transform images obtained in FFT are 
complex images.

coeffientforgaussianhighpass 1 gaussianlowpass–=

coefficient e
x xcenter–( )2 2f2xcenter2( )⁄–

e
y ycenter–( )– 2 2f12ycenter2( )⁄

e z zcenter–( )
2 2f12zcenter2( )⁄–

⋅ ⋅=
MIPAV User’s Guide, Volume 2, Algorithms 196

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Fast Fourier Transformation (FFT)
REFERENCES

Refer to the following references for more information about this algorithm:

Nasir. Ahmed, Discrete-Time Signals and Systems (Reston, Virginia: Reston Publication 
Company, 1983), pp. 243–258.

Raphael C. Gonzalez and Richard E. Woods. Digital Image Processing (Boston: Addison-
Wesley, 1992), pp. 201–213, 244.

Jae S. Lim and Joe S. Lim, Two-Dimensional Signal and Image Processing (Upper Saddle 
River, New Jersey: Prentice-Hall PTR, 1990), pp. 57–58, 195–213.

William H. Press, Brian P. Flannery, Saul A. Teukolsky, and William T. Vetterling, 
"Numerical Recipes in C," The Art of Scientific Computing, Second Edition (Cambridge, 
Massachusetts: Cambridge University Press, p. 1993), pp. 233,  521–525.

Applying the FFT algorithm
Generally, when an image is filtered in the frequency domain, you use the 
following three-step process:

1 Apply Forward FFT. In this first step, the spatial image is converted to a 
complex fourier transform image. 

2 Apply Frequency Filter: Next, you can enhance and attenuate selected 
frequency components by multiplying the fourier transform image by 
the low-pass, high-pass, band-pass, or band-stop filters.

3 Apply Inverse FFT: Finally, you can perform an inverse fast fourier 
transform to reconvert the image to the spatial domain.

You can use the FFT algorithm to perform one or all of these steps.
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STEP 1: CONVERTING DATASET FROM 
SPATIAL TO FOURIER DOMAIN USING 
THE FORWARD FFT COMMAND

To convert the dataset from the spatial to fourier domain, complete the 
following steps:

1 In the Default Image window, open a dataset that is displayed in the 
spatial domain. 

2 In the MIPAV window, select Algorithm > FFT. The FFT dialog box 
opens (Figure 2).

3 Select the destination. 

4 By default, the forward FFT is selected. (The frequency filter and inverse 
FFT methods cannot be applied to real spatial datasets.)

5 Select the filter construction method. If you select the Butterworth filter, 
enter the order.

• FIR: Click Windowed finite impulse response. Enter the kernel 
diameter, which must be an odd number that is greater than or 
equal to 3. To save memory at the expense of zeroing edge pixels, 
select or clear image cropping.

• Gaussian: Click Gaussian filter.

• Butterworth: Click Butterworth filter, and then enter the order of 
the Butterworth filter.

6 Having selected the filter construction method, you can choose to apply 
the following options: 

• If you select Display log magnitude, the log10 [1 + square root (real 
part**2 + imaginary part**2)] is shown. If the Display log 
magnitude is clear, square root (real part**2 + imaginary part**2) is 
shown. 

• If your image has unequal dimensions, you can select Allow unequal 
FFT dimensions to allow unequal FFT dimensions. If you want the 
FFT to equalize the dimensions to produce a symmetrical image, 
clear the check box.  

• If you selected the FIR filter, you can crop the image to save 
MIPAV User’s Guide, Volume 2, Algorithms 198

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Fast Fourier Transformation (FFT)
memory. Enter an odd number for the convolution kernel diameter. 
The number must be odd so there is symmetry around a center 
point.

7 Click OK to perform the forward FFT. MIPAV applies the FFT 
algorithm. When complete, the fourier transform of the image appears.

STEP 2: ENHANCING AND ATTENUATING 
FREQUENCY COMPONENTS USING FREQUENCY 
FILTER 

To apply the frequency option to enhance and attenuate frequency 
components, complete the following steps:

1 Select the fourier transform of a spatial image. The image appears in a 
default image window. 

2 In the MIPAV window, select Algorithms > FFT. The FFT dialog box 
(Figure 2) opens. 

3 Select the destination.

4 Select Frequency Filter.  

5 Click, if desired, the check box to display the log magnitude. 

6 Select one of the following filter specifications:

• Lowpass: Type the value of the frequency. The value must be 
greater than 0.0, but less than or equal to 1.0. where 0.0 is the zero 
frequency and 1.0 is the absolute value of the frequency at the end of 
a centered fourier dimension.

• Highpass: Enter the value of the frequency. The value must be 
greater than 0.0, but less than or equal to 1.0. 0.0 is the zero 
frequency, 1.0 is the absolute value of the frequency at the end of a 
centered fourier dimension.

• Bandpass: Type the values of the frequencies F1 and F2, with F2 
greater than F1. The value must be greater than 0.0, but less than or 
equal to 1.0 where 0.0 is the zero frequency and 1.0 is the absolute 
value of the frequency at the end of a centered fourier dimension.

• Bandstop: Enter the values of the frequencies F1 and F2, with F2 
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greater than F1. The value must be greater than 0.0, but less than or 
equal to 1.0 where 0.0 is the zero frequency and 1.0 is the absolute 
value of the frequency at the end of a centered fourier dimension.

7 When complete, click OK. MIPAV applies the FFT algorithm. When 
complete, the fourier transform of the image appears.

Process each 
slice 
independently 
(2.5D)

Filters each slice of the 
dataset independently of 
adjacent slices.

Display log 
magnitude

Displays 1 plus the 
magnitude of the FFT.

Allow unequal 
FFT dimensions

Allows the image to have 
unequal dimensions. If this 
option is not selected, FFT 
makes the dimensions 
equal, which may result in 
more memory usage during 
processing.

Windowed 
finite impulse 
response

Constructs an ideal filter 
kernel and a Hamming 
window kernel in the spatial 
domain and multiplies them. 
The resultant kernel is a 
circle or sphere of odd 
diameter with its center at 
(kernel diameter -1)/2 in 
every dimension.

Crop image to 
save memory

Saves memory by assigning 
the edge pixels of the image 
a value of zero.

Convolution 
kernel 
diameter-odd

Limits the diameter of the 
convolution kernel to the 
size that you specify. 

Gaussian filter Applies the Gaussian filter to the image. The Gaussian filters only low-pass and 
high-pass filters are available.

Butterworth 
filter

Applies the Butterworth filter, which has a maximally flat response in its 
passband. The passband is the range of frequencies that pass with a minimum 
of attenuation through an electronic filter.

Figure 2.  FFT dialog box 
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OPTIONAL STEP: ATTENUATING FREQUENCY 
COMPONENTS USING THE PAINT TOOL 

With the Paint tool you can attenuate frequency components to values 
whose magnitude is 1,000 times the minimum floating point value. The 
values are not simply attenuated to zero because this would result in the 
phase information being lost and cause phase discontinuities in the image. 
Frequency components whose magnitudes are less than or equal to 1,000 
times the minimum floating point value are unaffected by the paint tool. To 
do this, complete the following steps:

1 Display the paint toolbar if it is not already visible. To do this, in the 
MIPAV window, select Toolsbar > Paint toolbar. The paint toolbar 
appears.

2 Select  Paint Brush to select the paint brush.

Order Displays the order of the Butterworth filter.

New image Places the result of the algorithm in a new image window.

Replace image Replaces the current active image with the results of the algorithm.

Forward FFT Converts spatial image to a complex fourier transform image.

Frequency filter Enhances or attenuates selected frequency components by multiplying the 
fourier transform image by the low-pass, high-pass, band-pass, or band-stop 
filters.

Lowpass Suppresses frequencies above a specified threshold. Frequencies below the 
threshold are transmitted.

Highpass Suppresses frequencies below a specified threshold. Frequencies above the 
threshold are transmitted.

Bandpass Suppresses all frequencies except those in a specified band.

Bandstop Suppresses a band of frequencies from being transmitted through the filter. 
Frequencies above and below the band are transmitted.

OK Applies the FFT algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box.

Help Displays online help for this dialog box.

Figure 2.  FFT dialog box  (continued)
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3 Select the size of the paint brush tip. Choose one of the following:

•  Small Tip—To select a tip that is one pixel in size. 

•  Medium Tip—To select a tip that is 16 pixels (4 x 4 square) in 
size.

•  Large Tip—To select a tip that is 100 pixels (10 x 10 square) in 
size.  As you draw, you can select one pixel at a time or drag to draw 
paint strokes on the image.

As you draw, you can select one pixel at a time or drag to draw paint 
strokes on the image.

Note: In painting complex images, the complex image is assumed to have been 
generated from real data. x(n1,n2) real <- > X(k1,k2) = X*(-k1,-k2) for 2D and 
x(n1,n2,n3) real <-> X(k1,k2,k3) = X*(-k1,-k2,-k3). Thus, real data yields a 
conjugate symmetric fourier transform. Therefore, when one pixel is painted in a 
complex image, its conjugate symmetric pixel is also painted. As you draw in 2D, 
the paint also appears on the opposite side of the image. As you draw in 3D, the 
paint also appears on the opposite side of the image on another slice. This 
mirroring technique ensures that, when the inverse fourier transform is applied 
to the frequency image, the spatial image that results is purely real.

4 When finished, to return to normal mode, click  Normal Mode.

5 You can erase the paint from the image's paint layer by completing the 
following steps. You can either erase all paint from the image or erase 
paint from a specific conjugate symmetric area. 

To erase all paint in the image, click  Global Erase.

To erase space from a specific area, complete the following steps:

• Click Erase.

• Select the size of the eraser tip. Click   Small Tip to select a tip 

that is 1  pixel in size. Click  Medium Tip to select a tip that is 16 

pixels (4 x 4 square) in size. Click  Large Tip to select a tip that is 
100 pixels (10 x 10 square) in size.

• Use the mouse to begin erasing. You can select one pixel at a time or 
drag the mouse. If desired, use the magnification buttons to magnify 
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the image.

• When finished, to return to normal mode, click  Normal Mode. 

6 Click Commit to commit the changes (copy them permanently to an 
image). 

STEP 3: RECONVERTING THE IMAGE TO THE 
SPATIAL DOMAIN

To reconvert the image to the spatial domain, complete the following steps:

1 Select the fourier transform of a spatial image. The image appears in a 
default image window. 

2 In the MIPAV window, select Algorithms > FFT. The FFT dialog box  
(Figure 2) opens. 

3 Select the destination.

4 Select Inverse FFT. 

5 If desired, click Display log magnitude. 

6 Click OK. When complete processing is complete, the image appears in 
the spatial domain.
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Filters (Frequency) 

Frequency filters process an image in the frequency domain. The image is 
first, Fourier transformed, then multiplied with the filter function, and then 
transformed back to the spatial domain. Attenuating high frequencies 
results in a smoother image in the spatial domain, attenuating low 
frequencies enhances the edges.

Background
Frequency filtering is based on the Fourier Transform. The operator usually 
takes an image and a filter function in the Fourier domain. This image is 
then multiplied with the filter function in a pixel-by-pixel fashion:

EQUATION 1

G(k,l)=F(k,l)*H(k,l)

Where F(k,l) is the input image in the Fourier domain, H(k,l) is the filter 
function and G(k,l) is the result filtered image.

The form of the filter function determines the effects of the operator. There 
are basically four different kinds of filters: lowpass, highpass, bandpass and 
bandstop filters. 

A low-pass filter attenuates high frequencies and retains low frequencies 
unchanged. The result in the spatial domain is equivalent to that of a 
smoothing filter; as the blocked high frequencies correspond to sharp 
intensity changes, i.e. to the fine-scale details and noise in the spatial 
domain image. 

A highpass filter yields edge enhancement or edge detection in the spatial 
domain, because edges contain mostly high frequencies. In other hand, 
areas of rather constant gray level consist of mainly low frequencies and are, 
therefore, suppressed. 

A bandpass filter attenuates very low and very high frequencies, but 
retains a middle range band of frequencies. Bandpass filtering is used to 
enhance edges (suppressing low frequencies) while reducing the noise at 
the same time (attenuating high frequencies).
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The most simple lowpass filter is the ideal lowpass. It suppresses all 
frequencies higher than the cut-off frequency F0 and leaves smaller 

frequencies unchanged, which can be described as:

EQUATION 2

H(k,l)=1 if (k2+l2)1/2 < F0

 and 

EQUATION 3

H(k,l)=0 if (k2+l2)1/2 > F0

Where, H(k,l) is the filter function.

In most implementations, F0 is given as a fraction of the highest frequency 

represented in the Fourier domain image.

The drawback of this filter function is a ringing effect that occurs along the 
edges of the filtered spatial domain image. See Figure 1. 

Better results can be achieved with a Gaussian shaped filter function. 

EQUATION 4

H(k.l)=exp(-F2(k,l)/2Fo2)

Figure 1.  The ideal lowpass filter in frequency and spatial domains
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Where, H(k,l) is the Gaussian lowpass filter function, and F0 is the cut-off 

frequency.

The advantage is that the Gaussian has the same shape in the spatial and 
Fourier domains and therefore does not incur the ringing effect in the 
spatial domain of the filtered image. See also Volume 2 Algorithms, 
“Gaussian filter”. See Figure 2.

A commonly used discrete approximation to the Gaussian is the 
Butterworth filter. Applying this filter in the frequency domain shows a 
similar result to the Gaussian smoothing in the spatial domain. One 
difference is that the computational cost of the spatial filter increases with 
the size of the filter kernel, whereas the costs for a frequency filter are 
independent on the filter function. Hence, the spatial Gaussian filter is more 
appropriate for narrow lowpass filtering, while the Butterworth filter is a 
better implementation for wide lowpass filtering. See also “Gaussian and 
Butterworth filters” .

The same principles apply to highpass filters. A highpass filter function can 
be obtained by inverting the corresponding lowpass filter, e.g. an ideal 
highpass filter blocks all frequencies smaller than F0 and leaves the others 

unchanged.

A bandpass filter is a combination of both lowpass and highpass filters. It 
attenuates all frequencies smaller than a frequency Fmin and higher than a 

frequency Fmax, while the frequencies between the two cut-offs remain in 

the resulting output image. 

Figure 2.   Gaussian low pass filter: (a) a plot of Gaussian function, (b) 
the inverse Fourier transform of Gaussian, (c) Frequency response of 
Gaussian with different F0
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A bandstop filter is a filter that passes most frequencies unaltered, but 
attenuates those in a specific range to very low levels.

GAUSSIAN AND BUTTERWORTH FILTERS

In the frequency filtering step, both the real and imaginary parts of the 
fourier transform are scaled by the same formula, which depends only on 
the distance from the center of image. 

The FIR filter must create two fourier transforms: one for the original image 
and one for the kernel. The Butterworth and Gaussian filters only need to 
create one fourier transform for the image since frequency scaling is done 
with a formula. Therefore, the FIR filter uses about twice as much memory 
as the Gaussian or Butterworth filters. 

Centering is needed for the Gaussian and Butterworth filters since the 
scaling formulas are based on frequency magnitude increasing from the 
center of the image.

Butterworth 2D and 3D filters

The following are the formulas for the Butterworth 2D and 3D filters, 
respectively

. EQUATION 5

The real data is the product of the real data and the coefficient. The 
imaginary data is the product of the imaginary data and the coefficient.

Butterworth low-pass, high-pass, band-pass, 
and band-stop filters

The following are the equations for the Butterworth low-pass, high-pass, 
band-pass, and band-stop filters.

Butterworth low-pass filter

distsq x xcenter–( )
2 xcenter( )

2 y ycenter–( )
2 ycenter( )

2
⁄+⁄=

distsq x xcenter–( )
2 xcenter2

( ) y ycenter–( )
2 ycenter( )

2

z zcenter–( )
2 zcenter( )

2
⁄

+⁄+⁄=
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Butterworth high-pass filter

Butterworth band-pass filter

Band-stop filter

Gaussian low- and high-pass filters

The following equations are for the Gaussian low- and high-pass filters.

Gaussian low-pass (2D) filter

Gaussian low-pass (3D) filter

Note: The routine bessj1 for determining a bessel function of the first kind and 

coefficient 1.0

1.0 distsq
f1( )

---------------⎝ ⎠
⎛ ⎞

2 butterworthorder⋅
+

------------------------------------------------------------------------------------------=

coefficient 1.0

1.0 f1( )
distsq
---------------⎝ ⎠

⎛ ⎞+
2 butterworthorder⋅

------------------------------------------------------------------------------------------=

width f2 f1 centersq f1 f2⋅=,–=

num distsq centersq–( )
2.0butterworthorder=

coeff num

num distsq centersq–( )+ 2 butterworthorder⋅
( )
------------------------------------------------------------------------------------------------------------------------------=

width f2 f1 centersq f1 f2⋅=,–=

num distsq width⋅( )
2 butterworthorder⋅

=

coeff num

num distsq width⋅( )
2 butterworthorder⋅

+⎝ ⎠
⎛ ⎞
-------------------------------------------------------------------------------------------------------------------------=

coeffientforgaussianhighpass 1 gaussianlowpass–=
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first order is taken from “Numerical Recipes in C.”

WINDOWED FINITE IMPULSE RESPONSE

Window functions are time limited. This means there is always a finite 
integer Nw such that w(n) almost equal to 0 for all |n|> Nw. The final 

windowed impulse response is thus always time-limited, as needed for 
practical implementation. This window method designs a finite-impulse-
response (FIR) digital filter based on the Hamming function.

Hamming function can be described as

EQUATION 6

w(n)=0.53836-0.46164*cos(2Pi*n/N-1)

The method consists of simply windowing a theoretically ideal filter impulse 
response h(n) by some suitably chosen window function w(n), yielding the 
following equation:

EQUATION 7

hw(n)=w(n)*h(n), where n belongs to Z

For example, the impulse response of the ideal lowpass filter is the sinc 
function.

EQUATION 8

h(n)=B*sinc(Bn) almost equal to B*(sin(Pi*Bn)/Pi*Bn), where n belongs to 
Z

where B=2fc is the normalized bandwidth of the lowpass filter and fc 

coefficient e
x xcenter–( )

2 2f2xcenter2
( )⁄–

e
y ycenter–( )– 2 2f12ycenter2

( )⁄

e z zcenter–( )
2 2f12zcenter2( )⁄–

⋅ ⋅=
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denotes the cut-off frequency. 

Since h(n)=sinc(BnT) decays away from time 0 as 1/n, the method truncates 
it to the interval [-N, N] for some sufficiently large N defined by the user 
and as a result it obtains a finite response filter that approximates the ideal 
filter.

As for Hamming function, |N| >3 is sufficient for good approximation.

Outline of the method

The Filters Frequency method processes images by filtering in the 
frequency domain in three steps:

1 It performs a forward Fast Fourier Transform (FFT) to convert a 
spatial image into its frequency image.

2 It enhances some frequency components of the image and 
attenuates other frequency components of the image by using a lowpass, 
highpass, bandpass, or bandstop filter. Frequency filters may be 
constructed with 1 of 3 methods: Hamming windows, Gaussian filters, and 
Butterworth filters. However, for the Gaussian filters only lowpass and 
highpass filters are available.

3 It performs an inverse FFT to convert from the frequency domain 
back into the spatial domain.

This method performs all three steps in a single combined process. 

Note: Since the core algorithm of this module is the FFT, it requires that all 
the dimensions of an N-dimensional dataset were powers of two. To be able 
to use this algorithm on datasets with arbitrary dimensions, the data is zero 
padded to powers of two before applying the forward FFT and stripped 
down to the original dimensions after applying the inverse FFT. The powers 
of two are not kept identical because symmetrical Fourier pictures are not 
required.

The module also creates a Gabor filter, which is essentially a tilted Gaussian 
with two unequal axes at an offset (freqU, freqV) from the origin. A Gabor 
filter only responds to a texture having both a particular frequency and a 
particular orientation. Note that a filter and its mirror image reflected 
across the u and v frequency axes produce identical frequency responses. 
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See also Volume 2 Algorithms, “Gabor Filter”.

The Frequency Filter algorithm also used in homomorphic filtering, for 
more information refer to Volume 2 Algorithms, “Homomorphic Filter”.

REFERENCES

Digital Image Processing Second Edition by Rafael C. Gonzalez and Richard E. Woods, 
Prentice-Hall, Inc., 2002, Chapter 4.5, pp. 191-194. 

Figure 3.  Applying the Frequency Filter algorithm with different parameters
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IMAGE TYPES

2D and 3D grayscale images. 

Applying the Frequency Filter algorithm 
To run this algorithm, complete the following steps:

1 Open an image of interest.

2 Select Algorithms > Filters Frequency.

3 The Frequency Filter dialog box appears.

4 Fill out the dialog box.

5 Specify the destination image frame, and then, press OK.

Depending on whether you selected the New Image or Replace Image 
option, the result appears in a new window or replaces the original image.

Process each slice 
independently 
(2.5D)

If true, processes each slice 
of a 3D image independently.

Windowed finite 
impulse response

If selected, the method will 
use the Windowed finite 
impulse response algorithm.

Crop image to 
save memory

If selected, this option crops 
image if the (largest image 
dimension + kDim - 1) value 
exceeds the smallest power 
of 2 number which is more or 
equal to the largest 
dimension.

Convolution 
kernel diameter—
odd

It must be an odd integer 
larger or equal than 3, see 
also “Windowed Finite 
Impulse Response” .

Gaussian filter If selected the method uses 
the Gaussian filter.

Butterworth filter If selected the method uses the Butterworth filter.

Figure 4.  Extract Object dialog box
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Order The order of the Butterworth filter.

Destination

New image The result image appears in a new image frame

Replace image The result image appears in the same image frame, replacing the result 
image.

Filter specifications

In that part of the dialog box, first select the filter type. Choose among: Lowpass, Highpass, 
Bandpass and Bandstop option. Then. Enter the lowpass frequency value, and also the higher 
frequency cutoff value if the Bandpass option is chosen.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.

Figure 4.  Extract Object dialog box (continued)
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Filters (Spatial): Adaptive Noise Reduction

This algorithm reduces noise without blurring the edges by replacing a pixel 
value with a weighted sum of all local pixels reached by following a path 
with small pixel intensity values between neighboring pixels.

Background
The Adaptive Noise Reduction algorithm is a port to Adaptive Noise 
Removal Filter, a software program. This program first transforms RGB 
color space into YCrCb color space. When the filtering is complete, it then 
transforms the YCrCb color space into RGB color space. Hence, all of the 
color operations occur in YCrCb space. However, the program does not 
transform black-and-white images into another space. 

In “Frequently Asked Questions About Color,” Charles Poynton reveals that 
the RGB-to-YCrCb and YCrCb-to-RGB conversion equations used in 
Adaptive Noise Removal Filter differ significantly from standard ones. First, 
the program creates an edge graph or pixel neighbor graph using a weakly 
median-filtered version of the YCrCb space. A weakly median-filter version 
means that median filtering only occurs if the pixel is not on an edge in Y, 
Cr, or Cb space. The edge graph is an array of arrays with the first array 
having a length equal to the number of pixels in the image and the second 
array having eight edge weights. The eight edge weights are calculated from 
the intensity differences between the center pixel and one of the eight 
neighboring pixels:

where E is the edge weight; dY, dR, and dB are the Y, Cr, and Cb differences; 
and wY, wR, and wB are the Y, Cr, and Cb weights derived from the Y, Cr, 
and Cb radiuses. A bigger relative radius results in a smaller weight for 
radiuses >= 0.1, which is typically the case.

After the edge graph is created, the program filters the Y, Cr, and Cb spaces 
separately. It uses the selected pixel as the center of a square with  L = 2R + 
1 where L = sides of length, R = range, and range = (int)(radius + 0.999).

E dYwY( )
2 dRwR( )

2 dBwB( )
2+ +( )=
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The enhancePixel function returns the filtered pixel value at every pixel in 
the image. If neighboring pixels are connected to the center pixel via a low-
cost path, queue elements corresponding to these neighboring pixels are 
added to the priority queue. If no queue element is retrieved from the 
queue, then the original pixel value is passed unchanged. If elements are 
retrieved from the queue, then those Y, Cr, or Cb pixel values that retrieved 
queue elements are put into a weighted sum. The weight is derived from an 
index into the filter array given by the queue element key times the 
invFilterLen. The filter array is generated with a Gaussian function.

Each queue element has a value, a baseKey, and a key. The value gives the 

location within the local  local square where R = range. The 
baseKey has a sum of the edgeGraph values over the low-cost path from the 
center pixel to the selected pixel, and key is equal to the sum of baseKey and 
the distMap value for the selected pixel. The distMap value at a given 
position inside the local square is equal to the edge preservation strength 
times the distance from the center pixel. A key is only added to the queue if 
key < maxDistance:

where M = maxDistance, Rd = radius, and S = edge preservation strength.

The priority queue is implemented as a binary heap and the binary heap is 
implemented as an array. A binary heap is a nearly full binary tree (only the 
bottom level may not be complete). This binary heap has the property that 
for every node other than a leaf, its key value is less than or equal to that of 
its children. In a binary heap the item of highest priority is always at the 
root of the tree or at node 0. When the highest priority item at the root is 
removed, the item of highest priority among the remainder moves into the 

root position. The children of node i are at  and . The parent of 

node i is at .

The filter radius can be separately adjusted for each Y, Cr, and Cb channel 
for color images. For black-and-white images only, the Y filter radius can be 
adjusted. A larger radius removes more noise but loses more detail.

2R 1+( ) 2R 1+( )

M int( ) Rd S 512+( )( )=

2i 1+ 2i 2+

int( ) i 1–
2

----------⎝ ⎠
⎛ ⎞
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The edge preservation strength can be adjusted. Larger values preserve 
more edges but sacrifice smoothness in low-contrast areas. Very large 
values may cause banding. 

To speed the filtering on color images, you can select the Filter Cr and Cb at 
halved dimensions check box. When run, the algorithm shrinks the Cr and 
Cb spaces by a factor of 2, generates an edge table for the shrunken space, 
filters the image, and then expands the filtered Cr and Cb spaces to their 
original dimensions. Although the algorithm runs faster, it also loses some 
details.

The New image option causes MIPAV to place the resulting image in a new 
image window. The Replace image option causes MIPAV to place the 
changed image in the same window.

IMAGE TYPES

You can apply this algorithm to both color and black-and-white 2D images.

SPECIAL NOTES

None.

Figure 1.  Adaptive Noise Reduction processing
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REFERENCES

Refer to the following references for more information:

Karlis Freivalds, “Adaptive Noise Removal Filter,” a software program, University of Latvia, 
Institute of Mathematics and Computer Science, at http://www.gradetools.com/karlisf.

Charles Poynton, “Frequently Asked Questions About Color,” at http://www.poynton.com.

Applying the Adaptive Noise Reduction algorithm
To run this algorithm, complete the following steps:

1 Open an image.

2 Perform, as an option, any image processing, such as improving the 
contrast, on the image.

3 Select Algorithms > Filters (spatial) > Adaptive noise reduction. The 
Adaptive Noise Reduction dialog box opens.

4 Complete the information in the dialog box.

5 Click OK. The algorithm begins to run.

A pop-up window appears with the status. A series of status messages 
appear in the window. 

When the algorithm finishes running, the pop-up window closes.

Depending on whether you selected New image or Replace image, the 
results appear in a new window or replace the image to which the 
algorithm was applied. 
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Y radius Specifies the local square used 
for Y space filtering, which is 
approximately 

in size. 

As the radius increases, the 
algorithm removes more noise, 
but loses more detail. The 
default value is 2.0.

Cr radius Specifies the local square used 
for Cr space filtering (only 
available for color), which is 
approximately  in size. 

As the radius increases, the 
algorithm removes more noise, 
but loses more detail. The 
default value is 4.0.

Cb radius Specifies the local square used for Cb space filtering, which is approximately 
in size. As the radius increases, the 

algorithm removes more noise but loses more detail. The default value is 5.0.

Edge 
preservation 
strength

Specifies a value for preserving edges. Larger values preserve more edges but 
sacrifice smoothness in low-contrast areas. Very large values may cause banding.   

For color images, the default value is 3072.0. For black-and-white images, the 

default value is  where IMx is image maximum and IMn is 

image minimum. 

Filter Cr and 
Cb at halved 
dimensions

Causes the algorithm to run faster but with some loss of detail. For color images, 
the default value is enabled; for other images, the default value is disabled. 

New image Shows the results of the algorithm in a new image window.

Replace image Replaces the original source image with the results of the algorithm.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes you made in this dialog box and closes the dialog box.

Help Displays online help for this dialog box.

Figure 2.  Adaptive Noise Reduction dialog box

2YRadius 1+( ) 2YRadius 1+( )

2CrRadius 1+( ) 2CrRadius 1+( )

2CbRadius 1+( ) 2CbRadius 1+( )

12.0
255.0
-------------⎝ ⎠

⎛ ⎞ IMx IMn–( )
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Filters (Spatial): Adaptive Path Smooth

By replacing a pixel value with a weighted sum of the local pixels on the low-
cost path, this algorithm reduces noise without blurring edges. It 
determines the weighted sum by following the path from the lowest-cost 
pixel at the edge of a local neighborhood back to the original pixel.

Background
MIPAV uses a modified port of image noise removal software by Karlis 
Freivalds  for this algorithm. Freivalds’ program starts by transforming 
RGB color space into YCrCb color space. After filtering is complete, the 
program then transforms the YCrCb color space back into RGB color space. 
Hence, all of the color operations occur in YCrCb space.

“Frequently Asked Questions about Color” by Charles Poynton reveals that 
the RGB-to-YCrCb and YCrCb-to-RGB conversion equations used in 
Freivalds’ program differ significantly from the standard ones. Grayscale 
images are not transformed into another space.

In the original program as ported in the Adaptive Noise Reduction 

algorithm, the weighted sum was applied to all pixels in the ( ) by 

( ) local square where range = (int)(radius + 0.999). The 

program finds the lowest-cost pixel at the edge of the ( ) by 

( ) local neighborhood. That pixel and the pixels along the low-

cost path back to the original center pixel are the only pixels used in the 
weighted sum.

First, the program creates an edge graph or pixel neighbor graph. The 2D 
edge graph is an array of arrays with the first array having a length equal to 
the number of pixels in the image and the second array having eight edge 
weights. The eight edge weights are calculated from the intensity differences 
between the center pixel and one of the eight neighboring pixels. 

2 range× 1+

2 range× 1+

2 range× 1+

2 range× 1+
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In 2D and 2.5D images, the edge graph encompasses the entire image. In 
3D with 26 nearest neighbors, an edge graph of size 

is separately created for every voxel in the image to conserve memory.

For color images:

where

EW = edge weight

dY, dR, and dB = Y, Cr, and Cb differences 

wY, wR, and wB = Y, Cr, and Cb weights derived from the Y, Cr, and 
Cb radiuses 

A bigger relative radius results in a smaller weight for radiuses >= 0.1, 
which should typically be the case. For grayscale images, edge weights are 
simply the absolute values of the differences between two pixels.

After the edge graph is created, the Y, Cr, and Cb spaces are separately 
filtered. The filter uses the selected pixel as the center of a square with sides 

of . 

The function enhancePixel returns the filtered pixel value at every pixel in 
the image. If neighboring pixels are connected to the center pixel via a low-
cost path, queue elements corresponding to these neighboring pixels are 
added to the priority queue. If no queue element is retrieved from the 
queue, then the original pixel value is passed unchanged. If elements are 
retrieved from the queue, then those Y, Cr, or Cb pixel values that retrieved 
queue elements in the path from the low-cost edge pixel to the center pixel 
are put into a weighted sum. The weight, derived from the distMap array, is 
simply the Gaussian function of the distance from the center pixel.

2 range× 1+( ) 2 range× 1+( ) 2 range× 1+( ) 26×××

EW dy wy×( )2 dr wr×( )2 dB wB×( )2+ +=

length 2 range 1+×=
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Each queue element has a value, a key, and an origin as indicated in the 
following:

• value = the location within the local ( )*( ) local 

square

• key = sum of the edge graph values on the low-cost path from the 
center pixel to the selected pixel

• origin = the value of the queue element that provides the neighboring 
pixel on the low-cost path back to the center pixel with the center pixel 
origin = -1

A key is only added to the queue if an edge weight is less than threshold. 

The priority queue is implemented as a binary heap and the binary heap is 
implemented as an array. A binary heap is a “nearly full” binary tree (only 
the bottom level may not be complete). This binary heap has the property 
that, for every node other than a leaf, its key value is less than or equal to 
that of its children. In a binary heap, the item of highest priority is always at 
the root of the tree or at node 0. When the highest priority item at the root is 
removed, the item of highest priority among the remainder moves into the 

root position. The children of node i are at  and . The parent 

of node i is at .

2 range× 1+ 2 range× 1+

2 i 1+× 2 i 2+×

int( ) i 1–( )
2

---------------
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On the Adaptive Path Smooth dialog box for color images, you can 
separately adjust the filter radius for each Y, Cr, and Cb channel for color 
images. On the Adaptive Path Smooth dialog box for grayscale images, you 
can only adjust a single radius. 

Tip: A larger radius removes more noise from the image but also loses more 
detail from the image.

You can also adjust the threshold for both color and grayscale images. 
Again, larger values preserve more edges but sacrifice smoothness in low-
contrast areas. In addition, banding may appear for very large values.

Figure 1.  Example of adaptive path smooth processing
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For color images only, there is an option to filter Cr and Cb at halved 
dimensions. If this option is selected, the Cr and Cb spaces are shrunk by a 
factor of 2, an edge table is generated for the shrunken space, the filtering is 
performed, and the filtered Cr and Cb spaces are expanded back up to their 
original dimensions. The algorithm runs faster, but the image loses detail.

On both dialog boxes, if you choose New image, MIPAV then places the 
resulting image in a new image window. Selecting the Replace image option 
causes MIPAV to place the changed image in the same window.

IMAGE TYPES

You can apply this algorithm to both color and grayscale 2D and 3D images.

SPECIAL NOTES

None.

REFERENCE

Refer to the following references for more information about this algorithm:

Image noise removal filter software by Karlis Freivalds at http://www.gradetools.com/
karlisf

Frequently Asked Questions About Color by Charles Poynton at http://
www.poynton.com/colorFAQ.html. 

Applying the Adaptive Path Smooth algorithm
To run this algorithm, complete the following steps:

1 Open an image.

2 Select Algorithms > Filter(spatial) > Adaptive path smooth. 
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Depending on whether the image is grayscale or color, the Adaptive 
Path Smooth dialog box for grayscale images (Figure 2) or the Adaptive 
Path Smooth dialog box for color images opens. If the image is 3D, a 
check box to process each slice independently appears (Figure 3).

3 Complete the information in the dialog box.

4 Click OK.

The algorithm begins to run, and a progress bar appears with the status. 
When the algorithm finishes running, the progress bar disappears, and 
the results appear either in a new window or they replace the original 
source image.

Radius The local square used is 
approximately (2 x Radius + 1) 
times (2 x Radius + 1) in size. As the 
radius increases the algorithm 
removes more noise but loses more 
details from the image. 

The default value is 2.0. 

Threshold Larger values preserve more edges 
but sacrifice smoothness in low-
contrast areas. For very large values, 
banding may appear. 

The default value is 0.1 x (image 
maximum - image minimum).

Include 
neighbors of 
low cost path

Adds nearest neighbors of path pixels to the queue if they differ from the path 
pixels by less than threshold. However, the nearest neighbor weight is only half 
that of a path pixel. The default value is not selected.

Process each 
slice 
independently

Filters each slice of the dataset independently of adjacent slices. The default 
value is not selected. (This check box only appears for 3D images.)

New image Shows the results of the algorithm in a new image window (default choice).

Replace image Replaces the current active image with the new image produced by the algorithm.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes this dialog 
box.

Help Displays online help for this dialog box.

Figure 2.  Adaptive Path Smooth dialog box for grayscale images
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Y radius The local square used for Y space is 
approximately (2 x YRadius + 1) 
times (2 x YRadius + 1) in size. As 
the radius increases the algorithm 
removes more noise but loses more 
details from the image. The default 
value is 2.0.

Cr radius The local square used for Cr space 
filtering is approximately (2 x CrR + 
1) x (2 x CrR + 1) in size. As the 
radius increases, the algorithm 
removes more noise but loses more 
details from the image. The default 
value is 4.0.

Cb radius The local square used for Cb space 
filtering is approximately (2 x CbR + 
1) x (2 x CbR + 1) in size. As the 
radius increases, the algorithm 
removes more noise but loses more 
detail from the image. The default 
value is 5.0.

Threshold Larger values preserve more edges but sacrifice smoothness in low-contrast 
areas. For very large values, banding may appear. The default value is 0.1 x (max 
(red max, green max, blue max) - min(red min, green min, blue min)).

Include 
neighbors of 
low cost path

Adds nearest neighbors of path pixels to the queue if they differ from the path 
pixels by less than threshold. However, the nearest neighbor weight is only half 
that of a path pixel. The default value is not selected.

Filter Cr and 
Cb at halved 
dimensions

When this option is selected, the algorithm runs faster but loses some detail. The 
default value is not selected. 

Process each 
slide 
independently

Filters each slice of the dataset independently of adjacent slices. The default value 
is not selected. (This check box only appears for 3D images.)

New image Shows the results of the algorithm in a new image window (default choice).

Replace 
image

Replaces the current active image with the new image produced by the algorithm.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes this dialog 
box.

Help Displays online help for this dialog box.

Figure 3.  Adaptive Path Smooth dialog box for 3D color images
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Filters (Spatial): Anisotropic Diffusion

This algorithm anisotropically diffuses an image. That is, it blurs over 
regions of an image where the gradient magnitude is relatively small 
(homogenous regions) but diffuses little over areas of the image where the 
gradient magnitude is large (i.e., edges). Therefore, objects are blurred, but 
their edges are blurred by a lesser amount. 

Figure 1 illustrates the relationship between anisotropic diffusion and gradient 
magnitude. In the figure, the original signal is noisy but two major peaks are still 
visible. Applying the diffusion process to the original signal and using the 
gradient magnitude to attenuate the diffusion process at places where the edge 
is strong produces a signal in which the overall signal-to-noise ratio has 
improved.

Figure 1.  A 1D example of anisotropic diffusion 

Note how the noise of the diffused signal is removed while only blurring the edge 
a small amount. The diffusion at the edge of the signals is attenuated by using a 
function of the gradient magnitude.
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Background
The following is the anisotropic diffusion equation:

EQUATION 1

where  is the variable conductance term. Typically, a function of the 

gradient magnitude , if  is a constant, then  which is 

the isotropic heat diffusion equation (Gaussian blurring).

In simple terms, the image I at some time t is given by the diffusion of the 
image where conductance term limits the diffusion process. This program 
uses a conductance term calculated by dividing a constant (k) divided by the 
square root of the sum of the squares of the normalized first order 
derivatives of the Gaussian function as an approximate gradient function. 
Figure 2 shows the result of applying this technique. The image on the left is 
a CT image before processing. The image on the right of it was diffused. 
Note the image was diffused within object boundary but to a much lesser 
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amount near the boundaries of the objects.

IMAGE TYPES

You can apply this algorithm just to gray-scale images.

SPECIAL NOTES

Refer to the section on “Filters (Spatial): Nonlinear Noise Reduction” on 
page 279. 

REFERENCES

Refer to the following references for more information:

P. Perona and J. Malik. “Scale-Space and Edge Detection Using Anisotropic Diffusion,” IEEE 
Trans. Pattern Analysis and Machine Intelligence, 12(7):629-639, July 1990.

Bart M. Ter Romeney, ed. Geometry-Driven Diffusion in Computer Vision. (Dordrecht, The 
Netherlands: Kluwer Academic Publishers, 1994).

Figure 2.  An image before and after applying the Anisotropic  
Diffusion algorithm  
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Applying the Anisotropic Diffusion algorithm
To run this algorithm, complete the following steps:

1 Open an image.

2 Perform, as an option, any image processing, such as improving the 
contrast, eliminating noise, etc., on the image.

3 Select Algorithms > Filters (spatial) > Anisotropic Diffusion. The 
Anisotropic Diffusion dialog box (Figure 3) opens.

4 Complete the information in the dialog box.

Note: Diffusing an image is a lengthy process. Give some consideration to the 
values you type into the Iterations and k boxes. The higher the number of  
iterations slows processing speed as does a small k value. 

5 Click OK. The algorithm begins to run.

A pop-up window appears with the status. The following message 
appears: “Diffusing image.” 

When the algorithm finishes running, the pop-up window closes.

Depending on whether you selected New image or Replace image, the 
results appear in a new window or replace the image to which the 
algorithm was applied.
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X dimension 
(0.5 - 5.0)*

Indicates the standard deviation 
(SD) of Gaussian in the X 
direction. 

Y dimension 
(0.5 - 5.0)*

Indicates the SD of Gaussian in 
the Y direction.

Z dimension 
(0.5 - 5.0)*

Indicates the SD of Gaussian in 
the Z direction.

Use image 
resolutions to 
normalize Z 
scale

Normalizes the Gaussian to 
compensate for the difference if 
the voxel resolution is less 
between slices than the voxel 
resolution in-plane. This option is 
selected by default.

Process each 
slice 
independently 
(2.5D)

Blurs each slice of the dataset 
independently.

Iterations 
(1-1000)

Specifies the number of times the 
process is run.

k (k > 1 slows 
diffusion)

Specifies the constant used to control the blurring rate. A small value slows the 
diffusion process (especially across edges) per iteration. A large value speeds 
the diffusion process but also allows for diffusion (blurring across edges); it also 
makes this function act similar to Gaussian blurring. See equation above.

New image Shows the results of the algorithm in a new image window.

Replace image Replaces the current active image with the results of the algorithm.

Whole image Applies the algorithm to the whole image.

VOI regions Applies the algorithm to the volumes (regions) delineated by the VOIs.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes you made in this dialog box and closes the dialog box.

Help Displays online help for this dialog box.

*An SD greater than 1 attenuates small scale edges typically caused by noise, but reduces edge accuracy.

Figure 3.  Anisotropic Diffusion dialog box 
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Filters (Spatial): Coherence-Enhancing Diffusion

Coherence-enhancing filtering is useful for filtering relatively thin, linear 
structures such as blood vessels, elongated cells, and muscle fibers. 
Coherence-enhancing filtering is a specific technique within the general 
classification of diffusion filtering. Diffusion filtering, which models the 
diffusion process, is an iterative approach of spatial filtering in which 
image intensities in a local neighborhood are utilized to compute new 
intensity values. 

Two major advantages of diffusion filtering over many other spatial domain 
filtering algorithms are:

• A priori image information can be incorporated into the filtering 
process 

• The iterative nature of diffusion filtering allows for fine grain control 
over the amount of filtering performed

There is not a consistent naming convention in the literature to identify 
different types of diffusion filters. This documentation follows the approach 
used by Weickert (see “References” on page 235). Specifically, since the 
diffusion process relates a concentration gradient with a flux, isotropic 
diffusion means that these quantities are parallel. Regularized means that 
the image is filtered prior to computing the derivatives required during the 
diffusion process. In linear diffusion the filter coefficients remain constant 
throughout the image, while nonlinear diffusion means the filter 
coefficients change in response to differential structures within the image. 
Coherence-enhancing filtering is a regularized nonlinear diffusion that 
attempts to smooth the image in the direction of nearby voxels with similar 
intensity values.

For more information about the algorithm, refer to MIPAV Volume 2 User Guide 
on the MIPAV web site:{http://mipav.cit.nih.gov/} 
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Background

All diffusion filters attempt to determine the image  that solves the 

well-known diffusion equation, which is a second-order partial differential 
defined as

where

=The time derivative of the image

div=The divergence operator

D =The diffusion tensor (which may be a scalar value)

=The gradient of the image

The quantity that distinguishes different diffusion filters is primarily the 
diffusion tensor also called the diffusivity.

In homogeneous linear diffusion filtering, the diffusivity, D, is set to 1 and 
the diffusion equation becomes:

In isotropic nonlinear diffusion filtering, the diffusivity term is a 
monotonically decreasing scalar function of the gradient magnitude 
squared, which encapsulates edge contrast information. In this case, the 

diffusion equation becomes:

It is well known that derivative operations performed on a discrete grid are 
an ill-posed problem, meaning derivatives are overly sensitive to noise. To 
convert derivative operations into a well-posed problem, the image is low-
pass filtered or smoothed prior to computing the derivative. Regularized 
isotropic (nonlinear) diffusion filtering is formulated the same as the 
isotropic nonlinear diffusion detailed above; however, the image is 
smoothed prior to computing the gradient. The diffusion equation is 
modified slightly to indicate regularization by including a standard 
deviation term in the image gradient as shown in the following equation:

I x( y ),

∂tI div D∇I( )=

It∂

I∇

∂tI ∂xxI ∂yyI+=

∂tI div D ∇I 2
( )∇I( )=
MIPAV User’s Guide, Volume 2, Algorithms 232

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Filters (Spatial): Coherence-Enhancing Diffusion
The smoothing to regularize the image is implemented as a convolution 
over the image and therefore this filtering operation is linear. Since 
differentiation is also a linear operation, the order of smoothing and 
differentiation can be switched, which means the derivative of the 
convolution kernel can be computed and convolved with the image resulting 
in a well-posed measure of the image derivative.

In edge-enhancing anisotropic diffusion, the diffusivity function allows 
more smoothing parallel to image edges and less smoothing perpendicular 
to these edges. This variable direction smoothing means that the flux and 
gradient vectors no longer remaining parallel throughout the image, hence 
the inclusion of the term anisotropic in the filter name. Directional 
diffusion requires that the diffusivity function provide more information 
than a simple scalar value representing the edge contrast. Therefore, the 
diffusivity function generates a matrix tensor that includes directional 
information about underlying edges. We refer to a tensor-valued diffusivity 
function as a diffusivity tensor. In edge-enhancing anisotropic diffusion, 
the diffusivity tensor is written as the following:

Directional information is included by constructing an orthonormal system 

of eigenvectors  of the diffusivity tensor so that  and 

.

Coherence-enhancing anisotropic diffusion is an extension of edge-
enhancing anisotropic diffusion that is specifically tailored to enhance line-
like image structures by integrating orientation information. The diffusivity 
tensor in this case becomes:

∂tI div D ∇Iσ
2

⎝ ⎠
⎛ ⎞ ∇Iσ⎝ ⎠

⎛ ⎞=

D ∇( Iσ ) D ∇Iσ∇Iσ
T

⎝ ⎠
⎛ ⎞=

ν1 ν2 … νn, , , ν1 ∇Iσ

ν2 ∇Iσ … Vn ∇Iσ⊥, ,⊥

D ∇Iσ( ) D Kρ ∇Iσ∇Iσ
T

⊗⎝ ⎠
⎛ ⎞=
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In this diffusivity tensor,  is a Gaussian kernel of standard deviation , 

which is convolved ( ) with each individual component of the  

matrix. Directional information is provided by solving the eigensystem of 

the diffusivity tensor without requiring  and .

Figure 2 shows the results of applying the coherence-enhancing anisotropic 
diffusion filter to an example MR knee image.

IMAGE TYPES

You can apply this algorithm to all data types except complex and to 2D, 
2.5D, and 3D images.

SPECIAL NOTES

The resulting image is, by default, a float image.

Kρ ρ

∇Iσ∇Iσ
T

ν1 ∇Iσ ν2 ∇Iσ … Vn ∇Iσ⊥, ,⊥

Figure 1.  Example of coherence-enhancing diffusion
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REFERENCES

Refer to the following references for more information about diffusion 
filtering in general and this algorithm in particular.

Weickert, Joachim. “Nonlinear Diffusion Filtering,” in Handbook of Computer Vision and 
Applications, Volume 2, eds. Bernd Jahne, Horst Haussecker, and Peter Geissler. (Academic 
Press, April 1999), 423–450.

Weickert, Joachim. Anisotropic Diffusion in Image Processing (Stuttgart, Germany: 
Teubner, 1998).

Applying the Coherence-Enhancing Diffusion algorithm

To run this algorithm, complete the following steps:

1 Select Algorithms > Filter > Coherence-Enhancing Diffusion. The 
Coherence-Enhancing Diffusion dialog box opens (Figure 2).

2 Complete the fields in the dialog box.

Number of 
iterations

Specifies the number of iterations, or 
number of times, to apply the algorithm 
to the image.

Diffusitivity 
denominator

Specifies a factor that controls the 
diffusion elongation. 

Derivative 
scale space

Specifies the standard deviation of the 
Gaussian kernel that is used for 
regularizing the derivative operations.

Gaussian 
scale space

Specifies the standard deviation of the 
Gaussian filter applied to the individual  
components of the diffusivity tensor.

Process each 
slice 
separately

Applies the algorithm to each slice 
individually. By default, this option is 
selected.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box.

Help Displays online help for this dialog box.

Figure 2.  Coherence Enhancing Diffusion dialog box
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3 When complete, click OK. 

The algorithm begins to run, and a status window appears. When the 
algorithm finishes, the resulting image appears in a new image window.

Figure 3.  Status message that appear when the Coherence-Enhancing 
Diffusion algorithm is running
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Filters (Spatial): Gaussian Blur

This algorithm blurs an image or the VOI of the image with a Gaussian 
function at a user-defined scale sigma (standard deviation [SD]). In 
essence, convolving a Gaussian function produces a similar result to 
applying a low-pass or smoothing filter. A low-pass filter attenuates high-
frequency components of the image (i.e., edges) and passes low-frequency 
components. This results in the blurring of the image. Smoothing filters are 
typically used for noise reduction and for blurring. The standard deviation 
of the Gaussian function controls the amount of blurring. A large standard 
deviation (i.e., > 2) significantly blurs, while a small standard deviation (i.e., 
0.5) blurs less. If the objective is to achieve noise reduction, a rank filter 
(median) might be more useful in some circumstances.

Advantages to convolving the Gaussian function to blur an image include:

• Structure is not added to the image.

• It, as well as the Fourier Transform of the Gaussian, can be analytically 
calculated.

• By varying the SD, a Gaussian scale space can easily be constructed.

Background
The radially symmetric Gaussian, in an n-dimensional space, is:

EQUATION 1

where  (referred to as the scale), is the standard deviation of the Gaussian 

and is a free parameter that describes the width of the operator (and thus 
the degree of blurring) and n indicates the number of dimensions.

Geometric measurements of images can be obtained by spatially convolving 
(shift-invariant and linear operation) a Gaussian neighborhood operator 

with an image, I, where  represents an n-dimensional image. The 

convolution process produces a weighted average of a local neighborhood 
where the width of the neighborhood is a function of the scale of the 

G x σ,( ) 1

2πσ( )
n 2⁄

-------------------------e x x⋅( ) 2σ2( )⁄–=

σ

I ℜn ℜ→⋅
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Gaussian operator. The scale of the Gaussian controls the resolution of the 
resultant image and thus the size of the structures that can be measured. A 

scale-space for an image of increasingly blurred images can be defined 

by L:nx +  and  where  represents convolution.

The following is the calculation of the full-width half max (FWHM) of the 
Gaussian function.

Figure 2 shows the Gaussian function. The dotted lines indicate the 
standard deviation of 1. The FWHM is indicated by the solid lines. For a 

Gaussian with a standard deviation equal to 1 ( ), the FWHM is 2.36.
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Figure 1 shows a Gaussian scale-space of the sagittal view of a MR head 

image. The original image is shown in the upper left ( ). Varying σ 

from 0.5 to 5.5 in steps of 0.5 blurs the other images (from left to right and 
top to bottom).

Figure 1.  Gaussian Blur algorithm processing

σ 1=
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Note that as the scale increases, small-scale features are suppressed. For 
example, at small scales the individual folds of the brain are quite defined, 
but, as the scale increases, these folds diffuse together resulting in the 
formation of a region one might define as the brain.

IMAGE TYPES

You can apply this algorithm to all image data types except Complex and to 
2D, 2.5D, 3D, and 4D images.

• By default, the resultant image is a float type image.

• By selecting Process each slide independently (2.5D) in the Gaussian 
Blur dialog box, you can achieve 2.5D blurring (each slice of the 
volume is blurred independently) of a 3D dataset (Figure 1).

SPECIAL NOTES

None.

Figure 2.  Gaussian function
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REFERENCES

See the following references for more information about this algorithm:

J. J. Koenderink, “The Structure of Images,” Biol Cybern 50:363–370, 1984.

J. J. Koenderink and A. J. van Doorn, “Receptive Field Families,” Biol Cybern 63:291–298, 
1990.

Tony Lindeberg, “Linear Scale-Space I: Basic Theory,” Geometry-Driven Diffusion in 
Computer Vision, Bart M. Ter Har Romeney, ed. (Dordrecht, The Netherlands: Kluwer 
Academic Publishers, 1994), pp. 1–38.

R. A. Young, “The Gaussian Derivative Model for Machine Vision: Visual Cortex Simulation,” 
Journal of the Optical Society of America, GMR-5323, 1986. 

Applying the Gaussian Blur algorithm
To run this algorithm, complete the following steps:

1 Select Algorithms > Filter > Gaussian Blur. The Gaussian Blur dialog 
box opens (Figure 3).

2 Complete the information in the dialog box.

3 Click OK. 

The algorithm begins to run, and a pop-up window appears with the 
status. The following message appears: “Blurring Image.” 

When the algorithm finishes running, the pop-up window closes, and 
the results appear in either a new window or replace the image to which 
the algorithm was applied.
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X Dimension Indicates the standard 
deviation (SD) of Gaussian in 
the X direction.

Y Dimension Indicates the SD of Gaussian in 
the Y direction.

Z Dimension Indicates the SD of Gaussian in 
the Z direction.

Use image 
resolutions to 
normalize Z 
scale

Normalizes the Gaussian to 
compensate for the difference if 
the voxel resolution is less 
between slices than the voxel 
resolution in-plane. This option 
is selected by default. 

Process each 
slice 
independently 
(2.5D)

Blurs each slice of the dataset 
independently of adjacent 
slices.

Process red 
channel

Applies the algorithm to the red 
channel only.

Process green 
channel

Applies the algorithm to the 
green channel only.

Process blue 
channel

Applies the algorithm to the 
blue channel only.

New image Shows the results of the algorithm in a new image window.

Replace 
image

Replaces the current active image with the results of the algorithm.

Whole image Applies the algorithm to the whole image.

VOI region(s) Applies the algorithm to the volumes (regions) delineated by the VOIs.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box.

Help Displays online help for this dialog box.

Figure 3.  Gaussian Blur dialog box 
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Filters (Spatial): Gradient Magnitude

Edge detection is the identification of meaningful discontinuities in gray 
level or color images. Edges are formed between two regions that have 
differing intensity values. This algorithm calculates the gradient magnitude 
of an image (or VOI of the image) using the first derivatives (Gx, Gy, and Gz 
[3D] ) of the Gaussian function at a user-defined scale sigma (standard 
deviation, or SD) and convolving it with image. The convolution of the first 
derivatives of the Gaussian with an image is a robust method of extracting 
edge information. By varying the SD, a scale-space of edges can easily be 
constructed.

Background
Figure 1 shows the 1D signal of an object, the first derivative of the object, 
and, last, the gradient magnitude (defined later). Note that the maximum 
responses of the gradient magnitude result correspond to the edges of the 
object.

At location (x,y) of a 2D image, the gradient vector is

: EQUATION 1

Figure 1.  Edge detection using derivative operators

∇ x y( , )
Ix
Iy

∂I
∂x
-----

∂I
∂y
-----

= =
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and points in the direction of the maximum rate of change of the image at 
that point. 

The gradient magnitude is defined as

: EQUATION 2

and is the maximum rate of increase of  in the direction of .

An efficient method of calculating the gradient magnitude is to analytically 
calculate the first derivative of Gaussian and convolve it with the image. The 
equation for this calculation follows

: EQUATION 3

 

IMAGE TYPES

You can apply this algorithm to all image data types except complex and to 
2D, 2.5D, 3D, and 4D images.

Figure 2.  Gradient Magnitude algorithm processing

A shows a computer tomography (CT) axial image of an abdomen. Image B 
depicts a gradient magnitude of image A calculated using Gaussian derivatives at  
= 0.5, and image C shows a gradient magnitude of image A calculated using 
Gaussian derivatives at  = 2.0.

mag ∇I( ) Ix
2 Iy

2+
1 2⁄

=

I x y,( ) ∇I

Ix x y, σ,( ) ∂
∂x
-----G x y σ,( , ) I x y( , )⊗=
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SPECIAL NOTES

The following notes apply:

• The resultant image is, by default, a float type image;

• To achieve 2.5D blurring (each slide of the volume is processed 
independently),  select Process each slide independently (2.5D) in the 
Gradient Magnitude dialog box.

REFERENCES

Refer to the following references for more information: 

Raphael C. Gonzalez and Richard E. Woods, Digital Image Processing (Boston: Addison-
Wesley, 1992).

J. J. Koenderink, “The Structure of Images,” Biol Cybern 50: 363–370, 1984.

Tony Lindeberg, “Linear Scale-Space I: Basic Theory,” Geometry-Driven Diffusion in 
Computer Vision, Bart M. Ter Har Romeney, ed. (Dordrecht, The Netherlands: Kluwer 
Academic Publishers, 1994), pp. 1–38.

Applying the Gradient Magnitude algorithm
To run this algorithm, complete the following steps:

1 Select Algorithms > Filter > Gradient Magnitude. The Gradient 
Magnitude dialog box opens (Figure 4).

2 Complete the information in the dialog box. 

3 When complete, click OK. The algorithm begins to run. 

A pop-up window appears with the status. The following message 
appears: “Calculating the Gradient Magnitude.” When the algorithm 
finishes running, the pop-up window closes.

Depending on whether you selected New Image or Replace Image, the 
result appears in a new window or replaces the image to which the 
algorithm was applied.
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X Dimension Indicates the standard deviation 
(SD) of Gaussian in the X 
direction.

Y Dimension Indicates the SD of Gaussian in 
the Y direction.

Z Dimension Indicates the SD of Gaussian in 
the Z direction.

Use image 
resolutions to 
normalize Z 
scale

Normalizes the Gaussian to 
compensate for the difference if 
the voxel resolution is less 
between slices than the voxel 
resolution in-plane. This option is 
selected by default. 

Process each 
slice 
independently 
(2.5D)

Blurs each slice of the dataset  
independently.

Process red 
channel

Applies algorithm to the red 
channel only.

Process green 
channel

Applies algorithm to the green 
channel only.

Process blue 
channel

Applies algorithm to the blue channel only.

New image Shows the results of the algorithm in a new image window.

Replace 
image

Replaces the current active image with the results of the algorithm.

Whole image Applies the algorithm to the whole image.

VOI region(s) Applies the algorithm to the volumes (regions) delineated by the VOIs.

OK Applies the Gradient Magnitude algorithm according to the specifications in this 
dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box.

Help Displays online help for this dialog box.

Figure 3.  Gradient Magnitude dialog box
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Filters (Spatial): Haralick Texture

The Haralick texture features are used for image classification. These 
features capture information about the patterns that emerge in the image 
texture. They are calculated by construction a co-occurrence matrix. Once 
the co-occurrence matrix has been constructed, calculations of the 12 
features begin.

For more information about the method, refer to the MIPAV web site {http://
mipav.cit.nih.gov/documentation/HTML%20Algorithms/
FiltersSpatialHaralickTexture.htm

Background
The algorithm is based on the material in the GLCM Texture Tutorial by 
Mryka Hall-Beyer at http://www.fp.ucalgary.ca/mhallbey/tutorial.html.

Haralick texture feature calculation can be divided into two parts

1 Construction of the co-occurrence matrices;

2 Calculation of the 12 texture features based on the co-occurrence 
matrices.

OUTLINE OF THE ALGORITHM

Construction of gray-level co-occurrence matrix (GLCM)

The gray-level co-occurrence matrix, GLCM is used to describe the patterns 
of neighboring pixels in an image at a given offset distance, d usually chosen 
to be 1. In the calculation of the texture features, five such matrices are 
needed to describe different orientations or direction possibilities. The five 
direction possibilities are North-South, Northeast-Southwest, East-West, 
Southeast-Northwest, and spatially invariant. Spatially invariant is created 
by counting in the four directions and summing the counts.

The co-occurrence matrix is a square with dimension Ng, where Ng is the 
number of rescaled gray levels in the image. Ng has a default value = 32 and 
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is required to be between 8 and 64. There are 2 reasons for compressing the 
data:

1 The matrix size would otherwise be excessively large. 16 bit data would 
give a matrix of size 65536 x 65536 = 4,294,967,296 cells.

2 If all cells in even 8 bit 256 x 256 data were used, there would be many 
cells filled with zeros (because that combination of gray levels simply 
does not occur). The GLCM approximates the joint probability 
distribution of the two pixels. Having many zero filled cells creates a 
very bad approximation. If the number of gray levels is reduced, the 
number of zeros is decreased, and the statistical validity is greatly 
improved.

Float, double, and ARGB_FLOAT data will always be rescaled. Other data 
will be rescaled if (image maximum - image minimum) is more than 64.

Element [i,j] of the matrix is generated by counting the number of times a 
pixel with value i is adjacent to a pixel with value j. The adjacency is tested 
for 1 of 4 direction possibilities: east and west, northeast and southwest, 
northwest and southeast, or north and south. Always summing the counts 
from 2 opposite directions ensures that the GLCM is symmetric. Then, each 
element [i, j] is divided by the sum of all the elements to turn the matrix 
elements into probabilities.

Co-occurrence matrix texture considers the relation between two pixels at a 
time, which called the reference and neighbor pixel. The frequency of 
occurrence is counted over a square window which is placed over each pixel 
interior to a band of width (window size-1)/2 at the edge of the image, since 
results are only calculated for those pixels over which the entire square 
window can be placed. The values in this outer band have been left at zero.
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IMAGE TYPES

Any noncomplex 2D image.

REFERENCES

Refer to the following references for more information: 

This code is based on the material in the GLCM Texture Tutorial by Mryka Hall-Beyer, which 
can be found at http://www.fp.ucalgary.ca/mhallbey/tutorial.htm

“An Analysis of co-occurrence texture statistics as a function of grey level quantization” by 
David A. Clausi, Can J. Remote Sensing, Vol. 28, No. 1, 2002, pp. 45-62.

Figure 1.  Construction of the east-west co-occurrence matrix for pixel 
distance equals 1. (a) – the original image with pixel image intensities 
showing as numbers; (b) shows the incremental stage that occurs when 
the outlined neighboring pixels in (a) are examined; (c) shows the final 
result of the co-occurrence matrix and (d) represents the matrix 
calculation
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Applying the algorithm

1 Open an image of interest.

2 Navigate to Algorithms > Filters Spatial>Haralick Texture.

3 The Haralick Texture dialog box appears, see Figure 3.

Figure 2.  Applying the Haralick Texture algorithm: (a) – the original image, (b)–(i) result images
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4 Complete the dialog box and press OK. Use the information from 
section “Calculation of the 12 texture features” .

The result images appear in new frames, see Figure 2.

CALCULATION OF THE 12 TEXTURE FEATURES

Texture features are calculated as weighted averages of the normalized co-
occurrence matrix cell contents. Texture features are listed in the dialog 
box, see Figure 3.

Figure 3.  Haralick texture dialog box
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Note: a weighted average multiplies each value to be used by a factor or a 
weight that expresses the relative importance of the value before summing all 
the weighted values and dividing by the number of values.

Contrast

Calculation:

When i and j are equal, the cell is on the diagonal and (i-j)=0. These values 
represent pixels entirely similar to their neighbor, so they are given a weight 
of 0. If i and j differ by 1, there is a small similarity, and the weight is 1. If i 
and j differ by 2, contrast is increasing and the weight is 4. The weights 
continue to increase exponentially as (i-j) increases. 

Dissimilarity

While in Contrast calculation weights increasing exponentially (0, 1, 4, 9, 
etc.) as one moves steps away from the diagonal, the dissimilarity weights 
increase linearly (0, 1, 2, 3 etc.).

Homogeneity (Inverse Difference Moment) 

Homogeneity weights values by the inverse of the Contrast weight, with 
weights decreasing exponentially away from the diagonal.

(EQ 1)

(EQ 2)
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Angular Second Moment (ASM)

Energy (Uniformity)

Note that ASM and Energy use each Pij as a weight for itself. High values of ASM 
or Energy occur only when the texture patterns window is very orderly 
organized.

Entropy

Notes about the entropy measure:

• Pij is a probability measure is always between 0 and 1; therefore, 
ln(Pij) will always be zero or negative;

(EQ 3)

(EQ 4)

(EQ 5)

(EQ 6)
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• Smaller values of Pij mean that the appearance of a given pixel 
combination is the less common;

• The smaller the value of Pij, the larger is the absolute value of ln(Pij);

• The (-1) multiplier in the entropy Equation 6 makes it positive;

• Therefore, the smaller the Pij value, the greater the weight, and the 
greater the value of -(Pij *ln(Pij)).

Since ln(0) is undefined, assume that 0 * ln(0) = 0 and 1 * ln(1) = 0. So the 
entropy is zero at p = 0 and p = 1 with a maximum value somewhere 
between.  The maximum entropy occurs when the derivative of (p * ln(p)) 
with respect to p equals zero. p = 1/e gives a maximum entropy value of 1/e, 
which is about 0.378.

Gray Level Co-occurrence Matrix (GLCM) Mean 

The GLCM Mean is expressed in terms of the gray level co-occurrence 
matrix. Consequently, the pixel value is weighted not by its frequency of 
occurrence by itself (as in common mean expression), but by the frequency 
of its occurrence in combination with a certain neighbor pixel value.

Note that there are two equations here:

• The left hand equation calculates the mean based on the reference 
pixels, µi. 

• The right hand equation calculates the mean using the neighbor pixels, 
µj. 

For the symmetrical GLCM, where each pixel in the window is counted once 
as a reference and once as a neighbor, these two values are identical.

Gray Level Co-occurrence Matrix (GLCM) Variance

Variance in texture performs the same task as does the common descriptive 
statistic called variance. It relies on the mean, and the dispersion around 
the mean, of cell values within the GLCM.

(EQ 7)
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Gray Level Co-occurrence Matrix (GLCM) Standard Deviation

Gray Level Co-occurrence Matrix (GLCM) Correlation

Correlation between pixels assumes that there are predictable and linear 
relationships between the pixel intensities, which can be expressed by the 
correlation equation.

Properties of Correlation

• Single objects usually have a higher correlation value within them than 
between adjacent objects. 

• Pixels are usually more highly correlated with pixels nearby than with 
more distant pixels. 

• Therefore, smaller window sizes will usually have a higher correlation 
value than larger windows. For that reason, it is useful to use the 
following approach in calculating Correlation – if Correlation is 
calculated for successively larger window sizes, the size at which the 
Correlation value declines may be taken as the size of definable objects 
within an image. Note that this works only if all objects in the image 
are about the same size. 

(EQ 8)

(EQ 9)

(EQ 10)
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Note that Correlation uses quite a different approach in calculation that the 
other texture measures described above. As a result, it provides different 
information and can often be used profitably in combination with other 
texture measures. If all the pixels have identical values, then the 
denominator variances are zero and the correlation equation would give an 
undefined result. If the variance is zero, then the equation is not used, and 
the correlation is set to 1 to reflect identical pixels.
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Filters (Spatial): Laplacian

Edge detection is the identification of meaningful discontinuities in gray 
level or color images. Edges are formed between two regions that have 
differing intensity values. This algorithm calculates the laplacian of an 
image (or VOI of the image) using the second derivatives (Gxx, Gyy, and 
Gzz [3D]) of the Gaussian function at a user-defined scale sigma [standard 
deviation (SD)] and convolving it with image. The convolution of the 
second derivatives of the Gaussian with an image is a robust method of 
extracting edge information. By varying the SD, a scale-space of edges can 
easily be constructed.

For more information about the algorithm, refer to MIPAV Volume 2 User Guide 
on the MIPAV web site:{http://mipav.cit.nih.gov/} 

Background
Figure 1 shows the 1D signal of an object. The first derivative of the object is 
shown next. Last, the Laplacian (defined later) is shown. Note that the zero-
crossing of the second derivative corresponds to the edges of the object.

Figure 1.  Edge detection using laplacian operators

Original

First derivative

Second derivative

Object

Zero crossings
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The laplacian function is defined as:

An efficient method of calculating the laplacian is to analytically calculate 
the second derivatives of Gaussian and convolve the sum with the image. 
The equation for this calculation follows:

IMAGE TYPES

You can apply this algorithm to all image data types except complex and to 
2D, 2.5D, and 3D images.

SPECIAL NOTES

The resulting image is, by default, a float type image.

To achieve 2.5D blurring (each slice of the volume is processed 

∇
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Figure 2.  (A) Original MR image; (B) laplacian results; and (C) extraction of the zero crossing of 
the laplacian (object edges)
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independently) of a 3D dataset, select Process each slice independently 
(2.5D) in the Laplacian dialog box (Figure 1).

REFERENCES

Refer to the following references for more information about this algorithm:

Tony Lindeberg, “Linear Scale-Space I: Basic Theory,” Geometry-Driven Diffusion in 
Computer Vision, Bart M. Ter Har Romeney, ed. (Dordrecht, The Netherlands: Kluwer 
Academic Publishers, 1994), pp. 1–38.

J. J. Koenderink, “The Structure of Images,” Biol Cybern 50:363–370, 1984.

Raphael C. Gonzalez and Richard E. Woods, Digital Image Processing (Boston: Addison-
Wesley, 1992).

Applying the Laplacian algorithm
To run this algorithm, complete the following steps:

1 Select Algorithms > Filter > Laplacian. The Laplacian  dialog box opens 
(Figure 3).

2 Complete the fields in the dialog box.

3 When complete, click OK. The algorithm begins to run. 

A pop-up window appears with the status. The following message 
appears: “Calculating the Laplacian.” 

When the algorithm finishes, the pop-up window closes. Depending on 
whether you selected New Image or Replace Image, the results either 
appear in a new window or replace the image to which the algorithm 
was applied. 
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.

X Dimension Specifies the standard 
deviation (SD) of Gaussian 
in the X direction.

Y Dimension Specifies the SD of 
Gaussian in the Y direction.

Z Dimension Specifies the SD of 
Gaussian in the Z direction.

Amplification 
factor

Applies, by default, the 
classical laplacian factor of 
1.0; values greater than 
1.0 and less than 1.2 
enable the laplacian to act 
as a high-pass, or high-
boost, filter.

Use image 
resolutions to 
normalize Z scale

Normalizes the Gaussian to 
compensate for the 
difference if the voxel 
resolution is less than the 
voxel resolution inplane.

Process each 
edge 
independently 
(2.5D)

Blurs each slice of the 
dataset independently.

Output edge 
image

Produces a binary image that represents the edges defined by the 0 crossings 
of the laplacian

Threshold edge 
noise between 
<_> and <_>

Limits the threshold edge noise to the range that you specify between the 0 
crossings of the laplacian; the default range is -10 to 10. 

New image Shows the results of the algorithm in a new image window.

Replace image Replaces the current active image with the results of the algorithm.

Whole image Applies the algorithm to the whole image.

VOI region(s) Applies the algorithm to the volumes (regions) delineated by the VOIs.

OK Applies the laplacian algorithm according to the specifications in this dialog 
box. 

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box.

Help Displays online help for this dialog box.

Figure 3.  Laplacian dialog box 
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Filters (Spatial): Local Normalization TBD

TBD.

Background
TBD. BEFORE AND AFTER GRAPHIC (WHAT HAPPENS WHEN 
ALGORITHM IS RUN)?

Figure 1.  Local Normalization algorithm processing

IMAGE TYPES

TBD.

SPECIAL NOTES

TBD.

REFERENCES

See the following references for more information about this algorithm:

TBD.

Applying the Local Normalization algorithm
To run this algorithm, complete the following steps:

1 [tbd]

2 [tbd]

3 [tbd]
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Filters (Spatial): Mean

This algorithm provides a simple way of reducing noise either in an entire 
image or in a delineated VOI in the image where

Mean = sum of all pixels in the kernel / total number of pixels in the 
kernel

This is one method of low-pass filtering, which is sometimes referred to as 
neighborhood averaging.

Background
In applying this algorithm, MIPAV first defines a region, either in the whole 
image or in the delineated VOI, over which it replaces a target pixel value 
with the average value over the kernel of pixels in which the target pixel is at 
the center. That is, for the target pixel: 

where k = kernel, s = kernel size, and I = image.

For slice averaging (Figure 1 and Figure 2), the kernels are odd-length 
squares (for example, 3 x 3). The processing time increases with the square 
of the kernel length. For volume averaging (Figure 2), the kernels are odd-
length cubes (such as 5 x 5 x 5), and the processing time increases with the 
cube of the kernel length. Refer to Figure 2 for examples of slice and volume 
averaging.

Note that the term average does not always represent the mean. If fact, 
there are three types of average: the commonly used mean, the median, and 
the infrequently used mode. The mean is defined as the sum of the values in 
a group divided by the number of values in the group. The median value is 
the value that has the same number of values greater and less than it. The 
mode is the value with the greatest number of occurrences.

If part of the neighborhood kernel falls outside the image when the pixel is 
on or near the boundary, MIPAV only uses that portion of the kernel inside 
the image.

mean 1
s
--- Ii

i 1=

i s=

∑ ki⋅=
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Example: Consider the upper right corner pixel in a 2D image if a 3 x 3 kernel is 
used. In this case, when the algorithm is applied, MIPAV uses only the target 
pixel and its lower, left, and diagonal left lower neighbors. It then divides the 
sum of these four pixels by 4.

If you select the New image option, MIPAV places the resulting image in a 
new image window. If you select the Replace image option, MIPAV returns 
the changed picture to the same image window. If you delineate a VOI on 
the image and select VOI regions, then MIPAV replaces the original value of 
a pixel  inside the VOI with the mean value of the kernel that contains the 
pixel at its center. The pixel values outside the VOI remain unchanged.

Because 2D images contain only one slice, the only option possible under 
Kernel Thickness in the Mean Filter dialog box is slice averaging—the Apply 
slice kernel option. The Apply volume kernel option, which performs 
volume averaging, is dimmed. However, both slice averaging and volume 
averaging are available for 3D images. Although slice averaging is the 
default value, users can choose volume averaging instead by selecting the 
Apply volume kernel option.

For slice averaging, the default kernel size is 3 x 3, but the following kernel 
sizes are available: 5 x 5, 7 x 7, 9 x 9, or 11 x 11. For volume averaging, the 
default kernel size is 3 x 3 x 3. However, you can select one of the following 
sizes instead: 5 x 5 x 5, 7 x 7 x7, 9 x 9 x 9, or 11 x 11 x 11. 

Figure 1.  Slice averaging

In slice averaging, MIPAV defines a region and replaces the target pixel value with the average value 
over the kernel of pixels in which the target pixel is at the center. 
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For color images the default is to obtain the means of the red, green, and 

blue channels. However, if users clear the Red channel, Green channel, or 
Blue channel check boxes, MIPAV only performs mean averaging on the 
color channels that are selected. 

Figure 2.  Image processing using the Mean algorithm

This figure depicts slice averaging and volume averaging applied to the whole 
image with various size kernels as noted.
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IMAGE TYPES

You can apply this algorithm to all image data types and to 2D, 2.5D, and 3D 
images.

SPECIAL NOTES

None.

REFERENCES

Refer to the following reference for more information about this algorithm:

Raphael C. Gonzalez and Richard E. Woods. Digital Image Processing, Second Edition 
(Upper Saddle River, New Jersey: Prentice-Hall, Inc., 2002), pp. 116–123.

Applying the Mean algorithm
To run this algorithm, complete the following steps:

1 Open an image. As an option, delineate a VOI.

2 Select Algorithms > Filter (spatial) > Mean. The Mean Filter dialog box 
(Figure 3) opens.

3 Complete the information in the dialog box.

4 Click OK.

The algorithm begins to run, and a pop-up window appears with the 
status. The following message appears: “Filtering image.” 

When the algorithm finishes running, the pop-up window closes, and 
the results either appear in a new window or replace the image to which 
the algorithm was applied.
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Kernel size Specifies the size of the k x k 
neighborhood that extends in all 
directions by (k - 1)/2 from the 
center pixel.

Red channel Applies the algorithm to the red 
channel.

Green channel Applies the algorithm to the 
green channel.

Blue channel Applies the algorithm to the 
blue channel.

New image Shows the results of the 
algorithm in a new image 
window.

Replace image Replaces the current active 
image with the newly calculated 
mean image.

Whole image Applies the algorithm to the 
whole image.

VOI regions Applies the algorithm to the volumes (regions) delineated by the VOIs.

Apply slice kernel Applies the kernel to only the specific slice in the dataset

Apply volume 
kernel

Applies the kernel to all of the slices—that is, the entire volume—in the 
dataset.

OK Applies the mean algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box.

Help Displays online help for this dialog box.

Figure 3.  Mean Filter dialog box
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Filters (Spatial): Median

The Median filter algorithm replaces a target pixel's value with the median 
value of the neighboring pixels. The designation of neighbor is determined 
by the size and shape of the kernel. A kernel is much like a mask; the pixels 
in the masked area are part of the neighborhood. The kernel's size and 
shape determines the number of pixel values used to calculate the median. 
You can adjust this algorithm's parameters to change the kernel's size and 
shape, apply selective filtering, and repetitively apply the selected filtering 
for any portion of the image you select.

The median filter algorithm is most useful for removing shot noise, which is 
noise that appears as random spots in an image. Shot noise can be caused 
by dust or a bad detector in image acquisition or by errors in data transfer 
(Lyon, Russ). Note that because there is no inverse function for the median 
filter algorithm, the original image cannot be reconstructed. This algorithm 
is also called a rank-type filter, because the list of values must be sorted 
before a useful value can be found.

For more information about the algorithm, refer to MIPAV Volume 2 User Guide 
on the MIPAV web site:{http://mipav.cit.nih.gov/} 

Background
When you apply the Median filter algorithm, the target pixel is identified 
and the values of the surrounding neighborhood are collected. Next, the 
system arranges the values of the target and neighborhood pixels in a list 
and sorts them; then it replaces the value of the target pixel with the list's 
median value (Figure 1). Given that the list has n items and n is an even 
number, the median is the item at n/2. When n is odd, the median is 
defined as an average of the items at position (n - 1)/2 and at position 
(n + 1)/2. 

Example: You cannot apply this algorithm if the target pixel is near the edge of 
a window. This algorithm is applied to all pixels in the kernel. If the target pixel, 
which is usually at the center of the kernel, is near the edge of the image 
window, the kernel probably contains undefined regions because the kernel is 
always symmetrical. Since the median filter algorithm cannot be calculated 
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reliably if the undefined regional data is present, if the target pixel is at the edge 
of the image, it is not processed.

Neighborhood pixels are determined by the shape and size of the kernel. 
(The selection of pixels using the kernel is sometimes referred to as the 
sliding window approach.) The most common kernel shapes are the square 
and cross. Square-shaped kernels are defined as all pixels in the k(k) 
region surrounding the target pixel, where k refers to the window size. 
Cross-shaped kernels are defined as the central row and column of the k(k) 
region. The kernel is usually centered on the target pixel and is symmetrical; 
pixels chosen are symmetrically located about the target pixel. Thus, pixels 
on opposite sides are equally weighted. The kernel varies in size, although 
commonly, a square kernel can range from 3 to 11 pixels per side. Other 
kernel shapes and sizes could be selected, but choosing the region of pixels 
to include always involves juggling the elimination of noise and increasing 
fuzziness and posterization of an image.

Pixel values are sorted in increasing order. Any sorting method is 
acceptable, although, because the number of pixels can be large, a fast 
sorting algorithm is preferable. The best sorting algorithm is one that can 
efficiently accommodate both small and large lists. Generally, when 
considering the number of items to sort, the numbers can range from 5 (in a 
3 x 3 cross) to 121 (in an 11 x 11 square). This algorithm implements the 
Shell-sort because it operates very efficiently for the sizes of the lists 
expected. 

Figure 1.  An example of median filter processing using a square 3 x 3 kernel
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As the kernel size increases, computation also increases. Because the 
median filter algorithm is already computationally intensive, this algorithm 
incorporates adaptive filtering to improve the responsiveness of the filter 
and to reduce the number of computations. Rather than using one specific 
method, adaptive filtering involves any number of novel approaches. A sim-
ple approach is to verify whether the target pixel is within some percentage 
of the median. This verifies that the pixel value is not outside the range of 
expected values of a pixel. For example, shot noise is generally a value that 
much larger or smaller than the average of the surrounding pixel values.  
Figure 2 illustrates how the median filter algorithm is used to remove shot 
noise. 

Filtering a color image is very similar to filtering a monochrome image. 
However, each color must be filtered separately because each color is a part 
of its own band or channel; each channel forms a monochrome image. This 
means that all red pixels are filtered, then all green, and then all blue, but 
never red and green pixels at the same time. Values in the alpha channel, 
which indicate pixel opacity levels, are not filtered.

Figure 2.  Removing shot noise with the Median Filter algorithm
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REFERENCES

See the following references for more information about this algorithm:

Douglas A. Lyon, Image Processing in Java, Upper Saddle River, New Jersey: Prentice-Hall, 
1999, pp: 201–214.

John C. Russ, The Image Processing Handbook, 3rd Edition Boca Raton, Florida: CRC 
Press, 1999, pp: 174–182.

Bernde Jahne, Practical Handbook on Image Processing for Scientific Applications, Boca 
Raton, Florida: CRC Press, 1997, pp: 331, 332.

IMAGE TYPES

You can apply this algorithm to color and gray-scale 2D, 2.5D, and 3D 
images. However, you cannot apply this algorithm to complex images.

SPECIAL NOTES

The following special notes apply:

• When this algorithm is applied to 3D datasets, you can apply the filter 
to either a single slice or volume kernel. If you choose to apply it to a 
volume kernel, MIPAV finds the median in a list of values from pixels 
in all directions along the x-, y-, and z-axes. Note that the kernel-size 
must be smaller than the number of slices in the image.

• The resultant image is, by default, a float image.

• An outlier detector is available for use in this algorithm. The outlier 
detector replaces the target pixel only if its magnitude exceeds the 
mean of the list by a user-inputted fraction of the standard deviation. 

• Currently the algorithm allows square and cross kernel shapes for 2D 
images and cube and axis kernel shapes for 3D images. Future plans 
include the addition of other kernel shapes.

• Color images may be filtered across any combination of the color 
channels (red, green, or blue). Alpha values—those values relating to 
how opaque a particular pixel is—are unaffected.
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Applying the Median Filter algorithm
To run this algorithm, complete the following steps:

1 Select Algorithms > Filter > Median Filter. The Median Filter dialog box  
(Figure 3) appears.

2 Complete the fields in the dialog box. Keep the following in mind:

• To filter a VOI region only, select the VOI and then select VOI 
Region(s). 

• Pixels that are too close to the edge of an image are not processed. 

• To apply a median filter to a color image, select the channels to 
filter. By default, MIPAV filters all three channels (red, green, and 
blue).

3 Click OK when complete. The algorithm begins to run. 

A pop-up window appears with the status, and the following message 
appears: “Filtering Image (Pass 1 of 1).” (Depending on what you 
entered in Number of iterations on the Median Filter dialog box, the 
number of passes varies.) When the algorithm finishes running, the 
pop-up window closes.

Depending on whether New image or Replace image was selected, 
results appear in a new window or replace the image to which the 
algorithm was applied. 
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Number of 
iterations

Indicates the number of times to 
filter the image with a median filter 
of the selected deviation, kernel 
size, and kernel shape.

Maximum 
standard 
deviation

The maximum allowable magnitude 
of the pixel value as a function of 
the standard deviation. The system 
replaces any pixel whose value is 
outside this function of the standard 
deviation from the mean of the 
neighborhood (as selected by the 
kernel-size and shape) by the 
median of the neighborhood. A 
value of 0.0 is equivalent to replac-
ing every pixel with the median of 
its neighborhood. A value of 1.0 
limits the filtering of the image. The 
system processes only target pixels 
whose values are greater than 1.0 
standard deviation from its neigh-
bors.

Kernel size A k x k region selects a 
neighborhood that extends in all 
directions by (k-1)/2, placing the 
target pixel in the center of the 
kernel.

Kernel shape Selects which pixels in the kernel size box are included as a part of the median’s 
neighborhood.

Kernel size 
adaptively 
changes

This checkbox indicates whether median filter should be run via adaptive filtering. 
Adaptive filtering has 3 main purposes: 

1. To remove salt-and-pepper (impulse) noise; 

2. To prove smoothing of other noise that may not be impulsive;

3. And to reduce distortion, such as excessive thinning or thickening of object 
borders.

Maximum 
Kernel Size

 This is the maximum kernel size that the window size can get increased to under 
the algorithm.

Red channel Filters the red channel (for use with RGB images).

Green 
channel

Filters the green channel (for use with RGB images).

Blue channel Filters the blue change (for use with RGB images).

Figure 3.  Median Filter dialog box 
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New image Indicates where the results of the algorithm appear. If you select this option, the 
results appear in a new image window.

Replace 
image

Indicates where the results of the algorithm appear. If you select this option, the 
results replace the current active image. 

Whole image Applies the algorithm to the whole image.

VOI 
region(s)

Applies the algorithm to the volumes (regions) delineated by the VOIs.

Apply slice 
kernel

Filters each slice of the image independently of other slices, finding neighboring 
pixels from the slice. 

Apply volume 
kernel 

Gathers pixel values from the slice as well as from neighboring slices.

OK Applies the Median algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes the dialog box.

Help Displays online help for this dialog box.

Figure 3.  Median Filter dialog box  (continued)
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Filters (Spatial): Mode

Mode filtering is a nonlinear spatial filtering technique that replaces a target 
pixel with the mode of neighboring pixels. The mode of a set of values is the 
value that occurs most frequently within the set. If all values are unique—
that is, all numbers occur only once in the set—the value of the target pixel 
stays the same. Mode filtering is similar in philosophy to median filtering.

Mode filtering is currently thought to be useful in filtering a segmented 
image to eliminate small clusters of pixels labeled one value that are 
completely within a large cluster of pixels of a different value. Mode filtering 
is currently being investigated in improving a C-means classification of 
brain images, which were first segmented using the brain extraction tool 
(BET). Mode filtering can be applied to grayscale images to remove some 
noise; however, a 3 x 3 x 3 cube kernel significantly blurs the image.

Background
When you apply the Mode algorithm, MIPAV identifies the target pixel and 
collects the values of the surrounding neighborhood. Next, it arranges the 
values of the target and neighborhood pixels in a list and sorts them. The 
value of the target pixel is replaced with the mode of the numbers in the list. 
Determining the mode of a sorted list of numbers is done in a single pass 
through the list by incrementing a count variable each time adjacent values 
are the same and maintaining the maximum count along with the 
corresponding value.

Neighborhood pixels are determined by the shape and size of the kernel. 
(The selection of pixels using the kernel is sometimes referred to as the 
sliding window approach.) The most common kernel shapes are the square 
and cross.

Square-shaped kernels are defined as all pixels in the k(k) region 
surrounding the target pixel, where k refers to the window size. Cross-
shaped kernels are defined as the central row and column of the k(k) region.

The kernel is usually centered on the target pixel and is symmetrical; pixels 
chosen are symmetrically located about the target pixel. Thus, pixels on 
opposite sides are equally weighted. The kernel varies in size, although 
commonly a square kernel can range from 3 to 11 pixels per side. Other 
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kernel shapes and sizes could be selected, but choosing the region of pixels 
to include always involves juggling the elimination of noise and increasing 
fuzziness and posterization of an image. 

Pixel values are sorted in increasing order. Any sorting method is 
acceptable, although, because the number of pixels can be large, a fast- 
sorting algorithms is preferable. The best sorting algorithm is one that can 
efficiently accommodate both small and large lists. Generally, when 
considering the number of items to sort, the numbers can range from 5 (in a 
3 x 3 cross) to 121 (in an 11 x 11 square). This algorithm implements the 
Shell-sort because it operates very efficiently for the sizes of the lists 
expected.

The left image in Figure 1 shows a segmented image that results after 
applying the C-means classification algorithm to a brain image produced 
with the brain extraction tool. The image on the right shows the result of 
applying the Mode filtering algorithm with a 3 x 3 x 3 local neighborhood to 
the image on the left. Clearly, the image on the right has fewer small isolated 
classes than the image on the left.

The Mode algorithm processes all pixels in the input image. The algorithm 
uses a symmetric neighborhood definition around the target pixel, resulting 
in border pixels, which require special processing. Border pixels correspond 
to those pixels where the neighborhood of a target pixel is incomplete. 
Incomplete neighborhoods occur:

• In-plane—In the corners of the image plane

• Through-plane—On the first and last (few) image planes

Figure 1.  Examples of (A) a segmented image and (B) the results of 
applying the Mode algorithm to the image
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In-plane border pixels are not filtered and the value assigned to the output 
pixel is simply the corresponding input value. Through-plane border pixels 
are filtered by duplicating the values of corresponding pixels on the target 
pixel plane.

IMAGE TYPES

You can apply this algorithm to 2D, 2.5D, and 3D images. Since the 
algorithm counts the number of pixels with the same value, it only allows 
the following list of data types.

• BYTE and UBBYTE

• SHORT and USHORT

• INTEGER and UINTEGER

NOTES

The resulting image is, by default, the same type as the input image.

REFERENCES

This algorithm was developed by members of the MIPAV team. Mode 
filtering is similar to median filtering, and to our knowledge there is not a 
significant amount of literature about the topic.

Applying the Mode algorithm
To run this algorithm, complete the following steps:

1 Open an image.

2 Select Algorithms > Filters (Spatial) > Mode. The Mode Filter dialog box 
(Figure 2) opens.

3 Complete the fields in the dialog box.

4 Click OK when complete. The algorithm begins to run.
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A pop-up window appears with the status.

When the algorithm finishes running, the pop-up window closes.

Depending on whether New image or Replace image was selected, 
results appear in a new window or replace the image to which the 
algorithm was applied.

Kernel size Specifies the size of the local 
neighborhood when performing mode 
filtering. A k x k region selects a 
neighborhood that extends in all 
directions by (k - 1)/2 placing the 
target pixel in the center of the kernel. 
Kernels for 2D images are odd valued 
and include 3 x 3, 5 x 5, 7 x 7, and so 
on.

Kernel shape Selects which pixels in the kernel size 
box are included as a part of the 
mode’s neighborhood.

New image Indicates where the results of the 
algorithm appear. If you select this 
option, the results appear in a new 
image window.

Replace image Indicates where the results of the 
algorithm appear. If you select this 
option, the results replace the current 
active image.

Whole image Applies the algorithm to the whole image.

VOI region(s) Applies the algorithm to the volumes (regions) delineated by the VOIs.

Apply slice 
kernel

Filters each slice of the image independently of other slices, finding neighboring 
pixels from the slice.

Apply volume 
kernel

Gathers pixel values from the slice as well as from neighboring slices. 

Figure 2.  Mode Filter dialog box
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OK Applies the Mode filtering algorithm according to the specifications in this dialog 
box.

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box.

Help Displays online help for this dialog box.

Figure 2.  Mode Filter dialog box (continued)
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Filters (Spatial): Nonlinear Noise Reduction

This algorithm provides a port of the SUSAN (Smallest Univalue Segment 
Assimilating Nucleus) low-level image processing program.  

For information about SUSAN, see http://www.fmrib.ox.ac.uk/~steve.

SUSAN noise reduction uses nonlinear filtering to reduce noise in an image 
while preserving both the underlying structure and the edges and corners. It 
does this by averaging a voxel only with local voxels that have similar 
intensity.

For more information about the algorithm, refer to the MIPAV web site:{http://
mipav.cit.nih.gov/documentation/HTML%20Algorithms/
FiltersSpatialNonlinearNoiseReduction.html}.

Background
The SUSAN program compares the brightness of each pixel within a mask 
with the brightness of the mask's nucleus. It then defines an area of the 
mask, called the univalue segment assimilating nucleus (USAN), that has 
the same or similar brightness as the nucleus. The USAN filter takes an 
average of the pixels in the USAN and then uses a Gaussian in both the 
brightness and spatial domains.

Table 1 explains the possible responses that the USAN filter provides if it 
cannot determine the neighborhood and based on whether you selected the 
option of using the median.

Table 1. Possible responses of the SUSAN filter

Use median USAN area The SUSAN filter . . .

Selected Zero Uses the median of the pixel’s 8 nearest neighbors in 2D 
images or 26 nearest neighbors in 3D images to estimate the 
pixel’s correct value.

Selected Nonzero Uses sums taken over the local neighborhood, not including 
the center pixel itself, to estimate the pixel’s correct value. 
This allows good reduction of impulse noise.
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In 2D images, the algorithm is based on the following equation: 

where

R = replacement intensity

I = intensity

S = spatial Gaussian

B = brightness Gaussian

sdx = mask standard deviation/image x resolution

sdy = mask standard deviation/image y resolution

T = brightness threshold

The brightness threshold allows discrimination between noise and the 
underlying image. Ideally, this value should be set greater than the noise 
level and less than the contrast of the underlying image. The filter blurs 
edges of contrast smaller than this threshold but not those of greater 
contrast. Reducing the brightness threshold gives less smoothing. The 
brightness threshold has a default value = 0.1 * (image maximum – image 
minimum).

The mask standard deviation (SD) determines the spatial extent of the 

Not selected Nonzero Uses sums taken over the local neighborhood including the 
center pixel to estimate the pixel’s correct value.

Not selected Zero Leaves the pixel unchanged.

Table 1. Possible responses of the SUSAN filter
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smoothing. The mask is basically Gaussian with a standard deviation that 
you specify. However, for a small, fast, flat response with a 3 x 3 or 3 x 3 x 3 
voxel mask, set the mask SD to 0. By default, the mask SD equals the x 
resolution.

This filter can process a 3D image as an entire indivisible unit or as separate 
independent slices. Refer to Figure 1 for an example of image processing 
using the Nonlinear Noise Reduction algorithm.

 

IMAGE TYPES 

You can apply this algorithm to black-and-white 2D, 2.5D, and 3D images.

SPECIAL NOTES

None.

REFERENCES

Refer to the following references for more information:

Figure 1.  Image processing using the Nonlinear Noise Reduction 
algorithm
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For information about SUSAN, see http://www.fmrib.ox.ac.uk/~steve.

S. M. Smith and J. M. Brady, “SUSAN—A New Approach to Low Level Image Processing,” 
International Journal of Computer Vision, Vol. 23, No. 1, May 1997, pp. 45-78.
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Applying the Nonlinear Noise Reduction algorithm
To run this algorithm, complete the following steps:

1 Open an image.

2 Select Algorithms > Filter (spatial) > Nonlinear noise reduction. The 
Nonlinear Noise Reduction dialog box (Figure 2) opens.

3 Complete the information in the dialog box.

4 Click OK. The algorithm begins to run. 

A pop-up window appears with the status. The following message 
appears: “Performing the nonlinear noise reduction.” When the 
algorithm finishes running, the pop-up window closes. 

Depending on whether you selected New image or Replace image, the 
results appear in a new window or replace the image to which the 
algorithm was applied.

Brightness 
threshold

Blurs edges of contrast 
smaller than this threshold. 
Reducing the brightness 
threshold gives less 
smoothing. The default value 
is 0.1 * (image maximum - 
image minimum).   

Mask Gaussian SD 
(0 for flat 
response) mm 

Determines the spatial extent 
of the smoothing (the default 
value is equal to the X 
resolution). For a small, fast, 
flat response with a 3 x 3 or 3 
x 3 x 3 voxel mask, set the 
mask SD to 0. 

Use median when 
neighborhood not 
found

Refer to Table 1 on page 279 
for an explanation. By 
default, this check box is 
selected.

Process each slice 
independently 

Smooths each slice of the dataset independently (applies only to 3D images).

New image Shows the results of the algorithm in a new image window (default choice).

Replace image Replaces the current active image with the newly calculated image.

OK Applies the algorithm according to the specifications in this dialog box.

Figure 2.  Nonlinear Noise Reduction dialog box 
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Cancel Disregards any changes that you made in the dialog box and closes the 
dialog box.

Help Displays online help for this dialog box.

Figure 2.  Nonlinear Noise Reduction dialog box  (continued)
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Filters (Spatial): Nonmaximum Suppression

This algorithm defines the edges of an image by calculating the 
nonmaximum suppression of an image at a user-defined scale. An edge is 
defined as the union of points for which the gradient magnitude assumes a 
maximum in the gradient direction.

For more information about the algorithm, refer to the MIPAV web site: {http://
mipav.cit.nih.gov/documentation/HTML%20Algorithms/
FiltersSpatialNonmaximumSuppression.html}. 

Background
The Nonmaximum Suppression algorithm uses a local orthonormal 
coordinate system (u,v) at any point (Pi), where the v axis is parallel to the 
gradient direction at Pi, and the u axis is perpendicular, and where I is the 
intensity value of the pixel.
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Assuming that the second- and third-order directional derivatives of I in the 
v direction are not simultaneously zero, a necessary and sufficient condition 
for Pi to be a gradient maximum in the gradient direction may be stated as:

Since only the sign information is important, this condition can be restated 
as:
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The nonmaximum suppression is the following:

Edge detection is an option for 2D images, but not for 2.5D or 3D images. If 
edge detection is selected, MIPAV generates an unsigned byte image in 
which the value of the edges is 255 and of all other points is 0. The 
nonmaximum suppression data must always be scaled to the same range, so 
the same noise threshold values always have the same meaning. For edge 
detection, the nonmaximum suppression data is scaled by 20,000.0/(image 
maximum – image minimum). We must not use a linear transformation, 
which shifts positive to negative or negative to positive.

If noise threshold is used, MIPAV sets scaled nonmaximum suppression 
values >= low threshold and <= high threshold equal to zero. It considers 
groups of four scaled, noise thresholded, nonmaximum suppression values, 
which intersect at one common corner. MIPAV records an edge value of 255 
only if at least one of these four modified nonmaximum suppression values 
is negative, at least one of these four modified nonmaximum suppression 
values is positive, and the upper left-hand pixel of the group has a value of 

. 

For 3D images a similar derivation follows:

where spherical coordinates are being used.

 

The nonmaximum suppression is:
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If you select VOI regions in the image, then the nonmaximum suppression 
image always contains the original source image values in regions outside 
the VOIs.

If Use image resolutions to normalized z scale is selected, then the z scale is 
multiplied by the image x resolution/image z resolution, so that the z scale 
is normalized to be the same as the x scale.
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IMAGE TYPES

The nonmaximum suppression image can be generated from 2D, 2.5D, and 
3D black-and-white images. However, the option to output an edge image is 
only available for black-and-white 2D images.

SPECIAL NOTES

None.

REFERENCES

Refer to the following reference for more information about this algorithm:

Lindeberg, Tony, and Bart M. ter Haar Romeny, Chapter 2, “Linear Scale-Space II: Early 
Visual Operations,” in Geometry-Driven Diffusion in Computer Vision, ed. Bart M. ter Haar 
Romeny (Dordrecht, The Netherlands: Kluwer Academic Publishers, 1994) p. 45.

Figure 1.  Examples of Nonmaximum Suppression processing
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Applying the Nonmaximum Suppression algorithm
To run this algorithm, complete the following steps:

1 Open an image.

2 Perform, as an option, any other image processing, such as improving 
the contrast, on the image.

3 Select Algorithms > Filter (spatial) > Nonmaximum suppression. The 
Nonmaximum suppression dialog box (Figure 2) opens.

4 Complete the information in the dialog box.

5 Click OK. The algorithm begins to run. 

A pop-up window appears with the status. The following message 
appears: “Calculating the Nonmaximum suppression.”

When the algorithm finishes running, the pop-up window closes. 
Depending on whether you selected New image or Replace image, the 
results appear in a new window or replace the image to which the 
algorithm was applied.

Note: For 2D images, if you selected Output edge image, a new window with an 
edge image appears.
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X dimension Indicates the scale of the Gaussian 
in the X direction (the default value 
is 1.0).

Y dimension Indicates the scale of the Gaussian 
in the Y direction (the default value 
is 1.0).

Z dimension Indicates the scale of the Gaussian 
in the Z direction (for 3D images 
only). The default value is 1.0. 

Use image 
resolutions to 
normalize Z 
scale

Normalizes the Z scale to 
compensate for the difference if the 
voxel resolution in distance per 
pixel is greater between slices than 
the voxel resolution in-plane (for 
3D images only, the default value is 
enabled). 

If enabled, then  where 

Z = scale Z, XRs = image X 
resolution, and ZRs = image Z 
resolution). 

Process each 
slice 
independently

Calculates nonmaximum suppression for each slice of the dataset independently 
(for 3D images only the default value is enabled).

New image Shows the results of the algorithm in a new image window (default choice). If 
selected, an output edge image appears in a second new window.

Replace image Replaces the current active image with the results of the algorithm.

Whole image Applies the algorithm to the whole image (default choice).

VOI region(s) Applies the algorithm inside VOIs. Outside VOIs, the pixel values are unchanged.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made iin the dialog box and closes this dialog 
box.

Help Displays online help for this dialog box.

Figure 2.  Nonmaximum Suppression dialog box 
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Filters (Spatial): Regularized Isotropic 
(Nonlinear) Diffusion

Regularized isotropic nonlinear diffusion is a specific technique within the 
general classification of diffusion filtering. Diffusion filtering, which 
models the diffusion process, is an iterative approach of spatial filtering in 
which image intensities in a neighborhood are utilized to compute new 
intensity values. 

Two major advantages of diffusion filtering over many other spatial domain 
filtering algorithms are:

• A priori image information can be incorporated into the filtering 
process

• The iterative nature of diffusion filtering allows for fine-grain control 
over the amount of filtering performed.

There is not a consistent naming convention in the literature to identify dif-
ferent types of diffusion filters. This documentation follows the approach 
used by Weickert. Specifically, since the diffusion process relates a concen-
tration gradient with a flux, isotropic diffusion means that these quantities 
are parallel. Regularized means that the image is filtered prior to comput-
ing the derivatives required during the diffusion process. In linear diffusion 
the filter coefficients remain constant throughout the image, while nonlin-
ear diffusion means the filter coefficients change in response to differential 
structures within the image.

For more information about the algorithm, refer to the MIPAV web site: {http://
mipav.cit.nih.gov/documentation/HTML%20Algorithms/
FiltersSpatialRegularizedIsotropicDiffusion.html}. 
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Chapter 2, Using MIPAV Algorithms: Filters (Spatial): Regularized Isotropic (Nonlinear)
Diffusion
Background

All diffusion filters attempt to determine the image  that solves the 

diffusion equation, which is a second-order partial differential defined as

where

=The time derivative of the image

div=The divergence operator

D=The diffusion tensor (which may be a scalar value)

=The gradient of the image

The quantity that distinguishes different diffusion filters is primarily the 
diffusion tensor, which is also called the diffusivity.

In homogeneous linear diffusion filtering, the diffusivity, D, is set to 1, and 
the diffusion equation becomes:

In isotropic nonlinear diffusion filtering, the diffusivity term is a 
monotonically decreasing scalar function of the gradient magnitude squared, 
which encapsulates edge contrast information. In this case, the diffusion 
equation becomes:

One useful diffusivity function is:

In this equation  is called a diffusion constant, which defines the point of 
inflection of the diffusivity function, which is shown for  in 
Figure 1.
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Chapter 2, Using MIPAV Algorithms: Filters (Spatial): Regularized Isotropic (Nonlinear)
Diffusion
Figure 1 shows that, for a given value of the diffusion constant , the larger 
the values of the image gradient, the smaller the value of the diffusivity 
function. Therefore, large values of the gradient, indicating the presence of 
an edge, the smaller the amount of diffusion. As the image gradient varies 
over the image, so does the amount of diffusion, which is why this is called 
an isotropic nonlinear diffusion filter.

It is well known that derivative operations performed on a discrete grid are 
an ill-posed problem, meaning derivatives are overly sensitive to noise. To 
convert derivative operations into a well-posed problem, the image is low-
pass filtered or smoothed prior to computing the derivative. Regularized 
isotropic (nonlinear) diffusion filtering is formulated the same as the 
isotropic nonlinear diffusion detailed above; however, the image is 
smoothed prior to computing the gradient. The diffusion equation is 
modified slightly to indicate regularization by including a standard 
deviation term in the image gradient as shown in the following equation:

The smoothing to regularize the image is implemented as a convolution 
over the image and therefore this filter is a linear operation. Since 
differentiation is also a linear operation, the order of smoothing and 
differentiation can be switched, which means the derivative of the 
convolution kernel is computed and convolved with the image, resulting in 
a well-posed measure of the image derivative.

Figure 1.  Diffusion constant for λ 0.15=

λ

∂tI div D ∇Iσ
2

⎝ ⎠
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MIPAV User’s Guide, Volume 2, Algorithms 294

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Filters (Spatial): Regularized Isotropic (Nonlinear)
Diffusion
The images in Figure 2 show the results of applying the regularized 
isotropic (nonlinear) diffusion filter to an example MR brain image.

 

IMAGE TYPES

You can apply this algorithm to all data types except complex and to 2D, 
2.5D, and 3D images.

SPECIAL NOTES

The resulting image is, by default, a float image.

REFERENCES

Refer to the following references for more information about diffusion 
filtering in general and this algorithm in particular.

Weickert, Joachim. “Nonlinear Diffusion Filtering,” in Handbook of Computer Vision and 
Applications, Volume 2, eds. Bernd Jahne, Horst Haussecker, and Peter Geissler. (Academic 
Press, April 1999), 423–450.

Weickert, Joachim. Anisotropic Diffusion in Image Processing (Stuttgart, Germany: 
Teubner, 1998).

Figure 2.  Examples of regularized isotropic (nonlinear) diffusion
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Diffusion
Applying the Regularized Isotropic (Nonlinear) 
Diffusion algorithm

To run this algorithm, complete the following steps:

1 Select Algorithms > Filter > Regularized Isotropic Diffusion. The 
Regularized Isotropic Diffusion dialog box opens (Figure 3).

2 Complete the fields in the dialog box.

3 When complete, click OK. 

The algorithm begins to run, and a status window appears. When the 
algorithm finishes, the resulting image appears in a new image window.

 

Number of 
iterations

Specifies the number of iterations, or 
number of times, to apply the algorithm 
to the image.

Gaussian 
standard 
deviation

Specifies the standard deviation of the 
Gaussian filter used to regularize the 
image.

Diffusion 
contrast 
parameter

Specifies the inflection point in the 
diffusivity function, which dictates the 
shape of the function.

Process each 
slice separately

Applies the algorithm to each slice 
individually. By default, this option is 
selected.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box.

Help Displays online help for this dialog box.

Figure 3.  Regularized Isotropic Diffusion dialog box  
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Filters (Spatial): Slice Averaging

This algorithm provides a way of reducing image noise by summing 
together a set of noisy images and dividing the sum by the number of 
images. The algorithm assumes that the noise in the images is 
uncorrelated and has zero average value. 

For more information about the algorithm, refer to the MIPAV web site: {http://
mipav.cit.nih.gov/documentation/HTML%20Algorithms/
FiltersSpatialSliceAveraging.html}. 

Background
This algorithm averages together the slices of a 3D image. The average used 
here is:

Mean = sum of values / total number of values

If you select All as the number of slices averaged: 

If you select 3, 5, or 7 as the number of slices averaged:

where

A = slice average

LSN = last slice number

lowest = maximum (1, z - offset)

A x y,( )

value x y s, ,( )

s 1=

s LSN=

∑

LSN
------------------------------------------------------=

A x y z, ,( )

value x y s, ,( )

s lowest=

s highest=

∑

highest lowest 1+–( )
---------------------------------------------------------------=
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highest = minimum (last slice number, z + offset)

offset = (number of slices averaged -1)/2
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Chapter 2, Using MIPAV Algorithms: Filters (Spatial): Slice Averaging
The preceeding equations prevent the inclusion of slice numbers less than 
the first slice number or greater than the last slice number in the averaging 
equation. 

Note: When averaging on the first slice with an averaging Number = 7, only 
include the first slice and the three slices above it in the averaging. When 
averaging on the last slice with averaging Number = 5, only include the last slice 
and the two slices below it in the averaging.

Under Slice Number, the default choice is All. If All is chosen, MIPAV 
creates a 2D image. If 3, 5, or 7 are chosen, then a 3D image is created. 

Because a 2D image cannot meaningfully replace a 3D image, if you select 
All, you can only choose New image. However, if you select 3, 5, or 7 as the 
number of slices, New image is the default choice, although you can select 
either New image or Replace image.
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IMAGE TYPES

You can apply this algorithm to all image data types and to 2D, 2.5D, and 3D 
images.

Figure 1.  Slice Averaging algorithm processing
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SPECIAL NOTES

None.

REFERENCES

Refer to the following for more information about this algorithm:

Raphael C. Gonzalez and Richard E. Woods. Digital Image Processing, Second Edition 
(Upper Saddle River, New Jersey: Prentice-Hall, Inc., 2002), pp. 119–123.

Applying the Slice Averaging algorithm
To run this algorithm, complete the following steps:

1 Open an image.

2 Select Algorithms > Filter (spatial) > Slice Averaging. The Slice 
Averaging dialog box (Figure 2) opens.

 

3 Averages 3 slices in the dataset and 
creates a 3D image.

5 Averages 5 slices in the dataset and 
creates a 3D image.

7 Averages 7 slices in the dataset and 
creates a 3D image.

All Averages all of the slices in the 
dataset and creates a 2D image 
(default choice).

New image Shows the results of the algorithm in 
a new image window (default choice).

Replace 
image

Replaces the current active image 
with the newly calculated 
image.

OK Applies the algorithm according to the 
specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes the dialog box.

Figure 2.  Slice Averaging dialog box
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3 Complete the information in the dialog box.

4 Click OK.

The algorithms begins to run, and a pop-up window appears with the 
status. The following messages appear: “Averaging data” and 
“Importing average data.”

When the algorithm finishes running, the pop-up window closes, and 
the results appear either in a new window or replace the image in which 
the algorithm was applied.

Help Displays online help for this dialog box.

Figure 2.  Slice Averaging dialog box
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Filters (Spatial): Unsharp Mask

When applied to an image, this algorithm produces a sharpened version of 
the image or the volume defined by a VOI of the image. A high-pass filtered 
(unsharp masked) image can be calculated by taking the difference of the 
original image and the low-pass filtered (blurred) version of that image. 
The effect of a high-pass filter, like the unsharp mask technique, is to 
enhance sharp intensity transitions (i.e., edges) but at the cost of 
enhancing noise.

For more information about the algorithm, refer to the MIPAV web site: {http://
mipav.cit.nih.gov/documentation/HTML%20Algorithms/
FiltersSpatialUnsharpMask.html}.

Background
The process of unsharp masking is defined by:

High pass = original – low pass

To control the amount of filtering, a weighting factor (k) is  added to the 
function:

High pass = original – (k * blurred image) where 1> k > 0

Choosing a small value for k (i.e., 0.2) produces an image where a small 
amount of filtering is applied to the original image. Choosing a large value 
for k produces a highly filtered image. Recall that convolving a Gaussian 
function with an image produces a low-pass filtered image. The selection of 
the standard deviation of the Gaussian affects the results of the unsharp 
masked image. For example, a low-pass filtered image produced using a 
small standard deviation (i.e., a little blurring) produces an unsharp 
masked image that is filtered only a small amount (Figure 1). 
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SPECIAL NOTES

The following notes apply:

• If you choose to show the results of the algorithm in a new window, the 
resultant image is, by default, a float type image. If you choose the 
replace the current image, the image type remains the same.

• To achieve 2.5D processing (each slice of the volume is filtered 
independently) of a 3D dataset, select Process each slice independently 
(2.5D) in the Unsharp Mask dialog box (Figure 2).

REFERENCES

See the following references for more information about this algorithm:

Tony Lindeberg and Bart Ter Har Romeny, “Linear Scale-Space I: Basic Theory,” Geometry-
Driven Diffusion in Computer Vision, ed. Bart Ter Har Romeny ((Dordrecht, The 
Netherlands: Kluwer Academic Publishers, 1994), pp. 1–38.

Raphael C. Gonzalez and Richard E. Woods, Digital Image Processing (Boston: Addison 
Wesley, 1992), pp. 196–197.

Figure 1.  Unsharp Mask processing

(A) is the original image of retina of the eye, and (B) is the unsharp mask where 
k = 0.75 and the Gaussian SD = 1.0.
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IMAGE TYPES

You can apply this algorithm to all image data types, except complex and 
RGB images, and to 2D, 2.5D, 3D, and 4D images.

Applying the Unsharp Mask algorithm
To run this algorithm, complete the following steps:

1 Select Algorithms > Filter (spatial) > Unsharp mask.  The Unsharp 
Mask dialog box (Figure 2) opens.  

2 Complete the information in the dialog box.  

3 Click OK. 

The algorithm begins to run, and a pop-up window appears with the 
status.  The following message appears:  “Unsharp Masking Image.” 

When the algorithm finishes running, the pop-up window closes, and 
the results either appear in a new window or replace the image to which 
the algorithm was applied.
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X Dimension Specifies the standard 
deviation (SD) of Gaussian in 
the X direction.

Y Dimension Specifies the SD of Gaussian 
in the Y direction.

Z Dimension Specifies the SD of Gaussian 
in the Z direction.

Use image 
resolutions to 
normalize Z scale

Normalizes the Gaussian to 
compensate for the difference 
if the voxel resolution is less 
between slides than the voxel 
resolution in-plaine. This 
option is selected by default.

Process each slice  
independently 
(2.5D)

Filters each slice of the 
dataset independently of 
adjacent slices.

Image - (k<1) * 
blurred image

Determines the amount of 
filtering, or sharpening, 
applied to the edges of the 
image or a VOI of the image. 
Low values sharpen image 
edges but increase noise. The 
default value is 0.75.

New image Shows the results of the algorithm in a new image window.

Replace image Replaces the current active image with the results of the algorithm.

Whole image Applies the algorithm to the whole image.

VOI region(s) Applies the algorithm to the volumes (regions) delineated by the VOIs.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes the 
dialog box.

Help Displays online help for this dialog box.

Figure 2.  Unsharp Mask dialog box
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Filters (Wavelet): De-noising BLS GSM

The wavelet transform or wavelet analysis is a solution to overcome the 
shortcomings of the Fourier transform. In wavelet analysis, the modulated 
window is shifted along the signal, and for every position, the spectrum is 
calculated. Then, this process is repeated many times with a slightly 
shorter (or longer) window for every new cycle. In the end, the result 
appears as a collection of time-frequency representations of the signal, all 
with different resolutions. Since the modulated window is fully scalable, 
this  solves the signal-cutting problem which arises in the  Fourier 
transform.

Because the result appears as a collection of time-frequency representations 
of the signal, we can speak of a multiresolution analysis. However, in the 
case of wavelets, we normally do not speak about time-frequency 
representations, but about time-scale representations, scale being in a way 
the opposite of frequency, because the term frequency is reserved for the 
Fourier transform.

For more information about the algorithm, refer to MIPAV Volume 2 User Guide 
on the MIPAV web site:{http://mipav.cit.nih.gov/documentation/
HTML%20Algorithms/FiltersWaveletDenoising.html}

Background
This method is port of MATLAB BLS-GSM Image Denoising software 
written by Javier Portilla of Universidad de Granada, Spain. For more 
information, refer to <http://decsai.ugr.es/~javier/denoise/index.htm>.
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OUTLINE OF THE ALGORITHM

1 The image is expanded so that all dimensions are powers of 2. To avoid 
boundary artifacts the method uses zero mirror padding going past each 
original boundary by the coefficient number equals 2.

2 The image is transformed from the image domain to the wavelet 
domain. For more information about wavelets, refer to "Filters Wavelet 
Thresholding" Chapter of the MIPAV help.

3 In the wavelet domain the image is decomposed into pyramid subbands 
at different scales and orientations.

4 Each subbandis denoised, except for the low pass residual band, using 
one of four techniques provided by the method, see Denoising Bayesian 
Least Squares Gray Scale Mixture dialog box.

5 The pyramid transform is inverted, obtaining the denoised image.

6 The processed subbands are recomposed back into a single image.
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STEERABLE PYRAMID

The Steerable Pyramid is a linear multi-scale, multi-orientation image 
decomposition that provides a useful front-end for image-processing and 
computer vision applications. The basis functions of the steerable pyramid 
are directional derivative operators that come in different sizes and 
orientations. An example decomposition of an image of a white disk on a 
black background is shown in Figure 2 (Left). This particular steerable 
pyramid contains 4 orientation subbands, at 2 scales. The number of 
orientations may be adjusted by changing the derivative order (for example, 

Figure 1.  Application of the Filters wavelet BLS GSM algorithm to the noisy image
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first derivatives yield two orientations). The smallest subband is the 
residual lowpass information. The residual highpass subband is not shown. 

The block diagram for the decomposition (both analysis and synthesis) is 
shown in Figure 2 (Right). Initially, the image is separated into low and 
highpass subbands, using filters L0 and H0. The lowpass subband is, then 
divided into a set of oriented bandpass subbands and a low(er)-pass 
subband. This low(er)-pass subband is subsampled by a factor of 2 in the X 
and Y directions. The recursive construction of a pyramid is achieved by 
inserting a copy of the shaded portion of the diagram at the location of the 
solid circle (i.e., the lowpass branch). For more detailed descriptions see 
“References” on page 310.

REFERENCES

Refer to the following references for more information about the  
Thresholding algorithm. 

"Image Denoising Using Scale Mixtures of Gaussians in the Wavelet Domain", Javier 
Portilla, Vasily Strela, Martin J. Wainwright, and Eero P. Simoncelli, IEEE Transactions on 
Image Processing, Vol. 12. No. 11, November, 2003, pp. 1338-1351.

"The Steerable Pyramid: A Flexible Architecture for Multi-Scale Derivative Computation", 
Eero P. Simoncelli and William T. Freeman, 2nd IEEE International Conference on Image 
Processing, Washington, D.C., vol. III, pp. 444-447, October, 1995.

IMAGE TYPES

This algorithm only applies to 2D black and white images.

Figure 2.   Left: an example of decomposition of an image of a white disk 
on a black background; Right: the block diagram for that decomposition
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Applying the Wavelet BLS GSM algorithm
To use this algorithm, do the following:

7 Open an image of interest.

8 Navigate to Algorithms > Filters (wavelet) > Denoising BLS GSM.

9 The Denoising Bayesian Least Squares Gray Scale Mixture dialog box 
appears.

10 Complete the dialog box. For more information about the dialog box 
options, refer to Denoising Bayesian Least Squares Gray Scale Mixture 
dialog box.

11 Specify where you wish the denoised image to appear - in a new image 
frame or in the same frame replacing the existing image.

12 Press OK.

13 The algorithm begins to run and the progress window appears with the 
status. When the algorithm finishes running, the denoised image 
appears in the designated image frame.

Denoising Bayesian Least Squares Gray Scale Mixture

Orthogonal 
wavelet

This is very fast technique, but of relatively poor denoising performance, 
because it is not translation invariant. For the Orthogonal wavelet technique 
the following filter options available:

• Daubechies 2,3,4

• Haar

• Quadrative Mirror Filter 5, 8, 9, 12, 13, 16

Numbers after the filter name refer to a highest number A of vanishing 
moments for given support width N=2A used in the filter.

Figure 3.  Wavelet Thresholding dialog box
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Undecimated 
version of 
orthogonal 
wavelet

This is a highly redundant 
version of the orthogonal 
wavelet that avoids intra-
subband aliasing, but still 
keeps a multiscale structure. 
The lowest level of the pyramid 
is extended 2 times in each 
dimension, whereas the rest of 
the scales are extended 4 
times in each dimension. It 
provides a good trade-off 
between computational cost 
and denoising performance 
(which is very high).

The following filter options 
available: Daubechies 2,3,4.

Steerable Pyramid This option allows the user to 
specify an arbitrary number of 
orientations. The splitting in 
oriented subbands is not 
applied to the very high 
frequencies, which are 
represented in a single 
subband (high-pass residual). 

With a moderate computational cost, for a modest number of orientations, 
e.g. 4 or less (the default value is 8), its results depend on the type of 
image, and is comparable (or slightly worse) on average than those 
obtained with the Undecimated version of orthogonal wavelet option.

Full steerable 
pyramid

Same as steerable pyramid, but now also the very high frequencies are 
spitted into orientations. It provides very high denoising performance (for 
some images slightly better than undecimated orthogonal wavelet), 
especially with a high number of orientations (8, for example), but it is very 
demanding computationally.

Number of 
orientations

– enter a number of orientations that will be used in calculating steerable 
pyramid, the default value is 8.

Number of scales – enter a number of scales that will be used in calculating Orthogonal 
wavelet, Undecimated Orthogonal wavelet and Steerable Pyramid. The 
default value is 4.

Noise standard 
deviation

enter the noise standard deviation.

Use white noise – if selected, the algorithm uses white noise.

Use power 
spectral density 

– if selected, the algorithm uses power spectral density that equals FFT 
(autocorrelation). Otherwise, it uses white noise. The default setting is to 
use white noise.

Figure 3.  Wavelet Thresholding dialog box (continued)
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Local neighborhood X (odd number) Local 
neighborhood Y (odd number)

– in these boxes, specify the number 
of pixels in neighborhood clusters 
which will be used for processing 
subbands.

Use parent –if selected, this option process subbands in couples of the same 
orientation adjacent in scale. That is, include the coarse scale parent in the 
neighborhood. Otherwise, it process subbands individually. At high noise 
levels eliminating the coarse-scale parent from the neighborhood 
significantly decreases performance.

Use boundary  –if selected, the algorithm uses the Mirror reflected boundary padding.

Include 
covariance in GSM 
model 

– if selected, the algorithm includes covariance in calculating the GSM 
model.

Optimize –if selected, the algorithm uses the full Bayesian Least Squares estimator. 
Otherwise, it uses a two-step estimator (the MAP estimator of the local 
multiplier, followed by linear estimation of the coefficient). Using the two-
step estimator results in a substantial reduction in performance.

New image Shows the results of the algorithm in a new image window (default choice).

Replace image Replaces the current active image with the newly calculated image.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.

Figure 3.  Wavelet Thresholding dialog box (continued)
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Filters (Wavelet): Thresholding

The wavelet transform or wavelet analysis is a solution to overcome the 
shortcomings of the Fourier transform. In wavelet analysis, the modulated 
window is shifted along the signal, and for every position, the spectrum is 
calculated. Then, this process is repeated many times with a slightly 
shorter (or longer) window for every new cycle. In the end, the result 
appears as a collection of time-frequency representations of the signal, all 
with different resolutions. Since the modulated window is fully scalable, 
this solves the signal-cutting problem which arises in the Fourier 
transform.

Because the result appears as a collection of time-frequency representations 
of the signal, we can speak of a multi resolution analysis. However, in the 
case of wavelets, we normally do not speak about time-frequency 
representations, but about time-scale representations, scale being in a way 
the opposite of frequency, because the term frequency is reserved for the 
Fourier transform.

For more information about the algorithm, refer to MIPAV Volume 2 User Guide 
on the MIPAV web site:{http://mipav.cit.nih.gov/documentation/
HTML%20Algorithms/FiltersWaveletThresholding.html} 

Background
The most basic definition of a wavelet is simply a function with a well 
defined temporal support that twist about the X axis (the wavelet should 
have exactly the same area above and below the axis).
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For more information about wavelets, refer to EE482C: Advanced Computer 
Organization Stream Processor Architecture, Stanford University, Homework 
#1, April, 18, 2002, 1.1 What are Wavelets.

USING WAVELETS TO REDUCE THE NOISE IN 
IMAGES

Consider that the image intensities for a given image are specified in the 
standard univariate non parametric regression setting

where ei are independent N(0, 1) random variables and the noise level 

sigma may be known or unknown. The goal is to recover the underlying 
function g from the noisy data, Y = (y1, . . . , yn), without assuming any 

particular parametric structure for g, e.g. using the non parametric 
regression.

Assume that 

Figure 1.  Meyer wavelet

Yi = g(ti) + s *ei, i = 1, . . . , n, (EQ 1)
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• ti are within the unit interval [0, 1],

• the sample points are equally spaced, i.e. ti = i/n, 

• and the sample size n is a power of two: n = 2j for some positive 
integer J. 

All these assumptions can be done without loss of generality and allow to 
perform both the discrete wavelet transform (DWT) and the inverse discrete 
wavelet transform (iDWT) using the Mallat's fast algorithm.

One of the basic approaches to non parametric regression is to consider the 
unknown function g expanded as a generalized Fourier series, and then to 
estimate the generalized Fourier coefficients from the data. This method 
applies the same generalized Fourier series approach using a wavelet series.

Since the DWT of white noise is also an array of independent N(0, 1) 
random variables, from Equation 1 follows that

where 

 are respectively the empirical scaling and the empirical wavelet coefficients 
of the noisy data Y, and epsilonjk are independent N(0, 1) random variables. 

The scaling coefficients 

represent low-frequency terms that usually contain important components 
about the underlying function g.

The method assumes that essentially only a few large djk or vanishing 

moments contain information about the underlying function g, while small 
djk can be attributed to the noise which uniformly contaminates all wavelet 

coefficients. This allows to keep only large coefficients and set all others to 
zero, which gives us approximate wavelet representation of the underlying 
function g.

(EQ 2)

ĉj0k and d̂jk

ĉj0k
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To decide which the significant large wavelet coefficients are, the method 
uses the hard and soft threshold algorithms.

WAVELET THRESHOLDING

First, we assume that the smoothness index sigma of the function g (which 
is the function to be recovered) is known, so the resulting estimator can be 
obtained by estimating the scaling coefficients cj0k by their empirical 

counterparts 

 and by estimating the wavelet coefficients djk via a linear shrinkage

Where lambda > 0 is a smoothing parameter.

In some thresholding methods the smoothing parameter lambda is used to 
determine those wavelet coefficients which contribute the most to the 
function g by thresholding them in a way where wavelet coefficients are set 
to zero if their absolute value is below a certain threshold level, lambda 
more or equal to 0.

The following thresholding techniques are implemented in the method:

• Hard thresholding

• Soft thresholding

• Nonnegative garrote thresholding

• SCAD thresholding

In hard thresholding, a wavelet coefficient whose magnitude is below 
the product of threshold and the maximum wavelet magnitude is zeroed, 
and a wavelet coefficient whose magnitude is greater than or equal to the 
product is left unchanged. See Equation 4.

(EQ 3)

ĉj0k
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In soft thresholding, a wavelet coefficient whose magnitude is below the 
product of threshold and the maximum wavelet magnitude is zeroed, and a 
wavelet coefficient whose magnitude is greater than or equal to the product 
has its magnitude decreased by the product. See Equation 15.

Thresholding allows the data itself to decide which wavelet coefficients are 
significant; hard thresholding is a discontinuous function, which employs a 
keep or kill rule, while soft thresholding is a continuous function that uses a 
shrink or kill rule. However, the signal reconstructed with the coefficients 
left after hard thresholding may have undesirable artifacts including side 
lobes. Therefore, two more thresholding techniques are implemented:

The nonnegative garrote thresholding is as follows

And the SCAD thresholding is as follows

(EQ 4)

(EQ 5)

(EQ 6)

(EQ 7)
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ZERO PADDING

Because the wavelet transform is mathematically defined only within a 
signal, the boundary problem arises. To solve that problem the method uses 
the zero image padding technique. The image is expanded so that all 
dimensions are powers of 2 and there is zero padding going past each 
original boundary by the coefficient number - 2.

OUTLINE OF THE ALGORITHM

The image is expanded so that all dimensions are powers of 2 and there is 
zero padding going past each original boundary by the coefficient number 
equals 2. 

1 The image is transformed into wavelet coefficients using the threshold 
type selected by the user.

2 The signal reconstructed from wavelet coefficients.

3 Then, an inverse wavelet transform is performed.

4 The image is stripped down to its original size. The data is clamped so as 
not to exceed the bounds of the data type of the image into which it is 
imported.

Note: the forward and inverse Daubechies wavelet transform routines are taken 
from Numerical Recipes in C, The Art of Scientific Computing 2nd edition by 
William H. Press, Saul A. Teukolsky, William T. Vetterling, and Brian P. Flannery, 
Cambridge University Press, 1997, Chapter 13.10, pp. 591   606. 

REFERENCES

Refer to the following references for more information about the 
Thresholding algorithm. 

Numerical Recipes in C The Art of Scientific Computing, 2nd edition, by William H. Press, 
Saul A. Teukolsky, William T. Vetterling, and Brian P. Flannery, Cambridge University Press, 
1997, Chapter 13.10, pp. 591 - 606. 
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 “Empirical Evaluation of Boundary Policies for Wavelet-based Image Coding” by Claudia 
Schremmer, Book Series Lecture Notes in Computer Science, Springer Berlin / Heidelberg, 
ISSN0302-9743 (Print) 1611-3349 (Online) January 01, 2001.

Wavelet Estimators in Nonparametric Regression: A Comparative Simulation Study by 
Anestis Antoniadis, Jeremie Bigot, Theofanis Sapatinas, Journal of Statistical Software, 
American Statistical Association, Vol. i06, 2006 http://www.jstatsoft.org/v06/i06.

Advanced Computer Organization Stream Processor Architecture, Homework #1, Stanford 
University, http://cva.stanford.edu/classes/ee482s/homework/hw1.pdf.
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IMAGE TYPES

2D and 3D black and white images.

Figure 2.   The sample images after applying the Filers Wavelet 
Threshold algorithm. All options were applied with the default dialog 
box settings which are Number of terms =4, Wavelet threshold=1.0E-4
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Applying the Wavelet Thresholding algorithm
To use this algorithm, do the following:

1 To apply the algorithm, do the following: 

2 Open an image of interest.

3 Navigate to Algorithms > Filters Wavelet > Thresholding.

4 In the Wavelet Thresholding dialog box that appears, complete the 
following fields:

• In the Number of Terms list box, select 4, 12 or 20. Numbers of 
Terms here means the number of wavelet vanishing moments or an 
approximation order;

• In the Wavelet Threshold box, specify the threshold value;

• To specify the threshold type, use the radio buttons: Hard, Soft, 
Nonnegative garrote, and SCAD;

• To display the log magnitude wavelet image, check the 
corresponding box. Displaying this image will help you to adjust the 
algorithm settings;

• Select the destination, use the New Image option to view the result 
image in a new frame, or use the Replace Image option o view the 
result image in the same frame.

5 Press OK. The algorithm begins to run and the new image appears in the 
specified frame. 
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Number of terms – this is the number of wavelet 
vanishing moments or an approximation 
order. Select 4, 12 or 20.

Wavelet threshold – use to specify the threshold value

Hard

Soft

Nonnegative 
garrote

SCAD

– use these radio buttons specify the 
threshold type.

Display log 
magnitude 
wavelet image

– check this box to display the log 
magnitude wavelet image. Displaying 
this image will help you to adjust the 
algorithm settings.

New image use this to view the result image in a 
new frame.

Replace image use this to view the result image in the same frame.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.

Figure 3.  Wavelet Thresholding dialog box
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Figure 4.  Applying the Wavelet Thresholding algorithm
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Fuzzy C-Means: Multispectral and Single Channel 
Algorithms

Segmentation involves dividing an image into distinct classes or types. For 
example, researchers may segment the brain into three classes: gray matter, 
white matter, and cerebrospinal fluid. There are two types of segmentation: 
hard and soft, or fuzzy.

HARD SEGMENTATION

A pixel is assigned to only one class. In medical images, absolute 
classification of a pixel is often not possible because of partial volume effects 
where multiple tissues contribute to a pixel or because a voxel causes 
intensity blurring across boundaries.

SOFT, OR FUZZY, SEGMENTATION

This type allows for the uncertainty in the location of object boundaries. In 
fuzzy segmentation, a membership function exists for each class at every 
pixel location. At each pixel location a class membership function has the 
value of zero if the pixel does not belong to the class. At each pixel location a 
class membership function has a value of 1 if the pixel belongs, with 
absolute certainty, to the class. Membership functions can vary from 0 to 1, 
with the constraint that at any pixel location the sum of the membership 
functions of all the classes must be 1. The fuzzy membership function 
reflects the similarity between the data value at that pixel and the value of 
the class centroid. As a pixel data value becomes closer to the class centroid, 
the class membership function approaches unity. 

Background
The Fuzzy C-Means algorithm is an unsupervised method. That is, it works 
without the use of a specialized set of data for determining parameters of an 
algorithm. This algorithm, which allows for fuzzy segmentation based on 
fuzzy set theory, generalizes the K-Means algorithm. The technique clusters 
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data by iteratively computing a fuzzy membership function and mean value 
estimate for each tissue class. The algorithm minimizes the sum over all 
pixels j and all classes k of:

where

ujk is the membership value at pixel location j for class k such that the 

sum over k from k = 1 to k =C (nClass) for ujk = 1. 

q is a weighing exponent on each membership value and determines 
the amount of “fuzziness” of the resulting segmentation. q must be 
greater than 1, is typically set to 2. 

yj is the observed single channel or multispectral image intensity at 

location j. 

vk is the centroid of class k

C is a number of classes (nClass)

Users provide initial centroid values or simply use default evenly spread 
pixel values generated by:

for (i = 0; i < nClass; i++)

centroid[i] = minimum + (maximum - minimum)*(i + 1)/(nClass + 1);

Minimization is achieved by an iterative process that performs two 
computations. First, the minimization process computes the membership 
functions using a current estimate of the centroids. 

In the single channel case (select Algorithms > Segmentation > Fuzzy C-
means > Single channel in the MIPAV window):

The minimization process also computes the centroids using current 

(EQ 1)

(EQ 2)
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estimates of the membership functions. 

In the single channel case:

In the multispectral case:

where summation is over all classes k and all images s

The iteration continues until the user-specified maximum number of 
iterations occurs or until convergence is detected. Convergence occurs when 
all membership functions over all pixel locations j change by less than the 
tolerance value between two iterations. The default maximum iteration 
number is 100 for the single channel case and 200 for the multispectral 
case. The default tolerance is 0.01.

After entering the parameters for the algorithm in the Fuzzy C-Means dialog 
box (Figure 3), researchers select one of three choices for the output images: 

• HARD ONLY

• FUZZY ONLY

• HARD & FUZZY BOTH 

Hard segmentation produces only one unsigned-byte output image. Pixels 
that do not meet threshold requirements are assigned the value of 0. The 
first class is assigned a value of 255/(nClass); the second class is assigned a 
pixel value of 2 x 255/(nClass), and so on. The last class has a value of 255. 

(EQ 3)

(EQ 4)
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Fuzzy segmentation produces one image, of the same type as the first source 
image, for every segmentation class. The membership function is scaled so 
that the minimum membership value scales to the first source image 
minimum value and the maximum membership value scales to the first 
source image maximum value. If boundary cropping is applied, all pixels 
outside the bounding box are assigned the minimum value of the first 
source image.

If researchers apply the multispectral version of the algorithm, they can add 
images to a list.

ADDING IMAGES TO THE LIST

To add an image to the list:

1 Click Load. The Open dialog box appears.

2 Select an image. 

If the following are true, MIPAV adds the image to the list:

• The image has the same dimensionality as the original image. 

• The length of each dimension is the same as that of the original 
image.

Otherwise, an error message appears. 

Removing images from the list
To remove an image from the list, click Remove. 

Note: You cannot remove the original image (the first image in the list) that was 
present at the time you selected Algorithms > Fuzzy C-means > Multispectral. 
The Remove Image button is only enabled (active) when at least two images are 
in the list. 

The multispectral case allows color images to be loaded. If the original 
image is color, then the initial dialog box includes, by default, three selected 
check boxes for red, green, and blue components. If the original image is not 
color, then the later loaded images cannot be color.
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With the single channel case, the signal threshold value is entered on the 
initial dialog box and the image centroids are entered on a later dialog box. 
The multispectral case does not have signal threshold on the initial dialog 
box. With the multispectral case, a later dialog box appears for every black-
and-white image or for every selected component of every color image and 
the signal thresholds and initial centroids are entered on these later dialog 
boxes.

IMAGE TYPES

The Fuzzy C-means algorithm runs on 2D and 3D datasets and can also be 
applied to RGB datasets. This algorithms cannot run to complex datasets. 

SPECIAL NOTES

None.

REFERENCES

Refer to the following references for more information about the Fuzzy C-
means algorithm.

Dzung L. Pham, Chenyang Xu, and Jerry L. Prince, “A Survey of Current Methods in Medical 
Image Segmentation,” Technical Report JHU/ECE 99–01 (Baltimore: Department of 
Electrical and Computer Engineering, The Johns Hopkins University, 2001). 

Alberto F. Goldszal and Dzung L. Pham, “Volumetric Segmentation,” Chapter 12 in 
Handbook of Medical Image Processing, (San Diego: Academic Press, 2000).

Dzung L. Pham and Jerry L. Prince, “Adaptive Fuzzy Segmentation of Magnetic Resonance 
Images,” IEEE Transactions on Medical Imaging, Vol. 18, No. 9, September 1999, pp. 737–
752.
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Applying the Fuzzy C-means algorithm
You can apply this algorithm on single images separately, or you can apply it 
on multispectral images.

Figure 1.  Fuzzy C-means algorithm processing
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ON SINGLE IMAGES

To run this algorithm, complete the following steps:

1 Start MIPAV if not already started. The MIPAV and the Output windows 
open.

2 Open an image. After a few moments, the image appears.

3 Select Algorithms > Fuzzy C-means > Multispectral. The Fuzzy C-means 
dialog box (Figure 2) opens.

4 Complete the fields. 

5 Click OK. 

The Threshold & Initial Centroids dialog box appears. 

By default, MIPAV determines the value of the initial centroids by result 
of the total number of intensities divided by the number of classes. To 
change the values, click OK. 

Number of 
desired 
classes

Indicates the number of groups into 
which the algorithm divides the 
dataset structures. 

By default, the number of desired 
classes is 3.

Desired 
exponent 
value

Determines the amount of "fuzziness" 
in the resulting segmentation. 

By default, the exponent value is 2.

End tolerance Indicates when convergence is 
reached. Generally, membership 
functions over all pixel locations 
change between iterations of the 
application of the fuzzy C-means 
algorithm. Convergence occurs if the 
change is equal to or less than the end 
tolerance level and when all 
membership functions over all pixel 
locations change by less than the 
tolerance value between two 
iterations. By default, the tolerance is 
0.01.

Figure 2.  Fuzzy C-Means dialog box for a single image 
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ON MULTISPECTRAL IMAGES

To run this algorithm, complete the following steps:

1 Start MIPAV if not already started. The MIPAV and the Output windows 
open.

2 Open an image. After a few moments, the image appears.

3 Select Algorithms > Fuzzy C-means > Multispectral. The Fuzzy C-means 
dialog box (Figure 3) opens.

4 Complete the fields. 

To add an image to the list, click Load and then select the image in the 
Open dialog box. The system then adds the image to the list and then, if 
it has the same dimensions as the original image, opens it in a new 
window. 

Maximum 
number of 
iterations

Indicates the maximum number of times the algorithm is applied. If convergence 
occurs, the system may apply the algorithm less times than the maximum number 
of iterations. By default, the maximum iteration value for single channel cases is 
200. 

Signal 
treshold

Determines the treshold. By default, the exponent value is 0.0.

Background 
cropping

Finds the smallest bounding box in the image or delineated VOI outside of which 
all image pixel values are below the image threshold.

Whole image Applies the algorithm to the whole image.

VOI region(s) Applies the algorithm only to the delineated VOIs.

HARD ONLY Performs only hard segmentation on the image

FUZZY ONLY Performs only fuzzy segmentation on the image.

HARD & 
FUZZY BOTH

Performs both types of segmentation—hard and soft—on the image.

OK Performs the Fuzzy C-Means algorithm on the image based on your choices in this 
dialog box.

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box. 

Help Displays online help for this algorithm.

Figure 2.  Fuzzy C-Means dialog box for a single image  (continued)
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To remove an image from the list, click Remove. 

5 Click OK. 

The Threshold & Initial Centroids dialog box appears. 

By default, MIPAV determines the value of the initial centroids by result 
of the total number of intensities divided by the number of classes. To 
change the values, click OK.

Note: If you are applying this algorithm to several datasets, when you click OK 
another Threshold & Initial Centroids window appears sequentially for each 
dataset. Click OK when complete. MIPAV applies the algorithm to the datasets. 
The resultant images appear in new image windows.

Number of 
desired 
classes

Indicates the number of groups 
into which the algorithm divides 
the dataset structures. 

Desired 
exponent 
value

Determines the amount of 
"fuzziness" in the resulting 
segmentation. 

Boundary 
noise 
cropping

Finds the smallest bounding box 
outside of which all first image 
pixel values are below the first 
image threshold. To save space, 
MIPAV copies values inside the 
bounding box to a smaller array 
and then uses the reduced array to 
performs calculations. 

Signal 
threshold

Appears only when you select 
Algorithm > Fuzzy C-means > 
Single Channel. 

By default, MIPAV assigns the 
image minimum value and uses 
only pixels whose values equal or 
exceed the theshold used in the 
centroid calculation. 

If you select the HARD ONLY 
option, MIPAV sets the pixels 
whose values are less than the 
threshold to a segmentation value 
of 0. This means that the pixels are 
outside of the specified classes.

Figure 3.  Fuzzy C-Means dialog box for multispectral images 
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End tolerance Indicates when convergence is reached. Generally, membership functions over all 
pixel locations change between iterations of the application of the fuzzy c-means 
algorithm. Convergence occurs if the change is equal to or less than the end 
tolerance level and when all membership functions over all pixel locations change 
by less than the tolerance value between two iterations. By default, the tolerance 
is 0.01.

Maximum 
number of 
iterations

Indicates the maximum number of times the algorithm is applied. If convergence 
occurs, the system may apply the algorithm  less times than the maximum 
number of iterations. By default, the maximum iteration value for single channel 
cases is 100. The maximum number in multispectral cases is 200.

Background 
noise 
cropping

Finds the smallest bounding box in the image or delineated VOI outside of which 
all image pixel values are below the image threshold.

Whole image Applies the algorithm to the whole image.

VOI region(s) Applies the algorithm only to the delineated VOIs.

HARD ONLY Performs only hard segmentation on the image

FUZZY ONLY Performs only fuzzy segmentation on the image.

HARD & 
FUZZY BOTH

Performs both types of segmentation—hard and soft—on the image.

Load Loads the images that you select.

Remove Removes the images that you select.

OK Performs the FuzzyC-Means algorithm on the selected images based on your 
choices in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box. 

Help Displays online help for this algorithm.

Figure 3.  Fuzzy C-Means dialog box for multispectral images  (continued)
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2D Histogram

The 2D Histogram algorithm takes as an input, two grayscale images or one 
color image to create a 2D histogram image based on the data in two input 
images. 

Background
The active image window is the source image whose frequency values are 
placed along the x-axis of the 2D histogram image. The second image forms 
the base image whose frequency values are placed along the y-axis of the 2D 
histogram image. 

If the color image is an input to the algorithm, the user must select which 
two color channels should be used for processing.

The user has the option to linearly rescale the second image for both 
grayscale and color images. If true, the range of data in second image is 
rescaled to be the same as the range of data in the first image. In other 
words, the second image minimum is rescaled to the first image minimum 
and the second image maximum is rescaled to the first image maximum. 
Also, if linear rescaling is used the number of bins in the second image is set 
equal to the number of bins in the first image. 

• The default number of bins equals the minimum of 256 and (max. 
value - min. value + 1) if the data is not float. 

• If the data is  float or  double the default number of bins is set to 256. 

The processing of maximum values is specially handled to prevent loss of 
top bin counts from rounding errors. 

The user has the option to calculate the log of result image for better 
visualization.

Figure 3 on page 339 shows the two input images, the output 2D histogram 
image and its lookup table. 
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IMAGE TYPES

You can apply this algorithm to both color and black-and-white images, as 
well as 2D and 3D images. 

NOTES

No notes.

Figure 1.  Two input images, output 2D histogram image and its lookup 
table
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Applying the 2D Histogram algorithm to grayscale 
images

1 Select Algorithms > Histogram Tools > 2D Histogram in the main 
MIPAV window. The Histogram Two Dimensional dialog box appears.

2 Select the base image from the drop-down list.

3 Check the Linearly rescale 2nd image checkbox if you want to rescale 
the 2-nd image. By default, the box is checked.

4 Enter the appropriate bin number for Image1 and Image2. The default 
value for both images is 256. 

5 Check the Calculate log of the result image checkbox if you want to 
calculate the log of the result image for better visualization. By default, 
the box is checked. Refer to Figure 2 on page 337 for details.

Figure 2.  The Histogram Two Dimensional dialog box for grayscale 
images

Histogram 2D with 
<File name> to: 

Select the base image from the list box.

Options

Linearly rescale 2-
nd image

Use this checkbox if you want 
to rescale the 2-nd image. By 
default, the box is checked.

Image 1 bin format Enter the bin number for the 
image 1. The default value is 
256.

Image 2 bin format Enter the bin number for the 
image 2. The default value is 
256.

Calculate the log of 
the result image

Check if you want to calculate the log of the result image for better 
visualization. By default, the box is checked. 

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.
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6 Click OK. The algorithm begins to run, and a progress bar appears 
momentarily with the status. When the algorithm finishes running, the 
progress bar disappears, and the results appear in a separate image 
window.

Applying the 2D Histogram algorithm to color images
To run this algorithm for color images, complete the following steps:

1 Select Algorithms > Histogram tools > 2D Histogram.

2 Use the checkbox to select any two colors from red, green, and blue. 
Note that, only two colors can be selected. 

3 Check the Linearly rescale 2nd image checkbox if you want to rescale 
the 2-nd image. By default, the box is checked.

4 Enter the appropriate bin number for the two colors selected. The 
default values is 256 for both colors. 

5 Check the Calculate log of the result image checkbox if you want to 
calculate the log of the result image for better visualization. By default, 
the box is checked. 

6 Click OK. See Figure 3 on page 339.

The algorithm begins to run, and the pop-up window appears to run with 
the status. The following message appears: “Processing Image”. When the 
algorithm is completed the pop-up window closes and the 2D histogram 
image appears in the new window. 
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Select 2 of 3 
colors 

Use the checkbox to select 
any two colors from red, 
green, and blue. Note that, 
only two colors can be 
selected.

Options

Linearly rescale Use this checkbox if you want to rescale the 2-nd color. By default, the box is 
checked.

Color 1 bin 
number

Enter the bin number for color 1. The default value is 256.

Color 2 bin 
number

Enter the bin number for color 2. The default value is 256.

Calculate the log 
of the result 
image

Check if you want to calculate the log of the result image for better 
visualization. By default, the box is checked. 

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.

Figure 3.  The Histogram Two Dimensional dialog box for color images
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Cumulative Histogram

The cumulative histogram is a histogram in which the vertical axis gives 
not just the counts for a single bin, but rather gives the counts for that bin 
plus all bins for smaller values of the response variable.

Background
Let I:Q -> [0,1] be an image and h is the distribution of its values (a 
histogram). The cumulative histogram of I is the function H: [0,1] -> [0,1] 
defined by

EQUATION 1

EXAMPLES

Following examples display cumulative histograms for grayscale and RGB 
images. Figure 2 shows a 3D grayscale image and its cumulative histogram. 
Figure 3 and Figure 4 show 2D RGB images and their cumulative histo-
grams for each channel. Note that, the RGB image from Figure 3 has in fact 

Figure 1.  A sample cumulative histogram

H x( ) h t( ) td
0

x

∫=
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only two color channels - Red and Blue, therefore its cumulative histogram 
for the Green channel shows nothing. 

a b

Figure 2.  A 3D grayscale image (a) and its cumulative histogram (b).

a b

Figure 3.  A 2D RGB image and its cumulative histograms for each 
channel.
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c d

a b

c d

Figure 4.  A 2D RGB image and its cumulative histograms .

Figure 3.  A 2D RGB image and its cumulative histograms for each 
channel.
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NOTES

No notes.

REFERENCES

J. Delon, Midway Image Equalization, Journal of Mathematical Imaging and Vision, vol.21, 
no.2, pp.119-134, 2004.

Understanding Histograms in Digital Photography, http://www.luminous-landscape.com/
tutorials/understanding-series/understanding-histograms.shtml

IMAGE TYPES

You can apply the Cumulative Histogram algorithm to 2D, 2.5D and 3D 
grayscale and color (RGB) images. For RGB images the algorithm will 
display a separate cumulative histogram for each channel (R, G, and B).

Applying Cumulative Histogram algorithm to images

TO APPLY CUMULATIVE HISTOGRAM TO 
GRAYSCALE IMAGES:

1 Open an image of interest.

2  In the main MIPAV window, navigate to Algorithms > Histogram Tools 
> Cumulative Histogram. 

3 The algorithm starts running and the cumulative histogram appears in a 
new image frame. See Figure 2.
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TO APPLY CUMULATIVE HISTOGRAM TO RGB 
IMAGES

1 Open an image of interest.

2 Call Algorithms > Histogram Tools > Cumulative Histogram from the 
main MIPAV menu. 

3 The algorithm starts running and the cumulative histograms for each 
channel (R,G, and B) appear. See Figure 3 and Figure 4.
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Histogram Equalization: Regional Adaptive

The Histogram Equalization: Regional Adaptive algorithm, a high-pass 
filter, enhances the contrast in an image by reevaluating the gray-scale, or 
intensity, value of each pixel based on the values of nearby pixels in the 
same region.

Background
Features in some images require a larger range of intensity values than are 
displayed. Histogram equalization is a method to improve the contrast of an 
area in an image by distributing an equal number of pixels across the range 
of intensities in the image. This algorithm tabulates the histogram for each 
region, then assigns the pixel to the new histogram level.

This algorithm acts in regions of an image, dividing the image into m rows 
and n columns. Each region is the source when remapping the histogram, 
adapting the value of the pixel to its location in the histogram of the region.

bin width—The permitted range of floating-point values of a pixel to equate to 
an intensity level in a 256-color image.

Although, depending on image type, there are some minor variations in how 
this algorithm proceeds, generally the algorithm first calculates the bin 
width of each region. It then processes each region by judging each pixel’s 
location within this new histogram. Regardless of pixel value, the algorithm 
remaps the brightest pixel in each region to the brightest value in the 
histogram (i.e., 256) and remaps the darkest pixel to the lowest value in the 
histogram (i.e., 0) of the pixels’ neighboring region, recording the new 
values as pixel-intensity values. The algorithm then processes each of the 
remaining regions in the original, or source, image in the same way and 
builds a new, or reference, image using the new pixel-intensity values.
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Performing histogram equalization makes it possible to see minor 
variations within portions of the reference image that appeared nearly 
uniform in the source image. Arithmetically, the process in a region is 
rather simple:

where Ni is the intensity of the ith pixel, and T is the total number of pixels 
in the region.

The reference image using the new histogram is similar to the source image; 
however, in areas where the source image had similar values, the reference 
image is enhanced. The reference histogram now stretches over a greater 
proportion of the possible image intensities (Figure 1).

 

k
Ni
T
-----

i 0=

j

∑=

Figure 1.  Source image and histogram and reference images and histograms for reference 
images that were separated into 1 x 1, 2 x 2,  and 3 x 3 regions
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Figure 1.  Source image and histogram and reference images and histograms for reference 
images that were separated into 1 x 1, 2 x 2,  and 3 x 3 regions (continued)
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Note: All histograms shown in this section are in log scale in the vertical axis.

The histogram for the source image is very compact in structure; that is, it 
has a great number of darker pixels, but very few brighter pixels. In fact, the 
bottom-most intensity values make up almost all of the pixels' values in the 
image. Note, however, in the histogram of the reference image, the look-up 
table is more evenly spread than that of the histogram for the source image. 
Also, areas of low intensity and low contrast in the source image were 
correspondingly remapped in the reference image to areas of higher 
contrast and generally overall brighter values. 

Notice that different low areas of the reference image are more 
distinguishable depending on the number of rows and columns that divide 
the image. The contrast changes are due to which pixel is considered the 
brightest and which the darkest in a particular region. The brightest pixel in 
a 1 x 1 separated image is the brightest of the image. However, when the 
image is divided into more regions, the brightest pixel in the region gets 
remapped as one of the brightest pixels in the image regardless of its 
absolute intensity in the image. Likewise, the darkest pixel in the region is 
remapped as one of the darkest in the image regardless of its absolute 
intensity.

Figure 1.  Source image and histogram and reference images and histograms for reference 
images that were separated into 1 x 1, 2 x 2,  and 3 x 3 regions (continued)
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The histogram equalization process can enforce certain characteristics 
about the image called clipping. As the algorithm processes the image, it 
counts out the number of pixels of a certain intensity. Clipping cuts that 
counting short; it stores the excess pixels of a particular intensity and 
redistributes that number equally among all intensities. For instance, if a 
particular intensity must be clipped at 100 and the count is 145, the 
algorithm redistributes 45 pixels to other brightnesses. It adds to the count 
of each intensity level an equal number of pixels if there are enough excess, 
but it attempts to spread the excess over as many pixels as possible. Figure 2 
shows examples of the source image from Figure 1 that was separated into 1 
x 1 regions with no clipping, 45-percent clipping, and 75-percent clipping.

IMAGE TYPES

You can apply this algorithm to both color and black-and-white images.

SPECIAL NOTES

This algorithm only works on the whole image, not on volumes of interest 
(VOIs). 

Figure 2.  Examples of no clipping, 45-percent clipping, and 75-percent clipping
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REFERENCES

Refer to the following references for more information:

Bob Cromwell,  “Localized Contrast Enhancement: Histogram Equalization,” paper on his 
web site at http://www.cromwell-intl.com/3d/histogram/Index.html.

Douglas A. Lyon, Image Processing in Java (Upper Saddle River, New Jersey: Prentice-Hall, 
1999).

Figure 2.  Examples of no clipping, 45-percent clipping, and 75-percent clipping
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Tamer Rabie, Rangaraj Rangayan, Raman Paranjape, “Adaptive-Neighborhood Image 
Deblurring,” The University of Calgary, Department of Electrical and Computer Engineering 
(Calgary, Alberta, Canada: NEC Research Institute, 2002).

John Russ, The Image Processing Handbook (Boca Raton, Florida: CRC Press LLC, 2003).

J. Alex Stark,  “Adaptive Image Contrast Enhancement Using Generalizations of Histogram 
Equalization,” in IEEE Transactions on Image Processing (May 2000).

Claes Tidestav, “Short Introduction to Adaptive Equalization.” (Uppsala, Swedon: Uppsala 
University, April 1996).
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Applying the Histogram Equalization: Regional 
Adaptive algorithm

To run this algorithm, complete the following steps:

1 Open an image. 

2 Perform, as an option, any other image processing on the image.

3 Select Algorithms > Histogram Equalization > Regional Adaptive. The 
Regional Adaptive Histogram Equalization dialog box (Figure 3) opens.

4 Complete the information in the dialog box.

5 Click OK. The algorithm begins to run.

 

Divisions of 
width

Indicates the number of times the 
algorithm should divide the image in 
width to make a region. 

If you select 2, the algorithm divides 
the image in width by 2 yielding two 
areas: a left side and a right side. 
Each is used separately for 
histogram equalization. 

Divisions of 
height

Indicates the number of times the 
algorithm should divide the image in 
height to make a region.

If you select 3, the algorithm divides 
the image in height by 3 yielding 
three areas: a top, middle, and 
bottom part.

Activate 
clamping

Allows you to specify the maximum 
number of pixels with a certain pixel 
bin.

Selecting this check box makes 
Fraction of most frequent pixel 
intensity active. 

Figure 3.  The Regional Adaptive Histogram Equalization dialog box 
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A pop-up window appears with the status. A series of status messages 
appear in the window. 

When the algorithm finishes running, the pop-up window closes.

Depending on whether you selected New image or Replace image, the 
results appear in a new window or replace the image to which the 
algorithm was applied.

Fraction of 
most 
frequent 
pixel 
intensity 
(%)

Indicates the percentage (1 through 99) of the maximum number of pixels per 
intensity allowed. The algorithm records and redistributes the pixels for any 
intensity that has more pixels than the calculated value. The default value is 75 
percent. A lower value reduces the contrast of a region and is sometimes required 
to prevent parts of the image from becoming oversatured. To use this field, first 
select Activate clamping.

Red channel Treats all of the pixels in the red channel as its own intensity as if the image were 
three separate monochrome images (only applicable to color images). 

Green 
channel

Treats all of the pixels in the green channel as its own intensity as if the image were 
three separate monochrome images (only applicable to color images). 

Blue channel Treats all of the pixels in the blue channel as its own intensity as if the image were 
three separate monochrome images (only applicable to color images). 

New image Shows the results of the algorithm in a new image window.

Replace 
image

Replaces the source image with the results of the algorithm.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes you made in this dialog box and closes the dialog box.

Help Displays online help for this dialog box.

Figure 3.  The Regional Adaptive Histogram Equalization dialog box  (continued)
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Histogram Equalization: Neighborhood Adaptive

The Histogram Equalization: Neighborhood Adaptive algorithm, a high-
pass filter, enhances the contrast in an image by reevaluating the grayscale, 
or intensity, value of each pixel based on a region of nearby pixels. 

Background
Features in some images require a larger range of intensity values than are 
displayed. Histogram equalization is a method to improve the contrast of 
an area in an image by shifting intensity values so that there are an equal 
number of pixels in an image in each intensity. This algorithm tabulates the 
histogram for a collection of neighboring pixels, sometimes called a kernel 
and then assigns the pixel to the new histogram level.

The name of this algorithm signifies that it processes the image by looking 
at the neighboring pixels when performing the equalization; hence, the 
name Neighborhood, or Local, Adaptive Histogram Equalization. Each 
neighborhood of pixels is the source when remapping the histogram, 
adapting the value of the pixel to its location in the histogram of the 
neighborhood.

The algorithm first collects a list of the pixel's neighbors, calculates the bin 
width of the pixel neighborhood, then builds the histogram of the 
neighborhood. 

bin width—The permitted range of floating-point values of a pixel to equate to 
an intensity level in a 256-color image.

The algorithm locates the value of the central pixel in the local histogram 
and replaces its intensity with the corresponding value in the histogram of 
its neighbors. The algorithm remaps the brightest pixel in a pixel neighbor-
hood to the brightest value in the histogram (i.e., 256) and the darkest pixel 
to the lowest value of the histogram (i.e., 0), recording the new values as 
pixel-intensity values. It then processes each pixel in this way, remapping 
pixel value to intensity as measured against a histogram of the pixel's neigh-
bors until the algorithm finishes checking all pixels of the image against the 
histogram of its neighbors and builds a new, or reference, image.
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Performing histogram equalization makes it possible to see minor varia-
tions within portions of the reference image that appeared nearly uniform 
in the original, or source, image.

Arithmetically, the process in a neighborhood is rather simple:

where Ni is the intensity of the ith pixel, and T is the total number of pixels in 

the neighborhood.

Neighborhood size greatly affects the reference image, since the intensity of 
each resulting pixel depends on the neighborhood. The more pixels in the 
neighborhood that are darker than the current pixel, the greater in intensity 
the current pixel becomes in the reference image. Likewise, the shape of the 
kernel determines the number of pixels in the neighborhood.

The algorithm creates a kernel around a pixel in a region of the image as 
shown in Figure 1. It then ranks the intensity of that pixel as compared to 
the surrounding pixels. In the figure, the box is 65 pixels wide. Using a 
square kernel, the algorithm collects all the pixel intensities inside the 
square and at the edges of the square. (Using a cross kernel, however, it 
collects only the intensities under the orange cross-hairs.) It next ranks the 
pixel intensity at the center of the cross hairs against the histogram of the 
pixels in the kernel.

Figure 1.  Sample of kernel created by algorithm

k
Ni
T
-----

i 0=

j

∑=
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The reference image using the new histogram is similar to the source image; 
however, in areas where the original image had similar values, the reference 
image is enhanced. The output histogram now stretches over a greater 
proportion of the possible image intensities.

Figure 2 shows example images that were created by starting with a source 
image then using a 21 x 21, a 45 x 45, or 65 x 65 square kernel through the 
image. 

The histogram of the source image is very compact in structure; that is, it 
has a great number of darker pixels, but very few brighter pixels. In fact, the 
bottom-most intensity values make up almost all of the pixels' values in the 
image. Note, however, in the histogram of the reference image, the look-up 
table is more evenly spread than in the histogram of the source image. Also, 
areas of low intensity and low contrast in the source image were corre-
spondingly remapped in the reference image to areas of higher contrast and 
generally overall brighter values.

Note: The red line at the border of the image is an active image line, a part of 
the program to help the user determine which image is on top and not a part of 
the image itself. 

Figure 2.  A source image and its histogram (A, B) compared to reference images using a 21 x 21 
(C, D), 45 x 45 (E,F), or 65 x 65 (G,H) square kernels and 65 x 65 (I,J) cross kernels
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Figure 2.  A source image and its histogram (A, B) compared to reference images using a 21 x 21 
(C, D), 45 x 45 (E,F), or 65 x 65 (G,H) square kernels and  (continued)65 x 65 (I,J) cross kernels
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There are a couple of features to notice about the resultant images. First, the 
reference images contain a lot of noise. This noise results because the 
algorithm remapped the areas of the image with smooth features using a 
histogram used for features with great variation (such as the lung cavity in 
the example images). Second, notice that the algorithm remaps large areas 
of the same level of intensity values very high-intensity areas. This feature 
could be expected, is distracting when  viewing the image, and is therefore a 
good reason to include a threshholding feature  to prevent processing on a 

Figure 2.  A source image and its histogram (A, B) compared to reference images using a 21 x 21 
(C, D), 45 x 45 (E,F), or 65 x 65 (G,H) square kernels and  (continued)65 x 65 (I,J) cross kernels
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pixel when its intensity is too low.

The histogram equalization process can enforce certain characteristics 
about the image called clipping. As the algorithm processes the image, it 
counts out the number of pixels of a certain intensity. Clipping cuts that 
counting short; it stores the excess pixels of a particular intensity and 
redistributes that number equally among all intensities. For instance, if a 
particular intensity must be clipped at 100 and the count is 145, the 
algorithm redistributes 45 pixels to other brightnesses. It adds to the count 
of each intensity level an equal number of pixels if there are enough excess, 
but attempts to spread the excess over as many pixels as possible.
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.  

Figure 3.  The effect of thresholding on images
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Figure 4.  A reference image and histogram with no clipping and with 75-percent clipping
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IMAGE TYPES

You can apply this algorithm to both color and black-and-white images.

SPECIAL NOTES

This algorithm can evaluate the entire image or only specified volumes of 
interest (VOIs).

REFERENCES

Refer to the following references for more information:

Bob Cromwell,  “Localized Contrast Enhancement: Histogram Equalization,” paper on his 
web site at http://www.cromwell-intl.com/3d/histogram/Index.html.

Douglas A. Lyon, Image Processing in Java (Upper Saddle River, New Jersey: Prentice-Hall, 
1999).

Tamer Rabie, Rangaraj Rangayan, Raman Paranjape, “Adaptive-Neighborhood Image 
Deblurring,” The University of Calgary, Department of Electrical and Computer Engineering 
(Calgary, Alberta, Canada: NEC Research Institute, 2002).

Figure 5.  A reference image and histogram with 45-percent clipping
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John Russ, The Image Processing Handbook (Boca Raton, Florida: CRC Press LLC, 2003).

J. Alex Stark,  “Adaptive Image Contrast Enhancement Using Generalizations of Histogram 
Equalization,” in IEEE Transactions on Image Processing (May 2000).

Claes Tidestav, “Short Introduction to Adaptive Equalization.” (Uppsala, Swedon: Uppsala 
University, April 1996).

Applying the Histogram Equalization: Neighborhood 
Adaptive algorithm

To run this algorithm, complete the following steps:

1 Open an image.

2 Perform, as an option, any other image processing on the image.

3 Select Algorithms > Histogram Equalization > Neighborhood Adaptive. 
The Local Adaptive Histogram Equalization dialog box (Figure 6) 
opens.

4 Complete the information in the dialog box.

5 Click OK. The algorithm begins to run.

A pop-up window appears with the status. A series of status messages 
appear in the window.

When the algorithm finishes running, the pop-up window closes.

Depending on whether you selected New image or Replace image, the 
results appear in a new window or replace the image to which the 
algorithms was applied.
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Kernel size Indicates the number 
of pixels horizontally or 
vertically to be used in 
finding the histogram 
with the pixel in 
question at the center. 
Select 31, 45, 65, or 
129, or type an odd 
number.

Kernel shape Specifies the shape of 
the kernel the 
algorithm should use. 
Select either:

• Square—To evaluate 
all pixels on any 
column or row away 
from the central pixel 
to the perimeters of 
the kernel

• Cross—To choose 
from only pixels in the 
same column or row to 
the perimeter of the 
kernel as neighbors of 
the pixel.

Use as scale 
maximum

Specifies where to find the maximum for the resulting histogram. Select Local, 
Slice (default), or Image. Note: This value is predefined for some image formats.

Use threshold Limits the algorithm to evaluate pixels only when above the specified value. By 
default, this field is clear and the algorithm therefore evaluates all pixels. 

Any given input, however, prevents some pixels from being evaluated. Although 
using this option potentially causes some valuable pixels to be lost, it reduces the 
noise associated with evaluating the image edges, which is usually only an image 
of the imaging device. The default is image minimum value.

Use clamping Indicates the percentage (1 through 99) of the maximum number of pixels per 
intensity allowed. The algorithm first calculates the number of pixels per intensity 
and then applies the clamping percentage to yield a maximum number of pixels 
per intensity allowed. The algorithm records the excess pixels for any 
intensity that has more pixels than the calculated value and redistributes 
them equally among all intensities. By default, this field is clear; when 
selected, 75 is the default percentage.

Red channel Treats all of the pixels in the red channel as its own intensity as if the image were 
three separate monochrome images (only applicable to color images). You can opt 
to act on any combination of red, blue, or green color channels.

Figure 6.  Local Adaptive Histogram Equalization dialog box
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Green channel Treats all of the pixels in the green channel as its own intensity as if the image 
were three separate monochrome images (only applicable to color images). You 
can opt to act on any combination of red, blue, or green color channels.

Blue channel Treats all of the pixels in the blue channel as its own intensity as if the image were 
three separate monochrome images (only applicable to color images). You can opt 
to act on any combination of red, blue, or green color channels.

New image Shows the results of the algorithm in a new image window.

Replace 
image

Replaces the source image with the results of the algorithm.

Whole image Applies the algorithm on the entire image.

VOI regions Applies the algorithm to only the selected VOI.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes you made in this dialog box and closes the dialog box.

Help Displays online help for this dialog box.

Figure 6.  Local Adaptive Histogram Equalization dialog box (continued)
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Histogram Matching

The Histogram Matching (also called Histogram Specification) algorithm 
generates an output image based upon a specified histogram. 

Background
The process of Histogram Matching takes in an input image and produces 
an output image that is based upon a specified histogram. The required 
parameters for this algorithm are the input image and the specified image, 
from which the specified histogram can be obtained. 

The algorithm works as follows:

The histograms for the input image p(f) and the specified image pd(g) are 
generated. Here, the desired histogram of the specified image is denoted as 
pd(g). Cumulative histograms – P(f) and Pd(g) are then generated using the 
following equations:

EQUATION 1

EQUATION 2

where f and g are the pixel intensity levels.

The transformation function is obtained by choosing g for each f, such that 
if g > f, then Pd(g) > P(f). The transformation function is then applied to the 
input image to produce an output image by remapping the pixel intensities. 
The objective is to find a transformed digital picture of a given picture, such 
that the sum of absolute errors between the intensity level histogram of the 
transformed picture and that of a reference picture is minimized. Refer to 
Figure 1.

P f( ) p k( )

k 0=

f

∑=

Pd g( ) pd k( )

k 0=

g

∑=
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Figure 1.  Histograms and cumulative histograms:                                                                                   
(A) histogram of 8x8 pixel image;                                                                                                                      
(B) cumulative histogram derived from (A);                                                                                               
(C) desired histogram of the same 8x8 pixel image;                                                                                
(D) cumulative histogram derived from (C);                                                                                              
(E) gray scale transformation function that approximately transforms 
the histogram (A) to desired histogram (C);                                                                                                                                     
(F) histogram of gray-scale-transformed image obtained by applying the 
transformation function in (E) to the image with the histogram shown in 
(A).
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Figure 2.  The input image and its histogram p(f)

Figure 3.  The specified image and its histogram pd(g)

Figure 4.  The result image and its histogram 
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REFERENCES

Rafael C. Gonzalez and Richard E. Woods. Digital Image Processing. Addison-Wesley 
Publishing Company, 1992, pp. 173-182

Jae S. Lim. Two-Dimensional Signal and Image Processing. Prentice–Hall, Inc., 1990, 
pp. 453-459

IMAGE TYPES

You can apply this algorithm to both color and black-and-white images, as 
well as 2D and 3D images. 

Applying the Histogram Matching algorithm
To use this algorithm, do the following:

1 Select Algorithms > Histogram Tools > Histogram Matching in the main 
MIPAV window. The Histogram Matching dialog box (Figure 5) 
appears.

2 Complete the information in the dialog box.

3 Click OK. The algorithm begins to run, and a progress bar appears 
momentarily with the status. When the algorithm finishes running, the 
progress bar disappears, and the results appear in a separate image 
window.

Histogram match 
<File name> to 

Select the specified image 
pd(g) from the list box

New image Shows the results of the algorithm in a new image window

Replace image Shows the results of the algorithm in the same image window

OK Applies the algorithm according to the specifications in this dialog box.
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Figure 5.  Histogram Matching dialog box

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.
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Histogram summary

Sometimes it is more useful to display information in graphical form. At 
other times, a tabular form is easier to use. In MIPAV, you can view the 
frequency, or intensity level, distribution in an image or VOI region in 
either form. To view the information as a graphic representation, you would 
use either the LUT icon on the image toolbar or the LUT menu in the 
MIPAV window (refer to “Improving contrast by generating and modifying 
histograms”  in Chapter 1, "Getting Started Quickly with MIPAV"). 
However, to view the information in a tabular form, you use the Histogram 
Summary command on the Utilities menu. You can also save the histogram 
summary information in a TXT (.txt) file.

Applying Histogram Summary to the image

To create a histogram summary on an entire image

1 Open an image.

2 Select Utilities > Histogram Summary in the MIPAV window. 
Frequency distribution information appears on the Data page in the 
Output window (Figure 1).

The histogram summary table includes the following 
four columns, see Figure 1:

• Image name—Name of the image

• Intensity value—Value of the pixel

• Count—Number of times that pixels of this intensity value occur in 
the image

• Square area or cubic volume—For 2D images, 

. For 3D images, 

.

area count x resolution× y resolution×·=

volume count x resolution× y resolution z resolution×× ··=
MIPAV User’s Guide, Volume 2, Algorithms 371

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Histogram summary
To create a histogram summary on a VOI

1 Open an image.

2 Delineate a VOI on the image.

3 Select the VOI.

4 Select Utilities > Histogram Summary in the MIPAV window. 
Frequency distribution information appears on the Global Data page 
and on the Data page in the Output window.

To save the histogram summary

1 Select File > Save Messages in the Output window. The Save dialog box 
opens.

2 Type a name and extension in File Name. Make sure that you use the 
*.txt extension.

3 Click Save. MIPAV saves the histogram summary under the specified 
name.

Figure 1.  Histogram summary in the Output window
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Number of bins Specify the number of bins 
here. The default value is 
256.

Whole image Check this option if you want 
create histogram for the 
whole image. 

VOI regions Check this option if you want 
create histogram only for 
selected VOI regions. 

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.

Figure 2.  The Histogram summary dialog box options
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Manual 2D Series

The Manual 2D Series algorithm allows you to manually or semi manually 
register two 2D grayscale or color images by placing corresponding points 
on both images, and then applying either the Landmark—Thin Plate Spline 
or Landmark—Least Squares algorithm. After applying one of these 
algorithms, you can then, if needed, use the other algorithm. In addition, at 
any time, you can manually adjust the alignment of each image.

The algorithm also lets you manually register different slices of a 2.5D and 
3D image datasets in the same way as 2D images. See also “Applying the 
Manual 2D Series algorithm to 2.5D images” on page 391 and “Applying the 
Manual 2D Series algorithm to 3D images” on page 393.

Background
Through the Registration: Manual 2D Series dialog (Figure 1), this algo-
rithm provides the tools for manually registering images, as well as the abil-
ity to use two of the landmark registration algorithms–Thin Plate Spline 
and Least Squares. 

The following tools are available for manually registering images:

• “Changing displaying proportion” on page 377

• “Moving the adjusted image” on page 380

• “Rotating the adjusted image” on page 381

• “Delineating the landmark points” on page 385

• “Applying the image registration algorithms” on page 386

IMAGE TYPES

You can apply this algorithm to 2D, 2.5 D, and 3D grayscale and color 
images. The dimensions or image type of the adjusted image need not be the 
same as the dimensions or image type of the reference image. The adjusted 
image has the same image type and the same extents as the reference image. 
See also: “Applying the Manual 2D Series algorithm on 2D images” , “Apply-
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ing the Manual 2D Series algorithm to 2.5D images” , and “Applying the 
Manual 2D Series algorithm to 3D images” .

SPECIAL NOTES

For 2D, 2.5D and 3D images, three or more landmark points are required. 
The algorithm may fail if nearly all of the points fall on the same line. 

REFERENCES

“Least-Squares Fitting of Two 3-D Point Sets” by K.S. Arun, T.S. Huang, and S.D. Blostein, IEEE 
Transactions on Pattern Analysis and Machine Intelligence, Vol. PAMI-9, No. 5, September, 1987, pp. 
698-700.

David Eberly, “Thin Plate Splines” of Magic Software at http://www.magic-software.com. Also at the 
same site are the files: MgcInterp2DThinPlateSpline.h, MgcInterp2DThinPlateSpline.cpp, 
MgcInterp3DThinPlateSpline.h, MgcInterp3DThinPlateSpline.cpp Paper that explains warping from 
one x,y source to another x,y target set.

Fred L. BookStein, “Principal Warps: Thin-Plate Splines and the Decompositions of Deformations,” 
IEEE Transactions on Pattern Analysis and Machine Intelligence, Vol. 11, No. 6, June 1989, pp. 567–
585.

Applying the Manual 2D Series algorithm on 2D images

To run this algorithm, complete the following steps:

1 Open two images– the reference image and the image you want to 
register or adjusted image.

2 Select the reference image. 

3 Select Algorithms > Registration > Manual 2D Series. The Load dialog 
box appears. See Figure 1.

4 Select the image that you want to register to the reference image. Note 
that, if only two images are open, the Set as Image B box automatically 
selects the other open image—the one you did not select—as Image B or  
adjusted image. See Figure 1.
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.

5 To select a different image, select the File option, and then click Browse to 
find and open another image.

6 Click OK.

7 The Manual 2D Series window opens. By default, the window opens in 
Blended mode. Note that, opening this window automatically corrects 
image resolution and scaling.

As shown in Figure 2, the Registration: Manual 2D Series window has the 
main menu (see below) and two tabs: Blended and Dual. Refer to “Blended 
tab” on page 376 and “Dual tab” on page 382.

Options available via the dialog menu

Blended tab
The Blended tab shows both images: the adjusted image superimposed on 
top of the reference image. By default, the image frame shows both images 
blended in proportion 50/50. 

Figure 1.  The Load dialog box

File Close Registration Closes this dialog without saving the 
images.

Show VOIs in blended 
window

On the Blended tab, displays the VOIs that 
you’ve delineated on the Dual tab.

Thin plate spline for intensity Uses the Thin Plate Spline algorithm for 
calculating intensity values. See also 
“Registration: Landmark—TPSpline” .

Help Runs help for this dialog box.
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CHANGING DISPLAYING PROPORTION

You can use the AlphaBlending image slider to change the displaying pro-
portion towards either increasing the amount of the reference image (the 
Ref.R side of the slider) or adjusted image (the Adj.A side of the slider) dis-
played. The image slider is located at the top of the Blended tab. See also 
Figure 2 and Section: “Moving and rotating the adjusted image” on 
page 379.

THE BLENDED TAB OPTIONS:

Figure 2.  The Blended tab and the image slider

 Display 
Lookup table

Opens the Lookup table dialog 
box. For the Lookup table (LUT) 
dialog box options, refer to 
MIPAV User’s Guide, Volume 1, 
Basics, Figure 120 “Look-up Table 
window”. See also “Using LUT to 
arrange the images” on 
page 389.

Figure 3.  The Blended tab options
MIPAV User’s Guide, Volume 2, Algorithms 377

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Manual 2D Series
 Checker 
Board

The checkerboard tool displays 
both portions of both images in 
an alternating fashion, much like 
the squares on a checkerboard. 
Portions of the reference image 
(Image A) appear where the 
light-colored squares would 
appear on the checkerboard; 
portions of the adjusted image 
(Image B)  appear in place of the 
dark-colored squares. 

You can use the  Checkerboard 
pattern dialog box options to 
adjust the number of rows and 
columns displayed. 

See also MIPAV User’s Guide, 
Volume 1, Basics, Figure 116 for 
more infromation about  the 
checkerboard tool.

 Magnify 
image 2.0x 

Magnifies the images 2xn times. 

 Magnify 
image 0.5x

Magnifies the images 0.5xn times; or minifies the images 2xn times, which is 
the same.

 Window 
region of 
Image B

Displays the window filled only 
with the adjusted image (Image 
B) over the reference image. You 
can use this window to look at 
the alignment of details in the 
images.

 Reset 
image to its 
original state

Restores image to its original state. This icon also deletes all landmark points on 
the reference image and on the adjusted image. If the Apply button has already 
been selected, the Reset icon undoes all changes that occurred since the last 
time the Apply button was selected. 

Figure 3.  The Blended tab options (continued)
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MOVING AND ROTATING THE ADJUSTED IMAGE

Figure 4 shows the icons which allow you to move the adjusted image in all 
directions or specifically up, down, left, and right a certain number of pixels. 
You can also rotate the adjusted image clockwise or counterclockwise. Note 
that all these tools are available only on the Blended tab.

To activate moving mode, click on the Translate image icon first, and 
then use the arrow icons to move the adjusted image in desired direction. 
You can also set up the moving increment (in pixels). Current increment is 
shown next to the Translate image icon. Refer to Figure 4.

To activate rotation mode, click on the Rotate Image icon, and then use 
the Rotate Clockwise or Rotate Counterclockwise icons to rotate the image. 
You can also set up the rotation increment (in grades). Current increment is 
shown next to the Rotate Image icon. 

Apply Commits the changes that you made to the images, but it leaves the window 
open for you to make further changes, if desired.

Translate 
image

Activates moving mode by making the moving icons available. The moving 
icons or the icons that display direction arrows let you move the adjusted image 
in one direction only by a specified number of pixels. The default number of 
pixels is 1; however, the number of pixels may be from 0.01 to 2048.0. 
Therefore, the direction arrows provide the greatest specificity in moving the 
image, which is perfect for fine adjustments.

To change the number of pixels, click the Set pixel increment icon; enter a 
desired number in the Pixel Increment box; and then click Apply. Refer to 
“Moving and rotating the adjusted image” on page 379.

 Rotate 
Image

Activates rotation mode. If the rotation of the adjusted image is incorrect, you 
can change the rotation of the image with the two rotation icons: Rotate 
clockwise and Rotate counterclockwise. Rotation icons allow you to turn the 
adjusted image in the desired direction only by a specified degree (1–360). The 
default degree is 1, and it is shown next to the Rotate Image icon. To change 
the degree, click the Change Degree Increment icon; enter a desired number in 
the Degree Increment box; and then click Apply. Refer to “Moving and rotating 
the adjusted image” on page 379

Figure 3.  The Blended tab options (continued)

  Translate 
Image

 Rotate Image
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MOVING THE ADJUSTED IMAGE

The Translate image icon activates moving mode for the adjusted image and 
allows you to move the image in any direction. This icon only appears on the 
Blended tab, which is where all manual adjustments to image registration 
occurs. To move the adjusted image, click Translate Image and, holding 
down the left mouse button, drag the icon in the direction in which you wish 
to move the image, and then release the mouse button. After a few 
moments, the image appears in the new position. Note that, depending on 
where you moved the adjusted image, its outer portions may disappear 
beyond the outer edges of the reference image. In this case, you can use the 
same icon to move the adjusted image again.

MOVING THE ADJUSTED IMAGE WITH THE 
DIRECTION ARROWS

The icons that display direction arrows let you move the adjusted image in 
one direction only by a specified number of pixels. The default number of 

Figure 4.  The Blended tab: activating moving and rotation modes

 Move up

 Move right
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pixels is 1; however, the number of pixels may be from 0.01 to 2048.0. 
Therefore, the direction arrows provide the greatest specificity in moving 
the image, which is perfect for fine adjustments. 

To change the number of pixels, click the Set pixel increment icon; enter a 
number in the Pixel Increment box; and then click Apply. See Figure 4.

ROTATING THE ADJUSTED IMAGE

If the rotation of the adjusted image is incorrect, you can change the 
rotation of the image using the rotation icons as shown in as shown in 
Figure 5.

1 To activate rotation mode, click the Rotate Image icon. 

2 Then, use the Set Degree Increment option to set up the desired degree 
increment. The increment’s range is between 0.01 and 360.0 degrees. 

3 Select the center of rotation for the image. In order to do that, click 
Rotate Image, and then set the center by clicking with the mouse on the 
image. The letter C appears with a yellow crosshair cursor (+). You can 
then drag a line from the center of rotation to move the image above or 
below the center of rotation. 

4 To rotate the image clockwise, click Rotate Clockwise; and to rotate the 
image counterclockwise, click Rotate Counterclockwise.

The image can also be rotated manually by dragging away from the center of 
rotation, and then dragging either clockwise of counterclockwise.

Rotate Image
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Note: You can change the degree increment any time to achieve exact 
registration. 

DUAL TAB 

The Dual tab shows both the reference image and the adjusted image side 
by side in the image area at the bottom of the page. 

Note that the border around the reference image, the image on the left side 
of the page, appears in red. The border around the adjusted image, which is 
on the right side of the page, appears in green. Several of the icons near the 
top of the page are color coded to the images. That is, the red icons apply to 
the reference image, and the green icons apply to the adjusted image. 

Figure 5.  Rotating the adjusted image.
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THE DUAL TAB OFFERS THE FOLLOWING 
OPTIONS

Blended tab Displays the Blended page, which shows the image to be registered 
superimposed on the reference image. This page allows you to move and align 
the image to be registered with the reference image. For the Blended tab 
options refer to Figure 2.

Dual tab Displays the Dual page, which shows each image side by side, and allows you 
to delineate three or more landmarks on each image before you apply the 
Landmark—Least Squares algorithm or the Landmark—Thin Plate Spline 
algorithm to the images. 

 Lookup 
Table

Displays the Lookup Table window, which includes two tabs: Image A, the 
reference image, and Image B, the image to be registered.

 Magnify 
reference image 
2.0x

Doubles the size of reference images, magnifying them to twice their current 
size. If an image is too large for the current window size, scroll bars appear, 
and you may need to manually adjust the size of the window.

To restore reference images to their original size, use the Magnify Reference 
Image 0.5x icon, as many times as you used this icon.

 Magnify 
reference image 
0.5x

Reduces the magnification level of reference images in half. To restore 
reference images to their original size, use the Magnify Reference Image 2.0x 
icon, as many times as you used this icon.

  Magnify 
adjusted image 
2.0x

Doubles the size of adjusted images, magnifying them to twice their current 
size. If an image is too large for the current window size, scroll bars appear, 
and you may need to manually adjust the size of the window.

To restore adjusted images to their original size, use the Magnify Reference 
Image 0.5x icon, as many times as you used this icon.

 Magnify 
adjusted image 
0.5x

Reduces the magnification level of adjusted images in half. To restore adjusted 
images to their original size, use the Magnify Reference Image 2.0x icon as 
many times as you used this icon.

 Apply least 
squares 
alignment

Applies the Landmark—Least Squares algorithm to the image to be registered. 
After the algorithm is applied, if needed, you can apply the Landmark—Thin 
Plate Splines algorithm on the image, or you can manually adjust the alignment 
of the image on the Blended page.

Figure 6.  The Dual tab options
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 Apply thin 
plate spline 
alignment

Applies the Landmark—Thin Plate Spline algorithm to the image to be 
registered. After this algorithm is applied, if needed, you can apply the 
Landmark—Least Squares algorithm on the image, or you can manually adjust 
the alignment of the image on the Blended page.

 Reset image 
to original state

Restores the image to its original state. This icon deletes all points on the 
reference image and on the adjusted image. If the Apply button has already 
been selected, the Reset icon undoes all changes that occurred since the last 
time the Apply button was selected. 

 Reference 
slice markers

Adds a landmark point to the reference image each time you click the left 
mouse button. Note that the points are sequentially labeled from 1 on in the 
order in which you created them. To remove points, return the cursor to its 
default mode by clicking Return to default mode, select the point to be 
deleted, and then click the Delete Selected Reference Slice Markers icon.

 Adjusted 
slice markers

Adds a landmark point to the adjusted image each time you click the left mouse 
button. Note that the points are sequentially labeled from 1 to n in the order in 
which you created them. To remove points, return the cursor to its default 
mode by clicking Return to default mode, select the point to be deleted, and 
click the Delete Selected Adjusted Slice Markers icon. Note: landmarks in the 
reference image should correspond to landmarks in the adjusted image.

 Delete 
selected 
reference slice 
markers

Removes the landmark point that you selected in the reference image. To 
remove a point, first return the cursor to its default mode by clicking Return to 
default mode, then select the point to be deleted, and then click the Delete 
Selected Reference Slice Markers icon.

 Delete 
selected 
adjusted slice 
markers

Removes the landmark point that you selected in the adjusted image. To 
remove the point, first return the cursor to its default mode by clicking Return 
to default mode, then select the point to be deleted, and finally click the 
Delete Selected Adjusted Slice Markers icon.

Copy refer-
ence markers to 
adjusted image

Copies landmarks from the reference image to adjusted image. Note that 
landmarks which were copied to the adjusted image have the same x, y 
coordinates as the reference image landmarks.

Copy 
adjusted 
markers to 
reference 
markers

Copies landmarks from the adjusted image to reference image. Note that 
landmarks you copied to the reference image have the same x, y coordinates 
as the adjusted image landmarks.

Figure 6.  The Dual tab options (continued)
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USING THE IMAGE REGISTRATION 
ALGORITHMS

Before applying the Landmark—Least Squares algorithm or the Land-
mark—Thin Plate Spline algorithm to the images you must delineate three 
or more landmark points or landmarks on each image. See Figure 7.

DELINEATING THE LANDMARK POINTS

To place landmarks on the reference image, click the Reference Slice 
Markers icon, and then click the mouse on the reference image where the 

 Return to 
default mode

Returns the cursor to its default mode, which allows you to change from adding 
points to deleting points from the image.

 Apply 
Commits the changes that you made to the images, but it leaves the window 
open for you to make further changes if desired.

Figure 6.  The Dual tab options (continued)

Figure 7.  The Dual tab shows both: the reference image and adjusted 
image side by side. Three corresponding landmark points were 
delineated in the reference and adjusted image.
MIPAV User’s Guide, Volume 2, Algorithms 385

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Manual 2D Series
landmark should be located. The landmark appears on the image in red type 
and is sequentially numbered. Create at least two more landmarks on the 
image.

To place landmarks on the adjusted image, click the Adjusted Slice 
Markers icon, and create at least three landmarks on the image by clicking 
the mouse. The landmarks, which are sequentially numbered, appear in 
green type. 

To remove a landmark point from the reference or adjusted image, you 
need to return the mouse cursor to its default mode by clicking on the 
Return to Default Mode icon. You can then select the point by clicking on it 
with the mouse, and then delete it by clicking the corresponding Delete 
Selected Markers icon.

APPLYING THE IMAGE REGISTRATION 
ALGORITHMS

After you have delineated the landmark points on both images, select the 
Least Squares algorithm. The Least Squares algorithm registers the 
adjusted image to the reference image by using corresponding points placed 
in both images.

The Thin Plate Spline algorithm allows you to register two images in a 
nonlinear manner using the corresponding landmark points that you 
delineate in both images.

The program registers the images and the landmarks appear in yellow type 
followed by the specific positions in parentheses. 

At this point, you should determine the following:

1 Whether there is a need to make other manual adjustments to the 
registration. If so, return to the Blended tab and use the direction or the 
rotation icons. Use the Window region of image B icon to verify 
alignment. Refer to “making manual reconcilements to the adjusted 
image” on page 387.

2 Whether to run the other algorithm. If so, simply call either the Least 
Squares or Thin Plate Spline algorithm, as appropriate.

 Apply Least 
Squares alignment

 Apply Thin Plate 
Spline alignment

 Reference 
Slice Markers

 Adjusted Slice 
Markers

 Return to 
Default mode
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3 Whether to restore the adjusted image to its original form by clicking 
Reset.

4 Whether to select Apply to keep changes made by the algorithm.

MAKING MANUAL RECONCILEMENTS TO THE 
ADJUSTED IMAGE 

After you apply either the Least Squares or the Thin Plate Spline algorithm 
on the images, you may want to manually ascertain whether key portions of 
the reference image and the image to be registered, or adjusted image, are 
in alignment. One way of checking alignment, or registration, is using the 
Window region of image B icon. A recommended method for checking 
registration and for correcting it follows.

To check registration, do the following:

1 Click Blended in the Manual 2D Series window to display the Blended 
page. Both the reference image and the image to be registered, or 
adjusted image, appear at the bottom of the window. The adjusted 
image is superimposed over the reference image.

2 By default, the arrow on the AlphaBlending slider appears in the middle 
of the slider at 0.5R/A, which means that 50 percent of each image are 
shown on the page.

3 Slide the arrow on the AlphaBlending slider all the way to the right until 
it reaches the label “Adj. A.” This label indicates that 100 percent of the 
adjusted image is displayed on the page and, therefore, the reference 
image does not appear.

4 Now, open Lookup table for the adjusted image. Note that the window 
includes two tabs: one for Image A, the reference image, and one for 
Image B, the adjusted image.

5 Use the LUT options to change the intensity for one of the color 
channels for the adjusted image, for example, to increase the red 
channel. The purpose in doing this task is to easily distinguish the 
adjusted image from the reference image. Refer to “Using LUT to 
arrange the images” on page 389.

 Window region
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6 Return to the Blended tab of Manual 2D Registration dialog box and 
move the AlphaBlending Image slider arrow all the way to the left on the 
slider. The label “Ref. R” indicates that the page now displays 100 
percent of the reference and does not display the adjusted image.

7 Click the Window Region of Image B icon and position the cursor over 
the reference image. Notice that a square box appears on the image. The 
box is filled with the adjusted image, which is appears in pale red. You 
can use this box to look at the alignment of details in the images. See 
Figure 8.

8 Determine whether you want to correct the alignment of the images. If 
you do, there are several ways to align the adjusted image: 

• Moving the image using the Translate image icon and direction arrows. 
See also “Moving the adjusted image” on page 380.

• Rotating the image using the Rotate Image icon. See also “Rotating the 
adjusted image” on page 381.

Figure 8.  The Window Region box is filled with the adjusted image
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USING LUT TO ARRANGE THE IMAGES

You can use the LUT options to distinguish the adjusted image from the 
reference image. In order to to that

1 Return to Blended mode.

2 Click the Lookup Table icon, to display the Lookup Table window. Note 
that the window includes two tabs: one for Image A – the reference 
image, and the other one for Image B – the adjusted image.

3 For the adjusted image, drag the image intensity line for the red channel 
up in the middle. In this case, it creates a lighter colored red. The 
adjusted image now appears in pale red. Actually, you can change the 
color of the image to any color. See Figure 9 below.

 Tip: You may want to maximize the window and enlarge the images so that 
you can view details of the images while checking alignment. To maximize the 
window, simply click Restore. To maximize the image, click the Magnify image 
2.0x icon, which magnifies the image to twice its current size, as many times 
as needed.

Figure 9.  The adjusted image and its Lookup table
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4 Return to the Blended tab and move the image slider arrow all the way 
to the left on the slider, so the page now displays only the reference 
image.

5 Click the Window Region of Image B icon and position the cursor over 
the reference image. 

6 The Windows Region box appears on the image, filled with the adjusted 
image, which is appears in pale red. 

7 Use this box to look at the alignment of details in the images. 

Figure 10.  The adjusted image which appears in the Blended tab and 
also in the Window Region.
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Applying the Manual 2D Series algorithm to 2.5D 
images

To run this algorithm on 2.5D images, complete the following steps:

1 Open a single 2.5 image dataset. When you apply this algorithm, you 
select the slices in the dataset that you want to register.

2 Perform, as an option, any other image processing, except scaling, on 
the image dataset.

3 Select Algorithms > Registration > Manual 2D Series. The Manual 2D 
Series window for 2.5D images (Figure 11) opens.

4 Because you are registering slices of the image, and not separate images, 
all of the necessary icons and controls appear in a simple window that 
does not include tabbed pages. Note that two additional sliders appear 
at the top of the page:

• Reference slice slider allows you to choose which slice to use as a 
reference image. 

• Adjusted slice slider allows you to choose which slice to use as an 
image to be registered. 

Note: the boxes to the right of each slider indicate the number of slice which you 
are currently viewing. All of the remaining icons and controls work in the same 
way that they do on the Manual 2D Series window for 2D images.

5 Choose the reference and adjusted slice. You can consider using the LUT 
to distinguish the adjusted image from the reference image as described 
in Section “Using LUT to arrange the images” on page 389.

6 Use the Alphablending image slider to display only the reference slice 
and then place at least four landmarks on the reference slice. Repeat the 
same procedure for the adjusted slice.

7 Now, move the image slider arrow all the way to the left on the slider, so 
the dialog box will display only the reference slice.
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8 Click the Window Region of Image B icon and position the cursor over 
the reference image. The Windows Region box appears on the image, 
filled with the adjusted image, as shown in Figure 11. Use this box to 
look at alignment of fine detail in the slices. 

9 At this point, you should determine the following:

• Whether there is a need to make manual adjustments to the 
registration. If so, use the direction or the rotation icons to verify 
alignment.

• Whether to run one of the registration algorithms. If so, simply call 
either the Least Squares or Thin Plate Spline algorithm, as 
appropriate. Select Apply to keep changes made by the algorithm.

Figure 11.  Applying the Manual 2D Series Registration algorithm on a 
2.5D image. Slice 3 (adjusted slice) is registered to slice 1 (reference 
slice). To differentiate the slices, we use LUT options to color the 
reference slice to pale green and adjusted slice to pale blue.
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Applying the Manual 2D Series algorithm to 3D images
When you apply this algorithm, you select the slices, which you want to 
register, in a single 3D dataset. To run the algorithm on 3D images, 
complete the following steps:

1 Open a single3 image dataset. Perform, as an option, any other image 
processing, except scaling, on the image dataset.

2 Select Algorithms > Registration > Manual 2D Series. The Manual 2D 
Series window for 3D images opens.

3 Because you are registering slices of a single 3D image, all of the 
necessary icons and controls appear in a window that does not include 
tabs. Note that there are three sliders appear at the top of the page:

• Reference slice slider allows you to choose which slice to use as a 
reference image. 

• Adjusted slice slider allows you to choose which slice to use as an 
image to be registered. 

• AlphaBlending Slider which, by default, displays both the 
reference and adjusted slices blended in proportion 50/50.

Note: the boxes to the right of the Reference Slice and Adjusted Slice slider 
indicate the number of slice which you are currently viewing. All of the remaining 
icons and controls work in the same way that they do on the Manual 2D Series 
window for 2D images.

4 Choose the reference and adjusted slice. Use the LUT to differentiate the 
adjusted image from the reference image. See also: Section “Using LUT 
to arrange the images” on page 389.

5 Use the AlphaBlending image slider to display only the reference slice 
and then place at least four landmarks on the reference slice. Repeat the 
same procedure for the adjusted slice.

6 Move the image slider arrow all the way to the left on the slider, so the 
window now displays only the reference slice.

7 Click the Window Region of Image B icon and position the cursor over 
the reference image. The Windows Region box appears on the image, 
filled with the adjusted image, as shown in Figure 12. You can use either 
this box or Checker Board to look at alignment of details in the slices. 
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8 At this point, you should figure out the following:

• Whether there is a need to make further manual adjustments to the 
registration. If so, use the direction or the rotation icons to verify 
alignment.

• Whether to run one of the registration algorithms. If so, simply call 
either the Least Squares or Thin Plate Spline algorithm, as 
appropriate. 

9 When done, select Apply to keep changes made by the algorithm.

Figure 12.  Registering the 3D image.
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Extract Surface (Marching Cubes)

The Extract Surface algorithm described in this section is based on the 
Marching Cubes algorithm, which was designed by William E. Lorensen 
and Harvey E. Cline to extract surface information from a 3D array of 
values. The applications of this algorithm are mainly concerned with 
medical visualizations such as CT and MRI scan data images.

Background
The basic notion of the algorithm is that we can define a voxel by the pixel 
values at the eight corners of the cube. We also can define an isosurface 
which intersects the cube, refer to Figures 1 and 2. If one or more pixels of a 
voxel have values less than the user-specified isovalue, and one or more 
have values greater than this value, we know that the voxel must contribute 
some component of the isosurface. 

By determining which edges of the voxel are intersected by the isosurface, 
we can create triangular patches that divide the voxel between regions 
within the isosurface and regions outside. By connecting the patches from 
all voxel on the isosurface boundary, we get a surface representation.

The indexing convention for vertices and edges used in the algorithm is 
shown in Figure 1 below.

Figure 1.  The indexing convention for vertices and edges. Here, edge 
indexes are shown in blue and vertex indexes are shown in magenta
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Example: If for example, the value at vertex 3 is below the isosurface value and 
all the values of all the other vertices are above the isosurface value, then we 
would create a triangular facet which cuts through edges 2,3, and 11 as shown in 
Figure 2. The exact position of the vertices of the triangular facet depends on the 
relationship of the isosurface value to the values at the vertices 3-2, 3-0, 3-7 
respectively.

Therefore, we must specify a threshold value, first. For this value, some vox-
els will be entirely inside or outside the corresponding isosurface and some 
voxels will be intersected by the isosurface. In the first pass of the algo-
rithm, the voxels that are intersected by the threshold value are identified. 
In the second pass, these voxels are examined and a set of one or more poly-
gons is produced. These polygons are then output for rendering.

Each of the voxel's 8 vertices can be either inside or outside of the isosurface 

value, thus, there are 28 = 256 possible ways how an isosurface can inter-
sect the voxel. To simplify the algorithm, we can reduce this complexity by 
assuming that cell combinations are duplicated under the following condi-
tions:

• Rotating by any degree over any of the 3 primary axis (X,Y, or Z);

• Mirroring the isosurface’s shape across any of the 3 primary axis;

• Inverting all corners and flipping the normals of the relating polygons.

Figure 2.  Vertex 3 is inside the volume
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By taking this symmetry into account, we can reduce the original 256 
combinations to a total of 15 combinations, refer to Figure 3.

Now we can use a table (called edgeTable) which maps the vertices under 
the isosurface to the intersecting edges. An 8 bit index can be formed from 
the table where each bit corresponds to a vertex, refer to Table 1.

Table 1. edgeTable

   cubeindex = 0;

   if (grid.val[0] < isolevel) cubeindex |= 1;

   if (grid.val[1] < isolevel) cubeindex |= 2;

   if (grid.val[2] < isolevel) cubeindex |= 4;

   if (grid.val[3] < isolevel) cubeindex |= 8;

   if (grid.val[4] < isolevel) cubeindex |= 16;

   if (grid.val[5] < isolevel) cubeindex |= 32;

   if (grid.val[6] < isolevel) cubeindex |= 64;

   if (grid.val[7] < isolevel) cubeindex |= 128;

Looking up the edgeTable returns a 12 bit number, each bit corresponding 
to an edge. 0 if the edge isn't cut by the isosurface and 1 if the edge is cut by 
the isosurface. If none of the edges are cut the table returns zero. This 
occurs when the cubeindex is 0, which means that all vertices are below the 
isosurface, or 0xff (all vertices above the isosurface).

Using the example shown in Figure 1, where only vertex 3 was below the 
isosurface, cubeindex would equal 0000 1000 or 8. The edgeTable{8} 
equals 1000 0000 1100. This means that edge 2,3, and 11 are intersected by 
the isosurface, refer to Figure 2.

Figure 3.  How 256 cases can be reduced to 15 cases
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Now the intersection points can be calculated by linear interpolation. If P1 

and P2 are the vertices of a cut edge and V1 and V2 are the scalar values of 

each vertex, the intersection point P is given by the following equation:

The last part of the algorithm involves forming the correct triangular facets 
from the positions where the isosurface intersects the edges of the grid cell. 
In order to do that, another table (also called triTable) is used. This table 
uses the same cubeindex from edgeTable, but allows the vertex sequence to 
be searched for as many triangular facets as necessary to represent the isos-
urface within the grid cell. Each of the non-trivial configurations results in 
between 1 and 4 triangles is added to the isosurface. The actual vertices 
themselves can be computed either by interpolating along the edges, or, by 
default their location to the middle of the edge. 

Since we can create surface patches for a single voxel, we can apply this 
algorithm to the entire volume.We can either treat each cube indepen-
dently, or we can propagate edge intersections between the cubes which 
share the edges. The sharing of edge/vertex information also results in a 
more compact model.

REFERENCES

The following sources were used:

Lorensen, W.E. and Cline, H.E., Marching Cubes: a high resolution 3D surface 
reconstruction algorithm, Computer Graphics, Vol. 21, No. 4, pp 163-169 (Proc. of 
SIGGRAPH), 1987.

Paul Bourke, Polygonising a scalar field Also known as: “3D Contouring,” “Marching 
Cubes,” “Surface Reconstruction;” May 1994, http://local.wasp.uwa.edu.au/~pbourke/
modelling/polygonise/ 
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IMAGE TYPES 

You can apply the Extract Surface algorithm to any type of images using in 
MIPAV. 

Output Files
The output of the algorithm is a set of vertices and normals as well as the 
map that shows how the vertices are connected. This information can be 
saved in following formats:

• Tab-delimited (*.txt);

• Surface (*.sur), which is MIPAV format. A surface file contains the 
above information plus the additional information that describes the 
surface color and more. This is defined by an XML scheme, which 
can be found on the MIPAV web site (http://mipav.cit.nih.gov/
documentation/xml-format/image/);

• VRML (*.wrl), which can then be processed by any application that 
can read and display VRML objects.

Applying the Extract Surface Algorithm

To run the algorithm, complete the following steps:

1 Open an image of interest;

2 Select Algorithms > Extract Surface (marching cubes);

3 The Extract Surface dialog box opens. Here, you can choose to apply 
following three options: 

• You may select a VOI region, and then apply the algorithm to the 
selected VOI;

• You may apply a mask to the image first, and then run the 
algorithm;

• Or you may extract a surface from the region with a chosen intensity 
level.

4 Select a type and location of the output file. You can save the result as a 
*.txt file (in Tab-delimited format), *.wrl file, or surface file (*.sur). 
Refer to Section “Output Files” for more information.
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5 Press OK.

The algorithm begins to run, and a progress bar appears with the status. 
When the algorithm finishes running, the progress bar disappears, and the 
results appear as a file in selected format in a chosen location. For more 

information about the dialog box options, refer to Figure 4.

Figure 4.  The Extract Surface dialog box options

VOI Region Applies the algorithm to the 
volume delineated by the 
VOI.

Mask Image Applies the algorithm to the 
volume within a chosen 
mask. You must apply the 
mask, first.

Intensity Level Applies the algorithm to the 
region with the chosen 
intensity level. By default, 
the intensity level value is 
set to 50.

Blur by 
(Std.Dev.)

Blurs the image to improve 
the extracted surface. The 
value specifies the standard 
deviation of the Gaussian 
filter used to regularize the 
image.

Decimate 
Surface

If selected, reduces the 
count of triangle facets, 
which results the more 
compact algorithm.

Choose Use this button to select a 
catalogue where you would 
like to store your results and 
choose a file format (*.txt, 
*.sur, or *.wrl).

OK Applies the algorithm 
according to the 
specifications in this dialog 
box. 

Cancel Disregards any changes that you made in this dialog box and closes it.

Help Displays online help for this dialog box.
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EXAMPLES 

1. To apply the algorithm to a VOI region:

1 Open an image of interest.

2 Delineate a VOI on the image, and then call the Algorithms> Extract 
Surface (marching cubes).

3 In the Extract Surface dialog box that appears, select the VOI Region 
option.

4 Select the surface file type as an output, and then specify the file name 
and location.

5 Press OK. The algorithm begins to run, and a progress bar appears 
showing the status. 

6 When the algorithm finishes running and the progress bar disappears, 
click the Volume Tri-planar View icon on the MIPAV toolbar.

7 The Resample dialog box appears. 

8 In the Expected Extents box, specify the value for the Z direction. The 
value must be in a power of two (32, 64, 128, 256). Refer to Figure 5. 

The bigger number you choose, the higher resolution you receive.1

Figure 5.  The Resample dialog

1. Please, note that the Resampling in a lengthy process. Give some consideration to values you choose 
for Z. The algorithm's speed also depends on the MIPAV memory allocation settings. Resample size 
also depends on the amount of memory on the graphics card. 
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9 Press Resample to proceed.

10 The 3D viewer opens for the selected image. 

11 Click the Add Surface to Viewer icon and add the surface file from Step 5 
to the Surface list. Then, select the file name and press Add. 

12 The surface will be added to the image. To adjust the display of the 
image, use the Surface options, such as color and opacity. Refer to 
Figure 6.

2. To use the Mask Image option:

1 Open an image of interest.

2 Create a mask.

Figure 6.  The view of the surface extracted using the VOI Region option 
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3 Call the Algorithms> Extract Surface (marching cubes).

4 In the dialog box that appears, select the Mask Image option.

5 Select the surface file as an output, and then specify the file name and 
location. Press OK.

6 When the algorithm finishes running, click the Volume Tri-planar View 
icon on the MIPAV toolbar and follow the steps 6--12 from the first 
example on page 401. Refer to Figure 7.

Figure 7.  The view of the surface extracted using the Mask Image option
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3. To use the Intensity Level option:

1 Open an image of interest.

2 Select the intensity level value. You can understand the intensity level by 
mousing over the image. The intensity value for the selected pixel is 
shown on the main MIPAV toolbar.

3 Call the Algorithms> Extract Surface (marching cubes).

4 In the dialog box that appears, select the Intensity Level option.

5 Enter the intensity value that you would like to apply. Refer to Figures  8 
and  9.

Figure 8.  The intensity level is shown on the main MIPAV toolbar
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6 Select the surface file as an output, and specify the file name and 
location. Press OK to run the algorithm.

7 When the algorithm finishes running, click the Volume Tri-planar View 
icon on the MIPAV toolbar and follow the steps 7–12 from the first 
example on page 401. 

Figure 10 shows the surface extracted using the Intensity Level option.

Figure 9.  Enter the intensity level value here
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Figure 10.  The view of the surface extracted using the Intensity Level 
option
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Mask

This algorithm generates a mask, with a specified intensity, of the region 
inside or outside the contoured VOI groups that are delineated on an 
image. This algorithm is an alternative to the other mask-generation 
methods discussed in Volume 1 of the MIPAV User’s Guide. 

Tip:  If you have already used contours to delineate a VOI, you might want to 
use this method because it provides a quick means to create a mask.

Background
When you apply this algorithm, enter the intensity value that fills the mask 
(contour). Then, indicate whether you want the algorithm to fill the area 
inside or outside of the contoured areas. When this algorithm runs, it 
determines which areas are contoured and fills the areas inside or outside of 
the contour with the specified intensity value (refer to Figure 1).

Figure 1.  Mask algorithm processing
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IMAGE TYPES

You can apply this algorithm to 2D, 2.5D, 3D, and 4D images. However, you 
cannot apply the algorithm to RGB images.

SPECIAL NOTES

If the intensity is higher or lower than the original extremes, the LUT is 
modified so that the new intensity is incorporated. After this algorithm is 
run, you may need to manually adjust the LUT so that you can see the 
structures clearly.

REFERENCES

There are no references for this algorithm.

Applying the Mask algorithm
To run this algorithm, complete the following steps:

1 Open an image, in Default view, in an image window. 

2 If not done already, contour the desired VOIs. MIPAV applies the mask 
to every VOI in the dataset, regardless of group affiliation. For more 
guidance on contouring a VOI, refer to volume 1 in the MIPAV User’s 
Guide.

3 In the MIPAV window, select Algorithms > Mask. The Mask Image 
dialog box  (Figure 2) appears.
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4 Enter the parameters and indicate whether to fill the region inside or 
outside of the region bound by the VOI contours. Enter the destination 
information (refer to the previous table for more information).

5 When complete, click OK.

A status window appears with the following message: “Masking” to 
indicate that the software is generating the mask by replacing the 
intensity levels. MIPAV then remaps the intensity values in the dataset 
to the LUT. The new masked image appears.

Value used to fill 
VOI(s)

Indicates the intensity value 
that replaces the existing 
value inside or outside the 
region bound by the VOI 
contours. 

To replace the intensity value 
inside the VOI region, type a 
value in this text box and then 
select the Interior/exterior fill 
check box.

To replace the intensity value 
outside the VOI region, simply 
type a value in this text box.

Interior/exterior 
fill

If selected, changes the 
intensity values of the region 
bound by the VOIs to the 
intensity value indicated in 
Value used to fill VOI(s).

New image If selected, indicates that the results of the algorithm appear in a new image 
window.

Replace image If selected, indicates that the results of the algorithm replace the current active 
image. 

OK Performs the Mask algorithm on the selected images based on your choices in 
this dialog box.

Cancel Disregards changes you made in this dialog box and closes the dialog box.

Help Displays online help for the algorithm.

Figure 2.  Mask Image dialog box 
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Tip: If the resulting masked image looks significantly lighter or darker than 
the original image, the new intensity value that you specified may be much 
higher or lower than the majority of other intensity values in the dataset. To 
change the LUT, do one of the following: (1) Click Quick LUT. Move the cursor 
to the resultant masked image and draw a box around an area where the 
intensity value was not changed. MIPAV uses these values to remap the image 
data to the LUT. (2) Adjust the LUT in the Lookup Table window. For more 
information on how to do this, refer to the MIPAV User’s Guide, Volume 1.
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Microscopy: Colocalization Orthogonal 
Regression

This algorithm quantifies automatically the amount of colocalization in 
images. Recently, this method was used to quantify protein-protein 
interactions from colocalization data analysis of two-color confocal 
microscope images. The method was accurate enough to determine 
dissociation rates of two interacting proteins labeled with fluorescence 
reporters in live cells. This method may be helpful in answering other 
biological questions that involve protein-protein interactions or co-
compartmentalization.

Disclaimer: Colocalization cannot distinguish interaction from co-
compartmentalization for compartments below light resolution (i.e., 
distances less than 200 nm).

The theory of colocalization assumes that a high level of similarity between 
two spatial patterns implies proximity of the two proteins, which implies 
direct or indirect protein binding, or co-compartmentalization, of the 
proteins.

Specifically, the algorithm creates a 2D histogram from two colors of a 
single image or from two black-and-white images. It uses an orthogonal line 
fit of the histogram data to generate a correlation line through the 
histogram. Upper right region rectangles with lower left corners on the 
correlation line are used as colocalization regions, regions where both of the 
two colors are significantly above background. The colocalization frame is 
tied to the original or modified source image or images, therefore only the 
pixels located in the colocalization region are displayed. A user-movable 
point allows for the display of source image pixels and statistics associated 
with different upper right colocalization regions. When not in free range 
mode, the point must move along the correlation line. In free range mode, 
the point can move anywhere in the histogram buffer.

In summary regarding the usage of this algorithm, one must make sure that 
the images acquired have low noise levels and no bleed through and that the 
optical setup used for each color leads to the same point spread function 
(PSF) and is free of registration errors. Assumptions made in this approach 
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are that pixel intensities linearly relate to concentration of molecular 
species being measured and that a pixel is either colocalized or not.

Background
Based on the type of image, when this algorithm is used, either the 
Orthogonal Regression Colocalization dialog box for color images or the 
Orthogonal Regression Colocalization dialog box for grayscale images 
(Figure 1 on page 421) opens.

As an option, the Colocalization Orthogonal Regression algorithm can 
perform background level subtraction on images. If the Subtract average 
VOI level check box is selected, then the algorithm calculates the average 
pixel levels in the yellow VOI in one-color images or in the two yellow VOIs 
in two black-and-white images. It then subtracts these two background 
levels from the 1 or 2 source images. If a registration was also selected, the 
background determinations occur before registration, and subtraction 
occurs after the registration. After the subtraction is performed, any pixels 
with negative values are set to zero.

As an option this algorithm can perform image registration before 
performing colocalization. If you select the Registration before 
Colocalization check box on the Orthogonal Regression Colocalization 
dialog box, this algorithm runs another algorithm—the Optimized 
Automatic Registration (OAR) 2D algorithm—first. In this registration, 
both images or colors are moved halfway to a common center point. The 
registration is always done on the entire image. The only registration 
parameter that you can vary is the cost function. Although correlation ratio 
is the default cost function, you can select least squares, normalized cross 
correlation, or normalized mutual information instead.

After registration, this algorithm performs colocalization on the registered 
image or images rather than on the original image. After subtraction, this 
algorithm performs colocalization on the subtracted image or images rather 
than on the original image. If the maximum data range is decreased, then 
the number of histogram bins decreases if necessary so as not to exceed the 
actual number of channels in the data range. 

The amount of colocalization can be measured with the linear correlation 
coefficient.
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Let L be the linear correlation coefficient
Let the two channels be R and G

Let the average values be  and 

Then 

This is equivalent to the more traditional form of the equation:

where N is the number of pixels.

The linear correlation coefficient ranges from -1 to 1 with 0 the value for 
random patterns and 1 the value for 100-percent colocalization. Negative 
values of the coefficient are not used for colocalization since that would 
indicate an anticolocalized situation with a bright pixel in one channel 
implying a dim pixel in another channel. 

Note: The medical literature on colocalization refers to the traditional linear 
correlation coefficient as Pearson's coefficient.

This algorithm uses the linear least squares method of calculating the best 

line fit for . It uses an orthogonal line fit where the 

minimized distance measurements are orthogonal to the proposed line. 
This is an orthogonal regression as opposed to a traditional direct 
regression of dependent y variable green on independent red variable x, 
which would minimize the vertical distances between the points and the 
fitted line. An inverse regression of red on green would minimize the 
horizontal distances between the points and the fitted line. All three lines 

pass through the point ( , ), but the three lines only coincide if the 

correlation coefficient equals -1 or 1. Use of a direct regression only makes 
sense if one variable is dependent and one variable is independent. Since 
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the red and green dyes used in colocalization are best thought of as two 
independent variables, the orthogonal regression is most appropriate. 

Note: Orthogonal regression is also called total least squares.

Points that are part of the dataless background in both images are excluded 
from the regression line calculations. Let R be the red channel and G be the 

green channel. If  and , the point i is not 

included in the regression line calculations. If the image is not a floating 
point image, background1= 1.0 and background2 =1.0. In floating point 
images, the image minimums are used as backgrounds so that no points are 
excluded. Note that there are two VOIs: the yellow background subtraction 
VOI and a nonyellow VOI used to delineate the region of the image included 
in calculations. You can select to use points from the entire image, only 
points from the contour VOI region, or only points allowed by a mask file. 

Tip: If VOI region is selected, then, after the algorithm is run, you can move 
the VOI by dragging it with the mouse to another region on the image. When 
the mouse button is released, the calculation is performed again updating the 
histogram. This allows the calculation to be performed with the same contour 
VOI in different positions.

The optional second iteration, thresholding, is different from the first 
iteration thresholding. In the first iteration, points are only excluded if they 
are below both background1 and background2. However, in the second 
iteration, points are excluded if they are below either lastPositive1 or 
lastPositive2. The (lastPositive1, lastPositive2) is the last point going from 
top to bottom on the first iteration regression line before an L-shaped 
subthreshold region with a zero or negative linear correlation coefficient is 
found. In the second iteration, the L-shaped subthreshold region 
determined from the first iteration is excluded from the regression line 
calculations. The default is to not perform a second iteration.

Ri background1< Gi background2<
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The slope and offset of the orthogonal regression line can be obtained from 
the eigenvector of the smallest eigenvalue of the 2 by 2 matrix:

The eigenvector has the components (direction x, direction y).

where

S = slope of the line

V= variance

C = covariance
.

Let n be the normal vector to the orthogonal regression line.

Let theta be the angle from the x axis to the normal.

where

count 1–( ) sample y variance×  count 1–( ) sample xy covariance×–
 count 1–( ) sample xy covariance ×– count 1–( ) sample x variance×

slope of the line direction y
direction x
------------------------- Vy Vx Vy Vx–( )

2 4Cxy2
×+–

2Cxy
--------------------------------------------------------------------------------= =

offset y S x×–=

n x cos θ y sin θ×+×=

θ arctan (slope)=
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The minimized residue, the mean square error (MSE), is given by the 
following:

A histogram buffer is generated with bin1 counts along the x axis and bin2 
counts along the y axis. The Orthogonal Regression Colocalization dialog 
box allows you to specify the two bin numbers. The default is the range of 
the data (max - min +1) or 256, whichever is less, for nonfloating point 
images and 256 for floating point images.

The algorithm calculates the linear correlation coefficients for all pixels 
whose values are either below threshold in buffer or are below 

 in secondBuffer. This is the L-shaped subthreshold region. 

The algorithm calculates along the color that has the greatest range along 
the line segment. The line segment's (color1,color2) point just above the 
point where the linear correlation coefficient becomes negative or zero is 
taken in a nonrigorous fashion as the threshold point separating upper right 
rectangular colocalized data from the lower left L-shaped noncolocalized 
data.

MSE variance x cos θ( )
2 covariance + xy sin 2θ variance y sin θ( )

2

variance x 2slope covariance xy slope2 variance y×+ )×+(=

×+××=

1 slope2+( )⁄

a threshold b+×
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The algorithm calculates the percent colocalization area, the percent red 
colocalization, and the percent green colocalization. Each point has a red 
value = threshold and a green value = secondThreshold. Thus, each point 

defines an upper right rectangular region characterized by  and 

.

The percent colocalization area is 100 times the number of pixels belonging 
to the upper right rectangular region divided by the number of pixels in the 
entire image or selected VOI. 

Note:Only pixels with at least one of the two levels above background that you 
specify in the Orthogonal Regression Colocalization dialog box are included in 
any of the above sums.

red threshold≥

green secondThreshold≥

Percent

If Limit colocalization to pixels >= threshold is . . . 

Selected Not selected (default)

Red colocalization 

where

R = Sum of the red values in the 
upper right rectangular region

 = Sum of the red values >= red 

threshold in the image or selected 
VOI

where

R = Sum of the red values in the 
upper right rectangular region

 = Sum of the red values in the 

image or the selected VOI

Green 
colocalization

where

G = Sum of the green values in the 
upper right rectangular region

 = Sum of the green values >= 

green threshold in the image or 
selected VOI

where

G = Sum of the green values in the 
upper right rectangular region

 = Sum of the green values in the 

image or the selected VOI

100 R
RT
-------×

RT

100 R
RI
-----×

RI

100 G
GT
-------×

GT

100 G
GI
------×

GI
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IMAGES TYPES

You can apply this algorithm to both color and black-and-white 2D or 3D 
images. 

SPECIAL NOTES

Limitations to colocalization include the following:

• The inability to distinguish binding proteins from nonbinding proteins 
located within a cellular compartment smaller than the resolution of 
light microscopes (rough 200 nm)

• All current colocalization methods, including this one, force each pixel 
to be classified as either entirely colocalized or entirely noncolocalized 
signals. Clearly, this is not the case. Unfortunately, a method that 
treats each pixel as the sum of colocalized and noncolocalized signals 
has not been developed yet.

• An important note regarding quantitative colocalization is the need to 
use low-noise images to make accurate measurements since two 
identical signals become more and more uncorrelated as their signal-
to-noise ratio decreases. The amount of noise in a region of interest 
can be determined by measuring the Pearson correlation coefficient of 
two consecutive acquisitions of the same channel. For example, one 
could try to keep all images with a correlation above 90 percent (e.g., 
increasing laser power, using more averages). Also, in order to 
compute accurately each colocalized fraction, the background must be 
subtracted from each channel.

• Other important notes regarding the usage of this algorithm: One must 
make sure that the images acquired have low-noise levels and no 
bleedthrough, and the optical setup used for each color leads to the 
same PSF and is free of registration errors. Assumptions made in this 
approach are that pixel intensities linearly relate to concentration of 
molecular species being measured and that a pixel is either colocalized 
or not. 
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REFERENCES

See the following references for more information about this algorithm:

Sylvain V. Costes, Dirk Daelemans, Edward H. Cho, George Pavlakis, and Stephen Lockett, 
“Protein-protein interaction quantified by microscopic co-localization in live cells.” 

Gishan Dissanaike and Shiyun Wang, Equations for slope and offset of the orthogonal least 
squares problem, “A Critical Examination of Orthogonal Regression and an application to 
tests of firm size interchangeability.”

E. M. M. Manders, J. Stap, G. J. Brakenhoff, R.Van Driel, and J. A. Aten, “Dynamics of three-
dimensional replication patterns during the S-phase, analysed by double labelling of DNA 
and confocal microscopy,” Journal of Cell Science, 103:857-862, 1992.

E. M. M. Manders, F. J. Verbeek, and J. A. Aten, “Measurement of co-localization of objects 
in dual-colour confocal images,” Journal of Microscopy, Vol. 169, Pt. 3:375-382, March 
1993.

Eigenvalue software for solving the orthogonal least squares problem is found at the internet 
site www.magic-software.com.

Jan A. Van Mieghem, Hadar I. Avi-Itzhak, and Roger D. Melen, Equations for slope and 
mean square error of the orthogonal least squares from “Straight Line Extraction Using 
Iterative Total Least Squares Methods,” Journal of Visual Communication and Image 
Representation, Vol. 6, No. 1, pp. 59-68, March 1995.
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Applying the Microscopy: Colocalization Orthogonal 
Regression algorithm

To run this algorithm, complete the following steps:

1 Open either one color or two black-and-white images.

2 Select Algorithms > Microscopy > Colocalization > Orthogonal 
Regression.

Depending on whether the image is grayscale or color, the Orthogonal 
Regression dialog box for grayscale images (Figure 1) or the Orthogonal 
Regression box for color images (Figure 2) opens.

3 Complete the information in the dialog box.

4 Click OK.

The algorithm begins to run, and a progress bar appears with the status. 
When the algorithm finishes running, the progress bar disappears, and 
a 2D histogram with a correlation line and statistics for the threshold 
point appears in a new window.

5 Use the mouse to move the point to see the statistics for different upper 
right rectangular colocalization regions. This colocalization frame is tied 
to the original or modified color source image or to the two original or 
modified grayscale source images. Only those pixels belonging to the 
upper right colocalization regions are visible in the source images. If you 
want to move the point off the line, select Free range mode.

If you created a VOI on the source image and selected the VOI region in 
the dialog box, then you can drag the VOI with the mouse. When you 
release the mouse, the algorithm recalculates using the new VOI 
position and updates the histogram.
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Figure 1.  Orthogonal Regression Colocalization dialog boxes for (A) color and (B) grayscale 
images

(A) Orthogonal Regression Colocalization 
dialog box for color images

(B) Orthogonal Regression Colocalization 
dialog box for grayscale images
MIPAV User’s Guide, Volume 2, Algorithms 421

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Microscopy: Colocalization Orthogonal Regression
Channel selection Color images: Specifies the colors to use in color images. 

• If only two of the channels contain data, then only a label appears. For 
example, if only red and green are present, then the label Colocalization of 
red with green appears. 

• If all three color channels have data, then red, green, and blue check 
boxes are present. Select two of the three check boxes. By default red and 
green are selected.

Grayscale images: Specifies the second grayscale image to be used. 
Select one from the list box.

Registration before 
colocalization

Performs registration on an entire image before performing colocalization. 
When you select Registration before colocalization, the Cost function box 
becomes available.

By default, registration is not selected.

Cost function Specifies the cost function to be used during registration. You can specify 
correlation ratio (default), least squares, normalized cross correlation, or 
normalized mutual information.

To make this box available, you must first select Registration before 
colocalization.

VOI background 
subtraction

Calculates the average background levels in the yellow VOI and subtracts 
them from the rest of the image if Subtract average VOI level is selected. 
The subtraction results are clamped to be >= zero. The default is no 
subtraction.

Bin numbers Specifies the number of histogram bins to be used in the 2D histogram.

The default is the range of the data or 256, whichever is less, for 
nonfloating point images and 256 for floating point images.

Options Second iteration excluding subthresholded region—Excludes the L-
shape subthreshold region determined from the first iteration from the 
regression line calculations. 

By default, this check box is clear.

Limit colocalization to pixels >= threshold—Uses, in red colocalization, 
only pixels with red values >= red threshold in the denominator sum and, 
in green colocalization, only pixels with green values >= green threshold in 
the denominator sum. The default value is not selected.

Figure 1.  Orthogonal Regression Colocalization dialog boxes for (A) color and (B) grayscale 
images (continued)
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Colocalization 
region

Whole image—Makes calculations on the whole image. By default, this 
option is selected.

VOI region—Makes calculations on only the pixels in the VOI. To enable 
this option, a contour VOI must be present in the image.

After this algorithm run and the histogram is produced, if you drag the VOI 
with the mouse and then release the mouse button, the system recalculates 
using the new VOI position. 

Mask file—Makes calculations on only the pixels in the mask.

Selecting this option enables the Choose mask file button.

Choose mask file—Allows you to select a mask file.

Free range Toggles between requiring the point to be in the least squares line and 
allowing the point to be anywhere in the histogram buffer. By default, the 
free range mode is not selected.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes the 
dialog box.

Help Displays online help for this dialog box.

Figure 1.  Orthogonal Regression Colocalization dialog boxes for (A) color and (B) grayscale 
images (continued)
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COLOCALIZATION HISTOGRAM WINDOW

The Colocalization Histogram window (Figure 2) contains a 2D histogram 
with a correlation line and a mouse-movable point on the correlation line. 
As the point is 

File Close Colocalization—Closes the colocalization window. 

Help About Colocalization—Displays online help for this window.

Reset Moves the movable point to the position where the linear correlation coefficient of 
the L-shaped subthreshold region has gone from negative or zero to positive.

Magnify 
image 2.0X 

Magnifies the histogram by 2.

Magnify 
image 0.5X

Magnify the histogram by one-half.

Figure 2.  2D Histogram window
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moved, the statistics at the top of the frame change to reflect the changed 
upper right rectangular colocalization region whose lower left corner is 
selected by the point. The colocalization frame is tied to a version of the 
source color image or to the versions of the two source black-and-white 
images, so that only those source image pixels in the upper right 
colocalization region are visible in the source images.

The percent colocalization area, the percent red colocalization, and the 
percent green colocalization change with the point location. Each point has 
a red value = threshold and a green value = secondThreshold. Thus, each 
point defines an upper right rectangular region characterized by red >= 
threshold and green >= secondThreshold.

The percent colocalization area is given by 100 times the number of pixels 
belonging to the upper right rectangular region divided by the number of 
pixels in the entire image or the selected VOI. If limit colocalization to pixels 
>= threshold is not selected, the percent red colocalization (refer to 
Figure 3) is given by 100 times the sum of the red values in the upper right 
rectangular region divided by the sum of the red values in the image or the 
selected VOI. The percent green colocalization is given by 100 times the 
sum of the green values in the upper right rectangular region divided by the 
sum of the green values in the image or the selected VOI. 

Displays 
Lookup 
Table (LUT)

Displays the Lookup Table (LUT) dialog box, which allows you to specify the LUT 
for this histogram.

Brightness Displays the Brightness/Contrast dialog box, which allows you to adjust the 
brightness and contrast in the histogram.

Log Toggles the histogram between showing counts and log10 (1+ histogram counts). 
The default is no log function.

Region Toggles the histogram between not showing lines and showing the bottom and 
left lines for the upper right colocalization region. The default is not to show the 
lines.

Figure 2.  2D Histogram window (continued)
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Note that only pixels above at least one of the two backgrounds are included 
in any of the above sums.

If limit colocalization to pixels >= threshold is selected, the percent red 
colocalization is given by 100 times the sum of the red values in the upper 
right rectangular region divided by the sum of the red values >= the red 
threshold in the image or selected VOI. The percent green colocalization is 
given by 100 times the sum of the green values in the upper right 
rectangular region divided by the sum of the green values >= the green 
threshold in the image or selected VOI.

Figure 3.  Colocalization Histogram window showing a histogram for a color image in which red 
and green color localization was done
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Figure 4.  The effect on the image when dragging the mouse-movable point on the histogram   
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Figure 5.  The effect on the image when dragging the mouse-movable point on the histogram  
MIPAV User’s Guide, Volume 2, Algorithms 428

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Microscopy: Blind Deconvolution
Microscopy: Blind Deconvolution

Blind Deconvolution is a technique, which permits recovery of the target 
object from a set of blurred images in the presence or a poorly determined 
or unknown Point Spread Function (PSF). In optical microscopy, blind 
deconvolution is used to remove the blurring induced by the limited aper-
ture of the microscope objective. Instead of subtracting blur from the 
image, a part of the light contribution to the blurred pixels is reassigned to 
the correct in-focus location in the image.

Background
To properly reassign the intensity values in the chosen image, the imaging 
system must be modeled. The model includes known attributes such as the 
objective numerical aperture, the refractive index of the sample immersion 
medium, and the wavelength of the light used to image the sample (either 
reflected light or fluorescence). Refer to page 434 for more detail.

An optical imaging system is then modeled as a convolution of the target 
image with a PSF. Here, the PSF is assumed to have a Gaussian shape. This 
convolution is considered to produce the blurred image. To de-blur the 
image, the convolution is reversed, and the blurred image is deconvolved 
with the same PSF. Images can be deconvolved using a PSF that is 
measured directly by imaging certain types of samples, such as fluorescent 
beads; or the PSF can be estimated based on the optical parameters of the 
microscope (imaging system). In blind deconvolution, an estimated PSF is 
used, and both the estimated (de-blurred) image and the PSF image are 
recovered by the deconvolution process. 

Blind deconvolution works through an iterative process. After the deconvo-
lution step, the estimated image produced by the deconvolution is corrected 
by comparing it to the original blurred image. The same correction is also 
applied to the PSF image. The corrected estimated image and PSF are later 
used in the next deconvolution step, and are further refined through the 
successive iterations. See algorithm details on page 430.

An initial estimate for the target image is set to be the converted input 
image, while the initial estimate for the PSF is determined as a Gaussian 
kernel of size 3x3 for 2D images or 3x3x3 for 3D images. Once the estimate 
and PSF images have been initialized the algorithm computes new 
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estimates with the iterative process as shown below. Refer to equations 1 – 
3: 

EQUATION 1

EQUATION 2

EQUATION 3

Here:

This algorithm uses a numerical method to calculate a maximum-likelihood 
estimation of the input image using the steps described in equations 1 – 3. 

1 An initial estimate of the input image is made;

2 This estimate is, then, convolved with a theoretical PSF calculated based 
on the optical parameters of the imaging system. See “Computing 
convolution” on page 431;

3 The resulting blurred estimate is compared with the input image;

λ k 1+( ) x y z, ,( ) λ k( ) x y z, ,( ) μ x y z, ,( ) λ k( ) x y z, ,( ) h k( ) x y z, ,( )•( ) h k( ) x– y z–,–,( )•⁄[ ]=

h' k 1+( ) x y z, ,( ) λ k( ) x y z, ,( ) μ x y z, ,( ) λ k( ) x y z, ,( ) h k( ) x y z, ,( )•( ) λ k( ) x– y z–,–,( )•⁄[ ]=

h k 1+( ) x y z, ,( ) constraints h' k 1+( ) x y z, ,( )( )=

is the original input image

is the estimated input image

is the estimated PSF 

is an unconstrained PSF 

represents convolution

μ x y z, ,( )

λ k( ) x y z, ,( )

h k( ) x y z, ,( )

h' k 1+( ) x y z, ,( )

λ k( ) x y z, ,( ) h•
k( )

x y z, ,( )
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4 After that, a correction is computed and employed to generate a new 
estimate. The same correction is also applied to the PSF, generating a 
new PSF estimate. 

5 The PSF estimate is constrained to form the new PSF estimate for the 
next iteration. Refer to “PSF constraints” below;

6 In the further iterations, the PSF estimate and the image estimate are 
updated together.

COMPUTING CONVOLUTION

Convolution is computed by taking the Fast Fourier Transformation (FFT) 
of the images, multiplying in Fourier space, and then taking the inverse 
FFT. Refer to Section “Fast Fourier Transformation (FFT)” on page 191 for 
more information about FFT. 

If the extents of the input image are not a power of 2, the nearest power of 2 
for each dimension is estimated and the input image is resampled to the 
power of 2 for efficient computation of FFT. 

PSF CONSTRAINTS

It is possible to incorporate some prior knowledge about the PSF into the 
algorithm. It has been shown that the solution to the PSF has to be 
constrained in some way so that reconstructions had resemblance to the 
true object and true PSF. Hence, the following constraints are applied to the 
PSF image before the next iteration: 

Unit summation – all intensity values in the PSF image must sum to 1.

Hourglass – limits the energy of the PSF so that portions of the 
background intensity, which lie outside an hourglass (or disk for 2D), 
are not assigned to the PSF.

Band-limit and missing cone  – constraint the Fourier transform of the 
PSF (the optical transfer function) to be band-limited.

Non negativity – ensures that the PSF has no negative values.
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IMAGE TYPES

You can apply this algorithm to color and grayscale, 2D and 3D images. 

Note: For color images, the input color image is, first, converted into grayscale. 
After that, the deconvolution process is performed on the grayscale 
representation of the image. And in the final processing step, the color values 
are restored by iterating once through the deconvolution process for each source 
channel using the estimated image and estimated PSF of the grayscale 
representation. All images are converted to floating point representation for 
processing. Refer to Figure 1.

NOTES

Blind deconvolution eliminates the need to acquire an empirical PSF, and 
can be used for both microscopy and non-microscopy images. Refer to 
Figure 2 that shows the Jupiter image.

Figure 1.  The original color image (A), the intermediate grayscale 
image (B), and the final estimate color image after 10 iterations (C).

Figure 2.  The original image of Jupiter in grayscale (A), the estimate 
image after five iterations (B), and the final estimate after 10 
iterations (C). 
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REFERENCES

Refer to the following sources for more information about blind 
deconvolution. 

Holmes, T.J., Maximum Likelihood Image Restoration Adapted for Noncoherent Optical 
Imaging, JOSA-A, 5(5): 666-673, 1988.

———, Bhattacharyya, S., Cooper, J., Hanzel, D., Krishnamurthi, V., Lin, W., Roysam, B., 
Szarowski, D., Turner, J., Light Microscopic Images Reconstructed by Maximum Likelihood 
Deconvolution, Ch. 24, Handbook of Biological Confocal Microscopy, J. Pawley, Plenum, 
1995.

———, Liu, Y., Image Restoration for 2D and 3D Fluorescence Microscopy, Visualization in 
Biomedical Microscopy, A. Kriete, VCH, 1992.

———, Blind Deconvolution of Quantum-Limited Noncoherent Imagery, JOSA-A, 9: 1052 - 
1061, 1992

USEFUL LINKS

http://www.mediacy.com/aqi/index.asp

http://micro.magnet.fsu.edu/primer/digitalimaging/deconvolution/
deconvolutionhome.html

http://micro.magnet.fsu.edu/primer/digitalimaging/deconvolution/deconintro.html

http://micro.magnet.fsu.edu/primer/digitalimaging/deconvolution/deconalgorithms.html

http://www.hamangia.freeserve.co.uk/how/index.html
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Applying the Maximum Likelihood Iterative Blind 
Deconvolution algorithm

To apply the algorithm, complete the following steps:

1 Open an image of interest.

2 From the main MIPAV menu select Algorithms > Microscopy > 
Restoration > Maximum Likelihood Iterated Blind Deconvolution.

3 The Maximum Likelihood Iterated Blind Deconvolution dialog box 
appears.

4  Complete the information in the dialog box.

Number of 
Iterations

Enter the number of times to 
iterate through the blind-
deconvolution process. The 
default value is 10 iterations.

Display 
intermediate 
image every

Enter the frequency of display 
for intermediate images here. 
The default value is 5, which 
means that the intermediate 
images will be displayed every 
five iterations. Displaying 
intermediate results allows 
the user to save a series of 
images and adjust the PSF 
parameters to produce the 
better result. Note that the 
best result may also come 
from an earlier iteration.

Objective 
Numerical 
Aperture

Enter the numerical aperture 
of the microscope objective 
used in the imaging system. 
The default value is 1.4.

Wavelength (nm) Enter the wavelength of the 
light used to image the sample, 
or the wavelength of the light 
fluorescence, in nanometers. 
The default wavelength is 520 
nanometers.

Refractive Index This is the refractive index of the sample immersion medium. The default 
value is 1.518 (the refractive index of common microscope immersion oils).

Figure 3.  The Maximum Likelihood Iterated Blind Deconvolution dialog box
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5 Press OK to run the algorithm.

6 The algorithm begins to run, and a pop-up window appears with the 
status: Computing iterative blind deconvolution. See Figure 4.

7 While running, the algorithm produces several intermediate images or 
estimates which appear on the screen. The number of estimates depends 
on two parameters: 1) the number of iterations and 2) the frequency of 
appearing of intermediate images. These parameters are set in the 
Number of Iterations: and Display intermediate images every: fields of 
the dialog box. 

Use microscope 
settings

Uncheck this box to turn off the microscope-specific optical parameters. 
However, if the box is checked and the theoretical PSF derived from the 
microscope parameters contains all zero values, the algorithm will 
automatically disable the checkbox. Refer to Section “PSF constraints” for 
more information. By default, the box is checked on.

Resample to the power of 2

Original Extents 
(extent X, extent 
Y, and extent Z)

Displays the original extents of the input image. If the image is not a 3D 
image, then the extent Z field is empty. A user cannot edit these values. 

Expected Extents 
(extent X, extent 
Y, and extent Z)

Displays the expected extents of the image to the nearest power of 2. If 
the image is not a 3D image, then the extent Z field is empty and non-
editable. It is recommended to not change the expected extents values as 
these are the most efficient values to the nearest power of 2.   

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.

Figure 3.  The Maximum Likelihood Iterated Blind Deconvolution dialog box (continued)

Figure 4.  A status pop-up window.
MIPAV User’s Guide, Volume 2, Algorithms 435

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Microscopy: Blind Deconvolution
8 If the Use Microscope Settings: box was checked, but the PSF derived 
from the microscope parameters contains all zero values, the algorithm 
automatically displays the warning as shown in Figure 5, and then, 
disables the checkbox. Refer to “PSF constraints” on page 431 to learn 
more about PSF constraints.

9 When the algorithm finishes running, the status window closes, and the 
intermediate and final results appear in new windows.

Selecting the algorithm parameters

Careful parameter selection must be done for the Blind Deconvolution algo-
rithm to produce good results. To find an optimal set of parameters values, 
apply this algorithm repeatedly on the same image (or a set of images) that 
you want to process with different parameter values and with a reasonable 
number of intermediate imaged selected.

Figure 6 below shows images that were produced from running the Blind 
Deconvolution algorithm with the default parameters against a color 
microscopy image. The final image was produced after 50 iterations. The 
intermediate images appear every five iterations.   

However, the initial image was in color the intermediate images (estimates) 
appear in grayscale. Refer to page 434 for details. Also note that the name of 
the intermediate image includes the word “estimate” and the number of the 
iteration.

Note:  Hourglass constraint: and Band-limit and missing cone constraint: 
mentioned on page 431 uses the Objective Numerical Aperture, Wavelength, and 
Refractive Index parameters provided by the user to determine the size and 
shape of the PSF.

Figure 5.  The PSF warning. 
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1

Figure 6.  The Blind Deconvolution algorithm was applied on the color 
image (first slide) with the default parameters values (shown on the 
second slide). The intermediate grayscale images are also shown.
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Figure 6.  The Blind Deconvolution algorithm was applied on the color 
image (first slide) with the default parameters values (shown on the 
second slide). The intermediate grayscale images are also shown.
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Microscopy: FRAP (Fluorescence Recovery After 
Photobleaching)

This algorithm allows the determination of an association rate, a 
dissociation rate, and a diffusion transfer coefficient by measuring the 
recovery of fluorescence in a photobleached area by diffusion from the 
nonphotobleached surround. The first images in a series of images over 
time are generally not photobleached. Photobleaching is then used to 
create a narrow band, small circle, or other small VOI where almost all of 
the fluorescence is removed. 

Background 
The normalized recovery of fluorescence over time t is modeled as 

. 

A complete photobleaching would reduce the fluorescence to zero. 
However, a fluorescence level of bottom rather than zero may be measured 

after photobleaching. As time approaches infinity, the terms  and 

 go to zero, and the measured fluorescence approaches bottom 

plus span, which is the mobile fraction.

The algorithm uses curve fitting to determine alpha, beta, gamma, bottom, 
and span. It then uses alpha, beta, gamma, and the ratio of the 
photobleached region fluorescence after bleaching to before bleaching to 
determine the association rate, the dissociation rate, and the diffusion 
transfer coefficient.

The mathematics of FRAP is based on compartmental modeling in which 
the compartments must be homogeneous. That is, the fluorescence within a 
compartment must not have a spatial gradient. If a compartment is not 
homogeneous, the algorithm cannot be used. More advanced algorithms 
must then be used to divide the compartments into multiple compartments 

bottom span 1 Γeαt 1( Γ )eβt–––( )×+

Γeαt

1( Γ )eβt–
MIPAV User’s Guide, Volume 2, Algorithms 439

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Microscopy: FRAP (Fluorescence Recovery After
Photobleaching)
or introduce partial differentials with respect to distance.

As an option, you may choose to perform registration before running the 
FRAP algorithm. During the registration, MIPAV registers slices to the first 
slice after photobleaching. Although the default cost function is correlation 
ratio, you can select instead least squares, normalized cross correlation, or 
normalized mutual information. By default the registered image appears in 
a frame.

Note: MIPAV runs FRAP on the registered image rather than on the original 
image.

The algorithm uses only one color in a color image. If a color image is 
registered, the registration is based only on this selected color, but all colors 
in the registered image undergo the same transformation. 

Recommendation: Because registration takes far more time than the FRAP 

calculation, if more than one FRAP calculation is a possibility, save the 

registered image to use in future FRAP calculations.

For images that have a photobleached narrow band with two neighboring 
unbleached regions, MIPAV uses the equations described in Using FRAP 
and Mathematical Modeling to Determine the In Vivo Kinetics of Nuclear 
Proteins by Carrero, McDonald, et al. (refer to “References” on page 452). 
Similar equations were derived for images that have a photobleached circle 
inside an unbleached region, and solutions were also implemented for the 
pure 1D diffusion case and for the single exponential model.

To perform FRAP on an image, you select Algorithms >Microscopy >FRAP. 
The Fluorescence Recovery after Photobleaching dialog box appears. The 
first task is to delineate the following VOIs on the image: 

• A red required photobleached VOI

• A green required whole organ VOI

• An optional blue background VOI

In delineating VOIs for FRAP, it is not necessary to select the New VOI icon. 
The procedure is to simply select the Add required photobleached VOI 
option on the FRAP dialog box and then, after selecting an Ellipse, 
Rectangle, Polyline, or Levelset icon in the VOI toolbar in the MIPAV 
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window, draw the VOI on the image. The required photobleached VOI 
appears in red on the image.

You return to the FRAP dialog box to create the next required VOI: the 
whole organ VOI. Select the appropriate option on the FRAP dialog box—in 
this case. Add required whole organ VOI—and then select the Ellipse, 
Rectangle, Polyline, or Levelset icon in the VOI toolbar and draw the VOI on 
the image. This VOI appears in green on the image.

As an option, you can create a third VOI by selecting Add optional 
background VOI on the FRAP dialog box and repeating the previous steps 
for drawing the VOI, which appears in blue, on the image.

Note: You must create these VOIs on the image after the Fluorescence Recovery 
after Photobleaching (FRAP) dialog box appears using the instructions provided 
in the section on “Applying the FRAP algorithm” on page 453. VOIs created 
outside the dialog box may not have the right colors.

The VOIs must all have curves present in the first slice after photobleaching 
(there is no reason to put curves in any other slice). As it runs, the algorithm 
propagates the photobleached and whole organ VOIs to the other image 
slices. The background VOI is not propagated to other slices. The pho-
tobleached VOI should be contained within the whole organ VOI. The whole 
organ region has a greater average intensity than the photobleached region, 
and the optional background region has a smaller average intensity than the 
photobleached region.

The algorithm uses the average of the background VOI from the first slice 
after photobleaching to obtain the background constant, which is 
subtracted from the photobleached intensity and whole organ intensity 
measurements. It then obtains the ratio Fa/F0, in which Fa is the first slice 
after photobleaching and F0 is the slice just before photobleaching.

Even with low illumination during the recovery phase, fluorescence loss 
through photobleaching is expected to occur over the course of the recovery 
curve. For this loss the time that matters is the exposure time for each slice 
picture and not the absolute time at which the exposure was made. Since the 
exposure time for each slice is the same, the time here is proportional to the 
number of slices. The background corrected photobleached values are 
divided by the background corrected whole organ values to correct for this 
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loss of fluroescence. 

The algorithm then normalizes the values of the (corrected photobleached/ 
corrected whole organ) by dividing by the value of this ratio just before 
photobleaching. These normalized photobleached ratios are fitted to a 
slightly modified version of equation 19 in the Carrero article: 

 with  and 

.

The mobile fraction equals bottom + span. In this curve fitting the time used 
is the time elapsed since photobleaching. Alpha, beta, gamma, and the ratio 
of the whole organ region fluorescence after bleaching to before bleaching 
are output. The dissociation rate, the association rate, and the diffusion 
transfer coefficient are obtained from alpha, beta, gamma, and the 
afterBeforeRatio.

For narrow band 2D, the effective diffusion coefficient in micrometers2 per 
second is found from the diffusion transfer coefficient. The software 
measures the photobleached width w as the minimum dimension of the 
photobleached VOI bounding box and measures the whole organ length l 
along the same direction.

For 1D pure diffusion fitting, the following equation applies:

EQUATION 1

where

t is time

I is the photobleached fluorescent intensity

w is the width of the bleaching along the membrane in micrometers 
(um)

R t α β Γ, , ,( ) bottom span 1 Γeαt– 1( Γ )eβt––( )×+= 0 α β> >

1 Γ 0≥ ≥

Deff diffusion transfer coefficient w l w–( )
4.0

----------------××=

I t( ) I final( ) 1 w2

w2 4πtDeff+⎝ ⎠
⎛ ⎞
--------------------------------------------–

⎝ ⎠
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎛ ⎞

=
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Deff is the effective 1D diffusion to coefficient in micrometers2 per 
second

Fitting data for the above equation solves for .

Then:

You can select an optional check box on the FRAP dialog box to double 
check the Gauss-Newton nonlinear fitting results with a simple grid search 
pattern. The software calculates the Sum of Squares of Errors (SSE) at every 
legal point on a grid and then finds the sum of the squares of the fitted 
photobleached data minus the actual photobleached data for every slice 
starting with the first slice after photobleaching.

For the 2D narrow band and 2D circle photobleached models, the algorithm 
uses a 3D grid with 201 alpha points, 201 beta points, and 101 gamma 
points. It then varies both alpha and beta from 0.05 times the values found 
in the nonlinear fit to 20 times the values found in the nonlinear fit. It 
geometrically increments the values so that each value is about 1.03 times 
as great as the previous value and arithmetically increments gamma by 0.01 
from 0 to 1.

The algorithm finds the global SSE minimum and, if present, any local SSE 
minimums, which are the lowest point in a 5 by 5 by 5 cube. The 3D space is 
searched with the restriction that beta <= alpha. Points with beta > alpha 
are not included in the 3D search and are simply filled in with SSE values 
equal to 1.1 times the SSE maximum found over the permissible space. The 
search is conducted with the bottom and span values kept fixed at the values 
found by the nonlinear fit. Since these values are very likely to have been 
accurately determined, this should not be a problem. In any event a search 
over a 5D space would be very time consuming. A 201 by 201 by 101 3D 
error image is created to display the calculated SSE values. The error image 
name is the source image name with _err appended on the end. 

Point VOIs appear at the locations of the global minimum and at local 
minimums if any exist. The algorithm stores point VOIs in a folder titled 
defaultVOI_sourceImageName_err. For the pure 1D fit and the single 
exponential fit, the search is simply one dimensional; therefore, the 

Deff

w2
-----------

Deff
D

w2
------- p p××=
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software does not create an error image. For the pure 1D fit,  values 

going from 0.05 times the nonlinear fit value to 20 times the nonlinear fit 

value are used to calculate SSE. For the single exponential fit,  half 

values going from 0.05 times the nonlinear fit value to 20 times the 
nonlinear fit value are used to calculate sse.

In the derivation for the case in which the photobleached area is a circle, 
there are only two compartments: 

• 0, the inside of the circle

• 1, the outside of the circle

The equations are:

EQUATION 2

As expected 

201
Deff

w2
-----------

201thalf

du0f
dt

----------- D1 uof D2 u1f ka u0f kd u0b×+×–×+×–=

du1f
dt

----------- D1 u0f D2 u1f ka u1f kd u1b×+×–×–×=

du0b
dt

------------- ka u0f kd u0b×–×=

du1b
dt

------------- ka u1f kd u1b×–×=

D1 Fa
Fa F0 Fa–+( )

--------------------------------------⎝ ⎠
⎛ ⎞ Dt Fa

F0
-------⎝ ⎠

⎛ ⎞ Dt==

D2 F0 Fa–( )
Fa F0 Fa–+( )

--------------------------------------⎝ ⎠
⎛ ⎞ Dt F0 Fa–( )

F0
------------------------⎝ ⎠

⎛ ⎞ Dt==

D1 D2 Dt=+

u u0f u1f u0b u1b,,,( )=

u0 0 kd
ka kd+( )

-----------------------⎝ ⎠
⎛ ⎞ Fa

F0
-------⎝ ⎠

⎛ ⎞ 0 ka
ka kd+( )

-----------------------⎝ ⎠
⎛ ⎞ Fa

F0
-------⎝ ⎠

⎛ ⎞, ,,⎝ ⎠
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The eigenvalues are found by setting the determinant to zero (0):

EQUATION 3

This gives the equation:

Using D1 + D2 = D, the above equation factors as:

D1 ka e––– D2 kd 0
D1 D2– ka e–– 0 kd
ka 0 kd– e– 0
0 ka 0 kd– e–

e4 D1 D2 2ka 2kd+ + +( ) e2 D1 ka 2D1 kd D2 ka 2D2 kd ka2

2ka kd kd2 e2 D1 ka kd D1 kd2 D2 ka kd D2 kd2
×+××+×+××+×+×

+

+

×+×+×+×(

) e 0=×

+×+

e e(× ka kd ) e2 D( ka kd ) e D kd×+×+ + +( ) 0=×+ +
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The quadratic gives the roots alpha and beta with 

where

The eigenvalue  gives the eigenvector:

The eigenvalue  gives the eigenvector:

The eigenvalue  gives the eigenvector:

The eigenvalue  gives the eigenvector:

α s– 1 s2
β s– 1 s2–=

+=

s1 D ka kd+ +( )
2

----------------------------------=

s2
D ka kd+ +( )

2 4D kd×–( )
2

------------------------------------------------------------------------=

e 0=

1

D1
D2
-------⎝ ⎠

⎛ ⎞

ka
kd
------⎝ ⎠

⎛ ⎞

D1 ka×( )
D2 kd×( )

------------------------⎝ ⎠
⎛ ⎞

e ka– kd–=

1

D1
D2
-------⎝ ⎠

⎛ ⎞

1

D1
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-------⎝ ⎠

⎛ ⎞–

–

e α=

e β=
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Let the eigenvectors be v1, v2, v3, and v4. Let the matrix V be given by:

Let the vector C be

Remembering that  is the vector of initial conditions, we wish to solve:

Adding equations 1 and 3:

1

D1 kd α+( )×

D2 kd α kd α D2 α ka α
2+×+×+×+×( )

-----------------------------------------------------------------------------------------------------------

ka
kd α+( )

---------------------

D1 ka×

D2 kd α kd α D2 α ka α
2+×+×+×+×( )

-----------------------------------------------------------------------------------------------------------

D2 kd β kd β D2 β ka β××××( )
D1 ka×

D2 kd β kd β D2 β ka β
2+×+×+×+×( )

---------------------------------------------------------------------------------------------------------

v11 v21 v31 v41
v12 v22 v32 v42
v13 v23 v33 v43
v14 v24 v34 v44

c1
c2
c3
c4

u0

VC u0=
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yields equation 5:

EQUATION 4

Adding equations 2 and 4:

EQUATION 5

yields equation 6:

EQUATION 6

Multiplying 5 by  and adding to 6 yields:

EQUATION 7

c1 c2 c3 c4 0 1( )

ka
kd
------⎝ ⎠

⎛ ⎞ c1 c2 ka
ka kd α+ +( )

---------------------------------⎝ ⎠
⎛ ⎞ c3 ka

kd β+( )
--------------------⎝ ⎠

⎛ ⎞ c4 0 3( )=×+×+–×

=+ + +

ka kd+( )
kd

-----------------------⎝ ⎠
⎛ ⎞ c1 ka( kd α )+ +

kd α+( )
----------------------------------⎝ ⎠

⎛ ⎞ c3

ka kd β+ +( )
kd β+( )

--------------------------------⎝ ⎠
⎛ ⎞ c4 0 5( )=×

×+×

D– 1
D2

----------

D1 ka kd+( )×
D2 kd×( )

-------------------------------------⎝ ⎠
⎛ ⎞ c1

D1 ka kd α+ +( )×

D2 kd α kd α D2 α ka α
2+×+×+×+×( )

-----------------------------------------------------------------------------------------------------------
⎝ ⎠
⎜ ⎟
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c3

D1 ka kd β+ +( )×

D2 kd β kd β D2 β ka β
2+×+×+×+×( )

---------------------------------------------------------------------------------------------------------
⎝ ⎠
⎜ ⎟
⎛ ⎞
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×+
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which simplifies to:

EQUATION 8

Multiplying equation 1 by  and adding to equation 2 yields:

EQUATION 9

D1
D2
------- c1 D1

D2
------- c2

D1 kd α+( )×

D2 kd α kd α D2 α ka α
2+×+×+×+×( )
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⎜ ⎟
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D1 kd β+( )×
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2+×+×+×+×+×+×( )

-----------------------------------------------------------------------------------------------------------------------------------------------------
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×

×+
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-----------------------------------------------------------------------------------------------------------
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Multiplying equation 8 by  and adding to equation 7 yields:

EQUATION 10

D1 ka kd α+ +( )×(

D2 kd α kd α D2 α ka α
2+×+×+×+×( )

----------------------------------------------------------------------------------------------------------- D1 ka kd α+ +( )×
D2 kd α+( )×

-----------------------------------------------⎝ ⎠
⎛ ⎞– c3

D1 ka kd β+ +( )×

D2 kd β kd β D× 2 β ka β
2+×+ +×+×( )

--------------------------------------------------------------------------------------------------------- D1 ka kd β+ +( )×
D2 kd β+( )×( )

----------------------------------------------– c4 Fa
F0
-------=×+

×

D– 1 α ka kd α+ +( )
2

××

D2 kd α+( ) D2 kd α kd α D2 α ka α
2+×+×+×+×( )××( )

--------------------------------------------------------------------------------------------------------------------------------------------------------- c3

D– 1 β ka kd β+ +( )××
2

D2 kd β+( ) D2 kd β kd β D2 β ka β
2+×+×+×+×( )××( )

------------------------------------------------------------------------------------------------------------------------------------------------------- c4 Fa
F0
-------= 7( )×+

×

k(– a kd α )+ +
kd α+( )

-------------------------------------

α– D1 ka kd α+ +( )××

D2 D2 kd α kd α D2 α ka α
2+×+×+×+×( )×( )

------------------------------------------------------------------------------------------------------------------------------ c3

β– D1 ka kd β+ +( )××

D2 D2 kd β kd β D2 β β
2+×+×+×+×( )×( )

---------------------------------------------------------------------------------------------------------------------------- c4 kd
ka kd+( )

-----------------------⎝ ⎠
⎛ ⎞ Fa

F0
-------×=×+

×

c4 α Fa
F0
-------⎝ ⎠

⎛ ⎞ D2 D2 kd β kd β D2 β ka β
2+×+×+ + +×( )

kd β+( )
ka( kd ) β β( α ) D1 ka( kd β )+ + +×–××+[ ]

---------------------------------------------------------------------------------------------------------------------×

×××=
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This simplifies to:

EQUATION 11

Substituting c4 back into equation 8 yields c3:

EQUATION 12

This simplifies to:

EQUATION 13

Putting c3 and c4 in equation 5 and solving for c1 yields:

EQUATION 14

Putting c1, c3, and c4 into equation 4 and solving for c2 yields c2 = 0.

Thus, the solution is:

EQUATION 15

The above equation is normalized by dividing by

c4

Fa
F0
-------⎝ ⎠

⎛ ⎞ D2 kd D–( ka kd 2S2 )–+ + +××

D ka( kd ) 4S2×+×[ ]
---------------------------------------------------------------------------------------------------=

c3
β Fa

F0
-------⎝ ⎠

⎛ ⎞ D2 kd α+( ) D2 kd α kd α D2 α kα α
2+×+×+×+×( )××××

α α( β ) D1 ka( kd ) ka kd α+ +( )×+××–×[ ]
----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=

c3

Fa
F0
-------⎝ ⎠

⎛ ⎞ D2 kd D ka kd 2S2–––( )×××

D ka( kd ) 4S2×+×[ ]
----------------------------------------------------------------------------------------------=

c1

Fa
F0
-------⎝ ⎠

⎛ ⎞ D2 kd××

D ka kd+( )×[ ]
---------------------------------------=

u0f c1 c3e α t×( ) c4e β t×( )

Fa
F0
-------⎝ ⎠

⎛ ⎞ D2 kd×
D ka kd+( )×( )

--------------------------------------× 1 D ka kd 2S2–––+

4S2eα t×
----------------------------------------------------- D– ka kd 2S2–+ +( )

4S2eβ t×
------------------------------------------------------+×=

+ +=
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EQUATION 16

The coefficient of exp(alpha*t) in the normalized equation equals -gamma 

so  and the normalized equation can be written 

as:

EQUATION 17

IMAGE TYPES

You can apply this algorithm to both color and black-and-white 3D images. 
However, with color images, the algorithm uses only one of the colors.

SPECIAL NOTES

This algorithm can only be used when the fluorescence is homogeneous in a 
compartment. If the fluorescence has spatial gradients across a compart-
ment, a model using partial derivatives with respect to distance should be 
employed.

REFERENCES

Axelrod, D., D. E. Koppel, J. Schlessinger, E. Elson, and W. W. Webb. “Mobility 
Measurement by Analysis of Fluorescence Photobleaching Recovery Kinetics.” Biophysical 
Journal 16 (1976):1055–1069.

Carrero, Gustavo, Darin McDonald, Ellen Crawford, Gerda de Vries, and Michael J. Hendzel. 
“Using FRAP and Mathematical Modeling to Determine the In Vivo Kinetics of Nuclear 
Proteins.” Methods 29 (2003):14–28.

Lippincott-Schwartz, J., J. F. Presley, K. J. M. Zaal, K. Hirschberg, C. D. Miller, and J. 
Ellenberg. “Monitoring the Dynamics and Mobility of Membrane Proteins Tagged with 
Green Fluorescent Protein.” Methods in Cell Biology 58 (1999):261–281.

Fa
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---------------------------------------
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Applying the FRAP algorithm
This section explains how to run the FRAP algorithm and how to modify the 
appearance of the resulting graph windows.

To run the FRAP algorithm

1 Open a 3D color or 3D black-and-white image.

2 Select Algorithms > Microscopy > FRAP. The Fluorescence Recovery 
after Photobleaching dialog box (Figure 3) opens.
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Add required 
photobleached 
VOI

Applies a mandatory 
photobleached VOI, which 
appears in red, to the first image 
slice after photobleaching. Make 
sure that the VOI delineates the 
photobleached area. By default, 
this radio button is selected.

Add required 
whole organ 
VOI

Adds a mandatory whole organ 
VOI, which appears in green, to 
the first image slice after 
photobleaching. This VOI should 
contain the entire photobleached 
VOI and should be brighter than 
the photobleached VOI.

All optional 
background 
VOI

Adds an optional background 
VOI, which appears in blue, to 
the first image after 
photobleaching. This VOI should 
delineate a featureless area that 
is darker than the photobleached 
area.

Color selection 
(only appears 
for color 
images)

Select one of the available 
colors—red, green, or blue—
listed that corresponds to the 
fluorescence undergoing 
photobleaching. By default, red is 
selected. However, if red is single 
valued, the default is green.

First slice after 
photobleaching

Type the slice number of the first 
slice after photobleaching. If the 
image’s file header contains this 
information, the slice number 
appears. Otherwise, the default 
is 4.

2D narrow 
band

Assumes a narrow photobleached band surrounded by a large unbleached region 
on each side. Unless a photobleached region circle is found in the file header, the 
default value is 2D narrow band.

2D circle Assumes a small circle in the midst of a large unbleached region. If the file 
header for the image contains information that the photobleached region is a 
circle, the default is 2D circle.

1D Assumes pure 1D diffusion.

Single 
exponential

Assumes recovery according to a single exponential.

Figure 1.  Fluorescence Recovery after Photobleaching dialog box  
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3 Select for color images the fluorescence color in the Color selection 
panel.

Note: Only the color that you select has a role in the FRAP mathematics.

4 Read to see, if an information panel is present, if either the shape of the 
photobleached region or the first slice after photobleaching is specified.

5 Go to the MIPAV window and adjust the image slice slider to display the 
first slice after photobleaching.

6 Type the number of the first slice after photobleaching in the text box in 
the Slice parameters panel.

Remember: The slice number appears on the title bar of the image window. 
As you move the image slice slider in the MIPAV window to the right, the slice 
number increases. As you move it to the left, the slice number decreases.

7 Select Add required photobleached VOI in the Select VOIs panel in the 
FRAP dialog box.

8 Go to the MIPAV window, and select one of these icons from the VOI 
toolbar:

Grid search 
with parameter 
variation

Conducts a double check by grid search.

Registration 
before FRAP

Registers the image slices that are not aligned. Select this item so that slice 
alignment occurs before FRAP. The default is no registration.

Cost function Specifies the registration cost function. You may select correlation ratio (the 
default), least squares, normalized cross correlation, or normalized mutual 
information. To use this item, you must first select Registration before FRAP.

Create 
registration 
image

Creates the registered image in a separate image window. To use this item, you 
must first select Registration before FRAP. By default, this item is selected.

OK Applies the algorithm according to the specifications made in the dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this dialog 
box.

Help Displays online help for this dialog box.

Figure 1.  Fluorescence Recovery after Photobleaching dialog box (continued) 
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• Draw rectangle VOI 

• Draw ellipse VOI 

• Draw polygon/polyline VOI 

• Draw levelset VOI 

9 Draw the VOI on the image. The VOI appears in red.

Note: In drawing these VOIs, you do not need to first select the New VOI icon.

10 Select Add required whole organ VOI in the Select VOIs panel in the 
FRAP dialog box.

11 Create a whole organ VOI by selecting , , , or  to draw a 
rectangle, ellipsoidal, polygon/polyline, or levelset VOI on the image 
around the whole organ region in the first slice after the photobleaching. 
A green VOI appears on the image.

Figure 2.  An image with a required photobleached VOI in red and a 
whole organ VOI in green 
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Whole organ region: The whole organ region should entirely contain the 
photobleached region and be brighter than the photobleached region.

12 Go to the next step, or, if you wish, create an optional background VOI 
using the following directions:

a Select Add optional background VOI in the Select VOIs panel in the 
FRAP dialog box.

b Go to the MIPAV window and select , , , or  to draw a 
rectangle, ellipsoidal, polygon/polyline, or levelset VOI on the image 
around the background region in the first slice after the 
photobleaching. A blue VOI appears on the image.

Background region: The background region should not contain any structures 
and should be darker than the photobleached region.

13 Register the image slices as an option by doing the following:

a Select Registration before FRAP.

b Select a cost function in the Cost function list. Although correlation 
ratio is the default cost function, you can also select least squares, 
normalized cross correlation, or normalized mutual information.

c Select or clear Create registration image. Since registration is far 
more time consuming than calculating FRAP, selection is the 
default.

14 Select the photobleached model assumed in analysis:

• 2D narrow band

• 2D circle

• 1D

• Single exponential

15 Select Grid search with parameter variation if you want to double check 
the nonlinear fitting engine with a grid search.

16 Click OK.
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The algorithm begins to run and a progress bar appears with the status. 
When the algorithm finishes running, the progress bar disappears, and 
the following windows appear:

• Photobleaching Recovery Curve window (Figure 3), which displays a 
graph of the fitting of the normalized photobleached region recovery 
curve (the calculated parameters appear on the Data page of the 
Output window)

File Open Graph (Ctrl0)—Allows you to open a previously saved graph. When you select this 
command, the Open Graph Data dialog box appears. 

Figure 3.  Graph windows: Photobleaching Recovery Curve, Uncorrected Photobleaching Recovery 
Curve, and Uncorrected Whole Organ windows
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• Uncorrected Photobleaching Recovery Curve window (Figure 3)

• Uncorrected Whole Organ window (Figure 3)

If you selected Create registration image in the FRAP dialog box, an 
image window with a registered source image appears.

Note: All of the three graph windows—the Photobleaching Recovery Curve, 
Uncorrected Photobleaching Recovery Curve, and Uncorrected Whole Organ 
windows—have the same menus and commands that work in the same way.

If you selected Grid search with parameter variation in the FRAP dialog 
box and either 2D narrow band or 2D circle, a 201 by 201 by 101 3D 
error image is created to display the sum of squared error values.

Save Graph (CtrlS)—Allows you to save a graph as a .PLT file. When you select this 
command, the Save dialog box appears.

Print Graph (CtrlP)—Allows you to print the graph. When you select this command, the 
Print dialog box appears.

Close Graph (CtrlX)—Closes the graph immediately.

Edit Delete Function—Allows you to delete a specified function on the graph unless the graph 
contains only one function.

Copy Function—Allows you to copy the function that you specify.

Paste Function—Allows you to paste a previously copied function to the graph.

Views Modify Graph Features—Allows you to change all of the graph features, such as the 
names and colors of the functions, the background color of the graph, the ranges used, 
whether the gridlines appear, and so on. When you select this command, the Modify Graph 
window opens.

Reset Range to Default—Changes the range displayed in the graph to the default range.

Reset Graph to Original—Changes the range displayed in the graph to the original range.

Graph Displays the amount of fluorescence over time (seconds).

Figure 3.  Graph windows: Photobleaching Recovery Curve, Uncorrected Photobleaching Recovery 
Curve, and Uncorrected Whole Organ windows (continued)
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To print graphs

In a graph window:

1 Select File > Print, or press Ctrl P on the keyboard. A Print dialog box 
(Figure 4) appears.

2 Select the printer, print range, and number of copies.

3 Click OK.

To save graphs

1 Select File > Save, or press Ctrl S on the keyboard. The Save dialog box 
appears. 

2 Select a directory in which to store the graph.

3 Type a name for the graph, including the .PLT extension, in the File 
Name box. 

4 Click OK.

To open previously saved graphs

1 Select File > Open, or press Ctrl O on the keyboard. The Open dialog box 
appears.

2 Navigate to the directory where the graph is stored.

Figure 4.  Print dialog box 
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3 Select the name of the graph.

4 Click OK.

To close graphs

Select File > Close, or press Ctrl X on the keyboard. The graph window 
closes.

To change the appearance of the graph window

Using the Modify Graph Features command on the Views menu of each of 
the graph windows, you can change how the data appears in each graph.   
When you select Views > Modify Graph Features, the Modify Graph dialog 
box opens.

The Modify Graph dialog box (Figure 6) allows you to change the following:

• The appearance of the graph

• Whether legends for functions appear on the graph

• The color and visibility of functions and whether points appear on the 
functions

• Mathematical adjustments to the functions

Figure 5.  Modify Graph Features command on the Views menu in  
a graph window
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To change the displayed titles of graphs

Changing the title of graphs is very easy. 

1 Select Views > Modify Graph Features in the graph window. The Modify 
Graph Features dialog box opens.

2 Type the new title in Title. You can simply type over the current title of 
the graph.

3 Click Apply.

To change the background color of graphs

1 Select Views > Modify Graph Features in the graph window. The Modify 
Graph dialog box opens.

2 Click Change background color on the Graphs page. The Pick 
Background Color dialog box (Figure 7) opens.

3 Select a color on the one of the pages in the dialog box: Swatches, HSB, 
or RGB page.

4 Click OK. The Pick Background Color dialog box closes.

Figure 6.  Modify Graph dialog box showing the Graph page
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5 Click Apply. The Modify Graph dialog box closes. The background of the 
graph window should now be the color you selected.

To return the graph window to its default settings

If you made changes in the way a graph appears in the Modify Graph dialog 
box and now would like to return to the default settings, select in the graph 
window View > Reset Graph to Original or press Ctrl Z on the keyboard.

Change 
background color

Allows you to change the background color of the grid. By default, the 
background color is light gray. When you click this button, the Pick 
Background Color dialog box opens.

Auto shrink 
range

Allows you to adjust the display of the Y axis of the graph. By default, this 
check box is selected.

Minimum for 
range

Specifies the minimum value for the Y axis, which must be 0.0 or less. The 
default value is 0.0.

Maximum for 
range

Specifies the maximum value for the X axis, which must be 1.0 or more. The 
default value is 1.0.

Reset default 
range

Reinstates the default range for the graph, which means that the value of 
Minimum for range returns to 0.0 and the value for Maximum for range 
returns to 1.0.

Apply Applies immediately the changes to the graph according to the specifications 
in this dialog box but keeps this dialog box open.

Cancel Disregards any changes that you made in the dialog box and closes this dialog 
box.

Help Displays online help for this dialog box.

Figure 7.  Pick Background Color dialog box
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To return the range displayed in the graph window to 
its default settings

The Modify Graph dialog box allows to change the range that is displayed in 
a graph window. If, after modifying the range, you want to reinstate the 
minimum and maximum values in the range for a graph, do either of the 
following:

In the graph window

Select Views > Reset Range to Default.

In the Modify Graph dialog box

1 Select Views > Modify Graph Features in the graph window. The Modify 
Graph dialog box opens. 

2 Select Reset default range.

3 Click Apply. 

The range returns to its default settings.

To display legends for functions

1 Select Views > Modify Graph Features in the graph window. The Modify 
Graph dialog box opens.

2 Click Legend. The Legend page (Figure 8) appears.

3 Select Show legend.

4 Accept or change the names of the functions in the text boxes.

5 Click Apply. The legends should appear in the graph window.
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To change the appearance of functions

1 Select Views > Modify Graph Features in the graph window. The Modify 
Graph dialog box appears.

2 Click Functions. The Functions page (Figure 9) appears.

Figure 8.  Legend page in the Modify Graph dialog box
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3 Select Points visible if you want to display all of the points on the 
functions.

4 Change the color of each function by clicking Change function color.

5 Click Apply. In the graph window, the appearance of the functions 
should display according to your specifications. 

To apply mathematical changes to the functions

1 Select Views > Modify Graph Features in the graph window. The Modify 
Graph dialog box appears.

2 Click Fitted Functions. The Fitted Functions page (Figure 10) appears.

3 Select Fit linear or Fit exponential. The default choice is None.

4 Select the functions to which these changes should be made.

5 Click Apply. The functions should change according to your 
specifications.

Figure 9.  Functions page in the Modify Graph dialog box
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Figure 10.  Fitted Functions page in the Modify Graph window
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Microscopy: Colocalization Orthogonal 
Regression (FRET)—Acceptor Photobleaching

This algorithm uses acceptor photobleaching to compare the proximity of 
fluorescent-labeled molecules in two 2D images over distance:

• An image before acceptor photobleaching, also referred to as the 
prebleached image

• An image after acceptor photobleaching, which is the postbleached 
image

Background
FRET refers to the nonradiative transfer of energy from an excited state   
donor fluorescent molecule to a nearby acceptor fluorescent molecule. The   
energy transfer efficiency E, defined as the number of energy transfer events 
divided by the number of photons absorbed by the donor, is related to the 
distance R between the acceptor and donor by:

EQUATION 1

where R0, the Forster critical distance, is the distance at which E = 0.5.

We also have

 EQUATION 2

where FDA is the donor fluorescence in the presence of an acceptor and FD 
is the donor fluorescence in the absence of the acceptor.

E 1

1 r
Ro
-------⎝ ⎠

⎛ ⎞+
6

------------------------------=

E 1 FDA
FD

------------–=
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The equivalent of an acceptor's absence can be created by photobleaching 
the acceptor. Thus, a method using equation 2 can be performed on a single 
sample by measuring the donor fluorescence before and after 
photobleaching the acceptor molecules.

Because FRET falls off as the sixth power of the distance between the donor   
and the acceptor, no FRET occurs for distances greater than 2R0. Since R0    
is on the order of 10 to 70 Angstroms, by performing FRET measurements it    
is possible to distinguish proteins that are merely nearby in the same   
compartment from those proteins that are interacting with each other.

To access the FRET algorithm, you first open the two images in question 
and then select Algorithm > Microscopy > FRET in the MIPAV window. 

Since unbleached acceptors quench the donor fluorescence with FRET and 
bleached acceptors do not quench donor fluorescence, the postbleached 
image donor fluorescence is greater than the prebleached image donor 
fluorescence.

In the Fluorescence Resonance Energy Transfer dialog box, you may choose 
as an option to register the two images before running the FRET algorithm. 
During registration MIPAV registers the pre bleached image to the post 
bleached image and uses correlation ratio as the default cost function. 
However, other cost functions available for use include least squares, 
normalized cross correlation, or normalized mutual information. After 
registration MIPAV runs FRET on the registered pre bleached image rather 
than on the original pre bleached image.

To run the algorithm, you must first delineate a VOI on the post bleached 
image. This requires that you select Add required donor fluorescence VOI in 
the dialog box and then return to the MIPAV window to choose an ellipse 
VOI, rectangle VOI, polyline VOI, or levelset VOI with which to draw the 
VOI. You can then, as an option, also identify a background VOI on the 
image by selecting Add optional background VOI and repeat the steps 
performed in drawing the required donor VOI. The VOIs must all be placed 
in the post bleached image, and the background region has a smaller 
average intensity than the donor region.

As an option, you can use both a signal normalization VOI and a 
background VOI. However, to use a signal normalization VOI, you must 
have a background VOI. 
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For color images, select the color corresponding to the donor fluorescence. 
For example, if the donor fluorescence is blue, select blue. If the donor 
fluorescence is red, select red.

Note: Only one color is used from a color image.

If a background VOI is present and no signal VOI is present, the average of 
the prebleached background is subtracted from the average of the 
prebleached donor region. The average of the postbleached background is 
subtracted is subtracted from the average of the postbleached donor region. 
Then, the energy transfer efficiency is calculated as (background subtracted 
postbleached donor intensity - background subtracted prebleached donor 
intensity)/background subtracted postbleached donor intensity.

Let b and s be the prebleached background and signal values, and let b2 and 
s2 be the postbleached background and signal values. Then, the following 
equation is used to linearly scale a donor value from the prebleached image 
into a donor value in the postbleached image range:

where

L = Linearly scaled prebleached donor

P = Prebleached donor

Then

IMAGE TYPES

You can apply this algorithm to two 2D images or one 2-slice 3D image. 

NOTES

None.

L s2 b2–( )
s1 b1–( )

----------------------⎝ ⎠
⎛ ⎞ P b2 s1 b1 s2×–×( )

s1 b1–( )
-----------------------------------------------+×=

Efficiency Postbleached donor Linearly scaled prebleached donor–( )
Postbleached donor

--------------------------------------------------------------------------------------------------------------------------------------------=
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Applying the FRET algorithm
To use this algorithm, do the following:

1 Open two 2D images or one 2-slice 3D image that contain fluorescent-
labeled components. The Load Bleached ROI message (Figure 1) 
appears.

2 Click Yes. MIPAV loads the images along with the bleached region of 
interest (ROI).

3 Select the prebleached image (refer to ‘‘Selecting Image Slices Quickly’’ 
below).

4 Select Algorithms > Microscopy > FRET in the MIPAV window. The 
FRET dialog box (Figure 2) appears.

Figure 1.  Load Bleached ROI message
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5 Select the postbleached image.

6 Select—for color images—the fluorescence color in the Color selection 
panel. 

Note: The Color selection panel does not appear in the dialog box if the images 
are grayscale or black and white. Also, the number of colors that you can select 
in the Color selection panel depends on the number of colors in the images. If, 
for example, only red and green appear in the images, then those are the only 
colors listed. If three colors are present, then red, green, and blue appear.

Selecting Image Slices Quickly
If the images or images slices are in the same file, you can quickly jump 

from one image or slice to another by using , the Decrements image 

slice icon, or , the Increments image slice icon.
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7 Select Add required donor fluorescence VOI.

Prebleached 
image

Specifies the image before 
acceptor photobleaching.

Postbleached 
image

An image after acceptor 
photobleaching.

Add required 
donor 
fluorescence VOI

Adds a mandatory VOI to 
the postbleached image.

Add optional 
background VOI

Adds an optional 
background VOI on the 
postbleached image.

Add optional 
signal 
normalization VOI

Requires that a background 
VOI be used. Adds an 
optional signal normalization 
VOI on the postbleached 
image.

Color selection 
(only appears for 
color images)

Select one of the available 
colors—red, green, or blue—
that corresponds to the 
fluorescence-labeled 
component being quantified 
in the images. By default, 
red is selected. Note that 
only colors that appear in 
the images are listed in this 
panel.

Registration 
before FRET‘

Registers the prebleached image to the postbleached image. The default is no 
registration. Selecting this check box enables the Cost function list.

Cost function Specifies the registration cost function. You may select correlation ratio (the 
default), least squares, normalized cross correlation, or normalized mutual 
information. To use this item, you must first select Registration before FRET.

Create 
registration image

Creates the registered image in a separate image window. To use this check 
box, you must first select Registration before FRET. By default, this check box 
is selected when registration is selected.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this dialog 
box.

Help Displays online help for this dialog box.

Figure 2.  Fluorescence Resonance Energy Transfer (FRET) dialog box
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8 Go to the MIPAV window, and select one of these icons from the VOI 
toolbar:

• Draw rectangle VOI 

• Draw ellipse VOI 

• Draw polygon/polyline VOI 

• Draw levelset VOI 

9 Draw the VOI on the postbleached image. The VOI appears in red.

Note: In drawing these VOIs, you do not need to first select the New VOI icon.

10 Go to step 12, or, if you wish, create an optional background VOI using 
the following directions:

a Select Add optional background VOI in the Select postbleach VOIs 
panel in the dialog box.

b Go to the MIPAV window and select , , , or  to draw a 
rectangle, ellipsoidal, polygon/polyline, or levelset VOI on the 
image. A blue VOI appears on the postbleached image.

Figure 3.  Example of (A) prebleached image and (B) postbleached 
image after FRET algorithm was applied
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Background region: The background region should not contain any structures 
and should be darker than the donor region.

11 Go to the next step, or, if you wish, create an optional signal 
normalization VOI.

a Select Add optional signal normalization VOI in the Select 
postbleach VOIs panel in the dialog box.

b Go to the MIPAV window and select , , , or  to draw a 
rectangle, ellipsoidal, polygon/polyline, or levelset VOI on the 
image. A green VOI appears on the postbleached image.

Note: To use an optional signal normalization VOI, you must create a 
background VOI.

12 Register the images as an option by doing the following:

a Select Registration before FRET.

b Select a cost function in the Cost function list. The default cost 
function is correlation ratio, but you can select least squares, 
normalized cross correlation, or normalized mutual information.

c Select or clear Create registration image. Since registration is far 
more time consuming than calculating FRET, if you selected the 
Registration before FRET check box, the Create registration image 
check box is selected by default.

13 Click OK. The algorithm begins to run, and a progress bar appears 
momentarily with the status. 

When the algorithm finishes running, the progress bar disappears. The 
data appears on the Data page in the Output window (Figure 4).
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Note: If you chose to register the images, the registered image appears in a 
separate image window, and the FRET data appears on the Data page in the 
Output window.

Figure 4.  FRET data in the Data page of the Output window
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Microscopy: Fluorescent Resonance Energy 
Transfer (FRET) Bleed Through and Efficiency

This section provides information on and discusses how to use the following 
two FRET algorithms:

• FRET Bleed Through algorithm

• FRET Efficiency algorithm

Used consecutively, the FRET Bleed Through algorithm uses two sets of 
three 2D images and the FRET Efficiency algorithm uses one set of three 2D 
images to measure effects dependent on the proximity of fluorescent-
labeled molecules.

Note: You must first run the FRET Bleed Through algorithm twice: once on 
acceptor-dyed images and once on donor-dyed images. Using the results 
achieved from running this algorithm, you then use the FRET Efficiency algorithm 
to process images that were dyed with both the donor and acceptor dyes to 
obtain the FRET efficiency.

Background
Fluorescent resonance energy transfer (FRET) refers to the nonradiative 
transfer of energy from an excited fluorochrome, called a donor, to a nearby 
fluorescent molecule, called an acceptor. The FRET technique measures the 
fluorescence signals of the donor, the acceptor, and the FRET signal. If 
FRET occurs, the donor channel signal is quenched and the acceptor 
channel signal is sensitized or increased.

The energy transfer efficiency E is conventionally defined as the number of 
energy transfer events divided by the number of photons absorbed by the 
donor, is related to the distance R between the acceptor and donor by:

EQUATION 1

E 1

1 r
Ro
-------⎝ ⎠

⎛ ⎞+
6

------------------------------=
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where R0, the Forster critical distance, is the distance at which E = 0.5.

Because FRET falls off as the sixth power of the distance between the donor 

and the acceptor, virtually no FRET occurs for distances greater than . 

Since  is on the order of 10 to 70 Angstroms, by performing FRET 

measurements it is possible to distinguish proteins that are merely nearby 
in the same compartment from those proteins that are interacting with each 

other. Virtually no FRET occurs for distances that are greater than .

Figure 1 schematically illustrates the process of fluorescence and FRET. 
When a fluorescent molecule (donor) is excited (using a blue photon in this 
example), the molecule goes into an excited state (S1) for a few nanoseconds. 
During this time the molecule loses some of its energy after which it returns 
to the ground state (S0) by emission of a less energetic photon (green 
photon in this example). If another fluorescence molecule (acceptor), which 
is excited by green photons and emits red photons, is very close by, then it is 
likely that the donor nonradiatively transfers its excitation energy to the 
acceptor and returns to the ground state without emitting a photon. As a 
consequence, the acceptor becomes excited and later returns to the ground 
state by giving off a photon of lower energy (red photon in this example).

2R0

R0

2R0
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Measuring FRET using the sensitized emission method requires three sets 
of 2D images. You must first run the FRET Bleed Through algorithm once 
on three donor dye only images and once on three acceptor dye only images. 
You then run the FRET Efficiency algorithm on three images with both 
donor and acceptor dyes. 

These images are:

• Image donor and/or acceptor dyes taken with a donor filter

• Image with donor and/or acceptor dyes taken with a FRET filter

• Image with donor and/or acceptor dyes taken with an acceptor filter

To obtain FRET efficiency, you need, therefore, a set of nine images. Table 1 
on page 480 and Figure 2 on page 482 list and show the images that are 
used as examples in this discussion.

Figure 1.  Jablonski diagram for FRET method

In acceptor photobleaching, since ID + IA = constant, if the acceptor is eliminated by photobleaching, then IA 
goes to zero and ID increases to constant.
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FP stands for "fluorescence protein".  The term "FP1 filter" refers to the pair 
of filters normally used to acquire an image of fluorescence protein 1 (FP1).  
The pair of filters consists of an excitation filter and an emission filter.  In 
order to measure bleed through, it is necessary to image each of the proteins 

Table 1. Setup of nine example images

To obtain the FRET efficiency, you need to have a complete set of nine images modeled after the images 
listed here.

Image 
name* Filter used

Excitement 
wavelength

Emission 
wavelength

Algorithm D
y
e
 u

se
d

 o
n

 i
m

a
g

e
s

D
o

n
o

r

A
cc

e
p

to
r

D
o

n
o

r

A
cc

e
p

to
r

FRET Bleed 
Through

A
cc

ep
to

r

R3_543F.tif

(Source)

Acceptor 1 (FP1)

R3_488F.tif FRET

R3_488Y.tif Donor 2 (PF2)

D
o
n
or

Y5_543F.tif FP2

Y5_488F.tif FRET

Y5_488Y.tif

(Source)

FP1

FRET 
Efficiency

A
cc

ep
to

r 
an

d
 d

o
n
o
r YR4_543F.tif

(Source)

Acceptor fluorescence 
photobleaching (AFP)

YR4_488F.tif FRET

YR4_488Y.tif Donor fluorescence 
photobleaching (DFP)

*Refer to Figure 2 on page 482 to see these example images. The naming convention for these images is the following:

R = Red (acceptor dye)
Y = Yellow (donor dye)
F = Filter for detecting acceptor signal
Y after number = Filter for detecting donor signal
488 = Excitation wavelength for donor dye
543 = Excitation wavelength for acceptor dye
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(1 and 2) with the correct filters (1 and 2), wrong filters (i.e., 2 and 1), as well 
as image each of the proteins with the FRET filter. The FRET filter uses the 
excitation filter for the donor protein and the emission filter for the acceptor 
protein. For the bleed-through calculations I avoided using the terms 
"donor" and "acceptor" and instead use "1" and "2" since the donor and 
acceptor are used equivalently for the bleed through calculations.  In the 
second part of the calculation to calculate the FRET efficiency, it does make 
a difference which is the donor and which is the acceptor, therefore I use the 
terms DFP and AFP.
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Figure 2.  Nine example images used to calculate FRET efficiency

R3_543F.tif
Dyes: Acceptor only
Filter: Acceptor 1 (FP1)

R3_488F.tif
Dyes: Acceptor only
Filter: FRET

R3_488Y.tif
Dyes: Acceptor only
Filter: Donor 2 (FP2)

Y5_543F.tif
Dyes: Donor only
Filter: FP2

Y5_488F.tif
Dyes: Donor only
Filter: FRET

Y5_488Y.tif
Dyes: Donor only
Filter: FP1

YR4_543F.tif
Dyes: Donor and acceptor
Filter: Acceptor 
fluorescence 

YR4_488F.tif
Dyes: Donor and acceptor
Filter: FRET

YR4_488Y.tif
Dyes: Donor and acceptor
Filter: Donor fluorescence 
photobleaching (DFP)
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FRET Bleed Through Algorithm
The FRET Bleed Through algorithm requires the six types of images listed 
in Table 2. You need to run the algorithm twice: Once on the set of three 
images with acceptor dye only (the first three images listed in the table); 
and once on the set of three images with donor dye only (the last three 
images listed in the table).

 

For both the acceptor dye only run and the donor dye only run, you need to 
create two or more VOI regions on the source image:

• A background VOI—The background region should have a smaller 
average intensity than the active region. Background VOIs appear in 
blue.

• One or more active VOIs—The area of the active regions are used 
for the bleed through calculations. Each different active VOI appears in 
a different nonblue color.

Caution: Do not use blue as an active VOI color.

Table 2. Six images used in applying the FRET Bleed Through algorithm

Sets of images
Example 
image* Type of image

Acceptor only   
dyed images

R3_543F.tif An acceptor only dyed image taken with an acceptor filter set

R3_488F.tif An acceptor only dyed image taken with a FRET filter set

R3_488Y.tif An acceptor only dyed image taken with a donor filter set

Donor only dyed 
images

Y5_543F.tif An donor only dyed image taken with an acceptor filter set

Y5_488F.tif An donor only dyed image taken with a FRET filter set

Y5_488Y.tif A donor only dyed image taken with a donor filter set

*Refer to Figure 2 on page 482 to view these example images. 
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You must create all of the VOIs on the source image, and the source image 
must be an image of the FP1 dye taken with a FP1 filter. That is, the source 
image must be either:

• An image with donor dye only taken with a donor fluorescent filter set

• An image with acceptor dye only taken with an acceptor fluorescent 
filter set

Note: Pixels that are saturated in any of the three images are excluded from all 
calculations.

Performing the Acceptor dye only run

Running the algorithm on images in which only the acceptor dye was used 
obtains the following values for each active VOI region:

• AFP (acceptor fluorescence photobleaching) to FRET bleed through 
value

• AFP to DFP (donor fluorescence photobleaching) bleed through value

The algorithm displays these values in the Output window.

Performing the Donor dye only run

Running the algorithm on a set of three images in which only the donor dye 
was used obtains the following values for each active VOI region, which are 
displayed in the Output window:

• DFP to FRET bleed through value

• DFP to AFP bleed through value

These values are displayed in the Output window.

Moving to FRET Efficiency

Once the four bleed through parameters (AFP to FRET bleed through, AFP 
to DFP bleed through value, DFP to FRET bleed through, and DFP to AFP 
bleed through) are obtained, you can then run the FRET Efficiency 
algorithm. You run the FRET Efficiency algorithm on the last set of three 
images in Figure 2 on page 482. This last set of images contain both donor 
and acceptor dyes.
MIPAV User’s Guide, Volume 2, Algorithms 484

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Microscopy: Fluorescent Resonance Energy Transfer
(FRET) Bleed Through and Efficiency
Applying the FRET Bleed Through algorithm
The images used in the following instructions are the ones listed in Table 2 
on page 483 and shown in the first two rows in Figure 2 on page 482.

PERFORMING THE ACCEPTOR DYE ONLY RUN

To use this algorithm, do the following:

1 Select File > Open to open the image file on which the acceptor dye and 
FP1 filter were used (example image: R3_543F.tif in Figure 2) (this 
image is the source image).

2 Select Algorithms > Microscopy > FRET Bleed Through (Figure 3). 

The FRET Bleed Through dialog box (Figure 5 on page 488) opens.

Calculating the FRET and FP2 values
The FRET Bleed Through algorithm calculates the FRET and FP2 
values using the following equations:

denom mean FP1 dye with FP1 filter active VOI( )
mean FP1 dye with FP1 filter background VOI( )

–=

FRET bleed-through mean FP1 dye with FRET filter active VOI( )
mean

–
FP1 dye with FP2 filter background VOI( )

[
] denom⁄

=

FP2 bleed-through mean FP1 dye with FP2 filter active VOI( )
mean FP1 dye with FP2 filter background VOI( )

–[
] denom⁄

=
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Note: If images on which you’re running the algorithm are in color, the FRET 
Bleed Through dialog box shown in Figure 4A appears. This dialog box includes a 
Channels group, which allows you to select the color channel on which to run the 
algorithm. If the images are in grayscale, the Channels group does not appear. 
Instead, the dialog box shown in Figure 4B opens.

Figure 3.  Algorithms > Microscopy > FRET Bleed Through command
MIPAV User’s Guide, Volume 2, Algorithms 486

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Microscopy: Fluorescent Resonance Energy Transfer
(FRET) Bleed Through and Efficiency
 

3 Select Acceptor dye only in Select dye type used.

4 Select Add background VOI in Select VOIs.

Figure 4.  FRET Bleed Through dialog box for (A) color images and (B) grayscale images

Channels only 
appears for color 
images

(A)

(B)
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5 Create a background VOI using the ellipse VOI , rectangle VOI , 

levelset VOI , or polyline VOI  on the image in the background of 
the image. This VOI appears in blue (Figure 5).

6 Select Add active VOI in Select VOIs.

7 Create an active VOI using the ellipse VOI , rectangle VOI , 

levelset VOI , or polyline VOI  in the foreground of the image, and 
adjust the contours of the VOI to eliminate any image background. This 
VOI appears in a nonblue color (Figure 5).

8 Decide whether to create additional active VOIs.

Figure 5.  Acceptor only run: FP1 image with a background VOI in blue and an active VOI in 
orange (example image: R3_543F.tif)

(B) Select the 
active VOI. The 
VOI is highlighted.

(C) Move one of 
the contours 
closer to the fore-
ground.

(D) Move all of the 
contours closer to 
the foreground, 
eliminating back-
ground from inside 
the VOI.(A) Image showing a background VOI in blue and an 

active VOI in a nonblue color. Because the active VOI 
must not include background, adjust the VOI to 
eliminate background from the area the VOI encloses. 

Background VOI

Active VOI
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If you decide against creating additional active VOIs, go to the next step. 
If you decide to create additional active VOIs, do the following:

a Select , the New VOI icon.

b Create another active VOI using the ellipse VOI , rectangle VOI 

, levelset VOI , or polyline VOI , and adjust the contours of 
the VOI to eliminate any image background. This VOI appears in a 
nonblue color that is different from the color of the first active VOI.

Note: If you do not select , the New VOI icon, MIPAV creates additional 
contours of the same color for the first active VOI and sums all areas within the 
contours of this VOI together.

9 Select Use red channel, Use green channel, or Use blue channel in 
Channels.

Remember: The Channels group only appears if the source image is in color. 

10 Click Load under Load 1FP image taken with FRET filter box. The Open 
Image dialog box (Figure 6) appears.
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11 Navigate to the directory where the image (example image: 
R3_488F.tif) is stored, and select the image. (Refer to Figure 2 on 
page 482 to see this image.)

12 Click Open. The name of the image appears in the Load 1FP image taken 
with FRET filter box (Figure 4 on page 487).

Note: The Remove button only becomes enabled when an image appears in the 
box (as it does in Figure 4 on page 487).

13 Click Load under the Load 1FP image taken with 2FP filter box. The 
Open Image dialog box (Figure 6) appears.

14 Navigate to the directory where the image (example image: 
R3_488Y.tif) (refer to Figure 2 on page 482 to see this image) is stored, 
and select the image. 

15 Click Open. The name of the image appears in the Load 1FP image taken 
with 2FP filter box (refer to Figure 4 on page 487).

16 Click OK. The algorithm begins to run. When the algorithm finishes, it 
places the data in the Output window (Figure 7). 

Figure 6.  Open Image dialog box
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PERFORMING THE DONOR DYE ONLY RUN

1 Select File > Open to open the image file on which the donor dye and 
FP2 filter were used (example image: Y5_488Y.tif in Figure 2 on 
page 482) (this image is the source image).

2 Select Algorithms > Microscopy > FRET Bleed Through. The FRET 
Bleed Through dialog box (Figure 4 on page 487) opens.

3 Select Donor dye only in Select dye type used (Figure 8).

4 Select Add background VOI in Select VOIs (Figure 9).

Figure 7.  Results in the Output window from the Acceptor dye only run 
of the FRET Bleed Through algorithm

Figure 8.  Donor dye only selection
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5 Create a background VOI using the ellipse VOI , rectangle VOI , 

levelset VOI , or polyline VOI  on the image in the background of 
the image. This VOI appears in blue (Figure 11).

6 Select Add active VOI in Select VOIs.

7 Create an active VOI using the ellipse VOI , rectangle VOI , 

levelset VOI , or polyline VOI  in the foreground of the image, and 
adjust the contours of the VOI to eliminate any image background. This 
VOI appears in a nonblue color (Figure 11).

8 Decide whether to create additional active VOIs.

If you decide against creating additional active VOIs, go to the next step. 
If you decide to create additional active VOIs, do the following:

a Select , the New VOI icon. 

b Create another active VOI using the ellipse VOI , rectangle VOI 

, levelset VOI , or polyline VOI , and adjust the contours of 

Figure 9.  Add background VOI selection

Figure 10.  Add active VOI selection
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the VOI to eliminate any image background. This VOI appears in a 
nonblue color that is different from the color of the first active VOI.

Note: If you do not select , the New VOI icon, MIPAV creates additional 
contours of the same color for the first active VOI and sums all areas within the 
contours of this VOI together.

9 Select Use red channel, Use green channel, or Use blue channel in 
Channels if the images are in color.

Remember: The Channels group only appears if the source image is in color.

10 Click Load under Load 1FP image taken with FRET filter box. The Open 
Image dialog box (Figure 12) appears.

Figure 11.  Donor only run: FP1 image with a background VOI in blue and an active VOI in orange 
(example image: Y5_488Y.tif)

Active VOI

Active VOI after it is 
adjusted to eliminate 
any background 

Background VOI

(A) (B)
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11 Navigate to the directory where the image (example image: 
Y5_488F.tif) is stored, and select the image. (Refer to Figure 2 on 
page 482 to see this image.)

12 Click Open. The name of the image appears in the Load 1FP image taken 
with FRET filter box (Figure 13).

Note: The Remove button becomes enabled when an image appears in the box.

13 Click Load under the Load 1FP image taken with 2FP filter box. The 
Open Image dialog box (Figure 12) appears.

14 Navigate to the directory where the image (example image: Y5_543F.tif) 
is stored, and select the image. The name of the image appears in the 
Load 1FP image taken with 2FP filter box (Figure 13).

Figure 12.  Open Image dialog box
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15 Click OK. The algorithm begins to run. When the algorithm finishes, it 
places the data in the Output window (Figure 14).

Figure 13.  The loaded images in the FRET Bleed Through dialog box

Figure 14.  Results in the Output window from the Donor dye only run of 
the FRET Bleed Through algorithm
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FRE

Select dye type used Acceptor dye only—The 
dye used on images that 
are processed through the 
acceptor-dye run of the 
FRET Bleed Through 
algorithm. As a result of 
this run, the algorithm 
calculates the AFP to 
FRET bleed through value 
and the AFP to DFP bleed 
through value.

Donor dye only—The 
dye used on images that 
are processed through the 
donor dye only run of the 
FRET Bleed Through 
algorithm. During this 
run, the algorithm 
calculates the DFP to 
FRET bleed through value 
and the DFP to AFP bleed 
through value.

Select VOIs Add background VOI—
Indicates a region in the 
image that is the 
background. Using the 
ellipse VOI, rectangle 
VOI, levelset VOI, or 
polyline VOI, you may 
create one background 
VOI. The background VOI 
appears in blue.

Add active VOI—Indicates one or more regions in the image that are in 
the foreground. You may create the first active VOI using the ellipse, 
rectangle, levelset, or polyline VOI. To create more active VOIs, first 
select New VOI and then select ellipse, rectangle, levelset, or polyline 
VOI. Each active VOI appears in a different, nonblue color.

Channels Use red color—Selects the red channel for the FRET analysis.

Use green color—Selects the green channel for the FRET analysis.

Use blue color—Selects the blue channel for the FRET analysis.

Load FP1 image taken 
with FRET filter

Lists the FRET filtered image that you selected after clicking Load.

Figure 15.  FRET Bleed Through dialog box
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FRET Efficiency algorithm
This FRET Efficiency algorithm uses the four bleed through parameters 
obtained from running the FRET Bleed Through algorithm. It requires a set 
of three images:

• Donor- and acceptor-dyed image taken with a donor fluorescence 
photobleaching (DFP) filter

• Donor- and acceptor-dyed image taken with a FRET filter

Load Allows you to load an FP1 image that was taken with the FRET filter. 
Clicking this button causes the Open Image dialog box—from which you 
can select an image—to appear.

Remove Removes the image that is selected in the Load FP1 image taken with 
FRET filter box.

Load FP1 image taken 
with FP2 filter

Lists the FP2 filtered image that you selected after clicking Load.

Load Allows you to load an FP1 image that was taken with the FP2 filter. 
Clicking this button causes the Open Image dialog box—from which you 
can select an image—to appear.

Remove Removes the image that is selected in the Load FP2 image taken with 
FP2 filter box.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes the 
dialog box.

Help Displays online help for this dialog box.

Figure 15.  FRET Bleed Through dialog box (continued)

Sets of images
Example 
image* Type of image

Donor and 
acceptor dyed 
images

YR4_543F.tif An acceptor- and donor-dyed image taken with an acceptor 
filter set

YR4_488F.tif An acceptor- and donor-dyed image taken with a FRET filter 
set

YR4_488Y.tif An acceptor- and donor-dyed image taken with a donor filter 
set

*Refer to Figure 2 on page 482 to view these example images. 
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• Donor- and acceptor-dyed image taken with an acceptor fluorescence 
photobleaching (AFP) filter

The algorithm assumes the presence of two or more VOI regions on the 
source image:

• A background VOI—The background region has a smaller average 
intensity than the active region. Background VOIs appear in blue.

• One or more active regions—The area of the active regions, or 
VOIs, are used for the efficiency calculations. Each different active VOI 
appears in a different nonblue color.

Caution: Do not use blue as an active VOI color.

Note: Pixels with saturation values in any of the three images are excluded from 
all calculations.

For each active VOI region, this algorithm outputs the FRET efficiency and 
the adjusted donor and adjusted acceptor intensities.

Applying the FRET Efficiency algorithm
The images used in these instructions were the ones shown in Table 2 on 
page 483 and shown in the last row in Figure 2 on page 482. You only need 
to run the FRET Efficiency algorithm once on the images.

To use this algorithm, do the following:

1 Select File > Open to open the image file on which both the acceptor dye 
and donor dyes were used and DFP filter were used (example image: 
YR4_488Y.tif).

2 Select Algorithms > Microscopy > FRET Efficiency. The FRET 
Efficiency dialog box (Figure 16) opens.
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3 Select Add background VOI in Select VOIs on the FRET Efficiency 
dialog box.

4 Create a background VOI on the image in the background of the image. 
This VOI appears in blue lines.

Figure 16.  FRET Efficiency dialog box (A) color images and (B) grayscale images

Channels only 
appears for color 
images

(A)

(B)
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5 Select Add active VOI in Select VOIs on the FRET Efficiency dialog box.

6 Create an active VOI using the ellipse VOI , rectangle VOI , 

levelset VOI , or polyline VOI  in the foreground of the image, and 
adjust the contours of the VOI to eliminate any image background. This 
VOI appears in a nonblue color (Figure 11).

7 Decide whether to create additional active VOIs.

If you decide against creating additional active VOIs, go to the next step. 
If you decide to create additional active VOIs, do the following:

a Select , the New VOI icon. 

b Create another VOI using the ellipse VOI , rectangle VOI , 

levelset VOI , or polyline VOI , and adjust the contours of the 
VOI to eliminate any image background. This VOI appears in a 
nonblue color that is different from the color of the first active VOI.

Note: If you do not select , the New VOI icon, MIPAV creates additional 
contours of the same color for the first active VOI and sums all areas within the 
contours of this VOI together.

Note: MIPAV prefills the Enter bleed through values. However, if the correct 
bleed through values are not automatically entered, type them into the fields.

8 Click Load under Load DFP/AFP image taken with FRET filter box. The 
Open Image dialog box appears.

9 Navigate to the directory where the image (example image: 
YR4_488F.tif) is stored, and select the image.

10 Click Open. The name of the image appears in the Load DFP/AFP image 
taken with FRET filter box.

Note: The Remove button becomes enabled when an image appears in the box.
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11 Click Load under the Load DFP/AFP image taken with AFP filter box. 
The Open Image dialog box appears.

12 Navigate to the directory where the image (example image: 
YR4_543F.tif) is stored, and select the image. The name of the image 
appears in the Load DFP/AFP image taken with AFP filter box.

13 Click OK. MIPAV places the data from this second part of the procedure 
in the Output window (Figure 7).

Select VOIS Add background VOI—
Indicates a region in the 
image that is the 
background, which has a 
smaller average intensity 
than the active region. 
Using the ellipse VOI, 
rectangle VOI, levelset 
VOI, or polyline VOI, you 
create a background 
VOI. The background 
VOI appears in blue.

Add active VOI—
Indicates one or more 
regions in the image that 
are in the foreground. 
You may create the first 
active VOI using the 
ellipse VOI, rectangle 
VOI, levelset VOI, or 
polyline VOI. To create 
more active VOIs, select 
New VOI. Each different 
active VOI appears in a 
different nonblue color.

Bleed through from DFP 
into FRET (0.0–1.0)

Indicates the bleed 
through value from DFP 
into FRET.

Bleed through from AFP 
into FRET (0.0–1.0)

Indicates the bleed 
through value from AFP 
into FRET.

Bleed through from DFP 
into AFP (0.0–1.0)

Indicates the bleed 
through value from DFP 
into AFP.

Bleed through from AFP 
into DFP (0.0–1.0)

Indicates the bleed through value from AFP into DFP.

Figure 17.  FRET Efficiency dialog box
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IMAGE TYPES

You apply both algorithms to three 2D images.

NOTES

Only one user-selected color can be used from a color image.

Both algorithms port the MATLAB routines provided by Dr. Stephen 
Lockett.

Channels Use red color—Selects the red channel.

Use green color—Selects the green channel.

Use blue color—Selects the blue channel.

Load DFP/AFP image 
taken with FRET filter

Lists the FRET filtered image that you selected after clicking Load.

Load Allows you to load a DFP/AFP image that was taken with the FRET 
filter. Clicking this button causes the Open Image dialog box—from 
which you can select an image—to appear.

Remove Removes the image that is selected in Load DFP/AFP image taken with 
FRET filter.

Load DFP/AFP image 
taken with AFP filter

Lists the AFP filtered image that you selected after clicking Load.

Load Allows you to load a DFP/AFP image that was taken with the AFP filter. 
Clicking this button causes the Open Image dialog box—from which 
you can select an image—to appear.

Remove Removes the image that is selected in Load DFP/AFP image taken with 
AFP filter.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes 
this dialog box.

Help Displays online help for this dialog box.

Figure 17.  FRET Efficiency dialog box (continued)
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Microscopy (Restoration): Computational 
Optical Sectional Microscopy (COSM)

This algorithm removes out-of-focus light in 3D volumes collected plane by 
plane using either widefield or confocal fluorescence microscopes. The 
implementation of this algorithm, detailed by Conchello and Hansen 
(1997), incorporates a roughness penalty into a regularized expectation 
maximization restoration procedure described by Conchello (1995). This 
implementation also includes an intensity penalty as detailed by Conchello 
and McNally (1996) (see “References” on page 508).

Background
Image restoration algorithms are used to compute a more accurate version 
of the imaged volume by removing artifacts of the imaging system. The 
sample microscopy imaging system is shown in Figure 1.

For example, an observed image function  can be written 

mathematically as:

where

 

 

 

The purpose of image restoration is to utilize the observed image , 

the known transfer function , and the estimate of the noise 

 to compute a better estimate of .

g x, ( y, z )

g x, ( y, z ) h x, ( y, z ) f x, ( y, z ) n x, ( y, z )+⊗=

f x, ( y, z ) true or undistorted image function=

h x, ( y, z ) transfer function of the imaging system=

n x, ( y, z ) noise term=

denotes convolution=⊗

g x, ( y, z )

h x, ( y, z )

n x, ( y, z ) f x, ( y, z )
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To run this algorithm, you, first, need to open an image of a system transfer 

function  of the imaging system and an observed image. One of 

the first computations performed by this algorithm is to convert the transfer 
function into a point spread function (PSF) by computing its Fourier 
transform. Because it is customary to refer to the PSF instead of the transfer 
function, this document follows that convention.

It is necessary that the observed image have the mouse focus when selecting 
the algorithm from the Algorithms menu. When the algorithm is selected, 
the XCOSM Expectation Maximum Restoration dialog box opens, 
presenting several parameters to specify, including the name of the open 
PSF image.

Figure 1.  Image formation and recording

h x( y z ), ,( )
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The PSF utilized by the algorithm is a processed version of the actual PSF by 
shifting each pixel in it by one-half of the images dimensions. This 
compensates for the standard shifting operation typically applied while 
computing the Fast Fourier Transform (FFT). Figure 2 shows the shifted 
transfer function that is an input into the X_COSM algorithm.

The observed image used in this documentation is a microscopic bead, a 
subject to the blurring introduced by the imaging system. Figure 3 shows a 
volume rendering of the blurred bead.

The algorithm allows processing lower resolution volumes to remove some 
of the blur, and thereby, speed up the processing of an image set. 

Figure 2.  The shifted version of the transfer function conventionally, but 
incorrectly, called the point spread function (PSF)
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ADJUSTING THE SPEED OF THE PROCESSING

The following three parameters that also appear as options in the X_COSM 
Expectation Maximum Restoration dialog box can be used to adjust the 
speed of the processing, depending on the specified values:

• Original size iteration percentage

• Half size iteration percentage

• Quarter size iteration percentage

Each of these boxes specify values that indicate the percentage of iterations 
that are performed at full resolution, half of the resolution, and quarter of 
the resolution respectively. The sum of the values in these boxes must add 
up to 100 percent, or the algorithm computes correct percentages starting 
with the value for full resolution. See Figure 5.

A factor that affects the speed of image processing is the value specified in 
the Number of iterations box. The length of time the algorithm spends in 
processing the image depends on how many times it iterates over the image.

In addition, the Backup number of iterations parameter specifies the 
number of iterations that should occur before the algorithm writes the 

Figure 3.  The observed bead used in this documentation. The red lines 
correspond to the bounding box of the image
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currently processed image to a disk. The value you specify in this box 
determines whether the algorithm saves intermediate results or not.

The algorithm allows for either an intensity penalty (Conchello and 
McNally, 1996) or a roughness penalty (Markham and Conchello, 1997). 
These constraints limit the amount of processing when intensity or 
roughness exceeds a set value, which controls the amount of deblurring that 
can occur. The penalty value is an exponential value that controls the 
amount of variation in intensity or roughness that is deblurred.

The final options on the dialog box—Entire image and VOI regions—permit 
restoring the whole image or those areas of the image that fall within one or 
more VOIs.

 REFERENCES
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IMAGE TYPES

All types of 3D microscopy images that can be opened in MIPAV.

Applying the X_COSM algorithm
To run this algorithm, do the following:

1 Open an observed image and a PSF image (Figure 4A and B).

2 Select the observed image to give it a mouse focus.

3 Select the Save User Defined LUT icon, to save the lookup table (LUT) 
for the observed image.

4 Select the PSF image, which gives it the mouse focus.

5 Select the Open User Defined LUT icon, which applies the LUT that you 
saved for the observed image to the PSF image.

Tip: The PSF image may look as if it is totally blank (Figure 4b). You may not see 
an image even if you select the Image Slice slider to look at all of the slices in the 
image. To improve the contrast in the PSF image, select the Quick LUT icon, and 
drag it over the PSF image to improve the contrast (Figure 4d).

6 Select the observed image to give it the mouse focus.

7 Select Algorithms > Microscopy > Restoration > XCOSM_EM. 

The XCOSM Expectation Maximum Restoration dialog box (Figure 5) 
opens.Complete the dialog box, or simply accept the default values. See 
also “Adjusting the speed of the processing” on page 507.
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8 Click OK. The algorithm begins to run. A message appears showing the 
status of image processing, which may take a while depending on the 
number of iterations requested in the XCOSM Expectation Maximum 
Restoration dialog box.Once processing is complete, a restored image 
appears. See Figure 4d.

(a) (b)

(c) (d)

Figure 4.  Observed and PSF images: (a) observed image, (b) PSF image 
as it appears initially,  (c) restored image, and (d) PSF image after 
applying the Quick LUT icon
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Restoration of 
[file name] with 
PSF

Indicates the name of 
the image with the 
focus (in this example, 
the image name is 
bead) and the file 
name of the image 
that contains the point 
spread function of the 
imaging system (in 
this case, psfbead). 

The default image to 
be restored is the 
image that had the 
focus before the image 
that is to be restored.

Window lower 
limit in Z

Allows restoration to 
begin at slices other 
than the first image 
slice, thus allowing the 
restoration of a portion 
of an image.

Estimate decay Indicates to estimate the exponential decay associated with the blur using the 
value in Decay constant. If you do not select this option, the value in Decay 
constant is ignored.

Decay constant Uses the specified value for estimating the exponential decay associated with 
the blur.

Original size 
iteration 
percentage

Indicates the percentage of iterations to be performed at full resolution. 

The percentage specified here plus the percentages specified in Half size 
iteration percentage and Quarter size iteration percentage must add to 100 
percent, or the algorithm computes correct percentages starting with the value 
for full resolution.

Half size 
iteration 
percentage

Indicates the percentage of iterations to be performed at one-half the 
resolution. 

The percentage specified here plus the percentages specified in Half size 
iteration percentage and Quarter size iteration percentage must add to 100 
percent, or the algorithm computes correct percentages starting with the value 
for full resolution.

Quarter size 
iteration 
percentage

Indicates the percentage of iteration to be performed at one-quarter the 
resolution.

The percentage specified here plus the percentages specified in Half size 
iteration percentage and Quarter size iteration percentage must add to 100 
percent, or the algorithm computes correct percentages starting with the value 
for full resolution.

Figure 5.  XCOSM Expectation Maximum Restoration dialog box
MIPAV User’s Guide, Volume 2, Algorithms 511

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Microscopy (Restoration): Computational Optical
Sectional Microscopy (COSM)
Number of 
iterations

Indicates the number of times the Expectation Maximization algorithm iterates 
over the image.

Backup number 
of iterations

Specifies the number of iterations should occur before the algorithm writes the 
currently processed image to disk. Specifying this value provides a mechanism 
for saving intermediate results.

Intensity 
penalty

Limits the amount of processing when intensity exceeds the value specified in 
the Penalty value box, controlling the amount of deblurring that can occur. 

Roughness 
penalty

Limits the amount of processing when roughness exceeds the value specified in 
the Penalty value box, controlling the amount of deblurring that can occur.

Penalty value Specifies a exponent value that controls the amount of variation in intensity or 
roughness that is deblurred. 

Entire image Restores the entire image.

VOI regions Restores only those values defined in one or more volumes of interest, or VOIs.

OK Applies this algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in this dialog box and closes the dialog 
box.

Help Displays online help for this dialog box.

Figure 5.  XCOSM Expectation Maximum Restoration dialog box (continued)
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Midsagittal Line Alignment

This section presents a detailed description of the Midsagittal Line 
Alignment algorithm which is used for the automatic detection of the 
midsagittal line in 2D and midsagittal plane in 3D brain images. 

The midsagittal line alignment is important because the ideal coordinate 
system attached to the head, in which the inter-hemispheric fissure is 
conveniently displayed, differs from the coordinate system of the image 
because of the usual tilt of the patient's head. It means that the midsagittal 
fissure is generally not displayed in the center of the image lattice where it 
should be. This might prevent from further visual inspection or analysis of 
the image, because the homologous anatomical structures or functional 
areas in both hemispheres are not displayed in the same axial or coronal 
slice in the 3D image. See Figure 1.

The algorithm searches for the midsagittal plane in 3D images or for 
midsagittal line in 2D images.

Background
Midsagittal plane is the plane with respect to which the image exhibits 

Figure 1.  The ideal coordinate system attached to the head in which the 
fissure is close to the plane Z = 0 (red) and the coordinate system of the 
image (blue) differ from each other by way of three angles (yaw, roll 
and pitch) and a 3D translation.
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maximum symmetry. Therefore, the algorithm defines the midsagittal plane 
as the one that maximizes the similarity between the image and it's 
symmetric. The Cross-Correlation cost function is used as a similarity 
measure. 

Symmetry is measured by flipping the image horizontally and then 
registering the flipped image against original. The plane that shows 
maximal symmetry, and thus approaches the cost function global minimum 
is a midsagittal plane. The algorithm uses a multi-resolution approach to 
evaluate the cost function. To find a global minimum of the cross-
correlation cost function, the algorithm uses the Powell method.

OUTLINE OF THE METHOD:

1 The minimum resolution of the image is determined.

2 The image is flipped horizontally and the flipped image is saved.

3 Both images are, then, resampled and interpolated to create high 
resolution isotropic voxels. The algorithm uses Trilinear interpolation to 
subsample the images.

4 The center of mass (COM) for both images is computed and one 
translation step is performed to align the COMs.

5 The iterative method is used to register original image against flipped. 
Refer to “Iterative method used to register original image against 
flipped” on page 514.

ITERATIVE METHOD USED TO REGISTER 
ORIGINAL IMAGE AGAINST FLIPPED

1 The first estimation of the midsagittal plane is made based on low 
density and low resolution. Both images –the original and flipped – are 
subsampled and interpolated to a low resolution (8 times). 

2 The coarse angle step (45 degrees with 15 degrees step) is used in each 
dimension when registering the original low resolution image against 
the flipped image. For each angle configuration, a six degrees of 
freedom (6-DOF) local optimization is also performed to find the 
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optimal midsagittal aligning. The parameters of the transformation are 
then systematically varied, where the cost function is evaluated for each 
setting. The parameters corresponding to the smallest value(s) of the 
cost function are, then, used as the initial transformation for the next 
level in the optimization. 

3 For each parameter setting corresponding to the top 20% of the cost 
function minima, the algorithm performs rotations over the fine grid 
(which is by default 15 degrees with 6 degrees step) and evaluates the 
cost function. 

4 Three best minima with corresponding transformation parameters are 
stored in a vector of minima and then used as initial parameters for the 
next optimization level.

5 The images are resampled and interpolated to a higher resolution (4 
times). The transformation corresponding to the smallest value(s) of the 
cost function is determined and used as the initial transformation for 
the next level in the optimization.

6 Similar processing as the previous two levels except the images are, first, 
sub-sampled and interpolated to 2 times.

7 Finally, 1mm resolution images are used. The algorithm returns the 
value of the rotation angle that was applied to register the original to 
flipped image.

8 The algorithm transforms the original image back by half of the 
registration rotation. This finds the estimated midsagittal plane. 

9 The estimated plane is aligned with the center of the image lattice.

For more information of which methods were used to 

• Calculate the Center of Mass;

• Subsample and interpolate the images;

• Find the global minima and use it in evaluation of the cost function; 

Refer to “Optimized Automatic Registration 3D” on page 596.
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IMAGE TYPES

2D and 3D grayscale and color brain images

RUNNING THE MIDSAGITTAL LINE 
ALIGNMENT ALGORITHM

To run the algorithm,

1 Open an image of interest;

2 Call Algorithms>Brain Tools>Midsaggital line alignment.

The algorithm begins to run and several windows appear with the status as 
shown in Figure 3. When the algorithm finishes running, the aligned image 
appears in a new image frame as shown in Figure 2-B.

Figure 2.  The original image (A) and the image after applying the 
midsagittal line alignment algorithm (B).
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Figure 3.  The Midsagittal Line Alignment algorithm is running.
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Morphology

The following sections present several important algorithms that employ 
the mathematical morphological operations such as erosion, dilation, 
opening, closing, particle analysis, calculation the background map, etc.

Introduction to the basic morphological operations
In this introductory section we will explain several important concepts in 
mathematical morphology that are used in MIPAV algorithms. These 
concepts are as follows: translation, reflection, complement, and difference. 

Let's introduce two objects A and B in Z2 with components a (ai,aj) and b 

(bi,bj) respectively. 

The translation of A by x = (x1,x2), which is denoted as (A)x, can be defined 

as 

EQUATION 1

The reflection of B, denoted as B^, is defined as

EQUATION 2

The complement of object A is

EQUATION 3

The difference of two objects or images A and B, denoted as A–B, is defined 
as
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EQUATION 4

Figure 1 illustrates the morphological operations mentioned above.

DATA TYPES

All morphological operations can be applied to the images of the following 
types:

Background Distance map
The Background Distance map operation converts a binary image (which 
consists of background and foreground pixels) into an image where every 
foreground pixel has a value corresponding to the minimum distance from 

Figure 1.  (a) Image A; (b) image A translated; (c) image B; (d) 
reflection of image B; (e) image A and its complement; (f) the difference 
of A and B. The origin of the image is shown as a black dot.

Data type Description

Boolean 1 bit per pixel/voxel (1 on, 0 off)

Unsigned byte 1 byte per pixel/voxel (0, 255)

Unsigned short 2 bytes per pixel/voxel (0, 65535)
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the background. The algorithm uses the Euclidean distance metric to trans-
form the image.

For 2D images, the algorithm determines the image resolution in X and Y 
directions, first. Then it identifies all edges pixels. And finally, it creates a 
distance metric, where each pixel of the metric is associated with a corre-
sponding region of the source image. Each pixel is assigned a calculated dis-
tance value corresponding to the Euclidean distance between a center of 
that pixel and the nearest point of the background. The nearest point is 
located using the image resolution. 

For two 2D points P(x1,y1) and Q(x2,y2) the “classical” Euclidian distance is 

computer as

EQUATION 5

The Background Distance map operation when computes the Euclidian 
distance takes into account the image resolutions in the X and Y 
dimensions. So that it is calculated as 

EQUATION 6

APPLYING BACKGROUND DISTANCE MAP 

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological> Background Distance map.

3 In the Background Distance map dialog box that appears, 

• Specify the destination of the Background Distance map image; 
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• And also specify whether you want to calculate the Background 
Distance map for the whole image or only for the selected VOIs.

4 Press OK to run the algorithm.

When the algorithm finishes running, the Background Distance map 
appears in the specified frame (the default option is a new frame). See also 
Figure 2.

Close
The closing of an object A by kernel B is defined as the dilation of A by B, 
followed by the erosion of the result by B. Closing generally smooths 
sections of contours, fuses narrow breaks, eliminates small holes and fills 
gaps in the contour. For 2D images it could be expressed using the following 
equation:

EQUATION 7

Figure 3 below illustrates closing of an object A with a disk kernel B. Note 
that the resulted image was also smoothed by the circular kernel B.

Figure 2.  Applying the Background Distance map operation to the image. You can see 1) the 
original image (left), 2) the dialog box with the default settings (center) and 3) the 
background distance map (right)
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APPLYING THE CLOSING

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological >Close.

3 In the Open dialog box that appears, 

• Specify the number of dilations (from 1 to 20);

• Specify the number of erosions (from 1 to 20);

• Select the structural element or kernel;

• Specify the destination of the result image; 

• And also specify whether you want apply the closing to the whole 
image or only for selected VOIs. For the dialog box options refer to 
Figure 4.

4 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the 
specified frame. See also Figure 5.

Figure 3.  Illustration of closing (a) the original image A, (b) the dilation 
of image A by kernel B, (c) the erosion of result of (b) by the same 
kernel B
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Number of 
dilations

Indicates the number of 
dilations to be performed.

Number of 
erosions

Indicates the number of 
erosions to be performed.

Kernel selection Use this list box to select the 
structuring element that will 
be used for erosion.

Circle diameter 
(mm)

This option is available only if 
you choose the User Sized 
Circle option in the Kernel 
Selection box. 

Enter a value for the circle 
diameter, here. 

Process image in 2.5D TBD.

Destination

New image – if selected, indicates that the result image appears in a new image window.

Replace image – if selected, indicates that the result image replaces the current active image. 

Process

Whole image

If selected, indicates that the erosion should be applied to the whole image.

VOI region(s)

If selected, indicates that the erosion should be applied only to selected VOI(s).

OK Performs the dilation on the selected image based on your choices in this 
dialog box.

Cancel Disregards changes you made in this dialog box and closes the dialog box.

Help Displays online help for the algorithm.

Figure 4.  Close dialog box 
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Delete Objects
The Delete operation deletes objects larger than a maximum size indicated 
in the Delete dialog box and also objects smaller than the indicated 
minimum size.

APPLYING THE ALGORITHM

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological> Delete Objects.

3 In the Delete Objects dialog box that appears, 

• Specify the maximum size of the object;

• Specify the minimum size of the object;

• Specify the destination of the result image; 

• And also specify whether you want apply the algorithm to the whole 
image or only for selected VOIs. 

4 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the 
specified frame. See also Figure 6.

(a) (b)

Figure 5.  The original image (a) and the result image after the closing 
that includes 15 dilations followed by 15 erosions applied with the “3x3 
-4 connected” kernel
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Dilate
We define the dilation as a process that consists of obtaining the reflection 
of B about its origin, and then shifting this reflection by x. The dilation of A 
by B is then the set of all x displacements such that B^ and A overlap by at 
least one nonzero element. That can be expressed using the following 
equation:

EQUATION 8

The object B is commonly referred to as a structuring element or kernel in 
dilation, as well as in the other morphological operations. Figure 7 (a) below 
shows a simple dilation by the symmetric kernel, so that B^=B. Figure 7 (b) 
shows a kernel designed to achieve more dilation vertically than 
horizontally.

(a) (b)

Figure 6.  Applying the Delete Objects operation; (a) the original image, (b) the result image. The 
parameters are shown in the dialog box

                                     (a)

Figure 7.  (a) An original image A, a square structural element B and its 
reflection, and the dilation of A by B; (b) an original image A, an 
elongated structural element B and its reflection, and the dilation of A 
by B
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APPLYING THE DILATION

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological> Dilate.

3 In the Dilation dialog box that appears, 

• Specify the number of dilations (from 1 to 20);

• Select the structural element or kernel;

• Specify the destination of the dilated image; 

• And also specify whether you want apply the dilation to the whole 
image or only for selected VOIs. For the dialog box options refer to 
Figure 8.

4 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the 
specified frame. See also Figure 9.

                                    (b)

Figure 7.  (a) An original image A, a square structural element B and its 
reflection, and the dilation of A by B; (b) an original image A, an 
elongated structural element B and its reflection, and the dilation of A 
by B
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Number of 
dilations

Indicates the number of 
dilations to be performed.

Kernel selection Use this list box to select the 
structuring element that will 
be used for dilation.

Circle diameter 
(mm)

This option is available only if 
you choose the User Sized 
Circle option in the Kernel 
Selection box. 

Enter a value for the circle 
diameter, here. 

Destination

New image

If selected, indicates that the result image appears in a new image window.

Replace image

If selected, indicates that the result image replaces the current active image. 

Process

Whole image

If selected, indicates that the dilation should be applied to the whole image.

VOI region(s)

If selected, indicates that the dilation should be applied only to selected VOI(s).

OK Performs the dilation on the selected image based on your choices in this 
dialog box.

Cancel Disregards changes you made in this dialog box and closes the dialog box.

Help Displays online help for the algorithm.

Figure 8.  Dilation dialog box 
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Distance Map
The algorithm uses the Euclidean distance metric to calculate a distance 
map for a selected image or image region. For 2D images, 

1 The algorithm determines the image resolution in X and Y directions. 

2 Then it identifies all edge pixels. 

3 Then, it creates a distance metric, where each pixel of the metric is 
associated with a corresponding region of the source image. Each pixel 
is assigned a calculated distance value corresponding to the Euclidean 
distance between a center of that pixel and the nearest edge point. 

For more information, please refer to “Background Distance map” on 
page 519.

APPLYING DISTANCE MAP

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological> Distance Map.

3 Specify whether you want apply the dilation to the whole image or only 
for selected VOIs. 

(a) (b)

Figure 9.  The original image (a) and the result image after 5 dilations 
applied with the “3x3–4 connected” kernel
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Fi
or
di
4 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the 
specified frame. See also Figure 9.

Erode
The erosion of A by B is the set of all points x such that B, translated by x, is 
contained in A. For 2D images it could be expressed using the following 
equation:

EQUATION 9

APPLYING THE EROSION

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological> Erode.

3 In the Erode dialog box that appears, 

• Specify the number of erosions (from 1 to 20);

• Select the structural element or kernel;

• Specify the destination of the result image; 

gure 10.  Applying the Background Distance map operation to the image. You can see 1) the 
iginal image (left), 2) the dialog box with the default settings (center) and 3) the background 
stance map (right)
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• And also specify whether you want apply the erosion to the whole 
image or only for selected VOIs. For the dialog box options refer to 
Figure 11.

4 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the 
specified frame. See also Figure 12.

 

Number of 
erosions

Indicates the number of 
erosions to be performed.

Kernel selection Use this list box to select the 
structuring element that will 
be used for erosion.

Circle diameter 
(mm)

This option is available only if 
you choose the User Sized 
Circle option in the Kernel 
Selection box. 

Enter a value for the circle 
diameter, here. 

Destination

New image

If selected, indicates that the result image appears in a new image window.

Replace image

If selected, indicates that the result image replaces the current active image. 

Process

Whole image

If selected, indicates that the erosion should be applied to the whole image.

VOI region(s)

If selected, indicates that the erosion should be applied only to selected VOI(s).

Process image in 
2.5D

TBD.

OK Performs the dilation on the selected image based on your choices in this 
dialog box.

Cancel Disregards changes you made in this dialog box and closes the dialog box.

Help Displays online help for the algorithm.

Figure 11.  Erosion dialog box 
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Evaluate Segmentation
Evaluate Segmentation operation compares segmentation results of a test 
image to segmentation results of an ideal gold standard true image. For 
each evaluated segmentation pair, the false negative volume fraction, the 
false positive volume fraction, and the positive volume fraction are sent to 
the Output window. See Figure 13-e.

APPLYING EVALUATE SEGMENTATION

To apply the algorithm, 

1 Open a segmented image of interest and its gold standard segmented 
image.

Note that the images should be of the following types: Boolean, Unsigned byte, 
or Short. Before running the algorithm, convert the images using the Utilities> 
Conversion Tools> Convert Type menu. See also “Convert Type” on page 365. 
You can also use the Paint Conversion tools menu options to convert the paint to 
the Unsigned Byte mask image. See Figure 13. 

2 Select the gold standard segmented image.

3 Call Algorithms>Morphological> Evaluate Segmentation.

4 The Evaluate Segmentation dialog box appears. 

(a) (b)

Figure 12.  The original image (a) and the result image after 5 erosions 
applied with the “3x3 -4 connected” kernel
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5 In the dialog box, select the test image, and then press OK to run the 
algorithm.

When the algorithm finishes running, the result statistics appears in the 
Output window. See also Figure 13.

(a) (b)

(c) (d)

Figure 13.  The Evaluate Segmentation algorithm : (a) – a gold standard 
segmented image, (b) – its unsigned byte mask, (c) – a segmented 
image for evaluation, (d) – its unsigned byte mask, and (d) – the 
Evaluate Segmentation dialog box and the Output window 
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Fill holes
To fill holes in objects MIPAV uses the following procedure: 

• It segments an image to produce binary representation of objects; 

• Then, it computes complement of a binary image as a mask image; 

• It generates a seed image as the border of the image; 

• Then, it propagates the seed into the mask; 

• And finally, it complements the result of propagation to produce the 
final result.

APPLYING FILL HOLES

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological> Fill Holes.

3 The Fill Objects dialog box appears. In the dialog box:

• Specify if you want to process the image in 2.5 D (this option is 
available for 3D images only);

(e)

Figure 13.  The Evaluate Segmentation algorithm (continued): (a) – a 
gold standard segmented image, (b) – its unsigned byte mask, (c) – a 
segmented image for evaluation, (d) – its unsigned byte mask, and (d) – 
the Evaluate Segmentation dialog box and the Output window 
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• Specify the destination of the result image. 

4 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the new 
image frame. See also Figure 14.

Find Edges 
The technique finds the edges of the objects in an image using combinations 
of the following morphological operations: dilation, erosion, and XOR. The 
algorithm has two options – it could find outer edges or inner edges 
depending on the user’s choise.The algorithm, first, determines the image 
resolution. And then it uses the resolution to calculate the kernel or struc-
tural element that will be used for the dilation or erosion. 

If the Outer Edging option was selected, the algorithm dilates the 
original image, and then performs XOR operation of the dilated image with 
the original image.

If the Inner Edging option was selected, the algorithm erodes the 
original image, and then performs XOR operation of the eroded image with 
the original image.

(a) (b) (c)

Figure 14.  The Fill Holes algorithm: (a) the original image; (b) the Fill Objects dialog box; 
(c) the result image
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APPLYING FIND EDGES

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological> Find Edges.

3 The Find Edges dialog box appears. In the dialog box:

• Specify what option you would like to use – Outer Edging or Inner 
Edging;

• Specify the destination of the result image;

• And also specify whether you want apply the algorithm to the whole 
image or only for selected VOI(s). 

4 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the new 
image frame. See also Figure 15.

ID objects
The algorithm labels each object in an image with a different integer value 
and also deletes objects which are outside of the user defined threshold. It 
converts the image to black and white in order to prepare it for boundary 
tracing; and then it uses morphology functions, such as open, close and fill 
holes to remove pixels which do not belong to the objects of interest.

(a) (b) (c)

Figure 15.  The Find Edges algorithm: (a) the original image; (b) the Find Edges dialog box; 
(c) the result image
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APPLYING ID OBJECTS

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological> ID objects.

3 The Identify Objects dialog box appears. In the dialog box:

• Specify the destination of the result image;

• Specify whether you want apply the algorithm to the whole image or 
only to selected VOI(s);

• And also enter the max and min size for the particles you would like 
to exclude from the calculation.

4 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the 

Figure 16.  ID Objects algorithm
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designated image frame and the statistics appears in the Output window. 
See also Figure 16.

Note: you might consider smoothing the image and removing excess noise, first, 
and then apply ID Objects. 

Morphological filter 
Morphological filter can be used to correct an image for the shading that 
was introduced in the image forming procedure. In other words, it corrects 
for non-uniform illumination and non-uniform camera sensitivity. 

The illumination over the microscope field-of-view Iill(x,y) usually interacts 

in a multiplicative (non-uniform) way with the biological object a(x,y) to 
produce the image b(x,y): 

EQUATION 10

b(x,y) = Iill(x, y) • a(x, y), 

where the object a(x,y) representing various microscope imaging 

modalities, such as reflectable model r(x, y), optical density model 10−OD(x , y) 

or fluorescence model c(x, y). The Morphological filter works with the 

fluorescence model c(x, y), assuming that this model only holds for low 
concentrations. The camera and microscope are also contributing gain and 

offset to the image, thus the equation for c(x, y) can be rewritten as:

EQUATION 11

c[m,n] = gain[m,n] • b[m,n]+ offset[m,n]= gain[m,n] • Iill[m,n]• a[m,n] + 
offset[m,n]

where, a) the camera gain and offset can vary as a function of position and, 
therefore, contributing to the shading; and b) Iill[m,n], gain[m,n] and 

offset[m,n] are slowly varying compared to a[m,n].

The algorithm, first, compute (using morphological smoothing) a smoothed 
version of c[m,n], where the smoothing is large compared to the size of the 
objects in the image. This smoothed version is the estimate of the 
background of the image. Second, it subtracts the smoothed version from 
c[m,n]. And then, it restores the desired average brightness value. This can 
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be written as a following formula:

EQUATION 12

aˆ [m,n] = c[m,n] − MorphSmooth{c[m,n]} + constant,

where the morphological smoothing filter MorphSmooth{c[m,n]} involves 

two basic operations – the maximum filter and the minimum filter.

• In the maximum filter, defined over a window W of J x K pixels 
where both J and K are considered to be of odd size (e.g., 5 × 3), the 
value in the output image, corresponding to the center pixel A in the 
input window, is the maximum brightness value found in the input 
window.

• In the minimum filter, defined over a similar J x K window (W), the 
value in the output image, corresponding to the center pixel A in the 
input window, is the minimum brightness value found in the input 
window.

Therefore, the maximum and minimum filters can be described as exam-
ples of the morphological dilation and erosion respectively. 

Dilation:

EQUATION 13

D(A) = max [j,k]∈W {a[m − j, n − k]} = max W (A)

Erosion:

EQUATION 14

E(A) = min [j,k ]∈W {a[m − j, n − k]} = min W(A)

Finally, the algorithm defines the morphological smoothing filter described 
as follows:

EQUATION 15

MorphSmooth(A) = min(max(max(min(A)))),

where all of the filter operations are applied over the same J x K filter 
window W. To better understand Equation 15, assume that you have two 
“subroutines” available, one for the minimum filter and the other one for 
the maximum filter, and that you apply them in a sequential fashion. See 
MIPAV User’s Guide, Volume 2, Algorithms 538

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Morphology
Figure 17.

APPLYING MORPHOLOGICAL FILTER

Before applying Morphological filter you might consider smoothing the image 
using Gaussian Blur and (or) reducing the image noise using one of the noise 
reduction algorithms available in MIPAV. 

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological >Morphological Filter.

3 In the Morphological Filter dialog box that appears, 

• Specify the window size in the X direction;

• Specify the window size in the Y direction;

• Specify the window size in the Z direction (for 3D images only);

• For 2.5D images, specify whether you want to process slices 
independently or not;

• Specify the destination of the result image; 

(a) (b) (c)

Figure 17.  a: the original image; b: the same image after applying the noise reduction 
algorithm; c: the image from (b) after applying Morphological filter with parameters shown in 
Figure 18
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• And also specify whether you want apply the opening to the whole 
image or only for selected VOIs. For the dialog box options refer to 
Figure 18 on page 540.

4 Press OK to run the algorithm. 

When the algorithm finishes running, the result image appears in the 
specified frame. See also Figure 17.

 

Open
The opening of image A by a structuring element (a kernel) B is simply a 
combination of two operations: an erosion of A by B, followed by a dilation 

Filter size Specify the size of the filter 
window W in X, Y and Z (for 
3D images) direction. See 
also Equation 13 and 
Equation 14.

Options Process each slice 
independently – check this 
check box if you want to 
process slices independently. 
this option only works for 
2.5D images.

Destination

New image – if selected, indicates that the result image appears in a new image window.

Replace image – if selected, indicates that the result image replaces the current active image. 

Process

Whole image

If selected, indicates that the algorithm should be applied to the whole image.

VOI region(s)

If selected, indicates that the algorithm should be applied only to selected VOI(s).

OK Performs the dilation on the selected image based on your choices in this 
dialog box.

Cancel Disregards changes you made in this dialog box and closes the dialog box.

Help Displays online help for the algorithm.

Figure 18.  Morphological Filter dialog box 
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of the result by B. See also Figure 19. 

Opening generally smooths the contour of an image, breaks narrow strips 
and eliminates thin protrusions. The equation for the opening is as follows:

EQUATION 16

APPLYING THE OPENING

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological >Open.

3 In the Open dialog box that appears, 

• Specify the number of erosions (from 1 to 20);

• Specify the number of dilations (from 1 to 20);

• Select the structural element or kernel;

• Specify the destination of the result image; 

Figure 19.  Illustration of opening (a) the original image A, (b) the 
erosion of image A by kernel B, (c) the dilation of result of (b) by the 
same kernel B, (d) image A after opening
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• And also specify whether you want apply the opening to the whole 
image or only for selected VOIs. For the dialog box options refer to 
Figure 20.

4 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the 
specified frame. See also Figure 21.

 

Number of 
erosions

Indicates the number of 
erosions to be performed.

Number of 
dilations

Indicates the number of 
dilations to be performed.

Kernel selection Use this list box to select the 
structuring element that will 
be used for erosion.

Circle diameter 
(mm)

This option is available only if 
you choose the User Sized 
Circle option in the Kernel 
Selection box. 

Enter a value for the circle 
diameter, here. 

Process image in 2.5D TBD.

Destination

New image – if selected, indicates that the result image appears in a new image window.

Replace image – if selected, indicates that the result image replaces the current active image. 

Process

Whole image

If selected, indicates that the algorithm should be applied to the whole image.

VOI region(s)

If selected, indicates that the algorithm should be applied only to selected VOI(s).

OK Performs the dilation on the selected image based on your choices in this 
dialog box.

Cancel Disregards changes you made in this dialog box and closes the dialog box.

Help Displays online help for the algorithm.

Figure 20.  Open dialog box 
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Particle analysis
This method combines several morphological operations to produce the 
information on the particle composition for the binary images. 

1 It performs a number of openings and closings with the user defined 
structural element. This allows to separate the foreground elements 
from the background.

2 Then, it applies to the result skeletonize following by pruning. 

3 To separate slightly overlapping particles, the method then uses 
watershed segmentation, which is as follows: 

• In the binary image, the black pixels are replaced with grey pixels of 
an intensity proportional to their distance from a white pixel (i.e. 
black pixels close to the edge are light grey, those closer to the 
middle are nearer black);

• This forms the Euclidian distance map (EDM) for the image; 

• From this, it calculates the centres of the objects or the ultimate 
eroded points (UEPs), i.e. points that are equidistant from the 
edges. These points are then dilated until the meet another black 
pixel, then a watershed line is drawn. See also “Ultimate erode” on 
page 556.

4 The result statistics appears in the Output MIPAV window. See also 
Figure 22.

(a) (b)

Figure 21.  The original image (a) and the result image after the opening 
that includes 19 erosions followed by 19 dilations applied with the “3x3 
-4 connected” kernel
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(a) (b)

((

(c) (d)

(e) (f)

Figure 22.  Particle Analysis: (a) – an original binary image. The 
following steps were performed: (b) erosion; (c) dilation; (d) 
skeletonize; (e) prune; (f) watershed; (g) – the result image; (h) – 
particle statistics as it appears in the Output window
MIPAV User’s Guide, Volume 2, Algorithms 544

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Morphology
IMAGE TYPES

Particle analysis can be applied only to binary images. 

APPLYING PARTICLE ANALYSIS

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological >Particle analysis.

3 In the Particle Analysis New dialog box that appears, 

(g)

(h)

Figure 22.  Particle Analysis: (a) – an original binary image. The 
following steps were performed: (b) erosion; (c) dilation; (d) 
skeletonize; (e) prune; (f) watershed; (g) – the result image; (h) – 
particle statistics as it appears in the Output window (continued)
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• Specify the number of openings (from 1 to 20);

• For opening(s), also specify the structural element or kernel;

• Specify the number of closings (from 1 to 20);

• For closing(s), also specify the structural element or kernel;

• Specify the destination of the result image; 

• And also specify whether you want apply the opening to the whole 
image or only for selected VOIs. For the dialog box options refer to 
Figure 23.

4 Check the Show Intermediate Result Frames box, to view intermediate 
images.

5 Press OK to run the algorithm.

When the algorithm finishes running, the particle statistics appears in the 
Output window and the result image appears in the specified frame. See 
also Figure 22.

 

Number of open Indicates the number of 
openings to be performed.

Kernel selection Use this list box to select the 
structuring element that will 
be used for opening.

Number of close Indicates the number of 
closings to be performed.

Kernel selection Use this list box to select the 
structuring element that will 
be used for closing.

Circle diameter 
(mm) for 
openings and 
closings

This option is available only if 
you choose the User Sized 
Circle option in the Kernel 
Selection box. 

Enter a value for the kernel 
diameter, here. 

Destination

New image – if selected, indicates that the result image appears in a new image window.

Replace image – if selected, indicates that the result image replaces the current active image. 

Process

Figure 23.  Particle Analysis New dialog box 
MIPAV User’s Guide, Volume 2, Algorithms 546

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Morphology
Skeletonize
Skeletonize operation skeletonizes the image by means of a lookup table, 
which is used to repeatedly remove pixels from the edges of objects in a 
binary image, reducing them to single pixel wide skeletons. The method is 
based on a thinning algorithm by Zhang and Suen. 

The lookup table shown below has an entry for each of the 256 possible 3x3 
neighborhood configurations. An entry of ‘1’ signifies to delete the indicated 
pixel on the first pass, ‘2’ means to delete the indicated pixel on the second 
pass, and ‘3’ indicates to delete the pixel on either pass.

Whole image

If selected, indicates that the erosion should be applied to the whole image.

VOI region(s)

If selected, indicates that the erosion should be applied only to selected VOI(s).

Show 
Intermediate 
Result Frames

Check to view intermediate images.

OK Performs the dilation on the selected image based on your choices in this 
dialog box.

Cancel Disregards changes you made in this dialog box and closes the dialog box.

Help Displays online help for the algorithm.

Figure 23.  Particle Analysis New dialog box  (continued)

The lookup table

       0, 0, 0, 1, 0, 0, 1, 3, 0, 0, 3, 1, 1, 0, 1, 3, 0, 0, 0, 0, 0, 0, 0, 0, 2, 0, 2, 0, 3, 0, 3, 3, 0, 0, 0, 0,

       0, 0, 0, 0, 3, 0, 0, 0, 0, 0, 0, 0, 2, 0, 0, 0, 0, 0, 0, 0, 2, 0, 0, 0, 3, 0, 2, 2, 0, 0, 0, 0, 0, 0, 0, 0,

       0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 2, 0, 0, 0, 0, 0, 0, 0, 2, 0, 0, 0,

       2, 0, 0, 0, 3, 0, 0, 0, 0, 0, 0, 0, 3, 0, 0, 0, 3, 0, 2, 0, 0, 1, 3, 1, 0, 0, 1, 3, 0, 0, 0, 0, 0, 0, 0, 1,

       0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1, 3, 1, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 2, 0, 0, 0,

       0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 2, 3, 1, 3, 0, 0, 1, 3, 0, 0, 0, 0, 0, 0, 0, 1, 0, 0, 0, 0, 0, 0, 0, 0,

       0, 0, 0, 0, 0, 0, 0, 0, 2, 3, 0, 1, 0, 0, 0, 1, 0, 0, 0, 0, 0, 0, 0, 0, 3, 3, 0, 1, 0, 0, 0, 0, 2, 2, 0, 0,

     2, 0, 0, 0
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APPLYING THE ALGORITHM

To apply the algorithm, 

1 Open an image of interest.

2 Call Algorithms>Morphological >Skeletonize.

3 In the Skeletonize dialog box that appears, 

• Specify the number of pixels to remove (prune);

• Specify the destination frame for the result image;

• And also specify whether you want apply the skeletonizing to the 
whole image or only for selected VOIs. 

4 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the 
specified frame. See also Figure 24.

Skeletonize 3D pot field
The Skeletonize 3D Pot Field algorithm uses an iterative approach that 
simultaneously performs a hierarchical shape decomposition and a 
corresponding set of multi-resolution skeletons. A skeleton of a model is 
extracted from the components of its decomposition, therefore it causes 
both processes and the qualities of their results being interdependent. In 
particular, if the quality of the extracted skeleton does not meed some user 
specified criteria, then the model is decomposed into finer components and 

(a) (b)

Figure 24.  Skeletonize operation:  (a) the original image, (b) the result after applying the 
operation with the parameters shown in the dialog box
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a new skeleton is extracted from these components. The process of 
simultaneous shape decomposition and skeletonizing iterates until the 
quality of the skeleton becomes satisfactory. 

For an input image, the algorithm computes a family of increasingly 
detailed curve-skeletons. The algorithm is based upon computing a repul-
sive force field over a discretization of the 3D object (voxelized representa-
tion) and using topological characteristics of the resulting vector field, such 
as critical points and critical curves, to extract the curve-skeleton. 

The algorithm performs the following steps:

1 It identifies the boundary voxels of the 3D object as the source of the 
repulsive force field. 

2 It computes the repulsive force function at each object voxel and 
produces a 3D vector field results.

3 The algorithm detects the critical points of the 3D vector field and 
connects them using path-lines by integrating over the vector-field. This 
step produces the core skeleton.

4 Then, it computes the divergence of the vector field at each voxel. Points 
with low divergence values are selected as new seeds for new skeleton 
segments. Varying the divergence threshold (given as a percentage, i.e., 
the top 20%) creates the Level 1 hierarchy after the core skeleton.

5 Finally, the algorithmcomputes the curvature at every boundary voxel 
and selects  new seed points based on a user-supplied curvature 
threshold, given again as a percentage of the highest curvature value in 
the dataset (i.e. top 30%). This adds another level of hierarchy to the 
core and divergence skeletons, the Level 2 skeleton hierarchy. 
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ALGORITHM PARAMETERS

The key idea behind the potential field approach used in the algorithm is to 
generate a vector field inside the image by charging the image boundary. In 
order to generate that field, the algorithm uses a number of user defined 
parameters, such as electrical point charge or field strength, that should be 
specified in the Skeletonize 3 D dialog box, see Figure 27 on page 554.

Maximum value for outer pixel to be object

The algorithm places electrical point charges on the image boundary, 
considering each boundary voxel to be a point charge (a boundary voxel is 
determined as an image voxel which has a background neighbor). In order 
to differentiate the background voxels from image voxels, the Maximum 
value for outer pixel to be object parameter is added to the Skeletonize 
3D dialog box. This parameter allows a user to enter the max intensity value 
for image voxels.

Field strength and Distance of electrical charge from object 
boundary

The repulsive force at an interior object voxel due to a nearby point charge 
is defined as a force pushing the voxel away from the charge with a strength 
that is inverse proportional to the distance between the voxel and the 

(a) (b)

Figure 25.  (a) - the original image, (b) - the skeleton1

1. These images are borrowed from the Nicu D. Cornea web site <<http://www.caip.rutgers.edu/~cornea/Skeletonization>>/
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charge, raised at a certain power M which is called (in this algorithm) the 
field strength. The Field strength and Distance of electrical charge 
from object boundary parameters are defined by the user. The final 
repulsive force at each interior voxel is computed by summing the 
influences of all the point charges. The resulting vector field is also called a 
force field.

Note that a high field strength (M) will cause for a given inferior voxel the 
charges from the local or closer points to have a higher influence than from 
the more distant charges, therefore creating a vector field with sharper 
path-lines because it follows the local boundary topology more closely. A 
low value for the field strength parameter will produce a smoother vector 
field, with more rounded corners, since the vector direction at a particular 
point is now influenced by more point charges. 

Setting the Distance of electrical charge from object boundary 
parameter to a very low value is not a good idea. E.g., imagine the example 
of a very long cylinder. Setting the threshold smaller than half the length of 
the cylinder will cause the field not to flow towards the one attracting point 
in the middle of the cylinder. Instead, it will go towards the center, creating 
a critical point at each slice along the cylinder.

Fractions of divergence points to use

The divergence of a vector field in a given region of space is a scalar quantity 
that characterizes the rate of flow leaving that region. A negative divergence 
value at a point indicates that the flow is moving mainly towards the given 
point. The algorithm takes the points with low divergence values, which 
indicate a low spot or “sink,” from these points the new seed points are cho-
sen using the threshold on the divergence value parameter. The threshold is 
given as a fraction of the lowest divergence value in the entire vector field. 
From each of these new seed points, a new field-line is generated which will 
connect to the core skeleton. 

By varying the Fractions of divergence points to use parameter the 
user can vary the number of seed points selected, and therefore the number 
of new skeleton segments, generating an entire hierarchy of skeletons that is 
called the Level 1 skeleton. Different values can be chosen based upon the 
application of the curve-skeleton.
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APPLYING SKELETONIZE 3D

Preliminary steps. In order to apply the Skeletonize 3D Pot Field algo-
rithm to an image, the image must have a sufficient number of planes com-
posed solely of background pixels at the X, Y, and Z boundaries of the image. 
For the default value of zero for the distance of the electrical charges from 
the object boundary, there must be background planes at x = 0, x = xDim -1, 

y = 0, y = yDim - 1, z = 0, and z = zDim - 1. Call the Utilities > Add Image Mar-

gins, Utilities> Pad, or Utilities >Insert Slice menus to run a tool that will 
help you to create a version of the image with the sufficient number of pad-
ding pixels.

To apply the algorithm, 

1 Open an image of interest, and then call Algorithms>Morphological 
>Skeletonize 3D Pot. The Skeletonize 3D dialog box appears.

2 Fill out the dialog box. For the dialog box options, refer to Figure 27 on 
page 554. 

3 Press OK to run the algorithm.

Be patient, because the first algorithm run may take a considerable time. 
When the algorithm finishes running, the result skeleton image appears. 
See Figure 26 on page 552.

(a) (b)

(c)

Figure 26.  (a): the original image; (b): the Pad dialog box; (c): the padded image; (d): the 
Output window shows the skeletonize 3D statistics; (d): the Level 1 skeleton obtained using the 
default parameter values, see Figure 27 on page 554.
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ALGORITHM NOTES

• Most of of the image calculation time (e.g. 98%) will spend in the 
potential field calculation. Therefore, the first time you run the 
algorithm, select the Save the Vector Fields radio button to save the x, 
y, and z vector fields and the Level 1 skeleton. On the following runs, 
select the Load the Vector Field from Files radio button to load the x, y, 
and z vector fields and the Level 1 skeleton. See also Figure 27 on 
page 554.

• Then, you can also vary the Fractions of divergence points to use 
parameter to change the extensiveness of the skeleton generated. As 
more divergence points are used in the Level 2 skeleton calculation, the 
skeleton will become more extensive. 

• The algorithm must be run on a single solid object. Use the following 
options to make sure that your image is a single solid object:

• A user selected threshold (defined using the Maximum value 
for outer pixel to be object parameter) helps separate the 
background voxels from the object voxels. 

• The default selected checkbox for slice by slice hole filling is used 
to convert the image into a single solid object.

• After identifying all image objects in 3D, all but the largest object 
are deleted.

(d)
(e)

Figure 26.  (a): the original image; (b): the Pad dialog box; (c): the padded image; (d): the 
Output window shows the skeletonize 3D statistics; (d): the Level 1 skeleton obtained using the 
default parameter values, see Figure 27 on page 554.
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Parameters

Maximum value 
for outer pixel to 
be object

For the image voxels, it 
determines the max intensity 
value that a voxel can have in 
order to be the image voxel 
(not the boundary voxel). The 
default value is set to 1.0

Slice by slice 
hole filling

If checked, performs the slice 
by slice hole filling for the 
image. Refer to “Algorithm 
notes” on page 553.

Distance of 
electrical charge 
from object 
boundary

This parameter determines 
the distance between the infe-
rior voxel and the boundary 
point charge. If a boundary 
point is at a distance greater 
than the entered value, then 
it is ignored, i.e., it does not   
influence the field at this 
point. See also “Algorithm 
parameters” on page 550.

Field strength A vector field inside the image is determined by the strength of the repulsive 
force from the nearby charge that affects each interior voxel. The repulsive 
field strength is inverse proportional to the distance between the voxel and the 
charge (determined by the Distance of electrical charge from object 
boundary parameter) raised at a certain power M which is determined by the 
Field Strength parameter.The final repulsive force at each interior voxel is 
computed by summing the influences of all the point charges. 

If the Field Strength parameter value is set high, it will create a vector field 
with sharper path-lines, because it follows the local boundary topology more 
closely. A low value for the Field Strength parameter will produce a smoother 
vector field, with more rounded corners. See also “Algorithm parameters” on 
page 550.

Fractions of 
divergence 
points to use

By varying this parameter you can vary a number of seed points and 
correspondingly the number of new skeleton segments, generating an entire 
hierarchy of skeletons for the Level 1 skeleton. See also “Algorithm 
parameters” on page 550.

Save the vector 
fields to files

The first time this program is run on an image select this option to save the x, 
y, and z vector fields and the Level 1 skeleton. 

Load the vector 
field from files

On the following runs select the Load the vector field from files option to load 
the previously saved x, y, and z vector fields and the Level 1 skeleton. 

Figure 27.  Skeletonize 3D dialog box 
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SKELETONIZE 3D POT REFERENCES

This is a port of the C++ code for pfSkel: Potential Field Based 3D Skeleton Extraction 
written by Nicu D. Cornea, Electrical and Computer Engineering Department, Rutgers, 
The State University of New Jersey, Piscataway, New Jersey, 08854, 
cornea@caip.rutgers.edu. The code was downloaded from http://www.caip.rutgers.edu/
~cornea/Skeletonization/

Chuang J-H, Tsai C, Ko M-C (2000) Skeletonization of Three-Dimensional Object Using 
Generalized Potential Field. IEEE Trans. Pattern Analysis and Machine Intelligence, 
22(11):1241-1251

Nicu D. Cornea, Deborah Silver, and Patrick Min, Curve-Skeleton Applications,  
Proceedings IEEE Visualization, 2005, pp. 95-102. 

Nicu D. Cornea, Deborah Silver, Xiaosong Yuan, and Raman Balasubramanian, Computing 
Hierarchical Curve-Skeletons of 3D Objects, Springer-Verlag, The Visual Computer, 
Vol. 21,  No. 11, October, 2005, pp. 945-955. 

On following runs vary the Fractions of divergence points to use parameter to change the 
extensiveness of the skeleton generated. As  more divergence points are used in the Level 2 skeleton 
calculation, the skeleton will become more extensive.

Open XVF file

Load Loads the file.

Remove Removes the file from loading.

Don’t save the 
vector field

If checked, doesn’t allow to save the vector field.

Output all 
skeleton points

If checked, sends to the output all skeleton points.

Output only 
segmented end 
points

If checked, sends to the output only segmented end points.

OK Performs the skeletonizind on the selected image based on your choices in this 
dialog box.

Cancel Disregards changes you made in this dialog box and closes the dialog box.

Help Displays online help for the algorithm.

Figure 27.  Skeletonize 3D dialog box  (continued)
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Ultimate erode
The algorithm generates the ultimate eroded points (UEPs) of an Euclidian 
distance map for an image.  These UEPs represent the centers of particles 
that would be separated by segmentation. The UEP's gray value is equal to 
the radius of the virtual inscribed circle of the corresponding particle. 

IMAGE TYPES

It requires a binary image (boolean type) as an input.

APPLYING ULTIMATE ERODE

To apply the algorithm, 

1 Call Algorithms>Morphological >Ultimate Erode.

2 In the Ultimate Erode dialog box that appears, 

• Use the Remove objects closer than text box to specify the min 
distance between the objects;

• Specify the image frame for the result image;

• And also specify whether you want apply Ultimate Erode to the 
whole image or only for selected VOIs. 

3 Press OK to run the algorithm.

When the algorithm finishes running, the result image appears in the 
specified frame. 

See also Figure 28.
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(a) (b)

Figure 28.  Ultimate Erode – (a) the original binary image, (b) the result after applying the 
operation with the parameters shown in the dialog box
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Muscle Segmentation

The Muscle Segmentation plug-in from MIPAV is a semi automatic tool for 
segmenting different muscles and muscles and fat in Computed 
Tomography (CT) images of the thigh and abdomen. Of particular interest 
is the lean to fat tissue ratio in the quadriceps, hamstrings, and Sartorius, 
while the remaining muscles are grouped together into the abductors. The 
Muscle Segmentation plug-in uses CT images of the thigh as this imaging 
modality provides the best muscle discrimination compared to other 
imaging options. The method incorporates several algorithms that 
interactively identify the Fasceal border and borders of the muscles of 
interest it also uses additional methodologies for preventing the same 
tissue being identified as belonging to two different muscles.

Background
The method uses the LiveWire tool for delineating boundaries in images. 
Specifically, the LiveWire tool allows users to identify a starting location on 
the boundary and then it automatically determines the minimum cost path 
between that starting point and current location of the cursor. The user 
accepts the LiveWire path by identifying an ending point. LiveWire then 
inserts additional points along the minimum cost path so that a piece wise 
linear approximation closely matches the minimum cost path. Once the 
boundary of a muscle is identified, the enclosed region is set to a uniform 
background color. This re-coloring prevents the LiveWire tool from 
including pixels already identified as belonging to one muscle while the user 
identifies additional adjacent muscles. 

OUTLINE OF THE METHOD 

The method is composed of a sequential set of different processing steps. A 
block diagram is shown in Figure 1. The input image is a CT image 
containing both the left and right thighs and also a phantom containing 
water and some other material with known density values. The output is a 
pseudo colored image, where different muscles and tissues correspond to 
different colors or shades of gray. The final image is referred to the 
segmented or label image. See Figure 9.
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The steps are as follows:

1 “Water calibration”  using a phantom

2 “Skin identification” 

3 Applying “LiveWire”  and “Level set tool”  to outline the VOIs on the 
image

4 “Fasceal detection and subcutaneous fat detection” 

5 “Threshold classification and quantification” 

6 “Tissue Classification” 

7 “Bone and bone marrow identification” 

8 “Quadriceps identification, classification, and quantification” 

9 “Hamstring and Sartorius identification, classification, and 
quantification” 

10 Showing results, refer to “Results” on page 567

WATER PHANTOM

The water phantom is included in the image so that an offset can be 
computed for each image in the study set, and it is used to correctly adjust 
the Hounsfield Units (HU) within the image. Figure 2 shows a typical image 
processed by the plug-in.

Figure 1.  A block diagram of the thigh muscle segmentation method
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WATER CALIBRATION

The processing begins with the user identifying a rectangular region-of-
interest (ROI) completely inside the water phantom and free of any partial 
volume pixels. The median value of this region is then determined and used 
as the Hounsfield value of water. Since this value should be zero in CT, the 
median value is subtracted from all image pixels. 

LIVEWIRE

The LiveWire tool implemented in the plug-in is used as an interactive 
boundary finding optimization. A local cost function involving a weighted 
combination of gradient magnitude, gradient direction, and zero-crossings 
of the Laplacian operator is computed for each pixel in the image. As the 
user moves from a selected starting point the result is a pixel-to-pixel path 
with a total minimum cost from the anchor point to the current cursor 
location as shown in Figure 3.

LiveWire produces a weighted directed graph across the image of the costs 
is generated via a minimum-spanning tree of the graph computed using 
Dijkstra's graph searching algorithm. Figure 3-b shows a graph of intensity 
values across the green line drawn in Figure 3-a to evaluate the accuracy of 

Figure 2.  A typical image processed by the Muscle Segmentation plug-
in. Visible in the figure are the right and left thigh as well as the water 
phantom, which appears as the gray rectangular block at the bottom 
center of the image
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LiveWire. Figure 3-c and Figure 3-d provide an analysis of the location of 
the LiveWire VOI.

HOW LIVEWIRE WORKS

First, the grayscale image is modeled as a rectangular matrix whose pixel 
values are integers ranging from 0 to 255 (if the image is a color one, it 
might be converted to a grayscale one and use the algorithm the same way, 
although it's better to maximize the costs on each color channel). Each pixel 
of the matrix is a vertex of the graph and has edges going to the 8 pixels 
around it, as up, down, left, right, upper-right, upper-left, down-right, 
down-left. The edge costs are defined based on a cost function.

(a) (b)

(c) (d)

Figure 3.   LiveWire produced VOI (Orange), LevelSet produced VOI 
(Red); Plot of intensity values along green line; Magnitude of gradient 
along the green line perpendicular to thigh edge; Intensity values when 
all the pixels inside the livewire detected VOI have been set to 1
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Since a minimum cost path should correspond to an image component 
boundary, pixels (or more accurately, links between neighboring pixels) 
that exhibit strong edge features should have low local costs and vice-versa. 
Thus, local component costs are created from the various edge features:

• Laplacian Zero-Crossing fZ

• Gradient Magnitude fG

• Gradient Direction fD

The local costs are computed as a weighted sum of these components. 
Letting l(p,q) represent the local cost on the directed link from pixel p to a 
neighboring pixel q, the local cost function is where each w is the weight of 

the corresponding feature function1. 

EQUATION 1

The Laplacian zero-crossing is a binary edge feature used for edge 
localization. Convolution of an image with a Laplacian kernel approximates 
the 2-nd partial derivative of the image. The Laplacian image zero-crossing 
corresponds to points of maximal (or minimal) gradient magnitude. Thus, 
Laplacian zero-crossings represent “good” edge properties and should, 

Figure 4.  Each pixel of the matrix is a vertex of the graph and has edges 
going to the 8 pixels around it, as up, down, left, right, upper-right, 
upper-left, down-right, down-left

1.  Empirically, weights of wZ = 0.43, wG = 0.43, and wD = 0.14 seem to work well in a wide range of 
images.

l p q,( ) wZ fz× q( ) wG fG q( )× wD fD× p q,( )+ +=
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therefore, have a low local cost. If IL(q) is the Laplacian of an image I at 

pixel q, then

EQUATION 2

fZ(q)=o, if IL(q)=o and fZ(q)=1, if IL(q)!=0

However, application of a discrete Laplacian kernel to a digital image 
produces very few zero-valued pixels. Rather, a zero-crossing is represented 
by two neighboring pixels that change from positive to negative. Of the two 
pixels, the one closest to zero is used to represent the zero-crossing. The 
resulting feature cost contains single-pixel wide cost where “canyons” used 
for boundary localization.

Since the Laplacian zero-crossing creates a binary feature, fZ(q) does not 

distinguish between strong, high gradient edges and weak, low gradient 
edges. However, GRADIENT MAGNITUDE provides a direct correlation 
between edge strength and local cost. If IX and IY represent the partials of 

an image I in the X and Y directions respectively, then the gradient 
magnitude G is approximated with

EQUATION 3

G=(Ix
2+Iy

2)

The gradient is scaled and inverted, so high gradients produce low costs and 
vice-versa. Thus, the gradient component function is

EQUATION 4

fG=(max(G)-g)/max(G)=1-(G/max(G))

giving an inverse linear ramp function. 

Finally, gradient magnitude costs are scaled by Euclidean distance. To keep 
the resulting maximum gradient at unity, fG(q) is scaled by 1 if q is a 

diagonal neighbor to p and by  if q is a horizontal or vertical 
neighbor. The gradient direction adds a smoothness constraint to the 
boundary by associating a high cost for sharp changes in boundary 
direction. 

The gradient direction is the unit vector defined by Ix and Iy. Letting D(p) be 

the unit vector perpendicular (rotated 90 degrees clockwise) to the gradient 

1 2( )⁄
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direction at point p (i.e., for D(p) = (IY(p), -IX(p))), the formulation of the 

gradient direction feature cost is

EQUATION 5

where

EQUATION 6

and

EQUATION 7

are vector dot products and

EQUATION 8

L(p,q)=q–p, if D(p)*(q–p) >=0

L(p,q)=p–q, if D(p)*(q–p),< 0

is the bidirectional link or edge vector between pixels p and q. Links are 
either horizontal, vertical, or diagonal (relative to the position of q in p's 
neighborhood) and point such that the dot product of D(p) and L(p, q) is 
positive. The neighborhood link direction associates a high cost to an edge 
or link between two pixels that have similar gradient directions but are 
perpendicular, or near perpendicular, to the link between them. Therefore, 
the direction feature cost is low when the gradient directions of the two 
pixels are similar to each other and to the link between them.

LEVEL SET TOOL

The level set tool is a less interactive tool that can be used for automatic 
segmentation of thigh components. Distance from the given contour to the 
nearest boundary is computed for all pixels from the user-specified point to 
all points along a path of pixels with close intensity. The level set extraction 
described for lattices of 3D data produces a collection of unique vertices, 

fD p q,( ) 2
3π
------ dp p q,( ) )( )acos dq p q,( ) )( )acos+( )⋅=

dp p q,( ) D p( ) L p q,( )⋅=

dq p q,( ) L p q,( ) D q( )⋅=
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edges, and triangles. These components can be stored as a triangle mesh 
that is represented by a vertex-edge-triangle data structure. The data 
structure supports various topological and geometrical queries about the 
mesh. Refer to the LevelSet tool in the MIPAV User Guide Volume 2.

Muscle Segmentation steps

SKIN IDENTIFICATION

The skin in the thigh image is identified by interactively isolating the outer 
boundary using the LiveWire algorithm. Typically, the user needs to identify 
only three or four points spaced around each thigh and the LiveWire 
algorithm inserts additional points on the boundary. Once a closed region is 
identified, a mask image is computed where all pixels inside and on the 
boundary are assigned a value of one and all other pixels are assigned a 
value of zero. This mask image is then eroded four times using a binary 
mathematical morphology operator creating another mask image. All pixels 
outside the eroded mask image are set to background value equals to –1024 
HU.

TISSUE CLASSIFICATION

Threshold classification of CT images allows identification of muscle and fat 
tissue within the thigh. Potential partial voluming effects are decreased by 
adopting a schema that is more exclusive than the Hounsfield scale assigns 
to normalized CT intensities:

-190 < fat pixel < -30

 0 < muscle pixel < 100

-30 < volume pixel < 0
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FASCEAL DETECTION AND SUBCUTANEOUS FAT 
DETECTION

The fasceal is a very thin, broken boundary that appears very faint and 
surrounds the muscles of the thigh. Because of these characteristics, we 
chose to interactively enter points on this border, which are then joined as a 
closed polyline. The fasceal boundary separates the subcutaneous fat from 
the muscles, interstitial fat, and other tissues within the muscles. Therefore, 
all the non-background pixels outside the fasceal boundary are by definition 
classified as subcutaneous fat pixels.

BONE AND BONE MARROW IDENTIFICATION

Bone is easily identified in CT images because corresponding pixels are 
significantly more intense (dense) than those found in the soft tissue. 
Therefore, we used a threshold value of 176 HU and above to classify the 
bone pixels. Once these pixels are identified, they are set to background 
value. The bone marrow pixels are then identified as those pixels above the 
background value that are inside the bone pixels. All bone marrow pixels 
are also set to the background value.

THRESHOLD CLASSIFICATION AND 
QUANTIFICATION

The result of all the processing described above is an image containing only 
muscle, interstitial fat, partial volume pixels, and perhaps blood vessels. 
Furthermore, the quantification results include the total thigh area and 
average Hounsfield value for both muscle and fat. These values are 
determined by applying a threshold operation, where 

• fat pixels are between -190 and -30 HU inclusive, 

• muscle pixels are between 0 and 100 HU inclusive, 

• and the partial volume muscle and fat pixel correspond to all the values 
between these ranges. 
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We refer to the resulting image as the total thigh label image.

QUADRICEPS IDENTIFICATION, 
CLASSIFICATION, AND QUANTIFICATION

The quadriceps is interactively identified with the LiveWire tool using an 
image that results by blending the total thigh label image with the gray scale 
image. Once a closed VOI for each quadriceps has been identified, they are 
classified using the same threshold regions for fat, muscle, and partial 
volume pixels as described above. The left and right quadriceps are 
quantified separately and the results of each are saved in an output file. An 
image with unique values for muscle, fat, and partial volume is also saved 
and is called the quadriceps label image. 

HAMSTRING AND SARTORIUS 
IDENTIFICATION, CLASSIFICATION, AND 
QUANTIFICATION

Identifying the hamstrings follows the processing steps for identifying the 
quadriceps, except that the pixels corresponding to the quadriceps are first 
set to the background value. This prevents the LiveWire tool from including 
pixels from a region that has already been identified as a different muscle. 
This insures there will be no overlapping pixels belonging to two different 
muscles. The Sartorius is similarly determined in an image with both the 
quadriceps and hamstrings set to background. Finally, the pixels 
corresponding to the other muscles (the abductors) are identified as those 
pixels not already classified.

RESULTS

Figure 5 shows the segmented resulting from the Muscle Segmentation 
plug-in for the image shown in Figure 2. The different muscles are shown in 
different colors, as well as the subcutaneous and interstitial fat.
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The fat/ lean statistics for chosen thigh (or abdomen) objects (e.g. the left 
and right thighs including all bones and muscles) appears in the Output 
window and also can be saved as a PDF file.

IMAGE TYPES

Any CT image of the thighs that can currently be opened by MIPAV.

Figure 5.  Segmented image that results from the Muscle Segmentation 
plug-in. The different muscles and fat regions are assigned different 
values

Figure 6.  Plug-in output
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Applying the Muscle Segmentation method
To run the plug-in do the following:

1 Start MIPAV.

2 Install the plug-in (in order to learn how to do that, refer to the MIPAV 
User’s Guide Volume 1, “Developing Plug-in programs”).

3 Open an image of interest (a thigh or abdomen image).

4 Call Plugin > General >Muscle Segmentation to run the plug-in.

5 The plug-in window appears with the image open in the window. See 
Figure 7.
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VOI SELECTION

The left pane in Figure 7 contains three tabs that represent different 
processing steps. When a tab is pressed the display shows its particular VOI 
set. Each VOI shown in the right pane has an associated checked button in 
the left pane. When any given button is pressed, that VOI is available for 
editing. In Figure 7, all muscle VOIs are filled. Based on these VOIs the 
plug-in generates a zero intensity image mask, which is then used by the 
LiveWire tool to guarantee non-overlapping segments. 

Figure 7.  The plug-in user interface with, first, the Thigh tab selected, 
then the Bone tab selected, and finally, the Muscle tab selected. All VOIs 
are available for editing
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THIGH

To draw a VOI around a chosen thigh,

1 Open the Thigh tab. See Figure 7.

2 To select a thigh, press an object button (Left Thigh or Right Thigh).

3 The VOI tab appears prompting you to draw a VOI around the chosen 
thigh, e.g. the left thigh.

4 Draw a VOI and then press OK

5 The VOI appears on the thigh.

To calculate VOI statistics and fat/lean ratio for the whole thigh, press 
Calculate. Refer to Analysis section to learn how to show results in the 
Output window.

BONE

To highlight a bone sample, press the Bone Sample button. The VOI 
appears selecting the bone sample on the phantom. 

To delineate a VOI around a chosen thigh bone,

1 Open the Bone tab. See Figure 7.

2 To select a bone, press an object button (Left Bone or Right Bone),

3 The VOI tab appears prompting you to draw a VOI around the chosen 
bone, e.g. the left bone.

4 Draw a VOI and then press OK

5 The VOI appears around the bone.

Repeat the same steps for a bone marrow. Refer to Analysis section to learn 
how to show results in the Output window.
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MUSCLES

To highlight a muscle sample, press the Water Sample button. The VOI 
appears selecting the water sample on the phantom.

To delineate VOIs around chosen muscles,

1 Open the Muscle tab. See Figure 7.

2 To select a muscle, press a corresponding object button e.g. Left Fascia 
or Right Fascia.

3 The VOI tab appears prompting you to draw a VOI around the chosen 
muscle, e.g. the let bone.

4 Draw a VOI and then press OK

5 The VOI appears around the chosen muscle.

6 Repeat the same steps for another muscle. 

After you've done with VOIs, click Calculate. This opens the Analysis tab. 
Refer to Analysis section to learn how to show results in the Output window.

SAVING SEGMENTATION VOIS

Each VOI is saved automatically in a separate XML file with publicly 
available schema. These files are saved in the image directory and can be 
viewed and modified outside of this tool and MIPAV. The file name for a 
VOI file looks like Right Object Name.xml or. Left Object Name.xml. See 
Figure 8.
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ANALYSIS

Use the Analysis tab options to select the thigh muscles using VOIs and 
output VOI statistics for selected VOIs. The statistics include the calculated 
Fat Area, Lean Area and Total Area for a chosen muscle. The Analysis tab is 
hidden when you run the plug-in, It appears only when you press the 
Calculate button in the Thigh, Bone or Muscle tab. See Figure 9.

To run the fat/lean ratio calculation for the thigh

1 Select the thigh object(s) (a thigh, a bone, a bone marrow, a muscle) by 
pressing the corresponding button. Note that you can select as many 
objects as you wish.

2 If you want to calculate a fat/ lean statistics for a single object (e.g. the 
left hamstring), select that object and then press Output. The fat/ lean 
statistics for the left hamstring appears in the output window.

3 If you want to calculate a fat/ lean statistics for a set of objects (e.g. the 
left thigh, left hamstring, and left quads), select these objects by 
pressing the corresponding buttons, and then press Output. The fat/ 
lean statistics appears in the output window.

Figure 8.   The catalogue where segmentation VOIs are stored
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4 If you want to calculate a fat/ lean statistics for all objects (e.g. the left 
and right thighs including all bones and muscles) press Output All. This 
will output a whole fat/lean statistics for both thighs in the Output 
window. See Figure 9.

5 To save the fat/ lean statistic as a PDF file, press Save. The PDF file 
appears in the same catalogue where VOIs for a selected image are 
stored.

TO SHOW/HIDE LUT:

To show the LUT, press Show LUT button, the image appears highlighted by 
LUT. To hide the LUT, press Hide LUT. See Figure 10.

Figure 9.  Fat/Lean ratio for the thigh and thigh muscles in the Output 
window. Use the scroll bar to view the whole statistics
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Figure 10.  Show and Hide LUT options
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Abdomen Segmentation

Given abdomen image slice or multiple slices, this algorithm automatically 
delineates contours that define the abdomen exterior border and 
subcutaneous fat area. The visceral cavity and abdomen muscles are then 
semi-automatically determined.

Background
The Abdomen Segmentation algorithm starts with the extraction of the 
abdomen perimeter. Then, it calculates the geometric center of the 
extracted abdomen area.

The algorithm draws radial lines from the detected abdomen perimeter to 
the geometric center at fixed angular increments (1–3 degree). Along each 
line, the it analyzes the intensity profile to determine the most inner point of 
the subcutaneous fat layer. 

The algorithm repeats this calculation for each radial line, and then, forms 
an inner contour of the subcutaneous fat area by connecting adjacent 
points. Inner points are identified as the points whose intensity is greater 
than an upper threshold value (16 HU which is corresponding to the muscle 
density) and less than lower threshold value of -300 HU.

Further segmentation of the visceral and subcutaneous fat pixels is done 
using the threshold values with the:

EQUATION 1

-190 < fat pixel < -30

 0 < muscle pixel < 100

-30 < partial volume pixel < 0

The visceral fat is, then, defined as the intraperitoneal area with pixel 
intensities that match fat intensities.

The subcutaneous area is defined as the fat layer between the inner body 
skin coat and the outer margin of the body wall musculature. The subcuta-
neous fat length (SFL) is defined as the distance between two points – one 
on the inner subcutaneous fat contour and another one on the outer abdom-
inal contour – and also intersecting the radial line. 
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Once the outer and the inner contours have been extracted and smoothed 
(see Smoothing contours), the algorithm creates the following three masks:

• Body fat mask, which is the area inside the outer contour;

• Visceral cavity mask, which is the area inside the inner contour;

• Subcutaneous fat mask, which is the area between the inner and 
outer contours.

For a given image slice, the total body fat, visceral fat and subcutaneous fat 
are calculated as the numbers of pixels that meet the following criteria:

• Enclosed by these masks;

Figure 1.  Determination of subcutaneous fat layer: (a) - radii drawn 
from the outer contour towards the body center at a fixed angle, (b) - a 
line VOI covering the radius, (c) - an intensity profile along the line VOI
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• Have intensities within the fat range (see Equation 1).

For 3D images, fat volumes are calculated using the slice thickness and the 
values obtained for each slice.

SMOOTHING CONTOURS

The smoothing method is based on the assumption that the subcutaneous 
fat length values (SFL) should change smoothly between the adjacent radii. 
However, larger discontinuities are permitted depending on the separation 
of the radii that defines (SFL) values. The method calculates the 
discontinuous contour using the mathematical morphological closing 
operation. 

For more information about the mathematical morphological operations 
used in MIPAV refer to the User Guide Volume 2, Algorithms available on 
the MIPAV web site {http://mipav.cit.nih.gov/documentation.php}.

REFERENCES

Automated quantification of body fat distribution on volumetric computed tomography, 
BINSHENG ZHAO, COLVILLE Jane, KALAIGIAN John, CURRAN Sean, LI JIANG, 
KIJEWSKI Peter, SCHWARTZ Lawrence H., Journal of Computer Assist. Tomogr., Volume 
30, # 5, Sept/Oct 2006, pp. 777–783.

Figure 2.   Segmentation: (a) - an abdomen (green) and subcutaneous 
area (blue) and (b) - a visceral cavity (yellow)
MIPAV User’s Guide, Volume 2, Algorithms 578

12/5/08 

http://mipav.cit.nih.gov/documentation.php


M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Abdomen Segmentation
Applying the method for the abdomen segmentation
When the plug-in is running, the left dialog box pane contains three tabs – 
Abdomen, Tissue, and Muscles that represent the subsequent segmentation 
steps. By default, the dialog opens the Abdomen tab. 

When any plug-in tab is open, it shows its particular VOI set. VOIs are color 
coded. Each VOI shown in the right pane has an associated checked button 
in the left pane, see Figure 3.

Pressing any given button opens the VOI tab and makes the associated VOI 
available for editing. Based on delineated VOIs the plug-in generates a zero 
intensity image mask, which is then used by the LiveWire tool to guarantee 
non-overlapping segments. 

ABDOMEN TAB

By default, the Abdomen tab can display three VOIs delineated on the 
abdomen, subcutaneous area, and water phantom, see Figure 3. There are 
three options offered by the plug-in:

Figure 3.   The Abdomen tab shows abdomen VOIs
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• If the predefined VOIs are stored in the default directory, the plug-in 
loads them automatically;

• You can delineate and/or modify VOIs manually using the VOI 
drawing tools provided by the MIPAV VOI toolbar;

• Or you can run the MIPAV algorithm to delineate abdomen, 
subcutaneous area VOIs on the image. See also Section Abdomen 
automatic segmentation algorithm.

For example, to draw the Abdomen VOI,

1 Open the image of interest.

2 Use the MIPAV Image slice slider to select the slice of interest. Or, you 
can select the slice of interest later from inside the plug-in. Note that 
you can use the MIPAV main menu and toolbars from inside the plug-
in.

3 Run the plug-in.

4 In the Abdomen tab, click on the Abdomen button. The VOI tab 
appears.

5 In the VOI tab, use the MIPAV VOI toolbar icons to delineate a single 
closed VOI around the abdomen. Make sure that MIPAV VOI toolbar is 
available.

6 To propagate the VOI to other slices, use the Propagate icons.

7 Click OK to save the VOI.

8 Repeat these steps for other tabs, tissues, and muscles. See Figure 9.

MODIFYING VOIS

If you load predefined VOIs, you can, then, modify them. For example, to 
modify the Abdomen VOI:

1 Open the Abdomen tab. See Figure 3.

2 Press the Abdomen button.

3 The VOI tab appears prompting you to modify the VOI.

4 Modify the VOI, and then press OK.
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5 The message window appears “Abdomen.xml exists. Overwrite?” Press 
OK if you want to overwrite the existing VOI. Press No if you want to 
save the VOI under a different name.

6 The updated abdomen VOI appears on the image. Repeat these steps for 
subcutaneous area.

To delete the VOI, select it and then click the Cut icon on the MIPAV 
toolbar. This will delete the VOI.

To run the fat/lean calculation for the Abdomen and Subcutaneous area, 
press Calculate. In the Analysis tab that appears, select the Abdomen and 
Subcutaneous areas by pressing the corresponding buttons. Press Output. 
The results appear in the Output window.

Figure 4.  Calculating the fat/lean ratio for the abdomen and 
subcutaneous area
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TISSUE TAB

In the Tissue tab, you can select and/or edit a VOI drawn around the 
visceral cavity, bone and water phantom. See Figure 6.

To select/edit a VOI around the visceral cavity,

1 Open the Tissue tab.

2 If VOIs do not appear automatically, press the Visceral cavity button; 
this will visualize the corresponding VOI on the image. 

3 The VOI tab appears prompting you to modify the VOI.

4 Modify the VOI if needed, and then press OK.

5 The updated VOI appears on the image.

6 Repeat these steps for the bone and water phantoms if needed.

If you choose to modify the visceral cavity VOI (or any other VOI), the 
message window appears “[VOI name].xml exists. Overwrite?” Press OK if 
you want to overwrite the existing VOI. Press No if you want to save the 
modified VOI under a different name.

Figure 5.  The Tissue tab
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MUSCLES TAB

To highlight an abdomen muscle, press the corresponding button. The VOI 
appears highlighting the selected muscle on the image.

To modify VOIs around chosen muscles,

1 Open the Muscles tab. 

2 Press the corresponding muscle button, for example, Left Psoas or Right 
Lat. Obliques.

3 The VOI tab appears prompting you to modify the VOI around the 
chosen muscle.

4 Modify the VOI and then press OK.

5 Repeat the same steps for other muscles. 

If you choose to modify the muscle VOI and pressed OK, the message 
window appears “[muscle name].xml exists. Overwrite?” Press OK if you 
want to overwrite the existing VOI. Press No if you want to save the 
modified VOI under a different name.

If you press the Aortic Calcium button, this will visualize the VOI contours 
drawn around the aortic calcinations.

Figure 6.  The Muscles tab
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After you've done with VOIs, click Calculate. This opens the Analysis tab. In 
the Analysis tab select the areas of interest by pressing the corresponding 
buttons. Press Output. The results appear in the Output window.

VOI TAB

The VOI tab appears when you click on the object button, for example, 
Abdomen button, in the Abdomen, Tissue and Muscles tab. In the VOI tab, 
you can select, highlight, modify and save the VOI. See also VOI tab 
warnings.

The following options are available:

VOI Selection box – this is the information box that tells you which VOI 
is about to being modified as well as lets you know the maximum number of 
curves allowed to be drawn for a particular VOI.

OK – if you choose to modify the VOI and pressed OK, the message window 
appears “[VOI name].xml exists. Overwrite?” Press OK if you want to 
overwrite the existing VOI. Press No if you want to save the modified VOI 
under a different name. Note that if the result VOI is not correct the plug-in 
will issue a warning message, refer to Section “VOI tab warnings” .

Hide all – hides all VOIs.

Show all – displays all VOIs.

Cancel – closes the VOI tab and returns you to the previous visited tab.

Reset – resets the image.

Hide except [current VOI name] – hides all VOIs except the current 
VOI.

To delete a chosen VOI use the Cut icon from the MIPAV toolbar.

VOI TAB WARNINGS

“Too many curves” warning. If you mistakenly draw too many curves for a 
chosen VOI, the plug-in will detect it and notify you when you press OK in 
order to save the VOI. It will not allow you to save the VOI until you delete 
the unwanted VOI(s).
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“Any curves made must be closed” warning. Any VOI drawn on the 
abdomen must be a closed curve. You are not allowed to draw an open line 
or point VOI, while using the plug-in. If the open VOI was drawn, the 
warning appears, informing you that the VOI is not closed.

“MIPAV created VOI” warning. When you open the VOI created by MIPAV, 

Figure 7.  The “Too many curves” warning

Figure 8.   The “Any curves made must be closed “warning
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the VOI tab displays the warning notifying you that this VOI was created 
automatically and needs revision. See also Section MIPAV automatic 
segmentation and Figure 9.

WHERE VOIS ARE STORED

By default, the plug-in looks for VOIs in the NIA_Seg subdirectory of the 
directory where the image dataset is stored. For example, if your abdomen 
image of interest is located in the C:\MIPAV\images\AbdomenImages 
catalogue, you should copy the image segmentation VOIs to the 
C:\MIPAV\images\AbdomenImages\NIA_Seg catalogue. In that case the 
plug-in will load those VOIs automatically. See Figure 10.

When created and/or modified, each VOI is saved in a separate XML file 
with the publicly available schema. The VOI files can be viewed and 
modified outside of this tool and MIPAV. The file name for a VOI file looks 
like Object Name.xml or Right/Left Object Name.xml. 

Figure 9.   The “MIPAV created VOI” warning
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CHANGING COLOR FOR VOIS

The default colors for VOIs are shown in Figure 15. You can change the color 
for a selected VOI(s) using the options offered by the Pick VOI Color dialog 
box, see Figure 11. Note that these changes will be in effect only for a current 
plug-in session. When you restart the plug-in all VOIs will return to the 
default colors.

To change the color for a chosen VOI, click on the colored square next to the 
VOI's button. This will open the Pick VOI Color dialog box. In the dialog 
box, select the color from the color palette and press OK. The new color will 
apply to the chosen VOI. See Figure 11.

Figure 10.   The plug-in looks for VOIs in the subdirectory of the 
directory where the image dataset is stored
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MANUAL SEGMENTATION

You can draw VOIs from inside the plug-in using the MIPAV VOI toolbar 
options. For example, to draw the Abdomen VOI,

1 Open an abdomen image of interest.

2 Run the plug-in. See Figure 12.

3 Select the Abdomen tab.

Figure 11.  VOI color selection
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4 Use the MIPAV Image slice slider to select the slice of interest.

5 In the Abdomen tab, click on the Abdomen button. The VOI tab 
appears.

6 In the VOI tab, use the MIPAV VOI toolbar icons to delineate a single 
closed VOI around the abdomen. Make sure that MIPAV VOI toolbar is 
available.

7 To propagate the VOI to adjacent slices, use the Propagate icons.

8 Click OK to save the VOI.

9 Repeat these steps for other VOIs. See also Section “VOI tab warnings” .

Figure 12.  Manual segmentation steps
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MIPAV AUTOMATIC SEGMENTATION

By default, the plug-in calculates the fat/lean ratio for the abdomen based 
on the predefined VOIs. The VOIs for a chosen image dataset should be 
stored as XML files the NIA_Seg subdirectory of the directory where the 
image file is stored. In that case the plug-in finds VOIs and loads them 
automatically. Refer to Section “Where VOIs are stored” on page 586.

In case if some VOIs are missed, the plug-in will display the warning 
window and ask you if you want MIPAV to create these VOIs automatically. 
If you hit Yes, MIPAV will run the automatic segmentation procedure and 
delineate missed VOIs on the image. For more information about the 
abdomen segmentation algorithm, refer to Section “Background” on 
page 576.

To distinguish VOIs created by MIPAV from the VOIs that come with the 
image, the plug-in color codes the VOI buttons as they appear in the tabs. 
For VOI created by MIPAV, the corresponding buttons appear in red color.

For example, Figure 13 shows the Abdomen tab with the Abdomen and 

Figure 13.  The MIPAV automatic segmentation of the abdomen and subcutaneous area
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Subcutaneous area buttons appear in red, which means that the VOIs for 
these areas were created by MIPAV. See also Figure 9.

USING THE MIPAV VOI STATISTICS 
GENERATOR

To view the VOI statistics you can use the Analysis tab options (refer to 
Section Analysis tab) or run the VOI Statistics Generator from the main 
MIPAV menu. 

To run the VOI Statistics Generator, call VOI > Statistics Generator menu. 
The Calculate Statistics on VOI groups dialog box appears. 

Figure 14.  Using the MIPAV Statistics Generator
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In the dialog box,

1 In the VOI Selection tab, select all VOI groups;

2 Then, navigate to the Statistic Options tab. Scroll down to the end of list, 
and then check the following statistics calculation options: Total Area, 
Fat Area, Lean Area, Mean Total HU, Mean Fat HU, Mean Lean HU. 
Note that these options only appear if you run the Muscle Segmentation 
plug-in;

3 Select the By Contour and Slice option;

4 Press Calculate;

5 The fat/ lean statistics for selected abdomen objects appears in the 
Logging tab. See Figure 14.

ANALYSIS TAB

The Analysis tab appears when you click the Calculate button. It has 12 
buttons; each button possesses the name corresponding to the particular 
VOI. 

To run the fat/lean ratio calculation

1 Select the abdomen object(s) (the abdomen, subcutaneous area, visceral 
cavity, etc.) by pressing the corresponding button. Note that you can 
select as many objects as you wish.

2 If you want to run the calculation for a single object, for example for the 
visceral cavity, select that object, and then press Output. The statistics 
appears in the output window.

3 If you want to calculate a fat/ lean statistics for a set of abdomen objects, 
select these objects by pressing the corresponding buttons, and then 
press Output. The fat/ lean statistics appears in the output window.

4 If you want to calculate a fat/ lean statistics for all objects, press Output 
All. This will output a whole fat/lean statistics in the Output window. 
See Figure 15.
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SAVING THE STATISTICS AS A PDF FILE

To save the output statistics as a PDF file, press the Save button. The data 
from the Output window will be saved as a PDF file in the folder where VOI 
files are stored. The information window will appear displaying the path to 
the PDF file and the file name. See also Figure 16 and Figure 17.

Figure 15.  The Analysis tab
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Figure 16.  Saving the statistics as a PDF file

Figure 17.  The MIPAV Segmentation PDF file
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TO SHOW AND HIDE LUT

To show the LUT, press Show LUT button, the image appears highlighted by 
LUT. To hide the LUT, press Hide LUT. See Figure 18.

Figure 18.  Showing the LUT for selected VOIs
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Optimized Automatic Registration 3D

The Optimized Automatic Image Registration method in MIPAV deter-
mines a transformation that minimizes a cost function, which represents 
the quality of alignment between two images. The standard registration 
problem of computing a transformation that best aligns a reference image 
to a target image is formulated as a mathematical optimization problem 
of determining the global minimum of a cost function. The method evalu-
ates the cost function at several different image resolutions, starting with 
the lowest resolution. Each step of increasing resolution utilizes the previ-
ously determined optimal transformation as a starting point and further 
refines its values. This method usually works well with the images of the 
same modality.

Background
The main approach for determining an optimal transformation is to calcu-
late a cost function, determine how it changes as individual transformation 
parameters are varied, and find the parameters that minimize the value of 
the cost function. For instance, Figure 1 shows a plot of a sample cost func-
tion for a selection of transformation parameters; in each plot, a single 
parameter is varied while all other are kept constant.

Another fundamental step in this registration method is to resample and 
interpolate the reference and target images at several different resolutions 
(starting with a coarse voxel size and gradually increasing the resolution), 
while searching for the min cost function. 

An advantage of this multi-resolution approach is that the initial optimization 
considerably reduces computational cost, since the number of sample points is 
substantially less. In addition, the overall alignment is easier to find at a 
coarse resolution.  Improved accuracy of the transformation paremeters is 
achieved using the highest resolution image that has not been subsampled.

The resampling process may influence the computed value of the cost func-
tion; therefore, several different interpolation methods are incorporated 
with this technique. These methods are discussed in more detail later 
in“Resampling Interpolation” on page 605.
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Taking into account the resampling and interpolation criteria, the Opti-
mized Automatic Registration method begins searching for an optimum 
transformation using the Powell method at a coarse resolution. Once a 
transformation has been determined that minimizes the cost function, the 
transformation is  further refined by progressively increasing the resolution.

The algorithm offers various resampling interpolation methods combined 
with the Correlation Ratio, Least Squares, Normalized Cross Correlation, 
and Normalized Mutual Information as a cost function. 

See also “Cost functions used in MIPAV algorithms” .

IMAGE TYPES 

You can apply Optimized Automatic Registration method to color, grayscale 
and black-and-white  2D and 3D images. 

Figure 1.  The plots of the Correlation Ratio cost function versus some of 
the individual parameter values. In each plot (A, B, C, and D), a single 
parameter is varied while the other are kept constant
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OUTLINE OF THE METHOD

Pre-optimization steps

1 The minimum resolution of the reference and target images is 
determined. For more information, refer to “Blurring” on page 599.

2 Both images are resampled and interpolated to create high resolution  
isotropic voxels. The following interpolation methods are available: 
trilinear (a default), B-spline 3-rd and 4-th order, 4, 5, 6 Lagrangian, 
and Windowed sinc. Refer to “Interpolation methods used in MIPAV” 
on page 74.

3 The center of mass (COM) for both images is then computed and one 
translation step is performed to align the COM. Refer to “Calculating the 
center of mass” on page 600.

Optimization steps 

As a part of the transformation optimization process the images are 
subsampled by 8, 4, and  2 times.

4 levelEight optimization. Both images are subsampled and interpo-
lated, so that each image is 8 times smaller. The parameters of the trans-
formation are then systematically varied, where the cost function is 
evaluated for each setting. The parameters corresponding to the small-
est value(s) of the cost function are then used as the initial transforma-
tion for the next level in the optimization.

5 levelFour optimization. The images are subsampled and 
interpolated,  so that each image is 4 times smaller. And the 
transformation corresponding to the smallest value(s) of the cost 
function are determined and used as the initial transformation for the 
next level in the optimization.

6 levelTwo optimization. Similar processing as the previous two levels 
except the images are, first, subsampled and interpolated, so that each 
image is 2 times smaller.

7 levelOne optimization – 1mm resolution images are used in this step 
and the transformation is generalized to include 12 degrees of freedom.
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Post optimization

8 Using the same interpolation methods as described in Step 2 and the 
optimal transformation determined above, the method transforms the 
reference image into the same coordinate system of the target image.

Following Sections 1.2-1.5 describe in detail the algorithms and methods 
used to perform Steps 1-8 of the optimization routine.

PRE OPTIMIZATION

Blurring

The registration algorithm first, determines the minimum resolution for 
each dimension of the reference and target images. The reference image is 
blurred to the resolution of the target image if one of the resolutions in a 
dimension of the target image is 50% or larger than the corresponding reso-
lution in the reference image. Likewise, the target image is blurred to the 
resolution of the reference image if one of the resolutions in a dimension of 
the reference image is 50% or larger than the corresponding resolution in 
the target image. It is possible (but not likely) that both the reference and 
target images will be blurred.  

See also “Resampling Interpolation” on page 605.

Resampling

Once this isotropic 1mm resolution images have been obtained, the  
subsampled versions are also created. The sub-sampling algorithm then 
simply keeps every n-th point (that is, 2, 4 or 8) on the lattice in each 
direction. Therefore, the new volume contains 1/n3 as many points as the 
original.

Resampling can be performed for x, y, and z axes for 3D images, or for only x 
and y for 2D images.
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CALCULATING THE CENTER OF MASS

To calculate the center of mass (COM), the method uses the right hand 
convention in 3D coordinate systems (X, Y, Z). Thus, in the image space, the 
left hand corner of the image is set to (0,0,0). The x axis goes left to right, y 
axis goes top to bottom and z axis goes into the screen. 

1 To calculate the COM, we, first, define the characteristics function of an 
object in an image to be as described in Equation 1:

EQUATION 1

2 Then, an area of an image can be calculated as 

EQUATION 2

3 And the center of mass, denoted by (xCOM, yCOM)1 is given by the 1-st 

moments of the object: 

Figure 2.  Calculating the center of mass (COM)

1. For 2D images. For 3D images, add the z coordinate also.
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EQUATION 3

PROCESS

The process used in this method performs the following:

• Calculates the COM for both images as described above in 
“Calculating the center of mass” on page 600; 

• Aligns the COM of both images, which is an initial transfomation 
that involves only translation;

• For each resampled image (which is 8, 4, 2, and 1 times), determines 
the transform that minimizes the cost function.

levelEight optimization

levelEight optimization is primarily concerned with determining the rota-
tional transformation that will lead to the globally optimal transformation, 
which corresponds to the global minimum of the cost function. levelEight 
optimization uses the lowest resolution images and coarse rotation angles 
evaluated at relatively large step sizes.

Optimization

This Optimized Automatic Registration method is based on the empirical 
observation that finding the correct orientation, or rotation, is the most dif-
ficult task in image registration, since the three rotation parameters are 
highly coupled and most of the erroneous registrations that have been 
examined have happened primarily due to an incorrect orientation. There-
fore, the search concentrates on the rotational part of the transformation. 

Specifically, the reference image is oriented, interpolated, and the cost func-
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tion evaluated for coarse rotations angles (-30, -30, -30), (-30, -30, -15), …, 
(-30, -30, 30), where the values represent the amount of rotation in degrees 
about the x, y, and z axes respectively. Since there are three rotation angles 
and each angle can contain five different values, there are 125 possible angle 
configurations. 

For each angle configuration, a 4-DOF local optimization is also performed 
to find the optimal translation and (global) scale. By default, the initial 
values are set to

• 0 for translation

• 1 for scale. 

The best 20% of the cost values and/or the corresponding angle configura-
tions (candidate local minima) are stored in a vector of minima that is used 
as a starting point for a further optimization, which uses a smaller step size 
over a narrower range of angles. Refer to Figure 3.

For each parameter setting corresponding to the top 20% of the cost func-
tion minima, the algorithm performs rotations over the fine grid (which is 
by default 15 degrees with 6 degrees step) and evaluates the cost function. 

The method now finds all angle configurations that have the corresponding 
cost function values lower than their neighbors from the vector of candidate 
local minima.

For each of these sets of parameters a 7-DOF optimization is then per-
formed, storing the results of the transformation and costs before and after 
optimization in a vector of minima. See also “Degrees of freedom” on 
page 606.

Since the relative costs of each candidate solution may change at higher res-
olutions, where structures become more sharply defined, the top 20% of the 
cost function minima points are considered for the next higher resolution 
(4) stage, rather than just a single best solution.

By default, the algorithm uses Trilinear interpolation to transform images 
to this new orientation.
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levelFour optimization

The levelFour optimization step uses the interpolated images subsampled 
by 4 to determine the transformation that minimizes the cost function 
starting with the transformations determined in levelEight. 

The optimization determines a 7-DOF transformation that corresponds to 
the minimum value of the cost function. This transformation is then per-
turbed and the cost function is computed for these new settings. The pertur-
bations correspond to six-degrees for each rotation parameter and a global 
scaling factor of 0.8, 0.9, 1.1, and 1.2. A type of transformation (translation 
and/or global scale) is specified by a user. It includes the following transfor-
mations: Affine-12 (a default), Rigid-6, Global Rescale-7, and Specific Res-
cale-9. Here, numbers indicate degree of freedom (DOF).

Figure 3.  levelEight optimization
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A vector of parameters and top 20% of the min cost function values are con-
sidered for the next step, which involves images subsampled by 2.

See also “Cost functions used in MIPAV algorithms” on page 63 and “Degrees 
of freedom” on page 606

levelTwo

In levelTwo, the method uses the images subsampled and interpolated by 2.   
The cost function is evaluated using the transformation parameters 
corresponding to the top 20% minima obtained from the levelFour. It finds 
the best minimum, and then optimizes it with the 7-DOF and then 9-DOF 
transformation. The method then returns the best minimum after 
optimization.

Note: if a user has limited the degrees of freedom to six, as for the rigid 
transformation, there will only be one optimization run, with six degrees of 
freedom.

levelOne

This step uses the unsubsampled interpolated images and computes the 
value of the cost function for each parameter setting determined in the 
previous levelTwo optimization.   The parameters corresponding to the 
minimum value of the cost function with this resolution are then further 
optimized for transformations with 7-, 9-, and 12- DOF, unless a rigid (6-
DOF) transformation is desired.

What is saved

The method stores 

• The set of parameters or vector at which the minimum was reached; 

• The value of the cost function at that minimum; 

• And the matrix, which was the true input into the cost function and 
represents the transformation that gives the minimum cost of 
differences between the images.
MIPAV User’s Guide, Volume 2, Algorithms 604

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Optimized Automatic Registration 3D
Additional registration parameters

To better align the images, one can also include into calculation additional 
registration parameters, such as weighting coefficients and advanced 
parameters used for calculating the min cost function. For more informa-
tion, refer to “Applying the AlgorithmOAR 3D” on page 607.

RESAMPLING INTERPOLATION

The Optimized Automatic Registration method resampes images using an 
interpolation scheme, where anisotropic voxels in the Z direction are resam-
pled into isotropic 1mm cubic voxels. New voxel values are computed using 
a weighted combination of existing voxel values within a defined neighbor-
hood of the new voxel location. The interpolation methods are available in 
this implementation of the registration technique, include Trilinear, B-
spline 3-rd order, B-spline 4-th order, Cubic Lagrangian, Quintic 
Lagrangian, Heptic Lagrangian, and Windowed sinc. 

For mor information about the interpolation methods used in Optimized 
Automatic Registration, refer to  “Interpolation methods used in MIPAV” .

Cost Functions
A similarity or cost function measures the similarity between two images. 
During the Optimized Automatic  Registration the adjusted image V is 
transformed using the transformation functions described above. And the 

similarity S(U;Vt) between the reference image U and transformed image Vt 
is then calculated. The Optimized Automatic Registration method searches 
for the transformation that gives the smallest value of the cost func-
tion, which we assume is the transformation that also gives the best align-
ment. 

The cost functions which are implemented in this method include: 

• Correlation ratio, refer to “Cost functions used in MIPAV 
algorithms”  , “Correlation ratio” on page 64

• Least Squares, refer to “Cost functions used in MIPAV algorithms” , 
“Least Squares” on page 66 
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• Normalized Cross Correlation, see  “Cost functions used in MIPAV 
algorithms” , “Normalized cross correlation” on page 67

• Normalized Mutual Information, see “Cost functions used in MIPAV 
algorithms” , “Normalized mutual information” on page 70.

POWELL ALGORITHM

The Optimized Automatic Registration method uses the Powell algorithm to 
find the global minimum of the chosen cost function. For more information 
about the Powell algorithm, refer to the following link http://math.fuller-
ton.edu/mathews/n2003/PowellMethodMod.html

DEGREES OF FREEDOM

The number of independent pieces of information that go into the estimate 
of a parameter is called the degrees of freedom (DOF).

For more information refer to “Cost functions used in MIPAV algorithms” , 
“Degrees of freedom” on page 71.
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Applying the AlgorithmOAR 3D

To run the algorithm, complete the following steps:

1 Open an input and reference image.

2 Call Algorithms > Registration > Optimized Automatic Registration.

3 The Optimized Automatic Registration dialog box appears.

In the dialog box,

• Select the image in the Register to box;

• Complete the rest of the dialog box options. Refer to “” on page 608.

4 Press OK.

The algorithm begins to run and the Registering Images window appears 
with the status. When the algorithm stops running the registered image 
appears in a new image frame. Refer to Figure 4.

Recommendation: First, use the default algorithm settings. And then, after 

completing the first registration run, modify them depending on the result you 

receive.
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Applying the Constrained AlgorithmOAR 3D

To run the algorithm, complete the following steps:

1 Open an input and reference image.

2 Call Algorithms > Registration > Constrained Optimized Automatic 
Registration.

3 The Optimized Automatic Registration dialog box appears.

In the dialog box,

• Select the image in the Register to box;

• Complete the rest of the dialog box options. See Figure 5;

• Press the Advanced Settngs button, and then complete the Advanced 
OAR settings dialog box. In this dialog box, you can limit the number 
of iterations and also the translation’s range. Refer to Figure 6 on 
page 612 for the dialog box options.

4 Press OK.

The algorithm begins to run and the Registering Images window appears 
with the status. When the algorithm stops running the registered image 
appears in a new image frame.

A B C
Figure 4.  The input image (A), reference image (B) and result image (C). Registration was 
performed using the default algorithm settings.
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Recommendation: For the Constrained Optimized Automatic Registration 

algorithm, first, use the default algorithm settings. And then, after completing 

the first registration run, modify them (including Advanced settings) 

depending on the result you receive.

OPTIMIZED AUTOMATIC REGISTRATION 
DIALOG BOX OPTIONS
 

Input options

Register Select the reference image 
from the list. The list 
alphabetically displays all 
opened images.

Degrees of 
freedom

Specifies the spatial model 
used to restrict the type of 
linear transformation being 
applied during registration. 
Select one of the following: 
rigid-6, global rescale-7, 
specific rescale-9, and 
affine-12.

Interpolation Specifies the type of 
interpolation the algorithm 
will use when resampling. 
The list includes: 

• Trilinear 
• B-spline 3-rd order 
• B-spline 4-th order
• Cubic Lagrangian
• Quintic Lagrangian
• Heptic Lagrangian
• Windowed sinc

See also “Interpolation 
methods used in MIPAV” .

Figure 5.  The Optimized Automatic Registration dialog box options
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Cost function Specify a cost function which will be used to evaluate registration. The list 
includes: Least squares, Correlation ratio, Normalized cross correlation, Normal-
ized mutual information. For more information, refer to “Cost functions used in 
MIPAV algorithms” on page 63.

Use the max of 
the min 
resolutions of 
the two 
datasets when 
resampling

If this option is chosen in the dialog box, the method uses the maximum 
resolution of the two datasets. It throws away some image information, but 
works faster. If this option is not chosen the algorithms uses the minimum of the 
resolutions when resampling the images. This can be slower, but does not lose 
the information. 

Initiate 
registration 
process by 
applying Least 
Squares

This option provides a way to register images using the corresponding landmark 
points or VOIs placed in both images (you must put at least 4 landmarks). Note 
that this option works only for images that require rigid transformation e.g., 
rotation and/or translation, but it does not work on images that require scaling.

Rotations

Use this option if there is a need to make manual adjustments to registration. 

Apply same 
rotations to all 
dimensions

If checked, applies rotation that you specified to all dimensions. Otherwise, you 
should select the axis – X, Y, or Z – to which rotation should apply.

Coarse angle increment and Fine angle increment

options can be used for two pass registration. The first pass would apply a coarse-level rotation to 
quickly arrive at an approximate registration, and then the second pass would apply a finer-level 
rotation to continue from the point where the first pass registration has finished. By default, the coarse 
angle increment is set to 15 degrees and fine angle increment is set to 6 degrees. 

Weighted 
Images

This gives weights for certain areas within the reference or transformed image. 
These areas can be specified using VOIs or reference files. Here, higher 
weights mean a greater impact in that area on the registration.

No weight  – the weighting factor is not used for registration.

Register area delineated by VOIs only uses VOI to register a selected area.

Weight 
registration

If this option is checked, the following parameters become available:

Choose ref. weight opens the dialog where you can select the reference file 
which contains the information about the weighting factor.

Choose input weight opens the dialog where you can select the input file 
which contains the information about the weighting factor.

Output options

Figure 5.  The Optimized Automatic Registration dialog box options (continued)
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Display 
transformed 
image

allows to view the transformed image in a separate window. By default, this 
option is active.

Interpolation: – select the calculation method, which is used to produce the output image from 
the array of transformation matrices and input image. You can choose among 
Trilinear, B-spline 3-rd order, B-spline 4-th order, Cubic lagrangian, Quintic 
lagrangian, Heptic lagrangian, or Windowed sinc. The default choice is trilinear.

Advanced options

Pressing the Advanced button opens the Advanced OAR Settings dialog box where you can specify the 
additional parameters which will be used to calculate the min cost function. Parameters are as follows:

Multiple of 
tolerance to 
bracket the 
minimum

Recommended values are 
10–60.

Number of 
iterations

Recommended are 1–5 
iterations.

Number of 
minima from 
Level 8 to test 
at Level 4

By default this is the best 
20%, but you can enter your 
own number here.

Subsample image for speed subsamples the image.

Skip multilevel search. Assume images are close to alignment.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes it.

Help Displays online help for this dialog box.

Figure 5.  The Optimized Automatic Registration dialog box options (continued)
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ADVANCED OAR SETTINGS FOR 
CONSTRAINED OPTIMIZED AUTOMATIC 
REGISTRATION 3D
 

Pressing the Advanced button in the main Optimized Automatic Image Registration 3D dialog box (see 
Figure 5) opens the Advanced OAR Settings dialog box where you can specify the additional parameters 
and (or) constrains (if Constrained AlgorithmOAR 3D was called) that will be used to calculate the min 
cost function. Parameters are as follows:

Multiple of tolerance to bracket the minimum Recommended values are 10–60.

Number of 
iterations

Recommended are 1–5 iterations.

Number of minima from Level 8 to test at 
Level 4

By default, this is set to 5, but you can enter 
your own number here.

Translation 
search range

These options allow the user to specify the limits in translations range (in the X, 
Y, and Z dimensions), and therefore, constrain the optimized registration. The 
options appear active only if the Constrained Optimized Registration algorithm is 
called.

Limit 
translation 
range

If checked, this option limits 
the range of translations by 
the values (in mm) specified 
by the user.

Apply same 
translation to 
all dimensions

If checked, this option 
applies same limits to all 
dimensions.

Limits on X 
translation (or 
all translations)

Specify the translation limit 
in X direction, or in all direc-
tions if the Apply same 
translation to all dimen-
sions option is checked.

Limits on Y 
translation

Specify the translation limit 
in Y direction.

Limits on Z 
translation

Specify the translation limit in Z direction.

Subsample image for speed subsamples the image.

Skip multilevel search. Assume images are close to alignment.

Figure 6.  The Advanced Optimized Automatic Registration (constrained) dialog box options
MIPAV User’s Guide, Volume 2, Algorithms 612

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Optimized Automatic Registration 3D
Initialize 
registration 
process by 
aligning COG’s

If checked, the algorithm, first, aligns centers of gravity (COG) or centers of 
mass (COM) of both images, and then proceed with registration. See also 
“Calculating the center of mass” on page 600.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes it.

Help Displays online help for this dialog box.

Figure 6.  The Advanced Optimized Automatic Registration (constrained) dialog box options 
(continued)
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Registration: Patient Position (DICOM)

The method uses the image origin coordinates and image orientations to 
align DICOM images based on a patient position.

Background
The algorithm extracts the images orientation and origins coordinates from 
the DICOM files headers, and then uses them to register the images. In the 
DICOM protocol, image orientation specifies the direction cosines of the 
first row and the first column with respect to the patient and is defined as 
two unit vectors in the patient coordinate system. These were used as an 
initial estimate of the orientation parameters, with the initial translation 
parameters set to zero.

The DICOM standard uses a patient-centric LPS, coordinate system, where 
+x = left, +y = posterior, and +z = superior. The direction cosines between 
the rows and columns of the image and these axes are stored in the Image 
Orientation Patient field. For axial images with no rotation, this field will be 
1/0/0/0/1/0. This may be read as "image rows increase from right to left, 
image columns increase from anterior to posterior". Most DICOM viewers 
follow the convention of plotting the data starting in the upper left corner of 
the view.

For axial brain images, this will place the left side of the brain on the right 
side of the view, and the posterior of the brain toward the bottom of the 
view. This point of view is sometimes referred to as "radiological".

Sagittal will have an Image Orientation Patient field of 0/1/0/0/0/-1, 
indicating that rows increase from anterior to posterior, and columns 
increase from superior to inferior. In this case, the posterior will be toward 
to the right and the inferior toward to the bottom.

Coronal images will have an Image Orientation Patient field of 1/0/0/0/0/-
1.
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OUTLINE OF THE METHOD

"The algorithm reads origins coordinates from file headers.

"Then, it extracts the images orientation from DICOM files.

"Based on the extracted information, the algorithm obtains the 
transformation matrix from orientation of ImageB to orientation of 
ImageA.

"Then, it creates an index arrays that stores the reordering of Image B data 
(i.e. origin, resolution, dimension) to the ordering of Image A.

"It creates a model image that is ImageB transformed to coordinates of 
ImageA

"For that image, the algorithm updated resolutions and dimensionality for 
ImageB so that they correspond to the new ordering.

"It pads or crops the model image so that its size corresponds to the size of 
ImageA.

"The algorithm finds the optimal transformation T:(x, y, z)->(x', y', z') 
(same for all time frames), which will map any voxel in ImageB to its 
corresponding voxel in ImageA. This transformation consists of three 
translations (Tx, Ty, Tz) and three rotations (Rx, Ry, Rz).

TBD. BEFORE AND AFTER GRAPHIC (WHAT HAPPENS WHEN 
ALGORITHM IS RUN)?

Figure 1.  Patient Position (DICOM) algorithm processing

IMAGE TYPES

TBD.

SPECIAL NOTES

TBD.
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REFERENCES

See the following references for more information about this algorithm:

TBD.

Applying the Patient Position (DICOM) algorithm
To run this algorithm, complete the following steps:

1 [tbd]

2 [tbd]

3 [tbd]
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Registration: Landmark—Least Squares

The Registration: Landmark—Least Squares algorithm provides a way 
for  registering an image to the reference image by using corresponding 
points placed in both images. This algorithm works on images requiring 
rotation and translation, but it does not work on images requiring scaling, 
because this is a rigid transformation based on two homologous landmark 
datasets.

Background
The algorithm relates the two corresponding point sets on the image to be 
registered and on the reference image using the following equation:

where

pA[i][j] = the point set of the reference image

pB[i][j] = the point set of the image to be registered

i = a value from 0 to the number of dimensions - 1 

j = a value from 0 to the number of user-placed corresponding points - 
1

R = a rotation matrix

T = a translation vector

No[i][j] = a noise vector

This algorithm calculates a least-squares solution of R and T, which is based 
on a singular value decomposition of a 2 x 2 matrix in 2D or a 3 x 3 matrix in 
3D. It, first, calculates the centroid p1[i] in the image to be registered: 

pA i[ ] j[ ] R p( B i[ ] j[ ] ) T No i[ ] j[ ]+ +=

p1 i[ ] 1
N
---- pB i[ ] j[ ]

j 0=

N 1–

∑⋅=
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It, then, calculates the centroid p2[i] in the reference image:

where N = the number of corresponding user points.

The algorithm, next, calculates the difference between the points and the 
centroid voxel in the image to be registered (q1[i][j]):

and then the difference between the points and centroid voxel in the 
reference image (q2[i][j]):

The algorithm then performs the following steps: 

• Calculates the 2 x 2 or 3 x 3 matrix:

• Performs the singular value decomposition of H. That is:

• Calculates the following:

• Calculates the determinant of X (refer to the following table). 

If the determinant is 1, the algorithm succeeded and the rotation 

matrix .

If the determinant is -1 and the images are 3D, then the singular values 
of matrix H must be examined. If one and only one of the three 
singular values is 0 and the two singular values are unequal, then the 
case is coplanar, but not colinear. It is made to work by simply 
changing the sign of the third column of the V matrix to form Vp and 

obtain .

• Calculates the translation vector:  

p2 i[ ] 1
N
---- pA i[ ] j[ ]

j 0=

N 1–

∑⋅=

q1 i[ ] j[ ] pB i[ ] j[ ] p1 i[ ]–=

q2 i[ ] j[ ] pA i[ ] j[ ] p2 i[ ]–=

H q1 q2 transpose( )=

Express H U Λ( ) V transpose( )=

X V U transpose( )=

R X=

R Vp Utranspose( )=

T i[ ] p2 i[ ] R p1 i[ ]( )–=
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• Sets the first dim elements of the last column of the transformation 
matrix to T. 

• Copies R into the upper left dim by dim elements of the transformation 
matrix.

• Sets the last row of the transformation matrix to 0,0,1 in the 2D case or 
to 0,0,0,1 in the 3D case. 

• A bilinear or trilinear transformation is used with the given 
transformation matrix to transform the target image into the resulting 
image (Figure 1). Refer to “Interpolation methods used in MIPAV” .

IMAGE TYPES

You can apply this algorithm to 2D and 3D grayscale and color images.

Table 64.1 A determinant of X  depending on the image type

Image 
type

If this is true . . . Then . . .

CommentsDeterminant Matrix H Success Failure

2D 
images

 1 X Rotation matrix
R = X

-1 Has no zero 
singular values

X Data too noisy

-1 Has one 
singular value

X Data is colinear

3D 
images

 1 X

-1 Has no zero 
singular values

X Data too noisy

-1 Has one zero 
singular value 
and the other 
two singular 
values are 
unequal

X This is made to 
work by changing 
the sign of the 
third column of 
the V matrix to 
form Vp and 
obtain 

-1 Has two equal 
singular values

X Colinear

R Vp Utranspose( )=
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SPECIAL NOTES

The following notes apply:

• Do not use this algorithm in cases where an image must be scaled.

• For 2D images, you must identify at least three noncollinear points.

• For 3D images, you must identify at least four noncollinear points.

REFERENCE

Refer to the following reference for more information:

“Least-Squares Fitting of Two 3-D Point Sets” by K.S. Arun, T.S. Huang, and S.D. Blostein, 
IEEE Transactions on Pattern Analysis and Machine Intelligence, Vol. PAMI-9, No. 5, 
September, 1987, 
pp. 698-700.

Figure 1.  Landmark—Least Squares processing

Both the reference image (A) and the image to be registered (B) have at least 
three noncollinear landmarks identified. Applying the Landmark—Least Squares 
algorithm produces the image shown in C. 
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Applying the Landmark—Least Squares Registration 
algorithm

To run this algorithm, complete the following steps:

1 Open two images: the target image and the reference image. When you 
apply this algorithm, MIPAV registers the target image to the selected 
reference image.

2 Perform, as an option, any other image processing, except scaling, on 
both images.

3 Place a minimum of three points in 2D images or four points in 3D 
images in the reference image. The points must not be colinear. 

Note: Three-dimensional (3D) images can handle cases that are coplanar but 
not colinear.

4 Place the corresponding points in the target image. Note that the dialog 
box shows the last image clicked on as the target image.

Tip: Make sure that you delineate the points on the target image in the same 
order as on the reference image. That is, point 1 on the reference image 
should correspond to point 1 on the target image, point 2 on the reference 
image should correspond to point 2 on the target image, etc.

5 Select Algorithms > Registration > Landmark - Least Squares. The Least 
Squares Registration dialog box (Figure 2) appears.

6 Select the name of the target image in the Register to box if it is not 
already present.

7 Click OK. 

The algorithm begins to run. A pop-up window appears with the status. 

When the algorithm finishes running, the pop-up window closes, and 
the registered image appears in the Transformed Image window.
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Register [name 
of source 
image] to 
[name of 
reference 
image]

Displays a set of possible 
reference images. 

This box registers the 
image to be registered to 
the selected reference 
image. 

OK Applies the algorithm 
according to the 
specifications in this dialog 
box.

Cancel Disregards any changes that you made and closes the dialog box.

Help Displays online help for this dialog box.

Figure 2.  Least Squares Registration dialog box 
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Registration: Landmark—TPSpline

The Landmark—TPSpline (Thin Plate Spline) algorithm allows you to align 
two or more images along a corresponding VOI that you delineate in all of 
the  images.

Background
When applied to 2D images, the Landmark—TPSplines algorithm uses a 2D 
interpolation scheme for arbitrarily spaced tabulated data (xi,yi,f(xi,yi)). 

These splines are the generalization of the natural cubic splines in 1D. The 
spline surface represents a thin metal sheet that is constrained not to move 
at the grid points. When applied to 3D images, the TPSplines algorithm 
operate on data of the form (xi,yi,zi,f(xi,yi,zi).

MIPAV uses the spline matching points sets to obtain spline interpolation 
coefficients, which it uses to transform all the xorg,yorg grid positions in 
the base image space to xne w, ynew grid positions in the match space. 
Then, at every xorg,yorg grid position in the base space, MIPAV checks to 
see if the corresponding xnew,ynew grid position in the match space is 
within the image bounds of the match image.

If xnew and ynew is within the match space bounds, then the data value at 
the xnew,ynew grid position in the match space is assigned to be the 
registered value at the xorg,yorg position in the base space. Since xnew, 
ynew is a floating point number and the data in the match image is only 
contained at integer grid points, interpolation must be used. 

For a 2D image, the data value at xnew,ynew in the match space is obtained 
by bilinear interpolation from its four nearest neighbors. For a 3D image, 
the data value at xnew,ynew in the match space is obtained by trilinear 
interpolation from its eight nearest neighbors. If the xnew, ynew is outside 
the match space bounds, then a zero is assigned to the xorg, yorg position 
in the base space.

When processing the image, the algorithm first computes the thin plate 
spline coefficients and then generates match space grid positions from base 
space grid positions.
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IMAGE TYPES

You can apply this algorithm to all 2D and 3D image types. The dimensions 
or image type of the match image need not be the same as the dimensions or 
image type of the base image. The registered image has the same image type 
as the match image and the same extents as the base image.

SPECIAL NOTES

The following notes apply:

• For 2D images, three or more points are required. The algorithm may 
fail if nearly all of the points fall on the same line. 

• For 3D images, four or more points are required and the algorithm 
may fail if the points nearly all fall on the same plane.

REFERENCES

Refer to the following references for more information about this algorithm:

Figure 1.  Example of Registration: Landmark—TPSpline algorithm
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David Eberly, “Thin Plate Splines” of Magic Software at http://www.magic-software.com. 
Also at the same site are the files: MgcInterp2DThinPlateSpline.h, 
MgcInterp2DThinPlateSpline.cpp, MgcInterp3DThinPlateSpline.h, 
MgcInterp3DThinPlateSpline.cpp Paper that explains warping from one x,y source to 
another x’,y target set.

Fred L. BookStein, “Principal Warps: Thin-Plate Splines and the Decompositions of 
Deformations,” IEEE Transactions on Pattern Analysis and Machine Intelligence, Vol. 11, 
No. 6, June 1989, pp. 567–585.

Applying the Registration: Landmark—TPSpline 
algorithm

To run this algorithm, complete the following steps:

Selected image is a match image, the image that gets transformed until it is 
registered to the base image. 

1 Open two images: a base image and a match image.

2 Perform, as an option, any image processing, such as improving the 
contrast, eliminating noise, adding color, etc., on both images.

3 Delineate a point VOI on the base image using the point VOI icon  
and mouse.

4 Select the match image.

5 Delineate a point VOI on the match image at corresponding positions on 
the image.

Note: Make sure that you delineate the points on the match image in the 
same order as on the base image. That is, point 1 on the base image should 
correspond to point 1 on the match image, point 2 on the base image 
correspond to point 2 on the match image, and so on.

6 Click Algorithm > Registration > Landmark - TPSPline. The Thin Plate 
Spline Registration dialog box opens.

7 Select the base image in the Register to list box.  
MIPAV User’s Guide, Volume 2, Algorithms 625

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Registration: Landmark—TPSpline
8 lick OK. The algorithm begins to run. A pop-up window appears with 
the status. The following messages appear in succession: “Performing 
base to match grid transformation” and “Performing interpolation into 
result buffer.” When the algorithm finishes running, the pop-up window 
closes, and the result appears in a new image window.

                     

Register 
to

Displays a list of images 
including the base image and 
any match images. 

OK Applies the mean algorithm to 
the base image that you chose 
in this dialog box.

Cancel Disregards any changes that 
you made in this dialog box and 
closes the dialog box.

Help Displays online help for this dialog box.

Figure 2.  Thin Plate Spline Registration dialog box
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Registration: Manual 2D Series

The Manual 2D Series algorithm allows you to manually or semimanually 
register two 2D grayscale or color images by placing corresponding points 
on both images and then applying either the Landmark—Thin Plate Spline 
or Landmark—Least Squares algorithm. After applying one of these 
algorithms, you can then, if needed, use the other algorithm. In addition, at 
any time, you can manually adjust the alignment of each image.

The algorithm also lets you manually register different slices of a 2.5 image 
dataset in the same way as the 2D images.

Background
Through the Registration: Manual 2D Series window (Figure 1), this 
algorithm provides the tools for manually registering images and the ability 
to use two of the landmark registration algorithms. The Registration: 
Manual 2D Series window includes two tabs: Blended and Dual.

Figure 1.  Registration: Manual 2D Series window
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On the Blended page, the window superimposes the image to be registered 
on top of the reference image. This page includes icons for aligning, 
rotating, alphablending, and magnifying or minifying the images as well as 
icons for modifying the lookup table for each image and for applying a 
checkerboard pattern to assist in alignment.

Clicking the Dual tab opens the Dual page, which displays the images side 
by side. A number of icons appear in the toolbar. The red icons are color 
coded to the reference image, which appears on the left and is surrounded 
by a red border. The green icons apply to the image to be registered, which 
is shown on the right side of the page and is surrounded by a green border.

Before being able to use either the Thin Plate Spline or Least Squares 
algorithm, you must first delineate a minimum of three corresponding 
points on both images. These points serve as guides, or landmarks, for 
aligning the images. In order for the points to be corresponding, you should 
delineate each point in the same sequence; i.e., the first point that you 
delineate on the reference image should be the first point delineated on the 
image to be registered, the second point on the reference image should be 
the second point delineated on the image to be registered, and so on.

To delete a point, you must first select the point and then use the 
appropriate Delete icon to delete it. However, before you can select the 

point, you need to return the cursor to its default mode using the  icon.

On both the Blended and Dual pages, you can modify the lookup table 

(LUT) by clicking , the LUT icon. When you select , the Lookup Table 
window appears. This window includes two tabbed pages: one for Image A, 
the reference image, and one for Image B, the image to be registered.

A common icon— , the Reset icon—appears on both the Blended and 
Dual pages. Use this icon if you want to restore the original version of the 
images. This icon deletes all points on the reference image and on the image 
to be registered. 

Note: If the Apply button has already been selected, the Reset icon undoes all 
changes that occurred since the last time the Apply button was selected. 
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IMAGE TYPES

You can apply this algorithm to 2D grayscale and color images. 

The dimensions or image type of the image to be registered need not be the 
same as the dimensions or image type of the reference image. The registered 
image has the same image type as the image to be registered and the same 
extents as the reference image.

SPECIAL NOTES

The following notes apply:

• For 2D images, three or more points are required. The algorithm may 
fail if nearly all of the points fall on the same line. 

• For 3D images, four or more points are required and the algorithm 
may fail if the points nearly all fall on the same plane.

REFERENCES

Refer to the following references for more information:

“Least-Squares Fitting of Two 3-D Point Sets” by K.S. Arun, T.S. Huang, and S.D. Blostein, 
IEEE Transactions on Pattern Analysis and Machine Intelligence, Vol. PAMI-9, No. 5, 
September, 1987, pp. 698-700.

David Eberly, “Thin Plate Splines” of Magic Software at http://www.magic-software.com. 
Also at the same site are the files: MgcInterp2DThinPlateSpline.h, 
MgcInterp2DThinPlateSpline.cpp, MgcInterp3DThinPlateSpline.h, 
MgcInterp3DThinPlateSpline.cpp Paper that explains warping from one x,y source to 
another x,y target set.

Fred L. BookStein, “Principal Warps: Thin-Plate Splines and the Decompositions of 
Deformations,” IEEE Transactions on Pattern Analysis and Machine Intelligence, Vol. 11, 
No. 6, June 1989, pp. 567–585.
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Applying the Manual 2D Series algorithm on 2D images
To run this algorithm, complete the following steps:

1 Open two images: the reference image and the image that you want to 
register. 

2 Select the reference image. 

3 Select Algorithms > Registration > Manual 2D Series. The Load dialog 
box appears.

4 Select the image that you want to register to the reference image.  If only 
two images are open, the Set as Image B box automatically selects the 
other open image—the one you did not select—as Image B, or the image 
to be registered.

5 To select a different image, click Browse to find and open another image 
file.

6 Click OK. The Manual 2D Series window opens. 

Note:  Opening this window automatically corrects image resolution and 
scaling.

Figure 2.  The Load dialog box
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Note that this window includes two tabs:

• Blended, which displays the Blended page

• Dual, which displays the Dual page

The Blended page shows both images: the image to be registered 
superimposed on top of the reference image. Note that the icons near 
the top of the page allow you to move the image to be registered in all 
directions or specifically up, down, left, and right a certain number of 
pixels. You can also rotate the image to be registered clockwise or 
counterclockwise.

7 Click Dual to go to the Dual page. 

The Dual page shows both the reference image and the image to be 
registered side by side in the image area at the bottom of the page. 

Note that the border around the reference image, the image on the left 
side of the page, appears in red. The border around the image to be 
registered, which is on the right side of the page, appears in green. 
Several of the icons near the top of the page are color coded to the 
images. That is, the red icons apply to the reference image, and the 
green icons apply to the image to be registered.

8 Place at a minimum three landmarks, or points, on each of the images. 

On the reference image, click , the Reference Slice Markers icon, and 
click the mouse on the reference image where the landmark should be 
located. The landmark appears on the image in red type and is 
sequentially numbered. Create at least two more landmarks on the 
image.

On the image to be registered, click , the Adjusted Slice Markers 
icon, and creates a landmark on the image by clicking the mouse. The 
landmark, which is  sequentially numbered, appears in green type. 
Create a minimum of three landmarks on the image.

To delete a point on the reference image, you need to return the cursor 

to its default mode by clicking on . You can then select the point by 

clicking on it with the mouse and then delete it by clicking , the 
Delete selected reference slice markers icon.
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To delete a point on the image to be registered, or adjusted image, click 

, select the point, and then delete it by clicking  , the Delete 
adjusted slice markers icon.

9 Select, if desired, either , the Least Squares algorithm icon, or , 
the Thin Plate Spline algorithm, to register the images. The program 
registers the images and the landmarks appear in yellow type followed 
by the specific positions in parentheses.

10 At this point, you should determine the following:

• Whether there is a need to make manual adjustments to the 
registration. If so, return to the Blended page and use the direction 

or the rotation icons. Use  to verify alignment (refer to “Making 
manual adjustments to the image to be registered” on page 632 and 
to the following tables for more information.

• Whether to run the other algorithm. If so, simply click either , 

the Least Squares algorithm, or , Thin Plate Spline algorithm, as 
appropriate.

• Whether to restore the image to its original form by clicking .

• Whether to select Apply to keep changes made by the algorithm.

Making manual adjustments to the image to be 
registered

After you apply either , the Least Squares algorithm icon, or , the 
Thin Plate Spline algorithm on the images, you may want to manually 
ascertain whether key portions of the reference image and the image to be 
registered, or adjusted image,  are in alignment. One way of checking 

alignment, or registration, is using , the Window region of image B icon. A 
recommended method for checking registration and for correcting it 
follows.
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To check registration, do the following:

1 Click Blended in the Manual 2D Series window to display the Blended 
page. Both the reference image and the image to be registered, or 
adjusted image, appear at the bottom of the window. The adjusted 
image is superimposed over the reference image.

2 Note that the arrow on the Alphablending slider appears in the middle 
of the slider at 0.5R/A, which means that 50 percent of each image are 
shown on the page.

3 Slide the arrow on the Alphablending slider all the way to the right until 
it reaches the label “Adj. A.” This label indicates that 100 percent of the 
adjusted image is displayed on the page and, therefore, the reference 
image does not appear.

Note: The label “0.75A” means that 75 percent of the adjusted image appears 
and only 25 percent of the reference image is displayed.

4 Click , the Lookup Table icon, to display the Lookup Table window. Note 

that the window includes two tabs: one for Image A, the reference image, 
and one for Image B, the image to be registered.

5 Drag the image intensity line for the red channel up in the middle to 
adjust the color of the adjusted image. In this case, it creates a lighter 
colored red. The adjusted image now appears in pale red.

Note: Actually, you can change the color of the image to any color. The purpose 
in doing this task is to easily distinguish the adjusted image from the reference 
image.

6 Move the slider arrow all the way to the left on the slider. The label “Ref. 
R” indicates that the page now displays 100 percent of the reference and 
does not display the adjusted image.

7 Click  and position the cursor over the reference image. Notice that a 
square box appears on the image. The box is filled with a red image, 
which is  the adjusted image. You can use this box to look at the 
alignment of details in the images.
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Tip:  You may want to maximize the window and enlarge the images so that 
you can view details of the images while checking alignment. To maximize the 
window, simply click , the Restore button. To maximize the image, click 

, the Magnify image 2.0x icon, which magnifies the image to  twice its 
current size, as many times as needed.

8 Determine whether you want to correct the alignment of the images. If 
you do, there are several ways to move the adjusted image: 

• Moving the image using ,the Translate image icon (refer to 
“Moving the adjusted image in any direction” on page 635)

• Moving the image using the direction arrows (refer to “Moving the 
adjusted image with the direction arrows” on page 636):

• , the Move image up icon

• , the Move image down icon

• , the Move image right icon

• , the Move image left icon

• Setting the number of pixels to move the image with , the Set 
pixel increment icon

• Rotating the image with the following icons (refer to “Rotating the 
adjusted image” on page 636):

• , the Rotate image icon

• , the Rotate clockwise icon

• , the Rotate counterclockwise icon

• , the Set degree increment icon
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MOVING THE ADJUSTED IMAGE IN ANY 
DIRECTION

The Translate image icon, or , allows you to move the adjusted image in 
any  direction. This icon only appears on the Blended page, which is where 
all manual adjustments to image registration occurs. 

To move the adjusted image, click , and, holding down the left mouse button, 
drag the icon in the direction in which to move the image, and then release the 
mouse button. After a few moments, the image appears in the new position.  Note 
that, depending on where you moved the adjusted image, its outer portions  may 
disappear beyond the outer edges of the reference image (Figure 3). In this case, 

you can use  to move the adjusted image again.

Figure 3.  The Blended page of the Manual 2D Series window showing the adjusted image moved 
down and to the right
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MOVING THE ADJUSTED IMAGE WITH THE 
DIRECTION ARROWS

The icons that display direction arrows ( , the Move image up icon; , 

the Move image down icon; , the Move image right icon; and , the 
Move image left icon) let you move the adjusted image in one direction only 
by a specified number of pixels. The default number of pixels is 1; however, 
the number of pixels may be from 0.01 to 2048.0. Therefore, the direction 
arrows provide the greatest specificity in moving the image, which is perfect 
for fine adjustments.

To change the number of pixels, click , the Set pixel increment icon; 
enter a  number in the Pixel Increment box; and click Apply.

ROTATING THE ADJUSTED IMAGE

If the rotation of the adjusted image is incorrect, you can change the 

rotation of the image with the rotation icons: , the Rotate image icon; 

, the Rotate clockwise icon; and , the Rotate counterclockwise icon.

To select the center of rotation for the image, click  and set the center by 
clicking with the mouse on the image. The letter C appears with a yellow 
crosshair cursor (Figure 4). You can then drag a line from the center of 
rotation to move the image above or below the center of rotation. To rotate 

the image clockwise, click ; and  to rotate the image counterclockwise, 

click . 
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As with the direction arrow icons, you change the degree increment to 
achieve exact registration. The default degree increment is 1.0, but you can 

specify from 0.01 to 360 degrees. To change the degree increment, click , 
the Set degree increment icon. The Change Degree Increment dialog box 
appears. Enter the degree increment in the Degree Increment box, and click 
Apply.

Figure 4.  Manual 2D Series window showing center of rotation
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File
Close Registration Closes this window without saving the images.

Show VOIs in 
blended window

Displays, on the Blended page, the VOIs that you 
delineated on the Dual page.

Blended tab Displays the Blended page, which shows the image to be registered 
superimposed on the reference image. This page allows you to move and align 
the image to be registered with the reference image.

Dual tab Displays the Dual page, which shows each image side by side, and allows you 
to delineate three or more landmarks on each image before you apply the 
Landmark—Least Squares algorithm or the Landmark—Thin Plate Spline 
algorithm to the images.

Alphablending 
slider

Adjusts the translucency of the alpha channels in each image using the 
alphablending technique. When two images share a window, you can adjust 
the alphablending settings so that you can see a blend of both images and can 
compare overlapping regions in two datasets.

 Lookup table
Displays the Lookup Table window, which includes two tabs: Image A, the 
reference image, and Image B, the image to be registered.

 Checkerboard 
A & B

Displays a checkerboard pattern on the images. You can use this pattern for 
assistance in aligning the images.

Figure 5.  Manual 2D Series window showing the Blended page
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 Magnify 
image 2.0x

Doubles the size of images, magnifying them to twice their current size. If an 
image is too large for the current window size, scroll bars appear, and you may 
need to manually adjust the size of the window.

To restore an image to its original size, use , the Magnify image 0.5x icon, 
as many times as you used this icon.

 Magnify 
image 0.5x

Reduces the magnification level of images in half. To restore images to their 

original size, use , the Magnify image 2.0x icon, as many times as you 
used this icon.

 Window 
region of image B

Hides the reference image below a windowed mouse cursor; slide 
alphablending slider to the reference image

 Reset image 
to original state

Restores image to its original state. This icon deletes all points on the reference 
image and on the image to be registered. If the Apply button has already been 
selected, the Reset icon undoes all changes that occurred since the last time 
the Apply button was selected. 

 Apply
Commits the changes that you made to the images, but it leaves the window 
open for you to make further changes if desired.

 Set pixel 
increment

Determines the number of pixels to use when any of the move image icons are 
used. When you click this icon, the Change Pixel Increment dialog box opens. 

Although the default is 1.0, when the pixel increment is changed to another 
number, that number displays on the toolbar rather than 1.0. For example, if 

you changed the pixel increment to 550.0,  would appear on the toolbar. 
You can use any pixel increment from 0.01 to 2048.00.

 Translate 
image

Moves Image B, the image to be registered, in any direction you drag the 

image by the number of pixels indicated in , the Set pixel increment icon. 

 Move image 
up

Moves Image B, the image to be registered, up by the number of pixels 

indicated in , the Set pixel increment icon.

 Move image 
down

Moves Image B, the image to be registered, down by the number of pixels 

indicated in , the Set pixel increment icon.

Figure 5.  Manual 2D Series window showing the Blended page (continued)
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 Move image 
right

Moves Image B, the image to be registered, right by the number of pixels 

indicated in , the Set pixel increment icon.

 Move image 
left

Moves Image B, the image to be registered, left by the number of pixels 

indicated in , the Set pixel increment icon.

 Set degree 
increment

Determines the degree to use when rotating images, rotating images 
clockwise, or rotating images counterclockwise. When you click this icon, the 
Change Degree Increment dialog box opens.

Although the default degree increment is 1.0, when the degree increment is 
changed to another degree, that degree increment displays on the toolbar 
rather than 1.0. For example, if you changed the degree increment to 180.0, 

 would appear on the toolbar. You can set the degree increment from 0.01 
to 360.0. 

 Rotate image
Allows you to select a center of rotation by clicking on the image with the 
mouse. It then allows you to then move the image above or below the center 
of rotation by dragging a line from the center of rotation.

 Rotate 
clockwise

Rotates the image to be registered clockwise by the number of degrees 
indicated as the degree increment. To restore the image to its original rotation, 

click , the Reset image to original state icon.

 Rotate 
counterclockwise

Rotates the image to be registered counterclockwise by the number of degrees 
incited as the degree increment. To restore the image to its original rotation, 

click , the Reset image to original state icon.

Image area Superimposes the image to be registered on the reference image and allows 
for the image to be registered to be moved, magnified, or rotated.

Figure 5.  Manual 2D Series window showing the Blended page (continued)
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File
Close Registration Closes this window without saving the 

images.

Show VOIs in blended 
window

Displays, on the Blended page, the VOIs 
that you delineated on the Dual page.

Blended tab Displays the Blended page, which shows the image to be registered superimposed 
on the reference image. This page allows you to move and align the image to be 
registered with the reference image.

Dual tab Displays the Dual page, which shows each image side by side, and allows you to 
delineate three or more landmarks on each image before you apply the 
Landmark—Least Squares algorithm or the Landmark—Thin Plate Spline algorithm 
to the images.

 Lookup 
Table

Displays the Lookup Table window, which includes two tabs: Image A, the 
reference image, and Image B, the image to be registered.

 Magnify 
reference 
image 2.0x

Doubles the size of reference images, magnifying them to twice their current size. 
If an image is too large for the current window size, scroll bars appear, and you 
may need to manually adjust the size of the window.

To restore reference images to their original size, use , the Magnify reference 
image 0.5x icon, as many times as you used this icon.

Figure 6.  Manual 2D Series window showing the Dual page
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 Magnify 
reference 
image 0.5x

Reduces the magnification level of reference images in half. To restore reference 

images to their original size, use , the Magnify reference image 2.0x icon, as 
many times as you used this icon.

 Magnify 
adjusted 
image 2.0x

Doubles the size of adjusted images, magnifying them to twice their current size. 
If an image is too large for the current window size, scroll bars appear, and you 
may need to manually adjust the size of the window.

To restore adjusted images to their original size, use , the Magnify reference 
image 0.5x icon, as many times as you used this icon.

 Magnify 
adjusted 
image 0.5x

Reduces the magnification level of adjusted images in half. To restore adjusted 

images to their original size, use , the Magnify reference image 2.0x icon, as 
many times as you used this icon.

 Apply 
least squares 
alignment

Applies the Landmark—Least Squares algorithm to the image to be registered. 
After the algorithm is applied, if needed, you can apply the Landmark—Thin Plate 
Splines algorithm on the image, or you can manually adjust the alignment of the 
image on the Blended page.

 Apply thin 
plate spline 
alignment

Applies the Landmark—Thin Plate Spline algorithm to the image to be registered. 
After this algorithm is applied, if needed, you can apply the Landmark—Least 
Squares algorithm on the image, or you can manually adjust the alignment of the 
image on the Blended page.

 Reset 
image to 
original state

Restores the image to be registered to its original state. Restores image to its 
original state. This icon deletes all points on the reference image and on the 
image to be registered. If the Apply button has already been selected, the Reset 
icon undoes all changes that occurred since the last time the Apply button was 
selected.  

 Reference 
slice markers

Adds a point to the reference image each time you click the left mouse button. 
Note that the points are sequentially labeled from 1 on in the order in which you 
created them. To remove points, return the cursor to its default mode by clicking 

, select the point to be deleted, and click , Delete selected reference slice 
markers.

 Adjusted 
slice markers

Adds a point to the adjusted image each time you click the left mouse button. 
Note that the points are sequentially labeled from 1 on in the order in which you 
created them. To remove points, return the cursor to its default mode by clicking 

, select the point to be deleted, and click , Delete selected adjusted slice 
markers.

 Delete 
selected 
reference slice 
markers

Removes the point that you selected in the reference image. To remove a point, 

first return the cursor to its default mode by clicking , select the point to be 

deleted, and click , Delete selected reference slice markers.

Figure 6.  Manual 2D Series window showing the Dual page (continued)
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Applying the Manual 2D Series algorithm on 2.5 
images

To run this algorithm on 2.5D images, complete the following steps:

1 Open a single 2.5 image dataset. When you apply this algorithm, you 
select the slices in the dataset that you want to register.

2 Perform, as an option, any other image processing, except scaling, on 
the image dataset.

3 Select Algorithms > Registration > Manual 2D Series. The Manual 2D 
Series window for 2.5D images (Figure 7) opens.

Because you are registering slices of an image, and not separate images, 
all of the necessary icons and controls appear in a simple window that 
does not include tabbed pages. Note that there are two sliders at the top 
of the page:

• Reference slice slider—Allows you to choose which slice to use as a 
reference image. 

• Adjusted slice slider—Allows you to choose which slice to use as an 
image to be registered. 

The boxes to the right of each slider indicate which slice you are 
currently viewing. 

All of the remaining icons and controls work in the same way that they 
do on the Manual 2D Series window for 2D images (refer to Figure 5 and 
Figure 6).

 Delete 
selected 
adjusted slice 
markers

Removes the point that you selected in the image to be registered. To remove a 

point, first return the cursor to its default mode by clicking , select the point 

to be deleted, and click , Delete selected adjusted slice markers.

 Return to 
default mode

Returns the cursor to its default mode, which allows you to change from adding 
points to deleting points from the image.

 Apply 
Commits the changes that you made to the images, but it leaves the window open 
for you to make further changes if desired.

Figure 6.  Manual 2D Series window showing the Dual page (continued)
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Refer to the instructions for “Applying the Manual 2D Series algorithm 
on 2D images” on page 630.

Figure 7.  Manual 2D Series window

For 2.5D images, this window does not include the Blended and Dual tabbed 
pages. Rather is incorporates some of the same interface controls that appear on 
the Blended and Dual pages, such as icons and the alphablending slider. Note 
that you can place landmarks on the image in this window.
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Mosaic Registration

The Mosaic Registration method is a user interface for a semi-manual 
image registration. It allows the user, first, manually aligns two images 
using a mouse, and then it calls the Optimized Automatic Registration 2D 
algorithm (AlgorithmRegOAR2D) for further precise registration. As a 
result the method creates a new mosaic image from the two source images. 
Multiple images can also be added to the mosaic and aligned one at a time.

Background
The Mosaic Registration technique can be used for increasing a field of view 
(FOV) by combining two or more images in a single FOV.  Refer to Section 
“Outline of the method” . 

OUTLINE OF THE METHOD

Pre-registration steps

1 The user opens a reference image, and then adds a tile image. 

2 Both images are displayed as texture-mapped polygons. The texture 
sizes match the original image size. If an image is larger than the screen 
size, the polygon is scaled to fit the image to the screen size.

3 The centers for both images are computed, and then a single translation 
step is performed to align the image centers. 

Manual mouse based alignment

4 The user manually aligns both images using a mouse. Manual transla-
tion is done in a screen space – the center of the selected image is at the 
mouse position. Rotation is about the center of the selected image, the 
rotation angle is calculated based on the mouse movement. Scale is also 
based on mouse movement and is relative to the selected image. 

5 The minimum resolution of the reference and tile images is determined. 
For more information, refer to “Blurring” on page 652.
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6 The method registers the tile image to the reference image based on the 
how the user arrange the images using the mouse. It creates two new 
image frames, and then it writes the reference and tile mask images to 
these frames so that the reference and tile image overlap. Refer to “Reg-
istering the reference and tile images” on page 648.

7 The method saves the reference and tile polygon shapes, borders, 
images, and transformation matrices. 

Optimized Automatic Registration 2D

8 The method calls the Optimized Automatic Registration 2D algorithm to 
register images created in step 6. See also “AlgorithmOAR2D Optimiza-
tion Steps” on page 654.

Forming the mosaic image

9 After AlgorithmRegOAR2D finishes running, the method blends the tile 
image with the reference image, and then displays the result mosaic 
image. See also “Blending the tile image with the reference image” on 
page 649.

OPENING TWO IMAGES

When the user opens two images, the algorithm asks to open a reference 
image first, and then to add the tile image. In that step, the image centers 
are computed for each image, and then a single translation step is per-
formed to align the image centers.

MANUAL MOUSE-BASED ALIGNMENT

The mouse-based alignment step involves manual definition of identical 
points or key features between the reference and tile image (which means 
that the user should figure out the identical points), manual aligning both 
images using those points, and then saving the transformation vector. 

The manual mouse based alignment is a traditional affine transformation 
that involves rotation, translation and scale. After the manual transforma-
tion is done, the image content of the tile image is transformed to the geom-
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etry of the reference image and the transformation parameters are stored in 
the transformation vector.

Rotation

The method allows the user to rotate the tile image using the left mouse 
button. The rotation is performed around the center of the image until the 
identical points of both images were aligned. The rotation angle is then 
calculated based on the mouse's X- coordinate on the screen.

Translation

Manual translation is done using the right mouse button. The right mouse 
button, when pressed, points the mouse cursor to the center of the image. 
When the user moves the mouse, by default, the tile image moves along the 
reference image in the X and Y directions until the identical points in both 
images were aligned. The translation is then calculated based on the 
mouse's X and Y coordinates before and after translation. See Figure 2. To 
move the reference image, make it an active image first, and then use the 
same technique as was used for moving the tile image.

Scale

Manual scale can be done using the middle mouse button. The tile (or refer-
ence) image is scaled until the identical points in both images were aligned. 
The scale value is then calculated based on the mouse movement in Y direc-
tion on the screen. For example, each time the mouse moves up in Y direc-

Figure 1.  Calculating the rotation angle
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tion, the tile image is scaled larger, and each time the mouse moves down in 
Y direction, the tile image is scaled smaller.

Storing the transformation parameters

After each manual alignment step (e.g. each rotation, translation and scale), 
the method stores the current transformation for the tile image, so the new 
transformations can be concatenated onto the current transform. In other 
words, the method links the current transformations with the previous 
accumulated transformation, and then saves the transformation matrix.

REGISTERING THE REFERENCE AND TILE 
IMAGES

When the user press the Register Images button, the following happens: 

1 The Inverse Transform for the Reference image is calculated and 
applied to the reference image.

2 The Tile Transform is concatenated with the Inverse Reference 
Transform so that the tile image is transformed relative to the reference 
Image.

Figure 2.  The translation is calculated based on the mouse's X and Y 
coordinates before and after translation.
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3 The combined mosaic image size is calculated, based on the original 
reference image size and the transformed extents of the tile image. Now, 
the new image size is large enough to contain both images.

4 The reference image is resized to match the mosaic image.

5 The tile image is transformed and placed into a new tile image that has 
the same size as the reference image.

6 Two mask images are created, for the updated reference and tile images. 
These mask images have a value of one only where the two images 
overlap and a value of zero otherwise.

7 To further refine the registration, the AlgorithmRegOAR2D is then 
called for the reference, tile, and both mask images for a weighted 
registration, where the images are registered based on the image 
information only in the areas of the mask images that have the value 
equal to one. Therefore, the registration is based only on the areas 
where the two manually-aligned images overlap.

8 The Registration Transform is returned by the AlgorithmRegOAR2 
class. The Registration Transform represents the alignment with the 
lowest negative cost function value. 

9 The tile image is then transformed and blended to the reference image.

See also “Using the Optimized Automatic Registration 2D algorithm” on 
page 650.

BACKUP MOSAIC

Before AlgorithmRegOAR2D is called, the method stores the reference and 
tile polygon shapes, borders, images, and transformation matrices, so that 
the manual alignment can be undone at any time by the user. 

BLENDING THE TILE IMAGE WITH THE 
REFERENCE IMAGE

Once the two images are manually aligned and the registration is complete 
by AlgorithmRegOAR2D, the images are blended and the final image is then 
displayed.
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BRUTE FORCE

The Brute Force algorithm is a method of registering images, which 
includes: a) capturing a reference image, b) capturing a tile image, c) 
coarsely registering the reference image to the tile image to give approxi-
mate angle and offset parameters, and then d) finely registering the refer-
ence image to the tile image based on the parameters stored from the 
coarsely matching step. 

The coarsely registering step involves, first, resampling both images to a 
coarse resolution, and then applying a number of rotations and translations 
to register the tile image to reference image.

The finely registering step employs a control point matching between the 
reference image and the tile image using small image patches at a scale of 
one for the reference image and the tile image having lower resolution.

No optimization is performed in Brute Force registration.

The Brute Force algorithm starts when the user activates the Brute Force 
Registration option. See also “The Mosaic Registration dialog box options” 
on page 660“and “Brute Force Settings” on page 663.

Using the Optimized Automatic Registration 2D 
algorithm

BACKGROUND 

The Optimized Automatic Registration 2D algorithm searches for an 
optimal transformation that registers two images. The main approach for 
determining this optimal transformation is a) to calculate a cost function, b) 
determine how it changes as individual transformation parameters are 
varied, and c) find the parameters that minimize the value of the cost 
function. For example, Figure 3 shows a plot of a sample cost function for a 
selection of transformation parameters; in each plot, a single parameter is 
varied while all other are kept constant.
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See also “Cost functions used in MIPAV algorithms” on page 63.

Another fundamental step in this registration method is to resample and 
interpolate the reference and target images at several different resolutions 
(starting with a coarse pixel size and gradually increasing the resolution), 
while searching for the min cost function. An advantage of this multi-reso-
lution approach is that the initial optimization considerably reduces compu-
tational cost, since the number of sample points is substantially less. In 
addition, the overall alignment is easier to find at a coarse resolution. 

In that algorithm we use the inverse cost function, so the min cost corresponds 
to the better registration.

However, the resampling process may influence the computed value of the 
cost function; therefore, several different interpolation methods are incor-
porated with this technique. These methods are discussed in more detail 
later in Section “Resampling Interpolation” on page 657.

Taking into account the resampling and interpolation criteria, 
AlgorithmRegOAR2D begins searching for an optimum transformation at a 
coarse resolution of 8mm. Once a transformation has been determined that 

Figure 3.  The plots of the Correlation Ratio cost function versus some of 
the individual parameter values. In each plot (A, B, C, and D), a single 
parameter is varied while the other are kept constant
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minimizes the cost function, the transformation is further refined by pro-
gressively increasing the resolution, e.g. 8, 4, 2, 1. 

The algorithm offers various resampling interpolation methods combined 
with the Correlation Ratio, Least Squares, Normalized Cross Correlation, 
and Normalized Mutual Information as a cost function. See also Section 
1.2.5, “Cost functions.”

OUTLINE OF THE METHOD

Pre-Optimization

The algorithms input are two images after performing the manual align-
ment. It takes as an input both images as they appear from the Manual 
mouse-based alignment step, (these two new registered images are now 
called a reference and a target image), and then performs the pre-optimiza-
tion which includes blurring and resampling.

Blurring 

The registration algorithm first, determines the minimum resolution of the 
reference and target images. The reference image is blurred to the resolu-
tion of the target image if the resolution of the target image is 50% or larger 
than the corresponding resolution in the reference image. Likewise, the tar-
get image is blurred to the resolution of the reference image if the resolution 
of the reference image is 50% or larger than the corresponding resolution in 
the target image. It is possible (but not likely) that both   the reference and 
target image   will be blurred. Both images are then resampled into 1mm 
isotropic pixels. 

Calculating the center of mass

The algorithm calculates centers of mass (COM) for each image, and then a 
single translation step is performed to align the COMs. To calculate the 
COM, the method uses the right hand convention 2D coordinate systems 
(X, Y). Thus, in the image space, the left hand corner of the image is set to 
(0, 0). The X axis goes left to right and the Y axis goes top to bottom. The 
rotation about the Y axis can be determined by the angle between the nor-
mal to the planes for the two images, while translational compensate along 
the X axis is given by the difference in COMs in two images.
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Resampling

Once this isotropic 1mm resolution images have been obtained, the 2, 4 and 
8mm subsampled versions are also created. The sub-sampling algorithm 
then simply keeps every n-th point (that is, 2, 4 or 8) on the lattice in each 

direction. Therefore, the new volume contains 1/n2 as many points as the 
original. See also “Resampling Interpolation” on page 657.

Optimization

The optimization function is used to determine the optimum transforma-
tion. It takes as an input both images (blurred and resampled), and then 
progresses them through a series of different levels corresponding to both 
the reference and target images resampled and interpolated to higher levels 
of resolutions.

1 levelEight optimization. Both images are resampled and interpolated to 
a resolution of 8mm. The parameters of the transformation are then 
systematically varied, where the cost function is evaluated for each 
setting. The parameters corresponding to the smallest value(s) of the 
cost function are then used as the initial transformation for the next 
level in the optimization.

2 levelFour optimization. The images are resampled and interpolated to 
4mm and the transformation corresponding to the smallest value(s) of 
the cost function are determined and used as the initial transformation 
for the next level in the optimization.

3 levelTwo optimization. Similar processing as the previous two levels 
except the images are, first, resampled and interpolated to 2mm.

4 levelOne optimization – 1mm resolution images are used in this step 
and the transformation is generalized to include 12 degrees of freedom.

Post optimization

Using the same interpolation methods as described in  “Pre-Optimization”  
and the optimal transformation determined above, the method transforms 
the reference image into the same coordinate system of the target image.

Following sections describe in detail the algorithms and methods used to 
perform Steps 1–8 of the optimization routine.
MIPAV User’s Guide, Volume 2, Algorithms 653

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Mosaic Registration
ALGORITHMOAR2D OPTIMIZATION STEPS

levelEight optimization is primarily concerned with determining the 
rotational transformation that will lead to the globally optimal transforma-
tion, which corresponds to the global minimum of the cost function. lev-
elEight optimization uses the lowest resolution images (8mm) and coarse 
rotation angles evaluated at relatively large step sizes.

Rotation

This AlgorithmRegOAR2D method is based on the empirical observation 
that finding the correct orientation, or rotation, is the most difficult task in 
image registration, since the three rotation parameters are highly coupled 

Figure 4.  AlgorithmOAR2D the levelEight optimization steps
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and most of the erroneous registrations that have been examined have hap-
pened primarily due to an incorrect orientation. Therefore, the search con-
centrates on the rotational part of the transformation. 

Specifically, the reference image is oriented, interpolated, and the cost func-
tion evaluated for coarse rotations angles (-5, 0), (0, 5), …, (-5, 5), where the 
values represent the amount of rotation in degrees about the X, and Y axes 
respectively. 

For each angle configuration, a four degrees of freedom (4-DOF) local opti-
mization is also performed to find the optimal translation and (global) scale. 
By default, the initial values are set to

• zero for translation

• one for scale.

The best 20% of the cost values and the corresponding angle configurations 
(candidate local minima) are stored in a vector of minima that is used as a 
starting point for a further optimization, which uses a smaller step size over 
a narrower range of angles.

For each parameter setting corresponding to the top 20% of the cost func-
tion minima, the algorithm performs rotations over the fine grid (which is, 
by default, 3 degrees with 1 degrees step) and evaluates the cost function.

The method now finds all angle configurations that have the corresponding 
cost function values lower than their neighbors from the vector of candidate 
local minima.

For each of these sets of parameters a 7-DOF optimization is then per-
formed, storing the results of the transformation and costs before and after 
optimization in a vector of minima. 

Since the relative costs of each candidate solution may change at higher res-
olutions, where structures become more sharply defined, the top 20% of the 
cost function minima points are considered for the next higher resolution 
(4mm) stage, rather than just the single best solution.

By default, the algorithm uses Bilinear interpolation to transform images to 
this new orientation. And Least Squares is the cost function implemented in 
this method.
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levelFour optimization step uses the interpolated 4mm resolution 
images to determine the transformation that minimizes the cost function 
starting with the transformations determined in levelEight. The optimiza-
tion determines a 7-DOF transformation that corresponds to the minimum 
value of the cost function. This transformation is then perturbed and the 
cost function is computed for these new settings. The perturbations corre-
spond to six-degrees for each rotation parameter and a global scaling factor 
of 0.8, 0.9, 1.1, and 1.2. A type of transformation (translation and/or global 
scale) is specified by a user (see Section 1.5, Running the Mosaic Registra-
tion). It includes the following transformations: Affine-12 (the default), 
Rigid-6, Global Rescale-7, and Specific Rescale-9. A vector of parameters 
and top 20% of the min cost function values are considered for the next 
2mm step.

In levelTwo, the method uses the images interpolated to 2mm.   The cost 
function is evaluated using the transformation parameters corresponding to 
the top 20% minima obtained from the levelFour. It finds the best mini-
mum, and then optimizes it with the 7-DOF and then 9-DOF transforma-
tion. The method then returns the best minimum after optimization.

Note: if the user has limited the degrees of freedom to six, as for the rigid 
transformation, there will only be one optimization run in levelTwo, with six 
degrees of freedom. 

levelOne step uses the 1mm interpolated images and computes the value 
of the cost function for each parameter setting determined in the previous 
levelTwo optimization. The parameters corresponding to the minimum 
value of the cost function with this resolution are then further optimized for 
transformations with 7-, 9-, and 12- DOF, unless a rigid (6-DOF) 
transformation is desired.

What is saved

The method stores: 

• The set of parameters or vector at which the minimum was reached; 

• The value of the cost function at that minimum; 

• And the matrix, which was the true input into the cost function and 
represents the transformation that gives the minimum cost of 
differences between the images.
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RESAMPLING INTERPOLATION

AlgorithmRegOAR2D resampes images using an interpolation scheme, 
where image pixels are resampled into isotropic 1mm pixels. New pixel val-
ues are computed using a weighted combination of existing pixel values 
within a defined neighborhood of the new pixel location. The interpolation 
methods are available in this implementation of the registration technique 
include Bilinear, B-spline 3-rd order, B-spline 4-rd order, Cubic 
Lagrangian, Quintic Lagrangian, Heptic Lagrangian, and Windowed sinc. 

The major effect that the choice of interpolation could have is in determin-
ing the degree when the cost function becomes continuous or discontinuous 
with respect to changes made in the transformation parameters. Thus, 
selecting the appropriate interpolation method is important for future cal-
culation of the cost function. 

To learn more about the interpolation methods used in MIPAV, refer to 
“Interpolation methods used in MIPAV” .

COST FUNCTIONS

 The Optimized Automatic Registration 2D method searches for the trans-
formation that gives the smallest value of the inverse cost function, which 
we assume is the transformation that also gives the best alignment. 

Least Squares is the cost function implemented in this method. Refer to “Cost 
functions used in MIPAV algorithms”  for more information.

Powell method

Optimized Automatic Registration 2D uses the Powell method to find the 
global minimum of the chosen cost function. For more information about 
the Powell method, refer to < http://math.fullerton.edu/mathews/n2003/
PowellMethodMod.html>
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OUTPUT

The transformed image is displayed. In order to receive a better resolution, 
the same interpolation methods which were described in Section 
“Resampling Interpolation” on page 657 can be applied to the transformed 
image to produce the final output image. 

IMAGE TYPES

You can apply this algorithm to all 2D color (RGB) and grayscale images.

Running the Mosaic Registration method
To run Mosaic Registration (Figure 8), 

1 Call Algorithms>Registration> Mosaic Registration. 

2 In the Mosaic Registration dialog box, click the Open Reference Image 
button and then choose the reference image. The reference image 
appears in the dialog box. See Figure 5-2.

3 Press Add Tile Image and choose the tile image. See Figure 5-3.

4 Use the mouse to manually register two images. See Figure 5-4.

5 After the manual alignment is done, press Register Images to run the 
Optimized Automatic Registration 2D algorithm. Figure 5-5.

When the Optimized Automatic Registration 2D algorithm finishes running 
the result image appears in the dialog box window.
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Figure 5.  Running Mosaic Registration
MIPAV User’s Guide, Volume 2, Algorithms 659

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Mosaic Registration
THE MOSAIC REGISTRATION DIALOG BOX 
OPTIONS

Open Reference Image–browse your image directory to select the 
reference image. 
Open Tile Image – browse your image directory to select the reference 
image. 
Toggle Selected Image–highlights a selected image. By default, the 
reference image appears in the blue frame and the tile image is the active 
image and appears in the red frame. You can manually rotate and translate 
the toggled image, no matter if it is a reference or tile image.
Register Images–registers images using the Optimized Automatic 
Registration algorithm.
Undo Mosaic–undoes the registration. 
Save Mosaic–saves the result image.
Close all–closes all images.
Advanced Options–opens the Optimized Automatic Registration 2D 
dialog box. See “Optimized Automatic Registration 2D dialog box options” .

Figure 6.  Mosaic Registration dialog box
MIPAV User’s Guide, Volume 2, Algorithms 660

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Mosaic Registration
OPTIMIZED AUTOMATIC REGISTRATION 2D 
DIALOG BOX OPTIONS
 

Input options

Degrees of 
freedom

Specifies the spatial 
model used to restrict 
the type of linear trans-
formation being applied 
during registration. 
Select one of the follow-
ing: Affine-6 (the 
default), Rigid-6, Global 
rescale-7, Specific 
rescale-9, and Affine-12. 

See also “Cost functions 
used in MIPAV algo-
rithms” , “Degrees of 
freedom” on page 71.

Interpolation Specifies the type of interpolation the algorithm will use when resampling. The list 
includes: Bilinear, B-spline 3-rd order, B-spline 4-th order, Cubic Lagrangian, 
Quintic Lagrangian, Heptic Lagrangian, Windowed sinc. See also “Interpolation 
methods used in MIPAV” .

Process color image Check this box to process a color image.

Cost function Specify a cost function which will be used to evaluate registration. The list 
includes: Least squares, Correlation ratio, Normalized cross correlation, Normal-
ized mutual information 

Rotation angle sampling range specify the rotation angle. By default the angle is 
set from -5.0 to 5.0 degrees. 

Coarse angle 
increment

Fine angle 
increment

options can be used for two pass registration. The first registration pass would 
apply a coarse-level rotation to quickly arrive at an approximate registration, and 
then the second pass would apply a finer-level rotation to continue from the point 
where the first pass registration has finished. By default, the coarse angle 
increment is set to 2.0 degrees and fine angle increment is set to 1.0 degrees. 

Figure 7.  The Optimized Automatic Registration 2D dialog box options
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Subsample 
image for 
speed

–if checked, this option allows subsampling the image to speedup the registration.

Brute Force 
Registration

–if checked, this option calls the Brute Force algorithm. See also “Brute Force” on 
page 650.

Output Options:

Display 
transformed 
image

allows to view the transformed image in a separate window. By default, this 
option is active.

Interpolation: select the calculation method, to produce the output image from the array of 
transformation matrices and input image. You can choose among Bilinear, B-spline 
3-rd order, B-spline 4-th order, Cubic Lagrangian, Quintic Lagrangian, Heptic 
Lagrangian, or Windowed sinc. The default choice is Bilinear.

Set Parameters –saves current parameters.

Set Parameters and Register Images –saves current parameters and register images. 

Advanced 
Settings 

–opens the Advanced OAR Settings dialog box. Pressing the Advanced button 
opens the Advanced OAR Settings dialog box where you can specify the additional 
parameters which will be used to calculate the min cost function. 

Advanced OAR settings

Multiple of 
tolerance to 
bracket the 
minimum

Recommended values 
are 10–60.

Number of 
iterations

Recommended are 1–5 
iterations.

Number of 
minima from 
Level 8 to 
test at Level 
4

By default this is the best 
20%, but you can enter 
your own number here.

Subsample image for speed subsamples the image.

Skip multilevel search. Assume images are close to alignment.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes it.

Help Displays online help for this dialog box.

Figure 7.  The Optimized Automatic Registration 2D dialog box options (continued)
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BRUTE FORCE SETTINGS

The Brute Force registration is used, when the user activates the Brute 
Force Registration option in the Optimized Automatic Registration dialog 
box, see Figure 9.

Rotation Range – enter the rotation angle, use zero for no rotation 
optimization.
Translation Range – enter the translation range in pixels, use zero for no 
translation.
Scale in X – enter the scale value in percentile (%) which will apply to the 
image to scale it in the X axis direction. A zero value corresponds to no scale 
in X axis.
Scale in Y – enter the scale value in percentile (%) which will apply to the 
image to scale it in the Y axis direction. A zero value corresponds to no scale 
in Y axis.
Number of steps for testing scales – enter the number of steps which 
should performed to test the scale values (in X and Y directions). A zero 
value corresponds to no scale optimization. See Figure 8.

Figure 8.  The Brute Force algorithm settings
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Registration: Display Pixel Similarity Cost 
Functions

The algorithm calculates costs for various voxel similarity cost functions 
that are used in registration and output them to the Output window.

Background
For two chosen images, the algorithm takes pixel (voxel) similarity cost 
functions implemented in MIPAV, and then, for each cost function, it 
computes the cost value. The cost values are then displayed in the Data tab 
in the Output MIPAV window. 

Note that MIPAV uses inverse cost functions, therefore the min cost function 
corresponds to the better registration.

The following voxel similarity cost functions are utilized in this method:

• “Correlation ratio” on page 64 refer to  “Cost functions used in MIPAV 
algorithms” 

• “Normalized cross correlation” on page 67, refer to “Cost functions 
used in MIPAV algorithms”  

• “Normalized mutual information” on page 70, refer to “Cost functions 
used in MIPAV algorithms”  

To apply the method to images, make sure that both images are of the same 
type and same dimensionality. Also, if while running the method, the 
second image appears to have a resolution (or a number of bins) that differs 
from the resolution of the first image, the method will rescale the second 
image. 

IMAGE TYPES

You can apply this algorithm to color, grayscale, and black and white 2D 
and 3D images. Note that, in order to run the algorithm, both images must 
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be of the same type (e.g. both color, or both grayscale, or both black and 
white) and same dimensionality.

Applying Display Pixel Similarity Cost Function
To use this algorithm, do the following:

1 In the MIPAV window, select Algorithms >Registration > Display Pixel 
Similarity Cost Functions. The Show Pixel Similarity Cost Function 
Values dialog box (Figure 2) appears.

2 Complete the information in the dialog box. See Figure 2.

a b

c

Figure 1.  The Display Pixel Similarity Cost Functions mehod: (a) the first 
image, (b) the second image, and (c) the output of the method.
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3 Click OK. The algorithm begins to run, and a progress bar appears 
momentarily with the status. When the algorithm finishes running, the 
progress bar disappears, and the results appear in the Data tab in the 
Output  MIPAV window.

Pixel similarity 
costs between 
[Image 1} and 
[Image 2}

Use the list box, to select the 
second image from the list of 
available images. Note that both 
images must be of the same 
type– color, or grayscale, or black 
and white.

Linearly rescale 
2nd image

Because both images must have 
the same dimensions and 
extends, the second image might 
require rescaling in order to 
match the first one. Check this 
box to rescale the second image.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you’ve done in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.

Figure 2.   Show Pixel Similarity Cost Function Values dialog box
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Registration: Time Series Optimized Automatic 
Registration

This algorithm allows you to register the individual 3D volumes within a 
4D time series to a reference volume. The reference volume is either a 
particular one of the 3D volumes or an average of all of the 3D volumes.

Background
The Automatic Time Series Registration algorithm is based on MCFLIRT 
(Motion Correction—FMRIB's Linear Image Registration Tool), a tool 
developed at the Oxford Centre for Functional Magnetic Resonance 
Imaging of the Brain at the John Radcliffe Hospital, University of Oxford.

To use this algorithm, first select a 4D time series volume requiring 
registration. Then select Algorithms > Registration > Time series optimized 
automatic registration in the MIPAV window. The Time Series Registration 
dialog box (Figure 1 on page 674) opens.

REGISTERING VOLUMES

Note that the fields in the dialog box appear in two groups: Input Options, 
which apply to the 4D time series requiring internal registration, and 
Output Options, which apply to displays for the transformed 4D series. 
There are two choices for choosing a reference volume. You either choose a 
specific volume in the time series by selecting Register to reference volume 
(1 through the number of volumes in the time series) and typing the number 
of the volume in the box on the right, or you select Register to average 
volume, which averages all of the volumes in the reference volume. The 
algorithm rescales the reference volume so that the voxels are isotropic, that 
is, have equal x, y, and z dimensions.

If the reference volume exceeds a threshold of 75,000 voxels, the algorithm 
creates versions of the reference volume that are subsampled first by 2, then 
by 4, and, finally, by 8. Although three subsamplings are possible, only 2, 1, 
or 0 subsamplings may occur if the reference volume can be subsampled 
while it has greater than 75,000 voxels.
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The algorithm performs the following cycle with different tolerances used at 
each level with first the subsampled-by-8 reference volume; then the 
subsampled-by-4 reference volume; then the subsampled-by-2 reference 
volume; and, finally, the original reference volume. 

For each volume in the time series, the algorithm starts at the reference 
volume + 1 and proceeds to the last volume in the time series. It then starts 
at the reference volume - 1 and proceeds to the first volume in the time 
series.

For each volume, the algorithm does the following:

1 Isotropically rescales the current volume

2 Subsamples the current volume to the same subsampling level as the 
reference volume

3 Creates a cost function with the reference volume and the current 
volume and uses Powell's algorithm to optimize with the tolerances 
specific to the subsampling level

4 Stores the answer as a list of matrices, which it uses for the starting 
point in the next level of subsampling

To perform the cycle with only unsubsampled images at the expense of 
speed, make sure to clear Subsample image for speed in the Time Series 
Registration dialog box. 

To speed the registration, select Set final subsample at level 2 to cause the 
last set in the cycle using full-sized images to be skipped. 
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CHOOSING A COST FUNCTION

The default cost function is normalized cross correlation. However, you can 
also select correlation ratio, least squares, and normalized mutual 
information as cost functions.

Normalized cross correlation

Normalized cross correlation is: 

where N is the normalized cross correlation and var is the variance.

where 

R = the reference image value - reference image minimum value

I = the input image value - input image minimum value

count = total number of values

N var RI( )
varR varI⋅

--------------------------------=

varRI sum RI( )
count 1–( )

---------------------------- sumR sumI⋅( )
count 1–( ) count⋅( )

----------------------------------------------------–=

varR
sum R2

( )
count 1–( )

----------------------------= sumR sumR⋅( )
count 1–( ) count⋅( )

----------------------------------------------------–

varI
sum I2( )
count 1–( )

---------------------------- sumI sumI⋅( )
count 1–( ) count⋅( )

----------------------------------------------------–=
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Correlation ratio

For correlation ratio, the algorithm goes over all pixels forming numY, 
sumY, and sumY2: 

where

iV = indexValue
int = integer part of a number
I = input image value
R = reference image value
minI = minimum input image value
minR = minimum reference image value

The algorithm next calculates the individual variances for each ISO-set 
weighting them by the number of pixels from the input image that 
contribute.

Summing from  to : 

The following should be the bth ISO-subset variance: 

The algorithm then normalizes the weighting of numY[]:

 

iV int( ) R index( ) minR–( ) constant×=

numY iV[ ] numY iV[ ] 1+=

sumY iV[ ] sumY iV[ ] I minI–+=

sumY2 iV[ ] sumY2 iV[ ] I( minI )
2–+=

numTotY numTotY numY b[ ]+=   
totSumY totSumY sumY b[ ]+=  
totSumY2 totSumY2 sumY2 b[ ]+=

b 0= nBins 1–

varB sumY2 b[ ](= sumY b[ ] sumY b[ ] numY b[ ]⁄ ) numY b[ ] 1 )–⁄×–
Ratio corrRatio varB numY b[ ]×+=

corrRatio corrRatio( ) numTotY( )⁄=
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Next, it calculates the total variance of input image and then normalizes by 
the following:

 

Least squares

For least squares, the algorithm uses the following:

where 

LS = least squares

valueR = reference image[i] - minimum reference image value

valueI = input image[i] - minimum input image value

count = the number of values over which the sum is performed

Normalized mutual information

For normalized mutual information, the algorithm uses the following:

where

M = normalized mutual information
R = reference image values
I = input image values
q = locations

vartTot totSumY( 2 totSumY totSumY
numTotY ) numTotY 1–( )⁄

⁄×

corRatio corRatio variance⁄=

–=

LS
valueR valueI–( )

2
∑

count
-------------------------------------------------------=

M H R I,( ) H R( ) H I( )+( )⁄=

H R( I ), pjklog pjk( )
j k,
∑=
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where

pjk = (Number of elements for which Valuej < R(q) < Valuej+1 and 
Valuek < I(q) < Valuek+1)/total number of elements

H(R) = -sum over j of (pjlog(pj)) where pj = (Number of elements for 
which Valuej < R(q) <Valuej+1)/total number of elements

H(I) = -sum over k of (pklog(pk)) where pk = (Number of elements for 
which Valuek < I(q) < Valuek+1)/total number of elements

The normalized mutual information definitions require the specification of 
a partition of intensities: {Value0,Value1,...,ValueM}.

COMPLETING THE DIALOG BOX

Unless the algorithm is in the final cycle with full-sized images and you 
selected Finalize with normalized cross correlation sinc, the input image 
value is obtained with trilinear interpolation. In that case, windowed sinc 
interpolation is used to obtain the input image value in a normalized cross-
correlation routine.

To show the resulting image, select Display transformed image.

By default, the interpolation used to calculate the transformed image from 
the array of transformation matrices is trilinear. However, you can select 
bspline 3rd order, bspline 4th order, cubic lagrangian, quintic lagrangian, 
heptic lagrangian, or windowed sinc.

If you select graph rotations and translations, MIPAV produces two graphs: 
the first graph has x, y, and z translations, and the second graph contains x, 
y, and z rotations.

IMAGE TYPES

The algorithm works on both 4D color and grayscale images.
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SPECIAL NOTES

None.

REFERENCE

Refer to the following references for more information:

For more information on MCFLIRT, visit the MCFLIRT home page at http://
www.fmrib.ox.ac.uk/fsl/mcflirt/index.html. The main paper is: Jenkinson, M., Bannister, P., 
Brady, M., and Smith, S., “Improved optimisation for the robust and accurate linear 
registration and motion correction of brain images,” NeuroImage, 17(2): 825-841.

Jenkinson, Mark, and Smith, Stephen, “A global optimisation method for robust affine 
registration of brain images,” Medical Image Analysis, 5(2): 143-156.

Applying the Time Series Optimized Automatic 
Registration algorithm

To run this algorithm, complete the following steps:

1 Open an image.

2 Perform, as an option, any other image processing on the image.

3 Select Algorithms > Registration > Time Series optimized automatic 
registration. The Time Series Registration dialog box (Figure 1) opens.

4 Complete the information in the dialog box.

5 Click OK. 

The algorithm begins to run, and a progress bar appears with the status. 
When the algorithm finishes running, the progress bar disappears, and 
the results appear in a new window.

If you selected Display transformed image, the transformed image 
appears in a new window. If you also selected Graph rotations and 
translations, a graph of rotations and a graph of translations appear.
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Degrees of freedom Specifies the spatial model used to restrict the type of linear transformation 
being applied during registration. Select one of the following: rigid-6, global 
rescale-7, specific rescale-9, and affine-12.

Interpolation Select interpolation if isotropic resampling is needed. Select one of the 
following: trilinear (default choice), bspline 3rd order, bspline 4th order, 
cubic lagrangian, quintic lagrangian, heptic lagrangian, and windowed sinc.

Cost function Specifies a function that measures the deviation of output from input. 
Select one of the following: correlation ratio, least squares, normlized cross 
correlation, and normalized mutual information.

Finalize with 
normalized cross 
correlation sinc

Obtains the input image value for full-sized images by performing, as the 
last step of registration, a normalized cross correlation cost function, which 
uses windowed sinc interpolation. The default is not selected.

Subsample image 
for speed

Subsamples first by 8 times, then by 4 times, then 2 times, and, finally, by 
an unsampled image if the image is large enough. If not selected, all steps 
of the algorithm use full-size images. The default is selected.

Set final subsample 
at Level 2 (speeds 
registration)

Skips the last step in the algorithm that uses full-size images. The default is 
not selected.

Figure 1.  The Time Series Registration dialog box
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Register to 
reference volume 
(1-number of 
volumes in times 
series)

Registers the volume to be registered, or adjusted volume, to the reference 
volume you specify. For example, typing the number 22 in the text box on 
the right indicates that the adjusted volume should be registered to volume 
22 of the reference volume.

Register to average 
volume

Registers all volumes in the time series to the average of all of the volumes.

Display 
transformed image

Shows the resulting image of the registered volumes. 

Interpolation Calculates the output image from the array of transformation matrices and 
input image. You can select trilinear, bspline 3rd order, bspline 4th order, 
cubic lagrangian, quintic lagrangian, helptic lagrangian, or windowed sinc. 
The default choice is trilinear.

Graph rotations and 
translations

Produces two graphs: one graph includes the x, y, and z translations and 
the second graph contains x, y, and z rotations.

Display 
transformed image

Display transformed image If selected, the transformed image appears in a 
new window. By default, this option is selected.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box. 

Figure 1.  The Time Series Registration dialog box (continued)
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Reslice—Isotropic Voxels

Image resampling is an interpolation process in which anisotropic voxels 
(in the Z direction) are resampled into isotropic-sized voxels. The new 
voxels are formed by taking the weighted combination of the source voxels 
within a defined neighborhood of the reference voxel. Three interpolation 
methods are supported: linear, cubic convolution, and cubic B-spline. 

Refer to “Optimized Automatic Registration 3D” on page 596  for 
resampling an image at various orientations using a choice of interpolation 
methods.

Background
This section shows the equations that MIPAV uses for the three 
interpolation methods for the algorithm. Figure 1 shows an original image 
and the resulting images after linear, cubic convolution, and cubic B-spline 
interpolation are applied, see also “Interpolation methods used in MIPAV” .

LINEAR INTERPOLATION

The equations for linear interpolation are the following:

CUBIC CONVOLUTION INTERPOLATION

The equations that apply to cubic convolution interpolation are:

R u( ) u 1+= for 0 u 1<≤
R u( ) 1 u–= for 0 u 1<≤

R u( ) 3
2
--- u 3 5

2
--- u 2 1+–= for 0 u 1

R u( ) 1
2
--- u 3 5

2
--- u 2 4 u 1+–+–=

<≤

for 1 u 2<≤
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CUBIC B-SPLINE INTERPOLATION

MIPAV uses the following equations for cubic B-spline interpolation:

REFERENCES

None.

Figure 1.  Reslice—Isotropic Voxels algorithm applied to an image

R u( ) 3
2
--- 1

2
--- u 3 u 2–+= for 0 u 1<≤

R u( ) 1
6
--- 2 u–[ ]

3
= for 1 u 2<≤
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IMAGE TYPES

You can apply this algorithm to all image data types except RGB and 
complex. This algorithm can not be applied to 2D and 4D images.

Applying the Reslice—Isotropic Voxels algorithm
To run this algorithm, complete the following steps:

1 Open an image.

2 Select Algorithms > Reslice—Isotropic Voxels. The Reslice dialog box 
(Figure 2) opens.

3 Select an interpolation method in Interpolation.

4 Click OK. 

A status message appears. When the algorithm is complete, the results 
appear in a new image window.

Interpolation Specifies the type of interpolation to 
use when applying this algorithm. You 
can select one of the following: linear, 
cubic, or cubic B-spline.

OK Applies the Reslice—Isotropic Voxels 
algorithm according to the 
specifications in this dialog box.

Cancel Disregards any changes you made in 
this dialog box; closes the dialog box.

Help Displays online help for this dialog box.

Figure 2.  Reslice dialog box
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Registration: VOI Landmark

The VOI Landmark algorithm is a template matching motion correction 
technique that uses Gradient Magnitude as a similarity measure. This 
method replaces a tedious manual motion correction by a semi automatic 
procedure. The user interaction is reduced to a selection of a reference slice 
(it should be the first image slice) and a manual segmentation of the image 
in this slice.

The VOI Landmark algorithm can be applied for automatic motion 
correction in dynamic contrast enhanced MRI (DCE-MRI) perfusion scans 
which are used for the measurement of renal function.

Background
There are two main challenges for registration of the images in perfusion 
scans – the first is the extremely strong intensity variations over the time 
series, which can lead to apparent geometry changes – and the second is 
large displacements between single images in the time series.

As for the assessment of kinetic parameters for kidney, the shape of the 
kidney structures must be maintained during the motion correction 
process, therefore the algorithm employs the rigid motion model that 
implicitly maintains the structures during registration. Since the major 
motion of the kidney during the acquisition can be captured by a 
translation, the algorithm uses a template matching technique that 
constrains the rigid motion to translational and small rotational movements 
only. This also allows saving the computation time. 

TEMPLATE MATCHING REGISTRATION 
TECHNIQUE

The template matching registration technique selects only similar areas in 
the images to determine the registration parameters (instead of using 
information from entire images). In this method, the user delineates a VOI 
on the first image slice and this VOI is used as a template for registration. 
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AS A SIMILARITY MEASURE, THE METHOD 
USES GRADIENT MAGNITUDE

Two images are considered similar, if intensity changes occur at the same 
locations. An image intensity change can be detected via the image gradient. 
Since the algorithm registers the slices of the same image (which 
automatically means the same modality), the Gradient Magnitude was 
chosen as a similarity measure. See also “Cost functions used in MIPAV 
algorithms” .

The method uses a negative sum of Gradient Magnitudes as a cost function. 

TECHNIQUES FOR SEARCHING A GLOBAL 
MINIMUM

The method uses the coarse-to-fine search approach and two optimization 
algorithms to find the global minimum. The algorithms are as follows – the 
Exhaustive search for a global minimum and Downhill Simplex search for a 
global minimum.

In the coarse-to-fine approach, first, the images are reduced in scale and 
approximate match positions are determined. Then, the scales of the images 
are increased in two to three steps until full-resolution images are obtained. 
At each step, possible match positions are determined with associated 
confidence levels and a search at a higher resolution is performed only for 
high confidence matches.

The algorithm resamples images using an interpolation scheme, where 
anisotropic voxels (in the Z direction) are resampled into isotropic 1mm 
cubic voxels. New voxel values are computed using a weighted combination 
of existing voxel values within a defined neighborhood of the new voxel 
location. The algorithm uses the Gaussian interpolation technique with the 
scale varies from 0.5 to 5.0. 

See also “Cost functions used in MIPAV algorithms”  and “Interpolation 
methods used in MIPAV” .
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Exhaustive search for a global minimum

The exhaustive search for a global minimum, first, produces the 
topographic map for the chosen cost function - the cost surface. This 
narrows the search for a global minimum to the large but still finite solution 
space with the number of combinations of different variable values given 
by:

EQUATION 1

where,

N is a number of different variable combinations
Nvar is a total number of different variables
Qi is a number of different values that i can attain

It, first, searches for minima in a relatively large region of the cost surface at 
the coarse sampling and stores the best minima in the vector of best 
minima. Then, it progressively narrows the search to the best solutions until 
it finds the best minima.

Downhill simplex search for a global minimum

The Downhill simplex method constructs n vectors pi from the vector of 
initial parameter values x and the vector of step-sizes s as follows:

EQUATION 2

pi = (x0; x1; : : : ; xi + si; : : : ; xn)

These vectors form (n + 1) vertices of an n-dimensional simplex. During 
each iteration step, the algorithm improves parameter vectors pi by 

modifying the vertex with the highest function value by simple geometrical 
transformations: reflection, reflection followed by expansion, contraction 
and multiple contraction. Using these transformations, the simplex moves 
through parameter space towards the deepest minimum, where it contracts 
itself.

N Qi
i 1=

Nvar

∏=
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REFERENCES

The following literature was used:

(a) (b)

(c) (d)

Figure 1.  Applying the VOI landmark algorithm: (a) the first image slice 
with delineated VOI, (b) the result image when using the Exhaustive 
search for a global minimum, (c) the first slice of another image with 
delineated VOI, (d) the result image when using the Downhill Simplex 
search for a global minimum
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Nuclear Medicine 36(1), pp. 3-15, 2006.

H. J. Michaely, S. Sourbron, O. Dietrich, U. Attenberger, M. F. Reiser, and S. O. Schoenberg, 
“Functional renal MR imaging: an overview,” Abdom. Imaging, 2006.

Darko Zikic, Steven Sourbron, Xinxing Feng, Henrik J. Michaely, Ali Khamene, and Nassir 
Navab, “Automatic Alignment of Renal DCE-MRI Image Series for Improvement of 
Quantitative Tracer Kinetic Studies” SPIE Medical Imaging, San Diego, California, USA, 16-
21 February 2008.

IMAGE TYPES

All 3D and 4D images that can be opened in MIPAV.

Applying the VOI Landmark algorithm
To run this algorithm, complete the following steps:

1 Open a 3D kidney image.

2 Use the Image Slice Slider to navigate to the fist slice (the slice #0).

3 Use the Draw Polygon/Poly line VOI icon to delineate a VOI around the 
right or left kidney.

4 Call Algorithms> Registration >VOI Landmark.

5 In the Register dialog box that appears, specify the scale of Gaussian for 
X and Y dimensions.

6 Then, select the optimization algorithm: Exhaustive search for a 
global minimum or Downhill Simplex search for a global 
minimum. See Figure 1 and Figure 2.

For Exhaustive search only:

• Specify what value will be used to determine the global minimum, it 
could be either Minimum Difference between Gradient Magnitude 
Sums under VOI or negative Maximum Gradient Magnitude Sum 
under VOI.

• Specify the search range.

7 Press OK.

The algorithm begins to run and the progress window appears displaying 
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the progress. When the algorithm finishes running, the registered image 
appears in the same image frame. 

Figure 2.  Applying the Registration- VOI Landmark algorithm using the Exhaustive search option
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Figure 3.   Applying the Registration- VOI Landmark algorithm using the Downhill Simplex search 
option
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Scale of Gaussian Specify the scale of 
Gaussian used in the 
Gaussian interpolation 
(0.5–5.0).

Options Optimization – select 
either Exhaustive 
search or Downhill 
Simplex search. 

The following options available only for 
Exhaustive search

Step size – specify the step size 
(0.5–5.0) used to 
search for the min 
cost.

Min. diff. between 
Gradient Magnitude 
under VOI

– if selected, this value will be used to determine the min cost.

Max. Gradient 
Magnitude under 
VOI

– if selected, this value will be used to determine the min cost.

Search range Use the text boxes maxTx, maxTy, minTx, minTy, maxRz and minRz to 
specify the rotation and translation steps.

OK Applies the parameters that you specified to register the image.

Cancel Disregards any changes you made in this dialog box, closes the dialog box, 
and does not register the image.

Help Displays online help for this dialog box.

Figure 4.  Register (VOI Landmark) dialog box
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Shading Correction: Inhomogeneity N3 
Correction

This preprocessing algorithm corrects for shading artifacts often seen in 
MRI. The heart of the algorithm is an iterative approach that estimates 
both a multiplicative bias field and a distribution of true tissue intensities. 
Referred to as nonparametric intensity nonuniformity normalization 
(N3), this method makes no assumptions about the kind of anatomy 
present in a scan and is robust, accurate, and fully automatic.

Background
A common difficulty with tissue intensity model based methods is the 
determination of the model. The modeling assumption in the N3 algorithm 
is that of a field model: the assumption that nonuniformity blurs the 
histogram of the data in a way that it can be identified, quantified, and 
removed. This nonuniformity blurring distribution is referred to as the 
blurring kernel F. The following equation is the basis of the N3 method:

 EQUATION 1

Where at location x, v is the measured signal, u is the true signal emitted by 
the tissue, f is an unknown smoothly varying bias field, and n is white Gaus-
sian noise assumed to be independent of u. As can be seen, the unknown 
smoothly varying bias field f multiplies the true signal u, thereby corrupting 
it. Then the additive noise n is added, resulting in the output measured sig-
nal v. To compensate for the intensity nonuniformity, the first task is to esti-
mate its distribution, or f.

Then taking the log of all parameters, we are left with ^u = log(u) and  
^f=log(f), both of which we assume to be independent or uncorrected ran-
dom variables of probability densities U, V, and F. Then substituting these 
variables back into Equation 1 and converting the equation of distributions 
into one of probability densities, the distribution of their sum turns into the 
following convolution, see Equation 2:

v x( ) u x( ) f x( ) n x( )+×=
MIPAV User’s Guide, Volume 2, Algorithms 687

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Shading Correction: Inhomogeneity N3 Correction
EQUATION 2

Equation 2 models the nonuniformity distribution F viewed as blurring the 
intensity distribution U.

Now the model of intensity nonuniformity used here is that of a multiplica-
tive field corrupting the measured intensities. However, viewing the model 
from a signal processing perspective, one sees that there is a much more 
specific consequence, a reduction of only high-frequency components of U. 
Thus, the approach used in the N3 algorithm to correct for nonuniformity 
turns into an optimization problem, which goal is to maximize the fre-
quency contents of U.

HOW THE N3 METHOD WORKS

We begin with only a measured distorted signal, or image, which we call v. 
For computational purposes, we do not deal with simple v, but instead, with 
log^v and the histogram distribution of the log, and use ^v to denote V. The 
same representations are used for the true signal, u, and the distortion sig-
nal, f.

The model assumed here is that of a multiplicative biasing field that multi-
plies the true signal to distort it, thereby creating a signal with induced field 
inhomogeneity. So, just as a multiplication takes place to corrupt the field, a 
division should undo the corruption. Now carrying this idea over to the fre-
quency domain where all of the computations take place, multiplications 
turn into convolutions and divisions turn into deconvolutions.

To begin with, all one has is v. Users provide a value for the kernel full-
width, half maximum (FWHM) of  f. Then, the iteration takes place as this 
estimate of  f is later used to compute U and then U input back into the 
algorithm to create another mapping, another f, and hence another U. The 
process then repeats until convergence. The result is an estimated true 
value of U.

V v̂( ) F v̂( ) U û( )× F v̂ û–( )U û( )d û( )= =
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Mapping from v to f

The approach adopted for finding U depends largely on the mapping from v 
to f. The idea is to propose a distribution of U by sharpening the distribution 
V and then estimating the corresponding smooth field log(f), which pro-
duces a distribution U close to the one proposed. However, rather than 
searching through the space of all distributions U, one can take advantage of 
the simple form of the distribution F. Suppose the distributions of F is 
Gaussian. Then one need only search the space of all distributions U corre-
sponding to Gaussian distributed F having zero mean and given variance. In 
this way the space of all distributions U is collapsed into a single dimension, 
the width of the F distribution. Thus, concludes the mapping N3 creates 
from v to f.

Estimating u throughout an entire volume:

EQUATION 3

Estimating u (voxel by voxel):

EQUATION 4

Algorithm flow chart

This algorithm performs the process shown in the flow chart in Figure 1. 
What was previously described was just the basic algorithm idea. The equa-
tions behind the steps in the process are shown in an enlarged section of the 
flow chart in Figure 2.

E û( )
ûF v̂ û–( )U û( ) û( )d

∞–
∞

∫

F û( )U û( ) û( )d
∞–

∞
∫

----------------------------------------------------------=

v̂ û E û v̂[ ]=–
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The algorithm does the following:

1 Identifies the foreground. In this step, the algorithm thresholds the 
background.

2 Resamples to working resolution. Use the input working resolution 
“subsampling factor.”

3 Logs transform intensities. 

4 Obtains the expectation of the real signal. Given a measured signal, the 
algorithm obtains the expectation of the real signal by performing a 
voxel by voxel difference between the logs of signal and estimate bias 
field.

5 Obtains an initial estimate of distribution U. The algorithm estimates 
distribution U, where U is a sharpened distribution of V. The sharpening 
is done using input parameters FWHM and Z. Given a distribution F 
and the measured distribution of intensities V, the distribution U can be 
estimated using a deconvolution filter as follows:

EQUATION 5

EQUATION 6

and

where 

F* denotes complex conjugate
~F is the fourier transform of F

Z is a constant term to limit the magnitude of ~G
This estimation of U is then used to estimate the corresponding field.

6 Computes the expectation of real signal—The algorithm computes the 
expectation of the real signal given measured signal (both logged). Full 
volume computation done using distributions U and Gaussian blurring 

G̃ F∗̃

F̃2 Z2˜+
------------------=

Û ĜV̂≈
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kernel F (whose FWHM parameter is given by users). A basic mapping 
from v to f. This is the iterative portion, which is shown the main loop in 
Figure 1.

7 Obtains a new field estimate—The difference between the measured 
signal and the newly computed expectation of the real signal given the 
measured signal (all variables logged).

EQUATION 7

8 Smooths the bias field estimate—Using the B-spline technique with the 
parameter d field distance input provided by users. 

EQUATION 8

9 Terminates iterations—The algorithm then checks for the convergence 
of field estimates. If the subsequent field estimate ratio becomes smaller 
than the end tolerance parameter input by users, the iterations are 
terminated. If not, a new F is used in step 2, and the iteration repeats 
step 4 through step 9.

EQUATION 9

where rn is the ratio between subsequent field estimates at the n-th location, 

s -denotes standard deviation, and m denotes mean. Typically after 10 
iterations, e drops below 0.001.

10 Completes the final steps—Given the measured signal, obtain the 
expectation of the real signal by calculating a voxel by voxel difference 
between logs of signal and an estimate of the bias field. Once iteration is 
complete, exponential transform intensities V and F, extrapolate field to 
volume, resample data back to original solution. Then divide v by f. The 
result is u.

EQUATION 10

fê v̂( ) v̂ E û v̂–=

fs v̂( ) S fe v̂( ){ }=

e s rn{ }
m rn{ }
----------------- n, 1.…N= =

u v
f
--=
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Figure 1.  Flow chart describing the N3 method
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the next figure.
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Figure 2.  The N3 method showing the equations
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Figure 3  shows an original image A and the image B produced from using 
the best N3 paratmeters:

• Treshold = 100

• Maximum iterations = 100

• End tolerance = 0.0001

• Field distance = 33.33

• Subsampling factor = 2

• Kernel FWHM = 0.8

• Wiener = 0.01

Figure 4 shows an original image and the effect of different parameters  
used in the Inhomogeneity N3 Correction algorithm on the image.

Figure 3.  The effect of N3 on an image: (A) original image and (B) 
image after N3 correction

(A) Original image (B) After N3 correction
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Figure 4.  The effects of different settings for the Inhomogeneity N3 
algorithm on an image
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REFERENCES

Refer to the following references for more information about the N3 algo-
rithm. 

Sled, John G., Alex P. Zijdenbos, and Alan C. Evans. “A Nonparametric Method for Automatic Correc-
tion of Intensity Nonuniformity in MRI Data.” IEEE Transactions on Medical Imaging, 17(February 
1998):87–97. 

Sled, John G. “A Non-Parametric Method for Automatic Correction of Intensity Non-uniformity in MRI 
Data.” Masters thesis, Department of Biomedical Engineering, McGill University, May 1997.

IMAGE TYPES

You should apply this algorithm only to 2D and 3D MRI images.

Applying the Inhomogeneity N3 algorithm
To run this algorithm, complete the following steps:

1 Open an image.

2 Select Algorithms > Shading correction > Inhomogeneity N3 correction. 
The N3 Inhomogeneity Correction dialog box opens.

3 Complete the information in the dialog box (refer to “Choosing good 
parameters for N3 Algorithm” on page 697  for advice on which values 
to select.

4 Click OK. The algorithm begins to run.

5 A pop-up window appears with the status. A series of status messages 
appear in the window. 

6 When the algorithm finishes running, the pop-up window closes.

7 Depending on whether you selected New image or Replace image, the 
results appear in a new window or replace the image to which the 
algorithm was applied.
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Choosing good parameters for N3 Algorithm

Signal threshold—Check the histogram for the minimum image values in 
the image. Make sure these values are smaller than the shading artifact. 
Generally, this value is about 100. To save time, use as high a threshold as 
possible.

Maximum number of iterations—Generally, this parameter is only 
important if you wish to terminate the process early by entering a number 
short of the number of iterations necessary for the algorithm to complete 
the process. However, to allow the algorithm to work to completion, a safe 
value to enter would be at least 100. Making it too high should have no con-
sequence.

End tolerance—When the remaining parameters are chosen optimally, 
this parameter tends not to have much of an affect. However, with less 
effective parameters, the end tolerance can make a large difference, bring-
ing the algorithm to work at least sparsely on large artifacts when a minimal 
end tolerance is chosen. The alternative is a high end tolerance, which can 
bring the shading correction to be almost nonexistent. In this case, the 
default value for this parameter is generally all right. For best results, how-
ever, use 0.0001. As far as timing, even with the minimum value, the pro-
cessing time does not vary much.

Field distance—A large field distance takes all shading artifacts to be 
large. Small independent ones are ignored, while small clustered ones are 
smeared into one. So with large smear-like gradual (light) artifacts, a large 
parameter works well. However, a small field distance is much more pre-
cise. Every little artifact is independently corrected, and the intensity with 
which the algorithm works is much higher as can be noted in the field 
images. The field image of an image corrected with a small field distance has 
several dark clusters, generally distributed throughout the image even to 
parts where artifact may not be noticeable even to users. The field image of 
an image corrected with a large field distance may have one or two large 
smears, and nothing more.

The main trade-off here is time. Very small field distances can increase the 
processing time immensely. So the lowest one should go for optimal results 
yet without spending too much time on one image, which has been found to 
be about 10. That value should really only be used with several intense and 
isolated artifacts. For regular images a third of the default is sufficient. For 
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quick results or for artifacts largely spread and not too strong, choose a 
value that is a little less than the default value, but more than half of the 
default value.

Subsampling—For best results, specify 1. However, keep in mind that the 
higher the precision (lower the subsampling), the higher the likelihood that 
certain low-intensity pixels inside the image are treated as background cre-
ating a speckle artifact.

Kernel FWHM—Use 0.5.

Wiener—Use 0.01.

Signal threshold Treats those voxels of intensity 
that are lower than this threshold 
value as background.

The default value is 1.0.

Max number 
iterations

Specifies the maximum number 
of iterations allowed before the 
process is terminated. 

The default value is 50.

End tolerance Specifies convergence when all 
membership functions (of the 
fuzzy C cluster segmentation) 
over all pixel locations j change 
by less than this tolerance value 
between two iterations. The 
default value is 0.001.

Field distance Specifies the characteristic distance over which the field varies. The distance 
between adjacent knots in B-spline fitting with at least 4 knots going in every 
dimension. The automatic default is one third of the distance (resolution * 
extents) of the smallest dimension.

Subsampling Factor Specifies the value by which data is subsampled to a lower resolution in 
estimating the slowly varying nonuniformity field. It reduces sampling in the 
finest sampling direction by the shrink factor. Sampling in other directions is 
reduced only if reduced sampling in direction of finest resolution is less than 
current sampling. The default value is 4.
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Figure 5.  N3 Inhomogeneity Correction dialog box

Kernel FWHM Specifies the width of deconvolution kernel F (a Gaussian) used to sharpen the 
V(pdf of log(v), where v is the measured signal) histogram. Larger values give 
faster convergence while smaller values give greater accuracy. The default value 
is 0.01.

Wiener Filter Noise Indicates the noise used in Wiener filter.

Whole image Applies the algorithm to the whole image.

VOI region(s) Applies the algorithm to the volumes (regions) delineated by the VOIs.

Automatic 
histogram 
thresholding

Computes a threshold value through histogram analysis that should remove just 
the background from the computation. Selecting this check box disables the 
Signal threshold box, the Whole image, and VOI regions.

Create field image Indicates whether to create a field image.

OK Applies the algorithm according to the specifications in this dialog box.

Cancel Disregards any changes you made in this dialog box and closes the dialog box.

Help Displays online help for this dialog box.
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Standard Deviation Threshold

 Background
Standard Deviation Threshold works by, first, examining an active VOI for 
which the standard deviation (st.dev) of pixel intensities and other statistics 
are calculated. The algorithm, then, thresholds an image using the user 
defined parameters, such as a number of standard deviations and/or values 
outside the range. The thresholding can be done on the whole image or, 
alternatively, on other not active VOI(s) that might be on the image.

Figure 1.  (a): an original image with delineated single VOI, (b): the image thresholded 
using the default parameters opened in a new image frame, (c) the thresholded image 
painted over the original image, (d) VOI statistics for the original image
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IMAGE TYPES

You can apply this algorithm to all 2D, 3D, and 4D color (RGB) and 
grayscale images.

 APPLYING THE ALGORITHM TO GRAYSCALE 
IMAGES

Note that in order to run Standard Deviation Threshold you should have at least 
one active VOI on your image.

To use this algorithm, do the following:

1 Select at least one VOI on your image.

2 Launch the tool from Algorithms > Segmentation > Threshold > 
Threshold Using Standard Deviation.

3 The top of the Threshold Using Standard Deviation dialog box will show 
the statistics for the active VOI(s). 

4 In the middle Threshold Parameters box enter the user input 
parameters, such as 

• Number of standard deviations, which is used to create the 
threshold range. Once you’ve defined the standard deviation for the 
normal tissue, the range is calculated using the Number of 
standard deviations parameter.

• Values outside threshold are the values that will be assigned to 
pixels which are outside of the threshold range. The default value is 
set to zero. This parameter is later used to for calculating an inverse 
threshold.

• Inverse threshold – this option is checked by default. When the 
Inverse threshold option is active, the image intensity values 
outside the threshold range are kept, and the ones in the threshold 
are set to the values outside.

• Set min threshold value to image min – once the intensity 
range is calculated, you might want to stretch out the range to image 
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min. This eliminates the background noise.

• Set max threshold to image max – use this option to stretch out 
the range to image max.

5 In the Destination Box, specify where you want the thresholded image 
to appear. You might choose between opening the thresholded image in 
a new image frame or paint it on the existing image.

6 You can apply the tool to the whole image or only to other VOI(s) that 
might be delineated in the image.

7 Press OK to run the algorithm.

Results get displayed in the Output window. See also Figure 1 and Figure 2.

THE THRESHOLD USING STANDARD 
DEVIATION DIALOG BOX OPTIONS FOR 
GRAYSCALE IMAGES:

Active VOI 
statistics

This box shows statistics for the 
selected VOI(s) which were used 
to calculate a standard deviation.

Number of pixels – a total 
number of pixels in selected 
VOI(s);

Sum pixel intensities – a sum 
of intensities over all pixels in 
VOI(S);

Average pixel intensity equals 
Sum pixel intensities divided to 
Number of pixels;

Standard deviation of pixel 
intensity is a standard deviation 
calculated based on the following 
values Number of pixels, Sum 
pixel intensities, and Average 
pixel intensity.

Threshold parameters

Figure 2.  Threshold Using Standard Deviation dialog box options for grayscale images  
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 APPLYING THE ALGORITHM TO RGB IMAGES

Note that in order to run Standard Deviation Threshold you should have at least 
one active VOI on your image.

To use this algorithm, do the following:

1 Select at least one VOI on your image.

2 Launch the tool from Algorithms > Segmentation > Threshold > 
Threshold Using Standard Deviation.

Number of 
standard 
deviations

is used to create the threshold range. Once you’ve defined the standard 
deviation for the normal tissue, the range is calculated using that parameter.

Values outside 
threshold 

are the values that will be assigned to pixels which are outside of the threshold 
range. The default value is set to zero.

Inverse 
threshold 

– this option is checked by default. When the Inverse threshold option is active, 
the image intensity values outside the threshold range are kept, and the ones 
in the threshold are set to the values outside.

Set min 
threshold value 
to image min

 – once the intensity range is calculated, use this parameter to stretch out the 
intensity range to image min. This helps to eliminate the background noise.

Set max 
threshold to 
image max 

– use this option to stretch out the range to image max.

 Destination In that box, specify where you want the thresholded image to appear. You might 
choose between opening the thresholded image in a new image frame or paint it 
on the existing image.

Threshold Select Whole Image to apply the tool to the whole image;

Select VOI(S) regions to apply the tool only to other VOI(s) that might be 
delineated in the image.

OK Applies the algorithm according to the specifications made in the dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this dialog 
box.

Help Displays online help for this dialog box.

Figure 2.  Threshold Using Standard Deviation dialog box options for grayscale images 
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3 The top of the Threshold Using Standard Deviation dialog box will show 
the statistics (per channel) for the active VOI(s). 

4 In the middle Threshold Parameters box enter the user input 
parameters, such as 

• Number of standard deviations, which is used to create the 
threshold range. Enter the number of st.dev for each channel – R, G, 
and B channels.

• Values outside threshold are the values that will be assigned to 
pixels which are outside of the threshold range. The default values 
for each channel are set to zero. These values are later used to for 
calculating an inverse threshold.

• Inverse threshold – this option is checked by default. When the 
Inverse threshold option is active, the image intensity values 
outside the threshold range are kept, and the ones in the threshold 
are set to the values outside.

• Set min threshold value for R, G, and B to image min – once 
the intensity range is calculated, you might want to stretch out the 
intensity range for each channel to image min. This eliminates the 
background noise.

• Set max threshold value for R, G, and B to image max – use 
this option to stretch out the intensity range for each channel to 
image max.

5 In the Destination Box, specify where you want the thresholded image 
to appear. You might choose between opening the thresholded image in 
a new image frame or paint it over the existing image.

6 You can apply the tool to the whole image or only to other VOI(s) that 
might be delineated in the image.

7 Press OK to run the algorithm.

Results get displayed in the Output window. See also Figure 3 and Figure 4.
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sm

Figure 3.  (a): an original RGB image with delineated single VOI, (b): the same image thresholded 
using the default parameters opened in a new image frame, (c) statistics for the original image 
appears in the Output MIPAV window, (d) the Threshold Using Standard Deviation dialog box for 
RGB images with the default settings
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THE THRESHOLD USING STANDARD 
DEVIATION DIALOG BOX OPTIONS FOR RGB 
IMAGES:

Active VOI 
statistics

This box shows statistics for the 
selected VOI(s) which were used 
to calculate a standard deviation.

Number of pixels – a total 
number of pixels in selected 
VOI(s);

Sum pixel intensities – a sum 
of intensities over all channels for 
all pixels in VOI(s);

Average pixel intensity equals 
Sum pixel intensities divided to 
Number of pixels;

Standard deviation of pixel 
intensity is a standard deviation 
calculated based on the following 
values Number of pixels, Sum 
pixel intensities, and Average 
pixel intensity.

Threshold parameters

Number of 
standard 
deviations per 
channel (R, G, 
and B)

is used to create the threshold 
range. Once you’ve defined the 
standard deviation for each 
channel R, G, and B for the 
normal tissue, the range is 
calculated using that parameter.

Values outside 
range (0 to 
255) 

are the values that will be assigned to pixels which are outside of the threshold range.
The default value is set to zero.

Inverse 
threshold 

– this option is checked by default. When the Inverse threshold option is active, the 
image intensity values outside the threshold range are kept, and the ones in the 
threshold are set to the values outside.

Set min threshold value to image min 

for each channel R, G, and B.

 – once the intensity range is calculated, use 
this parameter to stretch out the intensity 
range for each channel R, G, and B to image 
min. This helps to eliminate the background 
noise

Figure 4.  Threshold Using Standard Deviation dialog box options for RGB images  
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Set max threshold to image max 

for each channel R, G, and B

– use this option to stretch out the intensity 
range for each channel to image max.

 Destination In that box, specify where you want the thresholded image to appear. You might 
choose between opening the thresholded image in a new image frame or paint it on 
the existing image.

Threshold Select Whole Image to apply the tool to the whole image;

Select VOI(S) regions to apply the tool only to other VOI(s) that might be 
delineated in the image.

OK Applies the algorithm according to the specifications made in the dialog box.

Cancel Disregards any changes that you made in the dialog box and closes this dialog box.

Help Displays online help for this dialog box.

Figure 4.  Threshold Using Standard Deviation dialog box options for RGB images (continued) 
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Subsampling images

The subsample algorithm in MIPAV allows you to reduce an image in size 
by a factor of 2, 4, or 8 times. Each pixel of the subsampled image is a 
Gaussian-weighted average of the original image’s 8 neighboring pixels for 
2D images or 26 neighboring voxels for 3D images. For example, 
subsampling a 3D image with the x, y, and z dimensions of 256 x 256 x 32, 
respectively, by a factor of 2 produces a new image with x, y, and z 
dimensions of 128 x 128 x 16, respectively.

To subsample the images

1 Open an image (Figure 1).

2 Select Algorithms>Transformation tools > Subsample. The Subsample 
dialog box (Figure 2) opens.

.

3 Select one of the following:

Figure 1.  Original image before subsampling
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• Subsample by 2

• Subsample by 4

• Subsample by 8

• Select, as an option for 2.5D images only, the Process each slice 
independently (2.5D) check box.

Tip: If you are not working with 2.5D images, the Process each slice 
independently (2.5D) check box does not appear in the Subsample dialog box.

4 Click OK. A status message appears briefly while the program generates 
the subsampled image in a new image window.

Subsample by 2 Subsamples each 
image dimension by a 
factor of 2.

Subsample by 4 Subsamples each 
image dimension by a 
factor of 4.

Subsample by 8 Subsamples each 
image dimension by a 
factor of 8.

Process each slice 
independently 
(2.5D)

Filters each slice of the dataset independently of adjacent slices.

OK Applies the parameters that you specified to subsample the image.

Cancel Disregards any changes you made in this dialog box, closes the dialog box, 
and does not subsample the image.

Help Displays online help for this dialog box.

Figure 2.  Subsample dialog box
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Figure 3.  An image subsampled by 2, by 4, and then by 8
MIPAV User’s Guide, Volume 2, Algorithms 710

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Threshold
Threshold

The Threshold algorithm replaces the image pixel values with the fill 
values specified by a user. The pixel values change or remain unchanged 
depending on whether the original color value is within the threshold 
range. For RGB or RGBa images, the Threshold command works on each 
individual RGB channel.

Background

IMAGE TYPES

You can apply this algorithm to all 2D, 3D, and 4D color (RGB) and 
grayscale images.

 APPLYING THE THRESHOLD ALGORITHM

To use this algorithm, do the following:

1 Select Algorithms > Segmentation> Threshold in the MIPAV window. 
The Threshold dialog box (Figure 1) appears.

2 Complete the information in the dialog box.

3 Click OK. The algorithm begins to run, and a progress bar appears 
momentarily with the status. When the algorithm finishes running, the 
progress bar disappears, and the results appear in a separate image 
window.
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THE THRESHOLD DIALOG BOX OPTIONS:

Apply same threshold to all channels

If checked, applies the same threshold values to all RGB channels. In that 
case only the Red box becomes available for entering the threshold values. 
Other boxes became unavailable. 

 Use <red, green, or blue> channel

Applies the threshold operation to each channel independently. For each pixel, 
the R, G, and B values will set to 255 if it is in range for that particular channel 
and to 0 otherwise. 

Use inverse threshold

If checked, changes all pixels which are outside of the specified range. In that 
case you must specify the desired pixel values into the Set outside values 
text box. 

Red, Green, Blue

For each channel, specify the threshold values in the corresponding boxes – 
Red, Green or Blue:

Figure 1.  The Threshold dialog box.
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Lower limit – end of threshold range;

Upper Limit – beginning of threshold range;

Set outside values to: enter the pixel values for pixels outside the threshold.

New image – places the result of the algorithm in a new image window.

Replace image – replaces the current active image with the results of the 
algorithm.

Whole image – applies the algorithm to the whole image.

VOI region(s)– applies the algorithm to the selected VOI(s).

OK – applies the algorithm according to the specifications in this dialog box.

Cancel– disregards any changes that you made in the dialog box and closes 
this dialog box.

Help –Displays online help for this dialog box.
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Transform

The Transform/Resample dialog box is a user interface for transforming 
and (or) resampling images. It offers multiple options that help a user to, 
first, define the transformation matrix, and then execute the 
transformation and (or) resampling. The interpolation method can also be 
specified in the dialog box. The following interpolation techniques are 
implemented: Nearest-Neighbor, Bilinear, Trilinear, 3rd order B-spline, 
4th order B-spline, Cubic Lagrangian, Quintic Lagrangian, Heptic 
Lagrangian, or Windowed sinc. 

To learn more about interpolation techniques used in the method, refer to 
Chapter “Interpolation methods used in MIPAV” .

Background
The dialog box has two tabs – Transform and Resample, see Figure 1. The 
Transform tab allows the user to set up the transformation matrix and 
choose the interpolation method. The Resample tab is designed to set up the 
resampling interpolation. 

TRANSFORMING IMAGES

The Transform tab of the dialog box allows the user to transform an image 
using the transformation matrix that can be either

• A matrix associated with the image, 

• A matrix stored in a separate file, 

• Or the user defined matrix.

The Transform tab options

TRANSFORM

No transformation – if selected, this option disables all transformation 
options, but the interpolation options are still available. Therefore, the user 
can not perform the transformation, but is still able to run the interpolation 
for a chosen image.
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Use image's associated matrix – if checked, this option allows using a 
transformation matrix associated with the image. See Figure 1.

Read matrix from file – if checked, reads the transformation matrix 
from a file. The user should select the file where the transformation matrix 
is stored.

Use defined transformation matrix – if checked, makes available the 
transformation text boxes, which are used to design the user defined 
transformation matrix. In these boxes, the user can enter values for 
translation, rotation, scale, and skew. Refer to Figure 2.

OPTIONS

Interpolation list box is designed to help the user to select the interpola-
tion technique. The list of available interpolation methods includes: Bilin-
ear, Trilinear, 3rd order B-spline, 4th order B-spline, Cubic Lagrangian, 
Quintic Lagrangian, Heptic Lagrangian, Nearest-Neighbor, and Windowed 
sinc. 

The default interpolation is Bilinear for 2D images and for 3D or 4D images 
with each slice processed independently. The default interpolation is Trilin-

Figure 1.  Transformation options

Figure 2.  The options available for defining a transformation matrix: Tx, 
Ty, Tz in mm - translations in the X, Y, and Z directions; Rx, Ry, Rz in 
degrees - rotations along the X, Y, and Z axis; Sx, Sy, Sz - scale in the X, 
Y, and Z directions; SKx, SKy, and SKz – skew in the X, Y, and Z direc-
tions
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ear for 3D or 4D images when not using slice processing. To learn more 
about interpolation techniques used in the method, refer to “Interpolation 
methods used in MIPAV” .

Rotate about radio buttons are designed to specify the image rotation. If 
Origin is selected, the image will be rotated about the MIPAV origin which 
is the upper left hand corner of the image. If Center is selected, the image 
will be rotated about its center. If Use Scanner Center is selected, the image 
will be rotated about the scanner's center, this choice is available only for 
DICOM images. See Figure 3.

Retain original image size – if selected, this option preserves the image 
size. The image will be either padded by pixels with zero intensity (black 
pixels) to preserve its size, or cropped. See Figure 3 and Figure 4(b) – 
padded and (c) – cropped.

Pad image to include entire original image – if selected, this option 
pads the image. While using this option the user can also specify the 
intensity value for padding pixels (this works for 2D images only). See 
Figure 4(d).

In order to include the entire original image, you must select Pad image….

Clip output values to input image – if checked, the option preserves 
the original image type. That means that, the transformed image minimum 
value cannot decrease below the original image minimum value, and the 
transformed image maximum value cannot increase above the original 
image maximum value. This check box is disabled if Nearest-Neighbor, 
Bilinear, or Trilinear interpolation is selected, because when using these 
interpolations, minimum values can not decrease and maximum values can 
not increase.

Figure 3.  The rotation choices.
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Process each slice independently (2.5D) – if checked, this option 
allows transforming each image slice separately. This works for 3D and 4D 
images.

Update origin – if checked, this option updates the image origin accord-
ing to the new image size and resolution. By default, this option is activated.

Transform VOIs – if checked, the transformation is applied to both the 
image and to all the VOI(s). Regardless of what interpolation is applied to 

Figure 4.  Two examples of using the Retain original image size option 
for 2D images: (b) with padding and (c) with cropping. An example of 
using the Pad image option to include entire original image option is (d). 
(a) – the original 2D image, (b) – the image scaled to 0.5 in X direction, 
(c) – the image scaled to 2 in X direction, (d) – the image scaled to 0.5 
in X direction and padded with pixels with intensities equal to 140
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the image, Nearest-Neighbor interpolation is always applied to the VOI(s).

Invert matrix – if checked, this option inverts the transformation matrix, 
first, and then applies the transformation with the inverted matrix. This 
option can only be activated if the Use image's associated matrix or 
Read matrix from file option is selected. See Figure 1.

See also “To transform an image:” on page 720.

RESAMPLING IMAGES

The Resample tab of the dialog box allows the user to resample images: 

• to the size of a specified image;

• to the user defined size;

• or by the user defined factor.

New pixel values are computed using a weighted combination of existing 
pixel values within a defined neighborhood of the new pixel location. The 
interpolation methods used in this implementation of the resampling tech-
nique include all available via the Transform tab. If the user did not change 
the interpolation method in the Transform tab, Trilinear (or Bilinear for 2D 
images and for 3D and 4D with independent slice processing) interpolation 
is used.

For more information about interpolation methods used in the Transform/
Resample algorithm, refer to “Interpolation methods used in MIPAV” .

The Resample tab options

The Resample tab offers the following options, see Figure 6:

Resample to size of is used to select the image which has resolution, 
dimensions, and units of measurement used to resample the current image.

Set pixels to preserve FOV – if selected, preserves the image's field of 
view (FOV) while resampling the image.

User defined size option allows the user to specify both the resolution 
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and dimension to which the image should be resampled.

Preserve field of view – if this option is activated, the algorithm 
preserves the image's FOV while resampling the image.

Lock XY aspect ratio allows the user to preserve the XY aspect ratio.

Lock XYZ aspect ratio allows the user to preserve the ratio between Z 
and the XY plane for 3D and 4D images not using independent slice 
processing.

ResX, ResY, ResZ text boxes are used to specify the new image resolution 
in each direction.

DimX, DimY, DimZ text boxes are used to specify the new image size in 
each direction.

Resample by factor slider is used to choose the resampling factor. The 
slider allows selecting factor values from 0.25 to 4.0.

See also “To resample an image:” on page 721.

Figure 5.  The Resample tab
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IMAGE TYPES

The Transform/Resample algorithm works on 2D, 3D and 4D color and 
grayscale images.

REFERENCES

Refer to the following references for more information about the Transform   
algorithm: 

Paul Bourke, Interpolation methods, http://local.wasp.uwa.edu.au/~pbourke/other/
interpolation/index.html - Trilinear interpolation.

B-splines: http://www.cl.cam.ac.uk/teaching/1999/AGraphHCI/SMAG/node4.html

Chapter 3: “Registration Methodology: Concepts and Algorithms” by Derek L.G.Hill and 
Philipe Batchelor in Medical Image Registration edited by Joseph V. Hajnal, Derek L.G.Hill, 
and David J. Hawkes, CRC Press, 2001, pp. 40-70.

Chapter 33 “Within-Modality Registration Using Intensity-Based Cost Functions” by Roger 
P. Woods in Handbook of Medical Image Processing and Analysis, Editor, Isaac N. 
Bankman, Academic Press, 2000, pp. 529-553.

Thomas M. Lehmann,* Member, IEEE, Claudia Gonner, and Klaus Spitzer Survey: 
Interpolation Methods in Medical Image Processing. IEEE Transactions on Medical 
Imaging, Vol. 18, No. 11, November 1999, pp. 1049-1075.

OUTPUT

The transformed and (or) resampled image is displayed, see Figure 4 and 
Figure 6.

Applying the Transform/Resample algorithm

To transform an image:

1 Open an image of interest.

2 Call Algorithms>Transformation tools >Transform. 

3 In the Transform/Resample dialog box, open the Transform tab and do 
the following:
MIPAV User’s Guide, Volume 2, Algorithms 720

12/5/08 

http://local.wasp.uwa.edu.au/~pbourke/other/interpolation/index.html
http://www.cl.cam.ac.uk/teaching/1999/AGraphHCI/SMAG/node4.html


M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Transform
• To specify a transformation matrix, select one of the following 
options: No Transformation, Image Associated Matrix, Read Matrix 
from File, or User Defined Matrix.

• Select the interpolation method that will be used to create a 
transformed image.

• Specify the image origin.

• Specify whether to preserve the image size or not.

• Specify whether to clip the output image if the intensity values are 
outside the original image range.

• Indicate if you wish to apply the transformation to all image's VOI(s) 
in addition to the image.

• Other options.

4 Click OK. The algorithm begins to run, and a progress bar appears 
momentarily with the status. When the algorithm finishes running, the 
progress bar disappears, and the result appears in a separate image 
window.

The transformation algorithm begins to run. When the algorithm finishes 
running, the transformed image appears in a new image frame. See also 
Section “The Transform tab options” on page 714.

To resample an image:

1 Open an image of interest.

2 Call Algorithms>Transformation tools >Transform. 

3 In the Transform/Resample dialog box, navigate to the Resample tab.

4 Use the Resample tab options to specify the size of the new resampled 
image.

• You can choose to resample the original image to the size of some 
other image, or you can choose to specify the new image size, or you 
can use the Resample Factor slider.

• When selecting the user defined size, you might also choose to 
preserve a field of view. You can lock the XY aspect ratio for 2D 
images and for 3D and 4D images using independent slice 
processing. You can lock the XYZ aspect ratio for 3D and 4D images 
not using independent slice processing.

• The interpolation method that will be used to create a resampled 
image must be specified in the Transform tab, refer to “The 
Transform tab options” on page 714.
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5 Press OK. The algorithm begins to run. When the resampling algorithm 
finishes running, the result image appears in a new image frame. See 
Figure 6. See also Section 1.2.1 “The Resample tab options.”

Figure 6.  Resampling images: (a) the original image, (b) the image 
resampled by 0.5 in X direction while the XY aspect ratio has been 
preserved, (c) the image resampled by 2 in X direction while the XY 
aspect ratio has been preserved
MIPAV User’s Guide, Volume 2, Algorithms 722

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Transform: Conformal Mapping Algorithms
Transform: Conformal Mapping Algorithms

The methods described in this document use conformal mapping to 
transform points in a circular sector, circle, ellipse, or nearly circular 
region to points in a circle or rectangle.

Background
A conformal mapping, is a transformation w=f(z) that preserves local 
angles. An analytic function is conformal at any point where it has a 
nonzero first derivative. A complex function is analytic on a region R if it is 
complex differentiable at every point in R. In a conformal mapping, in any 
small neighborhood the relative angle and shape are preserved.

CIRCULAR SECTOR TO RECTANGLE

The algorithm uses a 2D conformal mapping to convert a circular sector, 
defined by four user points at the sector corners, to a rectangle of the user 
specified size. The circular sector has an inner radius rmin, an outer radius 
rmax, and extends over an angle theta = alpha* pi radians, with 0 < alpha 
<= 1.

Let, z1 and z2 belong to rmax, and z3 and z4 belong to rmin as shown in 

Figure 1. The mapping to the user specified rectangle is performed in the 
following steps (1–6):

1 The maximum radius can be facing to the top, bottom, right, or left. So 
the algorithm, first, determines which of 4 orientations is present. 

2 Calculating the center of the circular segment. The center is calculated 
as a point (xc, yc) where two lines (z3, z2) and (z4, z1) cross. Therefore,

EQUATION 1
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3 Calculating the angle of the sector in radians, see Figure 2.

The angle is calculated as follows theta = theta2 - theta1. 

For the maximum radius facing to the left, we must take into account the 
discontinuity of the angle at the negative x axis. The angle changes from -Pi 
to Pi, so the equation for theta is now:

theta = abs(theta1) + abs(theta2) - 2.0 * Pi

The angle theta1 is along the line from center to z4 to z1 in - Pi to Pi radians:

tan(theta1) = ((y1 - y4)/(x1 - x4)) => theta1 = arctan((y1 - y4)/(x1 - x4))

the angle theta2 is along the line from center to z3 to z2 in - Pi to Pi radians:

tan(theta2)= ((y2 - y3)/(x2 - x3)) => theta2 = arctan((y2 - y3)/(x2 - x3))

4 For the conformal mapping, it requires that rmax > 1 and 0 < rmin < 1. 

Refer to “A Domain Decomposition Method for Conformal Mapping 
onto a Rectangle” Remark 4.7 (see “References” on page 733). The 
transformation theory is based on a mathematical crosscut along the 
unit circle.

Figure 1.  Calculating the center of the circle to which the circular 
segment belongs

Figure 2.  Calculating the angle of the circular segment
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Therefore, the algorithm divides all the distances from the circular center by 

. It produces a value of r so that

  < r < 

5 To convert a circular sector to a rectangle, the algorithm uses the 
following transformation function 

EQUATION 2

w = f(z) = u + iv = log(z)/(i*alpha* pi)

Let z =r*exp(i*theta)

Then, 

EQUATION 3

w = log(r*exp(i*theta))/(i*alpha* pi) =>
w= theta/(alpha* pi) - i*log(r)/(alpha* pi) 

u =theta/(alpha* pi), 
v = -log(r)/(alpha* pi)

Since conformal mapping requires that f(z) must be analytic on all points, 
the Cauchy-Riemann equations must be satisfied and f'(z) must not equal 
zero.

Satisfying the Cauchy-Riemann equations

Suppose that f(z)=f(x+iy)=u(x,y)+iv(x,y) is differentiable at the point 
z0=x0+iy0. Then, the partial derivatives of u and v exist at the point (x0, y0), 

and

EQUATION 4
MIPAV User’s Guide, Volume 2, Algorithms 725

12/5/08 



M   I   P   A   V
M e d i c a l   I m a g e   P r o c e s s i n g, A n a l y s i s,   &   V i s u a l i z a t i o n

Chapter 2, Using MIPAV Algorithms: Transform: Conformal Mapping Algorithms
Equating the real and imaginary parts gives

EQUATION 5

ux(x0, y0)=vy(x0, y0) and uy(x0, y0)=-vx(x0, y0)

The Cauchy-Riemann equations in polar form are:

EQUATION 6

du/dr = (1/r) (dv/dtheta)
-dv/dr = (1/r) (du/dtheta)

The first equation gives zero on both sides and the second equation gives 
(alpha* Pi)/r on both sides, so the Cauchy-Riemann equations hold.

Satisfying the non zero first derivative

EQUATION 7

f'(z) = 1/(i*alpha* pi *z), f’(z)=!0 except at infinity.

6 Now, the algorithm performs a conformal mapping from the circular 
segment to a rectangle of width 1 and height log(rmax/rmin)/theta. 

Values for f(z1), f(z2), f(z3), and f(z4) are as follows:

EQUATION 8
 

EQUATION 9
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EQUATION 10

EQUATION 11

7 Then, the rectangle from step 6 is linearly scaled to a rectangle of user 
specified xDim and yDim. Note that the linear scaling of one rectangle to 

another is not a conformal mapping unless the width and height are 
scaled by the same factor. When the maximum radius faces to the top, 
this gives us the following values for z1’, z2’, z3’and z4’:

z1’= (xDim-1, 0),

z2’= (0, 0),

z3’= (0, yDim-1),

z4’= (xDim-1, yDim-1)

Figure 3.  The region inside a circular sector is mapped to a rectangle:   
z1 is the upper right point on rmax, z2 is the upper left point on rmax, z3 is 
the lower left point on rmin, and z4 is the lower right point on rmin
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TRANSFORMATION: CIRCLE TO RECTANGLE

The algorithm uses a 2D conformal mapping to convert a circle to a 
rectangle of the user specified size. The circle has the radius r.

The user inputs 2 point VOIs. The first point is located at the center of the 
circle. The second point can be any point located on the actual circle. The 
user also inputs the X and Y dimensions (xDimDest and yDimDest) of the 
output image. See Figure 4. The algorithm performs three mappings to go 
from the circular area specified by the user to an output rectangle.

Mapping 1 

It maps from the destination rectangle to a rectangle centered on the origin. 
This is the mapping from a rectangle with the edge points (0,0), (xDimDest-
1, 0), (xDimDest-1, yDimDest-1), (0, yDimDest-1) to a rectangle with the 
edge points (-K,Kp), (K,Kp), (K,-Kp), (-K,-Kp).

Where K is the complete elliptic integral of the first kind using the modulus 
and Kp is the complete elliptic integral of the first kind using the 

Figure 4.  The user inputs 2 point VOIs. The first point is located at the 
center of the circle. The second point can be any point located on the 
actual circle
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complementary modulus: 

The modulus m belongs to the interval [0,1] and is arbitrarily chosen as 0.5.

Mapping 2 

This is a conformal mapping from the origin centered rectangle to the unit 
circle using:

EQUATION 12

where z is the input complex number, w is the output complex number, and 
cn(z, modulus) is the Jacobian Elliptic function of type cn.

Mapping 3 

The algorithm scales and translates from the unit circle to the user selected 
circle. It uses bilinear interpolation to find the contributions from the four 
nearest neighbors in the original user selected circle.

TRANSFORMATION: ELLIPSE TO CIRCLE

This algorithm performs the conformal mapping of an ellipse to a circle with 
the user defined radius.

Let's consider the original ellipse as having a tilt theta with the X axis. Then 
the conformal mapping from an ellipse to a circle is done in three following 
steps.

In the first step, the algorithm translates the circle from the center of the 
destination square image to the origin, rotates the circle by the angle -theta 
and converts it to a unit disc by dividing the distance from the center by the 
radius.
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The algorithm places the center of the circle on the center of the destination 
image. The algorithm considers only the points located on the destination 
circle, e.g. (j - yc)*(j - yc) + (i - xc)*(i - xc) less or equal radSq.

Then, it translates the circle to the image origin, so that

EQUATION 13

xp = i - xc

yp = j - yc

After that, it rotates around the circle by the angle -theta

EQUATION 14

xrot = xp * cos(theta) + yp * sin(theta)

yrot = -xp * sin(theta) + yp * cos(theta)

And the following step scales the circle to a unit disc:

EQUATION 15

xrot = xrot/radius 

yrot = yrot/radius

In the second step, it maps from the unit disc to a standard ellipse on the 
X axis with foci at (-1,0) (1,0) and with the same major axis/minor axis ratio 
as the original ellipse.

Let 2*a = major axis, 2*b = minor axis of the original ellipse.

For an ellipse with its center at the origin and foci on the X axis:

EQUATION 16

[x2/a2] + [y2/b2] = 1

The standard ellipse used here has foci at (-1,0) (1,0) and is of the form:

EQUATION 17

(x2/cosh2 (xi)) + (y2/sinh2 (xi)) = 1

To scale from the original ellipse to the standard ellipse, the algorithm uses 
the following transform:

EQUATION 18

tanh(xi) = sinh(xi)/cosh(xi) = b/a = minor axis/major axis = axisRatio
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xi = arg tanh(axisRatio)

xi = 0.5 * log((1 + axisRatio)/(1 - axisRatio))

To conformal map from the unit disc to the standard ellipse, the algorithm 
uses the following transform T1:

EQUATION 19

Where, K(s) is the complete elliptic integral of the first kind and F is the 
incomplete or normal elliptic integral of the first kind such that: 

EQUATION 20

Because the elliptical integral functions in MIPAV all use the form:

EQUATION 21

So x in the elliptical integral form used in Equation 20 equals sin(.) in the 
elliptical integral form used in MIPAV, or phi = arcsin(x):

For complex z

EQUATION 22

Now how to find s:
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EQUATION 23

Where u(s) decreases from infinity to zero as s moves from zero to one.

In the third step, the algorithm maps from the standard ellipse to the 
original ellipse by rotating, scaling, and translating. It uses bilinear 
interpolation to find the contributions from the four nearest neighbors in 
the original ellipse space.

TRANSFORMATION: NEARLY CIRCULAR 
REGION TO CIRCLE

The algorithm uses 2D conformal mapping to convert a not quite circular 
region, defined by the user defined VOI, to a circle of the user specified size. 

The conformal mapping is done in three steps:

1 It translates the circle from the center of the square image to the origin, 
and then converts it to a unit disc by dividing the distance from the 
center by the radius.

2 It maps from the unit circle to a unit nearly circular region at the origin.

3 It maps from the unit nearly circular region at the origin to the original 
nearly circular region by scaling and translating.

According to the Nehari book (see “References” on page 733) the function 
F(z):

EQUATION 24

maps |z|< 1 onto the nearly circular domain which boundary has the polar 

equation  where  is bounded and piecewise continuous and 

 is a small positive parameter. For more information, refer to Conformal 
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Mapping by Zeev Nehari, Dover Publications, Inc., 1952 see “References” .
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“2D-Shape Analysis Using Conformal Mapping” by E. Sharon and D. Mumford, 
International Journal of Computer Vision, Volume 70, Issue 1 (October 2006) pp: 55 - 75,     
2006, ISSN: 0920-5691.

A Domain Decomposition Method for Conformal Mapping onto a Rectangle”, N. 
Papamichael and N. S. Stylianopoulos, Constructive Approximation, Vol. 7, 1991, pp. 349-
379. Relevant result is given in Remark 4.7 on pages 374-375.

Advanced Calculus for Applications, Second Edition by F. B. Hildebrand, Section 10.4 
“Analytic Functions of a Complex Variable” pages 550-554 and Section 11.4 Conformal 
Mapping pages 628-632, Prentice-Hall, Inc., 1976. 

Applied and Computational Complex Analysis, Volume I by Peter Henrici, Chapter “On 
Schwarz-Christoffel Mapping Function”, pp. 411-412., John Wiley and Sons, Inc., 1974.

Conformal Mapping by Zeev Nehari, Dover Publications, Inc., 1952, Chapter V, “Conformal 
Mapping of Simply Connected Domains”, Section 11, “Conformal Mapping of Nearly Circular 
Domains”, pp. 263 - 265 and Chapter VI, “Mapping Properties of Special Functions”, Section 
3, “Elliptic Functions”, pp. 280-299.

“On Conformal Representations of the Interior of an Ellipse” by Stanislawa Kanas and 
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2006, pp. 329-348.
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Jacobi's elliptic functions, refer to http://en.wikipedia.org/wiki/Jacobian_elliptic_functions

Complete Elliptic Integral of the First Kind, refer to http://mathworld.wolfram.com/
CompleteEllipticIntegraloftheFirstKind.html

http://mathworld.com/InverseSine.html

http://mathworld.wolfram.com/LemniscateFunction.html

Applying the Circular Sector to Rectangle algorithm

IMAGE TYPES 

The algorithms can be applied to all ultrasound images that can be opened 
in MIPAV.
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RUNNING THE ALGORITHM

To run the Circular Sector to Rectangle algorithm, do the following:

1 Open an image of interest. The image must be a 2D color (RGB) or 
grayscale image.

2 Call Algorithms > Transformation > Circular Sector to Rectangle.

3 Put four points (use the Point VOI tool) at the edges of the ultrasound 
image.

4 Make sure that points 1 and 2 are located at the edges of the max radius 
boundary and points 3 and 4 located at the edges of the min radius 
boundary.

5 Specify the X and Y output dimensions. Press OK.

6 The algorithm begins to run and the output image appears in a new 
image frame. See Figure 5.

To verify that the circle center and points z3, and z2 are collinear and also the 

circle center and z4, and z1 are collinear, use the MIPAV line drawing tool, see 

Figure 5.

Figure 5.  Applying the Circular Segment to Rectangle algorithm
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Applying the Circle to Rectangle algorithm

IMAGE TYPES

The Ellipse to Circle algorithm works on 2D color and black and white 
images.

RUNNING THE ALGORITHM

To run the Circle to Rectangle to Rectangle algorithm, do the following:

1 Open an image of interest. The image must be a 2D color (RGB) or 
grayscale image.

2 Call Algorithms > Transformation > Circle to Rectangle.

3 Put two point VOIs on the image   the first point must be located at the 
center of the circle and the second point can be any point located on the 
actual circle. See Figure 6.

4 Specify the X and Y output dimensions. Press OK.

The algorithm begins to run and the output image appears in a new image 
frame.

Figure 6.  Applying the Circle to Rectangle algorithm
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Applying the Ellipse to Circle algorithm

IMAGE TYPES

The Ellipse to Circle algorithm works on 2D color and black and white 
images.

RUNNING THE ALGORITHM

To run the Ellipse to Circle algorithm, do the following:

1 Open an image of interest. The image must be a 2D color or black and 
white image.

2 Call Algorithms > Transformation > Ellipse to Circle.

3 Delineate an elliptical VOI on the image. See Figure 7.

4 In the Ellipse to Circle Conformal Mapping dialog box, specify the X and 
Y output dimensions. Note that because the output image must be a 
square image you need to specify only one dimension. Press OK.

The algorithm begins to run and the output image appears in a new image 
frame. See Figure 7.

Figure 7.  Applying the Ellipse to Circle algorithm: (a)-the eye image, 
(b)-the distorted eye image with an elliptical VOI, (c)-the part of the 
image under the VOI is transformed to a circle using the dialog box 
settings
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Applying the Nearly Circle to Circle algorithm

IMAGE TYPES

The Nearly Circle to Circle algorithm works on 2D color and black and white 
images.

RUNNING THE ALGORITHM

To run the Nearly Circle to Circle algorithm, do the following:

1 Open an image of interest. 

2 Call Algorithms > Transformation > Nearly Circle to Circle.

3 Delineate a VOI on the image. See Figure 8.

4 In the Nearly Circle to Circle Conformal Mapping dialog box, specify the 
output dimension. Note that because the output image must be a square 
image, you need to specify only one dimension. Press OK.

The algorithm begins to run and the output image appears in a new image 
frame.

Figure 8.  Applying the Nearly Circle to Circle algorithm: (a)-the eye 
image with a nearly circular VOI, (b)-the part of the image under the 
VOI is transformed to a circle using the dialog box settings
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Transform Nonlinear

The Transform Nonlinear (TransformBSpline) algorithm takes a source 
image and uses information read in from a nonlinear transformation 
(.nlt) file to perform a nonlinear B-Spline transformation on the image. 
For the B-Spline transformation, the dimensionality of the transformed 
image, the degree of the B-Spline (ranging from 1 to 4), the number of 
control points, and the values of the control points are obtained from the 
.nlt file. See Figure 2.

The .nlt file is an output file that appears after applying the “B-Spline 
Automatic Registration” algorithm to images. It can be found in the 
directory where your image of interest is located. The name of the .nlt file is 
the same as the name of the image file.

Note: make sure that the dimensions of the source image used in the .nlt file are 
the same as the dimensions of the source image used in the Transform Nonlinear 
algorithm.

Background
Refer to MIPAV Uses Guide Volume 2, Algorithms, “B-Spline Automatic 
Registration” .

IMAGE TYPES 

You can apply this algorithm to color (RGB) and grayscale 2D and 3D 
images. 

Applying the Transform Nonlinear algorithm

To run the algorithm, complete the following steps:

1 Open an image of interest;

2 Select Algorithms > Transformation tools > Transform Nonlinear;

3 The Nonlinear B-Spline Transformation dialog box appears;
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4 Use the Load button to select and open an appropriate .nlt file;

5 Press OK.

The algorithm begins to run, and a progress bar appears with the status. 
When the algorithm finishes running, the transformed image appears in a 
new image frame.

Figure 1.  Applying the Transform Nonlinear algorithm
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Figure 2.  A sample .nlt file
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Transform to power of 2

The Transform to power of 2 algorithm resamples the original image to dimensions 
that are powers of 2.

Background
By default, this algorithm will use Bilinear Interpolation for 2D images or 
Trilinear Interpolation for 3D images to resample the original image to 
dimensions that are powers of 2. 

Optionally, you can select another type of interpolation that will be used in 
the algorithm.

The parameters required are the expected extents in all dimensions.

The algorithm uses the following to calculate the appropriate new 
dimension size as a power of 2.

User inputs of <= 16 will result in 16.

User inputs of >16 and <= 40 will result in 32

User inputs of >40 and <= 80 will result in 64

User inputs of >80 and <= 160 will result in 128

User inputs of >160 and <= 448 will result in 256

IMAGE TYPES 

You can apply this algorithm to color and black-and-white images as well as 
2D and 3D image types. 
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Applying the Transform to Power of 2 Algorithm

To run the algorithm, complete the following steps:

1 Open an image of interest;

2 Select Algorithms > Transformation tools > Transform to power of 2;

3 Input the expected dimension sizes;

4 Optionally, select type of interpolation to be used in algorithm;

5 Press OK.

The algorithm begins to run, and a progress bar appears with the status. 
When the algorithm finishes running, the progress bar disappears, and the 
results appear as a file in selected format in a chosen location. For more 

information about the dialog box options, refer to Figure 1.    

Figure 1.  The Resample dialog box options

Original Extents 
extent X

X dimension of original 
image.

Original Extents 
extent Y

Y dimension of original 
image.

Original Extents 
extent Z

Z dimension of original 
image (if image is 3D).

Expected 
Extents extent 
X

Expected X dimension.

Expected 
Extents extent 
Y

Expected Y dimension.

Expected 
Extents extent 
Z

Expected Z dimension (if 
image is 3D).

Interpolation Specifies the type of interpolation the algorithm will use when resampling. The 
list includes: Trilinear, B-spline 3-rd order, B-spline 4-th order, Cubic Lagrangian, 
Quintic Lagrangian, Heptic Lagrangian, Windowed Sinc.

OK Applies the algorithm according to the specifications in this dialog box. 

Cancel Disregards any changes that you made in this dialog box and closes it.

Help Displays online help for this dialog box.
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Watershed

Watershed segmentation in MIPAV is an interactive algorithm that allows 
automatically segment the image regions of interest. The watershed 
transformation performs gray scale segmentation using the topographical 
approach. Interpreting an image as a topographical relief, the algorithm 
performs flooding starting from regional minima, which are seen as 
plateaus of constant altitude surrounded only by pixels of higher gray 
levels. Dams or watershed lines are built when pixels from different basins 
meet or when the pixel’s gray level reaches a certain threshold value which 
represents the image’s background.

Background

1 The user is asked to identify the background pixels and initial region(s) 
using VOIs. At least two VOIs are required – the first one to specify the 
image’s background and the second one to outline the image region(s) 
the user wish to segment (this VOI(s) represents the initial region(s)). 

Note that the order in which VOIs are defined on the image is important. The 
first VOI must always outline background pixels.

2 Inside each initial VOI, the algorithm finds the seed point and forms the 
seed vector.

3 For each seed point, it finds the local minimum and labels it as a 
catchment basin.

Figure 1.  1D example of watershed segmentation: (a) grey level profile 
of the image data, (b) watershed segmentation
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4 Then, the algorithm starts filling all catchment basins. E.g. imagine that 
there is a hole in each local minimum, and that the topographic surface 
is immersed in water and water starts filling all catchment basins from 
the bottom. If two catchment basins merge as a result of further 
immersion or when the pixel gray values from one of the basins reach a 
threshold determined by the background intensity values, a dam is built 
all the way to the highest surface altitude and the dam represents the 
watershed line. See Figure 1.

5 The algorithm, first, sorts the pixels in increasing order of their gray 
values, and then it performs a flooding step.

6 During the sorting step, the algorithm computes a gray-level histogram. 
And it also creates a vector H of pointers to pixels of gray-level h. For all 
gray-levels, starting from below pixels having gray-level h are processed 
(flooded). These pixels are directly accessed through the vector H.

7 Then, the algorithm computes the geodesic influence zones of the 
already labeled catchment basins at the next level h-1. The geodesic 
influence zone of a basin Bi are the pixels of gray-level hi which are 
closer to Bi than to any other catchment basin Bj. See Figure 1 and 
Figure 2.

8 The algorithm assigns the pixels having a certain gray-level hi to the 
corresponding geodesic influence zone.

9 Pixels that do not belong to the labeled catchment basin or geodesic 
influence zone represent the background.

Raw watershed segmentation produces a severely over segmented image 
with hundreds or thousands of catchment basins. To overcome that 
problem the following techniques are used in this implementation of the 
algorithm:

• Smoothing using Gaussian blur to remove small local minima before 
applying the algorithm.

• The user is asked to specify the image region(s) he (she) wishes to 
segment using VOIs.

• Post-processing that includes merging of found regions.
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REFERENCES

The following sources were used to create this help. 

http://www.icaen.uiowa.edu/~dip/LECTURE/Segmentation3.html#watershed

http://www.itk.org/HTML/WatershedSegmentationExample.html

IMAGE TYPES

You can apply this algorithm to 2D and 3D grayscale images.

(a) (b)

(c)

(a) – the original image with two VOIs: the VOI1 
highlights the image background and VOI2 is a 
group of three VOI delineated inside the objects 
we wish to segment

(b) this figure illustrates step 2 to step 7 of the 
algorithm

(c) the result segmented image

Figure 2.  Segmenting images using the interactive Watershed algorithm
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Applying the Watershed algorithm
Before applying the algorithm, 

• Convert color images to grayscale ones;

• Smooth the image to remove noise if needed, use the algorithms 
available via the Algorithms > Filters (spatial) menu.

To run the algorithm

1 Open an image of interest.

2 In the image, delineate at least two VOIs – the first one for background 
and the second one for the object(s) you wish to segment.

3 In the MIPAV window, select Algorithms > Segmentation >Watershed. 
The Watershed dialog box (see Figure 3) appears.

4 Complete the information in the dialog box.

5 Click OK. The algorithm begins to run, and a progress bar appears 
momentarily with the status. When the algorithm finishes running, the 
progress bar disappears, and the result appears in a separate image 
window. See Figure 2-c.

Energy file

Use pre-calculated 
energy file 

The energy file is generally a gradi-
ent magnitude image and the 
intensity peaks in this image are 
the watersheds boundaries. The 
algorithm creates and saves the 
energy file automatically when you 
first time run the algorithm for a 
chosen image. When you run the 
algorithm for the same image next 
time you have an option to open 
and use the previously saved 
energy file for your segmentation.

Scale of the 
Gaussian

Specify the scale of the Gaussian for each dimension. The Z Dimension 
option is only available for 3D images.

Use image 
resolutions to 
normalize Z scale

If checked, this option allows using the image resolutions to normalize the 
voxel size in Z dimension.

OK Applies the Watershed algorithm according to the specifications in this 
dialog box.

Figure 3.  Watershed dialog box
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Cancel Disregards any changes that you made in the dialog box and closes this 
dialog box.

Help Displays online help for this dialog box.

Figure 3.  Watershed dialog box (continued)
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Glossary
This glossary defines all acronyms and selected terms used in this guide. 

Numerics

2D. Two dimensional.

3D. Three dimensional.

4D. Four dimensional.

5D. Five dimensional.

A

ACR. American College of Radiology. The ACR, in conjunction with 
National Electrical Manufacturers Association, developed the Digital 
Image Communication in Medicine standard.

AE. Application entity.

Analyze. Unix-based medical-imaging display and analysis software 
developed by the Mayo Foundation. MIPAV allows researchers to 
process, analyze, and visualize Analyze-formatted image files on virtually 
any platform.
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API. Application program interface. Pieces of code that are used to 
perform common tasks, such as generate a standard window frame. 
Software developers often incorporate these pieces of code into their 
programs. An API is analogous to a package of form letters; APIs reduce 
programming time because common functions have already been written.

BMP. Extension for Windows Bitmap formatted files. BMP is the 
standard bitmap graphics file format that is used in the MS Windows 
environment.

boolean. This data type refers to data that represents symbolic 
relationships between entities, such as those implied by the logical 
operators AND, NOT, and OR. Examples of valid boolean values are 
TRUE and FALSE.

bytecode. Compiled format for Java code. Bytecode is analogous to 
object code. When the Java program is written and compiled, the 
compiled program is written in bytecode. When you execute the bytecode 
program, it is interpreted by the platform-specific Java Virtual Machine, 
which serves as an interface between your platform and the platform-
independent bytecode. Java bytecode can be ported to almost any 
platform and executed, provided the correct Java Virtual Machine has 
been installed.

CIT. Center for Information Technology. CIT provides, coordinates, and 
manages information technology so that computational science at the 
National Institutes of Health is advanced.

color 24. Color 24 is commonly referred to as 24-bit color images. Full 
RGB color requires that the intensities of three color components be 
specified for each and every pixel. It is common for each component 
intensity to be stored as an 8-bit integer, and so each pixel requires 24 
bits to completely and accurately specify its color. Image formats that 
store a full 24 bits to describe the color of each and every pixel are 
therefore known as 24-bit color images. 

CR. Computed radiography.
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C-STORE. Composite Storage. 

CT. Computed Tomography.

data type. A set of values from which a variable, constant, function, or 
expression may take its value. MIPAV accommodates the following data 
types: Boolean, Signed Byte, Unsigned Byte, Signed Short, Unsigned 
Short, Integer, Long, Float, Double, and Color 24. 

DCB. Division of Computational Bioscience. DCB is a research and 
development organization that provides engineering and computer 
science expertise to support biomedical research activities at the National 
Institutes of Health (NIH). DCB applies image processing and medical 
imaging technologies, high-performance parallel computing, high-speed 
networking, signal processing, state-of-the-art optical and electronic 
devices, bioinformatics, database technology, mathematical and 
statistical techniques, and modern hardware and software engineering 
principles to help solve biomedical research problems at NIH. 

DICOM. Digital Image Communication in Medicine. Standard protocol 
developed by the American College of Radiology (ACR) and National 
Electrical Manufacturers Association (NEMA). Specifies a standard 
method of communication between two devices. 

Double. Primitive, 64-bit, data type. Double is a floating point data type 
that accommodates decimal values, up to 14 or 15 significant digits of 

accuracy. Valid values can range from -1.7 x 10308 to 1.7 x 10308.

Endian. Data organization strategy. Refers to the way computer 
processors store data in memory. Big-endian format stores the most 
significant byte (MSB) first. Little-endian format stores the least 
significant byte (LSB) first.
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FF. Feet first.

Float. Primitive, 32-bit, data type. Float is a floating point data type that 
accommodates decimal values, up to 6 or 7 significant digits of accuracy. 

Valid values can range from -3.4 x 1038 to 3.4 x 1038.

FTP. File Transfer Protocol.

GIF. Graphic Interchange Format. A compressed, bit mapped, graphics 
file format that supports color and various resolutions.

GUI. Graphical user interface. A user interface that is based on graphics 
rather than text.

header offset. Space reserved at the beginning of some graphic files 
that contain non-image data.

HF. Head First

HP. Hewlett-Packard.

HSB. Hue Saturation Brightness. In this color model, hue is the color, 
saturation is the purity of the color; and brightness indicates the 
brightness or darkness of the color.

ID. Identifier.

IE. Information Entity. 

integer. Primitive, 32-bit, data type. Integer is sometimes abbreviated 
as int. Integer accommodates values that are whole numbers. Valid 
values range from -2,147,483,648 to +2,147,483,648.
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interlaced. A display technique that increases resolution. Half of the 
horizontal lines are drawn on the monitor during the first pass; the other 
half are drawn during the second pass. For example, the odd numbered 
lines may be drawn during the first pass and the even numbered lines 
during the second pass.

interpolation. The generation of intermediate values based on known 
values.

IOD. Information Object Definition

IOD. Information Object Definition. Provides an abstract definition of 
real-world objects applicable to the communication of digital medical 
information.

IP. Internet Protocol.

Java. High-level, object-oriented, platform-independent programming 
language developed by Sun Microsystems.

Java VM. Java Virtual Machine. 

JIT. Just-In-Time compiler. The JIT converts Java bytecode into 
machine language instructions. 

JPEG. Extension for Joint Photographics Experts Group formatted files. 
Also refers to a compression type.
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Linux. An operating system that is an open source implementation of 
UNIX. 

Long. Primitive, 64-bit data type. Long is a variation of the integer data 
type. Long accommodates values that are whole numbers. Valid values 
range from -9,223,372,036,854,775,808 to +9,223,372,036,854,775,808.

LSB. Least Significant Byte. Also see endian.

LUT. Lookup Table.

Mac OS. Macintosh Operating System

MB. Megabyte

MIPAV. Medical Image Processing, Analysis, and Visualization 
program. MIPAV is an n-dimensional, general-purpose, extensive image 
processing, and visualization program. It is platform-independent and 
assists researchers with extracting quantitative information from various 
medical imaging modalities.

MR. Magnetic Resonance.

MSB. Most Significant Byte. See endian for more details.

MSEE. Master of Science in Electrical Engineering

MTX. Extension for MIPAV's transform matrix files.

NEMA. National Electrical Manufacturers Association. 

NIH. National Institutes of Health.

NM. Nuclear medicine.
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OS. Operating system

PACS. Picture Archiving System.

PCX. Extension for PC Paintbrush formatted graphic files.

PDU. Protocol Data Unit.

PET. Positron Emission Tomography.

PICT. Extension for Macintosh formatted graphic files.

PLT. Extension for MIPAV’s graphics files.

PNG. Extension for Portable Network Graphic formatted graphic files.

PSD. Extension for Adobe Photoshop formatted graphic files.
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RAM. Random Access Memory

Raster. Bitmap file type. 

Raw. File type.

resolution. The sharpness and clarity of an image. 

RGB. Red Green Blue.

RIS. TBD.

RLE (Run Length Encoding). The file extension for graphics that 
have been reduced using run-length encoding. RLE is a compression 
method that converts consecutive identical characters into a code 
consisting of the character and the number marking the length of the run.

ROI. Region of Interest.

RS. Extension for Sun Raster formatted graphics files.
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SCP. Service Class Provider.

SCU. Service Class User.

SGI. Silicon Graphics Incorporated.

short. Primitive, 16-bit data type. Short is a variation of the integer data 
type. Short accommodates values that are whole numbers. Valid values 
range from 0 to +32,767.

signed byte. Primitive, 8-bit, data type. Signed byte is a variation of the 
integer data type. The signed byte data type signifies that valid values fall 
within a range of whole numbers. Valid values range from -128 to +128. 
Negative values (indicated by the negative sign) are permitted, hence the 
term, signed byte.

signed short. Primitive, 16-bit data type. Signed short is a variation of 
the integer data type. The signed short data type signifies that valid 
values fall within a range of whole numbers. Valid values range from -
32,768 to +32,767. Negative values (indicated by the negative sign) are 
permitted, hence the term, signed short.

Solaris. Unix-based operating environment that was developed by Sun 
Microsystems. Solaris consists of the Sun operating system and a 
windowing system.

SOP. Service Object Pair

SOP. Service Object Pair.

SPECT. TBD.

TCP/IP. Transmission Control Protocol/Internet Protocol. The suite of 
communications protocols used to connect hosts on the Internet.

TGA. Extension for Truevision Graphics Adapter formatted graphics 
files.

TIFF. Extension for Tag Image File Format formatted graphics files.
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UID. Unique Identifier.

UNIX. Multi-tasking, multi-user operating system developed by Bell 
Labs. Many versions of UNIX abound, including Linux. 

unsigned byte. Primitive, 8-bit, data type. Unsigned byte is a variation 
of the integer data type. The unsigned byte data type signifies that valid 
values must fall within a specified range of positive, whole-number 
values. Valid values range from 0 to +128. Negative values (indicated by 
the negative sign) are not valid, hence the term, unsigned byte.

unsigned short. Primitive, 16-bit data type. Unsigned short is a 
variation of the integer data type. The unsigned short data type signifies 
that valid values must fall within a specified range of positive, whole-
number values. Valid values range from 0 to +32,767. Note that negative 
values (indicated by the negative sign) are not valid, hence the term, 
unsigned byte.

US. Ultrasound

VM. Virtual Machine.

VOI. Volume of interest (used interchangeably with ROI).

voxel. Smallest distinguishable cube-shaped part of a 3D image.

XBM. X BitMap file format.

XPM. X PixMap file format.
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